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Preface 

About This Document 
Oracle Corporation acquired MICROS and its Fidelio Cruise products. All further 
references to Fidelio Cruise should be considered as Oracle Corporation. 
This document is a PDF rendition of the Help that you received when you first 
purchased the Fidelio Cruise Material Management System and may have formatting 
inconsistencies. 

Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 
https://support.oracle.com 

When contacting Customer Support, please provide the following: 
• Product version and program/module name
• Functional and technical description of the problem (include business impact)
• Detailed step-by-step instructions to re-create
• Exact error message received and any associated log files
• Screen shots of each step you take

Documentation 
Oracle Hospitality product documentation is available on the Oracle Help Center at 
http://docs.oracle.com/en/industries/hospitality/ 

https://support.oracle.com/
http://docs.oracle.com/en/industries/hospitality/


Welcome to Fidelio

Navigation:  Introduction >

Welcome to Fidelio Cruise Material Management System Help module

Fidelio Cruise Management System

The Fidelio Cruise Materials Management System (FCMMS) offers the ship operator a complete tool to manage
the purchasing and inventory control processes in an efficient, time and cost saving manner. 
The program follows the logical purchasing process from time of purchase to the point of consumption and is fully
integrated with the Fidelio Cruise Ship’s Property Management System (SPMS). This program can be used in a
shore side location - at a cruise operator’s Head Office (the Head Quarter Module) if they are responsible for the
purchasing process for the vessel or fleet of vessels or onboard a ship (Shipside Module) if the ship is directly
responsible for the purchasing task.
Customers for FCMMS are the existing Fidelio Cruise customers who have been using the original Fidelio Cruise
Food & Beverage system but as this program is also a stand-alone product - it can be used independently of the
Fidelio Cruise SPMS - non-Fidelio Cruise customers are potential customers. In addition to offering full integration
with the Fidelio Cruise SPMS and an on-line interface to the Micros Point of Sale system, one of the key benefits of
FCMMS is that it gives the user a total overview (historic and real time) of all consumables. The user can track and
check on the status of all food, beverage, uniforms, tools, shop stock, medical items and more, that have been
ordered, purchased, delivered, consumed and invoiced throughout the life cycle of that item.

Navigation:  Introduction >

About Fidelio Cruise

Welcome



See Also:

Fidelio Cruise Software GmbH was founded in February 1995 by Tony Heuer and Max Lessmoellmann and is headquartered 
in the district of Altona in Hamburg, Germany. Today the company has grown into a global operator with offices in Fort 
Lauderdale and Kuala Lumpur and is considered market leader in the provision of integrated Shipboard Property 
Management Systems.
As President of Fidelio Cruise Software GmbH, Tony brings nearly 30 years of experience gained in the hotel and cruise 
industries both from an operational and IT perspective. Tony's focus is on the on-going development of the wide range of 
Fidelio Cruise products as well as looking at future industry needs.
Max holds the position of Managing Director at Fidelio Cruise with over 25 years experience from the international hospitality 
industry. Max's main responsibility is overseeing the day-to-day operation of the business including all remote offices, financial 
planning and control, human resources and sale and pricing strategy.
Tony and Max lead a team of highly experienced individuals who bring a vast pool of knowledge and expertise - gained in the 
cruise, hotel and IT industries - to the organization and ultimately to the customer.
Ever since its founding, Fidelio Cruise has built a vast wealth of knowledge and expertise while serving a worldwide client 
base. 
The company philosophy is simple - to be innovative, pro-active and flexible while maintaining a focused vision for the future. 
Fidelio Cruise endeavors to seek the best possible utilization of major shareholder Micros-Fidelio (Ticker symbol MCRS, 
NASDAQ)and their worldwide support structure. Using the experience and expertise gained in the past 8 years, Fidelio Cruise 
delivers ongoing development of software systems for use onboard ocean and river passenger vessels and more recently, 
Naval vessels and super yachts. Additionally, Fidelio Cruise conducts turnkey installations including yard and owner 
consultation on new builds and conversions, project management, cabling, hardware to name a few of the services on offer. 
In these 15 years, Fidelio Cruise has grown into a global company whose software packages are installed on almost 200 
vessels representing 50 companies. To support this worldwide operation, Fidelio Cruise Group operates a 24-hour, 365 day a 
year Customer Support Center in Hamburg and Ft. Lauderdale, for the exclusive use of Fidelio Cruise Group clients.



Welcome



The Article Manager can be considered the first point of reference for all products available company wide and may be used to setup and view 
product items, view purchase history and view consumption information. The module has multi language support allowing several languages for 
product descriptions*. Each product can also have multiple unit conversions allowing different purchasing, receiving and recipe units. This coding 
can be established directly at the headquarters and relevant information can be transferred to the vessel by the system ensuring product 
information for all users is up to date in real time.

Article Manager Main Screen: 

The image below represents the Article Manager main screen as it would look during normal operation. We can see the main function buttons on the toolbar 
and, below this, we have multiple windows showing the store, grouping and product detail. We can also see the 'path' of the selected article and the store 
currency. At the very bottom of the screen, you will see your vessel information, date & time, current user, computer name, database in use and the module 
version number. 

Moving your mouse over the screenshot you will be able to activate 'hotspots' identified with the cursive lining changing to a . 
Click on these to jump to more detailed information about that particular button or window. 

*The number of languages should be setup at time of install.

The buttons toolbar contains the basic and most frequently used options for creating articles, copying and pasting, searching etc. within 
Article Manager.

Navigation:  Reference >

Article Manager

Navigation:  Reference > Main Screen >

Buttons:

Main Screen



Buttons:

You can click on the buttons below or the links to see more information and instructions on the buttons usage.

Most of the options have corresponding tools in the menu, keyboard shortcuts assigned to them, or are available with a right mouse click.        

See Also:

This option refreshes the screen layout. For example, when you have sorted columns by their heading or resized them, then clicking 
refresh will reset the layout to the default view.

Button Refresh: 

See Also:

In order to make it easier to find an article among the many thousands that have been created, there is an effective search engine 
which can be utilized in a number of ways. On occasion, you may be able to remember the code of a particular product, maybe even 
the barcode, but for the most part you will probably want to search using the article description, either full or partial. Sometimes you 
might just want to look in the product groupings for an item or similar items. All these options are possible with the product search 
facility.

Button Search: 

Refresh Will revert the screen layout to its default state.
Search: Opens the 'search engine' where you can look for an item by entering full or partial data.
Add: Starts the process of creating a new article.
Edit: Starts the process of editing an existing article.
Delete: Starts the process of deleting an existing article.
Copy: Copies an existing article.
Paste: Pastes an existing article.
Lock: Locks the currently opened module.
Exit: Exiting out the current module.
Close View: Closes the current view.

 Article View
 How to add a new Article

Navigation:  Reference > Main Screen > Buttons >

Button: Refresh

Click to refresh your screen layout.

 Item list

Navigation:  Reference > Main Screen > Buttons >

Button: Search

Main Screen



By clicking on the tab  the following screen will appear:

By clicking on the  you will clear all search results from the window.

By clicking on the  button you will be able to retrieve the last searched item

See Also:

Click on Search and the Product Search Engine will appear on the screen.

  Note:
The system will only show articles that are enabled!! If you require the system to look for all 
articles, you have to click the  Enabled Search for Disabled Items checkbox under the Search 
Options.

Main Screen



Selecting 'Add' will create a new article file. The system will open the Article window, displaying a series of folders containing all the 
available article settings. Here you will enter all the necessary information regarding this item. Many of the fields are optional and serve 
to enhance the article detail such as Images, Notes and Documents. 

Button Add: 

The Article window appears as follows:

See Also:

 Article View

Navigation:  Reference > Main Screen > Buttons >

Button: Add

Create a new Article.

The same function can be accessed with a right 
mouse click in the item list.

 Article view

Main Screen



Selecting 'Edit' will allow the user to modify or edit an existing article file.  The system will open the Article window and allow changes to 
certain settings.

Button Edit: 

See Also:

Selecting 'Delete' will allow the user to modify or edit an existing article file. 

Button Delete: 

See Also:

This option pastes a previously copied article setup. When the article is pasted, by default it is pasted as 'disabled'. If you wish to start 
using the article immediately, then you should thoroughly check ALL the article settings before enabling it for use, especially the Micros 
configuration needs to be appropriate. 

 How to create a new Article

Navigation:  Reference > Main Screen > Buttons >

Button: Edit

Edit an existing Article.

 Article view

Navigation:  Reference > Main Screen > Buttons >

Button: Delete

Delete an existing Article.

When selecting this button, the following screen will 
appear for confirmation.

 Article view

Navigation:  Reference > Main Screen > Buttons >

Button: Paste

Main Screen



Button Paste: 

The same function can be accessed with right mouse click in the right item list or as a keyboard shortcut - CTRL+P

This option copies an existing article setup. All of the fields are copied like for like when the article is 'pasted' with the exception of 
'Images'. 

Button Copy: 

The same function can be accessed with right mouse click in the item list or as a keyboard shortcut - CTRL+C

This option locks the current module and will show the log in prompt. For using the module again the user needs to log in again.

Button Lock: 

This option closes the current view. The Article Manager is divided into 2 sections the main menu on the left hand side of the window 
and the item, report or system configuration details view. By selecting this option the user can close one view and change to another.

Button Close View: 

After clicking 'Copy' and selecting the destination folder, click on 'Paste' to drop the newly copied article to the folder.

Navigation:  Reference > Main Screen > Buttons >

Button: Copy

You first have to select the article you want to copy, then click on copy and select the final destination.

Navigation:  Reference > Main Screen > Buttons >

Button: Lock

Locks the current module.

Navigation:  Reference > Main Screen > Buttons >

Button: Close View

Main Screen



This option will close the Article Manager. You can also select from the Menu; File -> Exit.

Button Exit: 

The folder tree represents the groups and subgroups for items within Article Manager. 

Groups and Subgroups: 

To view the Article, first select the Store... 

Click to close the current view.

Navigation:  Reference > Main Screen > Buttons >

Button: Exit

Click to close Article Manager. 

Navigation:  Reference > Main Screen >

Tree of Folders

Main Screen



...then select the group

By selecting a folder and then using a right mouse click, the following menu will appear:

Refresh Tree: Returns to the main tree
Add Folder Add a new folder
Rename Folder: Rename an existing folder
Delete Folder: Delete an existing folder. 

Please note: Only empty 
folder can be deleted.

Expand Tree: Opens subgroups for 
selected folder 

Collapse Tree: Closes subgroups for 
selected folder

Folder Properties: Displays selected folder 
information

Most of these options are also available as keyboard shortcuts or can be found in the Toolbar.

You can drag and drop folders with the following procedure:

Left click on the folder you wish to move to select it, hold <SHIFT> on the keyboard and then drag the folder to the desired location.

Main Screen



In the main window, you will see all the Articles that are assigned to the selected group.

Item List: 

On the top of the item list, you will see the path of the selected group (\ Spirits \ Vodka \ ) and the currency of the Store (GBP).

On above screen, the system displays all articles in the currently selected folder. From that screen, the user may double click the selected article in order to 
preview all article properties and the user can modify and change current settings for items.
By utilizing the option “Enable in grid editing”, the system will allow the user to type values of the fields directly inside the grid displayed to perform easy update 
of article data, without opening the article properties screen.

Below are the column headings:

Navigation:  Reference > Main Screen >

Item List

Group Field Notes

Item Details

Enabled Is the article enabled on the ship? Can it be utilized?

Code Article Code

Description Primary Description of the article

Unit Base unit of measure of the article

Pricing

HQ Fixed cost used by the HQ.

Ship Fixed cost to be utilized by the ship.

Retail POS

Enabled Will the article ne available for sales in the RPOS system?

Discountable Is the item allowed to be discounted?

Maximum Discount 
% What is the maximum % discount allowed?

Sales Group Sales group assigned to the article.

Promotion Group Promotion group assigned to the article.

Service Charge 
Group Service Charge group assigned to the article.

Tax Group Tax group assigned to the article.

SPMS Posting 
Group SPMS posting group assigned to the article.

Status Discount Type of status discount assigned to the article.

Menu Item ID Menu item ID to be used by other POS systems.

Check Description Short description of the article to be printed on the RPOS check.

Minimum Age Which is the minimum age the article can be sold to?

Selling factor If stocking and selling units are different, factor should 

Weighted item Will the item be used with electronic scales.

Secondary Receipt Does this article require secondary receipt? For example deposit receipt for alcohol 
purchased.

Stock Control Is this item stock controlled?

Main Screen



See Also:

This Menu contains basic options which are also represented in the Toolbar and, often available with a right mouse click.

Menu: 

Ordering Properties

Order Group What is the ordering group for that item? E.g.: Fish, fresh vegetables, liquor.

Lead Time What is the lead time for ordering this item?

Consignment Goods Should this item be considered a consignment good?

Consumption Type Type of consumption for the article.

# Reserve Days Should additional consumption reserve be added to the order request? Reflected in 
days of consumption.

Weight Article weight reflected in KG.

Tax Group The tax group the article will be assigned to.

Invoice Controlled By default this option is disabled and should only be enabled for items which are 
invoiced but not received.

Custom declaration

Included Should this article be included in ships custom declaration?

Customs Which category should the article belong to?

Factor The conversion factor between based unit of measure and the unit of measure of the 
category.

Shelf Life Control

Stock Controlled Is this item stock controlled?

Enabled Does the article need to have indicated on the PO specific expiry date?

#Days How many days counted from the date of delivery is requested as an expiry date of 
the product? 

Various

General Ledger 
Account Which GL account (item class) is the article linked to?

Comments Additional comments about the article.

Internal ID Internal ID used by the system.

 Article View - General

Navigation:  Reference > Main Screen >

Menu

Main Screen



This menu contains the basic layout setup and offers the possiblity to export selected data into text, pdf or excel sheets.

File Menu options: 

See Also:

Navigation:  Reference > Main Screen > Menu >

File Menu

Grid Layout:      

Skins:     

Export:               

Exit:

When changing the layout of the items in the window save changes so 

that the grid will always stay the same.   

With this option the color of the windows can be set.

By selecting export you will be able to export the selected store data into 

an excel, pdf or text file.

By selecting this you will exit the Article Manager Module.

Main Screen



As mentioned before here you can edit, save and delete adjustments to the structure/ sorting of the Article List window.

Modify the grid layout: 

With this option the user can modify the appearance of the Article Manager window .

Changing a skin:

Navigation:  Reference > Main Screen > Menu > File Menu >

File -> Grid Layout

   Edit Layout:        

   Save Layout:       

   Delete Layout:

With this option you can personalize the appearance and order of the item 
properties.   

When unique settings have been made you can save them with this option.

Deletes a previously customized layout.

Navigation:  Reference > Main Screen > Menu > File Menu >

File -> Skins

  Here you are able to select the color of your windows.

  Please keep in mind that selecting skins with many images may slow down your system.

Navigation:  Reference > Main Screen > Menu > File Menu >

File Menu : Export

Main Screen



This allows the user to export the contents of the Article list in the main window into text, PDF or Excel.

Export of data:

Click on Export and select 
the kind of file you want to 
export to.

Exporting the view to Excel 
allows the user to 
manipulate the data using 
the extended functionality 
that Excel provides. 

Perhaps you want to 
produce your statistical 
information and create 
graphs and charts, this is 
where the export feature 
will prove useful.

Exporting into PDF.

Exporting into text.

Main Screen



This option will close the Articles Manager Module. You may also select from the Menu; File -> Exit.

Exit: 

This menu contains the basic file options for creating and renaming or cutting & pasting folders. Most of the options have corresponding 
tools in the Toolbars, and several already have keyboard shortcuts assigned to them.

Edit: 

Here you can create a new sub-folder in the Tree of Folders. The same option can be accessed with a right mouse click in the folder 
section.

Add Folder: 

Navigation:  Reference > Main Screen > Menu > File Menu >

File Menu : Exit

Click to close Article Manager. 

Navigation:  Reference > Main Screen > Menu >

Edit if folder selected

Refresh Tree: 

Add Folder

Rename Folder

Delete Folder:       

Expand Tree:   

Collapse Tree:

Folder Properties:   

Returns to the main tree with the added folders.

Add a new folder.

Rename an existing folder.

Deleting an existing folder. Note: Only empty folder can be deleted.

Opens all subgroups.

Closes all subgroups.

Displays selected folder information.

Navigation:  Reference > Main Screen > Menu > Edit if Folder Selected >

Add Folder

By clicking on AD FOLDER a new folder will be created.

When prompted enter a folder name. by default the folder has no options security roles assigned. The users can only 

Main Screen



See Also:

With this option you can rename an existing Folder. The same function can be accessed with F2 or right mouse click on the Folder.

Rename: 

Here you can permanently delete an existing Folder. The same function can be accessed with SHIFT+DEL or by a right mouse click on 
the Folder.

Delete: 

This option allows the user to open all groups and subgroups in the selected Mainstore with one click.

Expand Tree:

work with the newly created folder if security groups have been properly assigned to the folder.

 Folder Properties

Navigation:  Reference > Main Screen > Menu > Edit if Folder Selected >

Rename Folder

Click on rename to change the name of the folder.

Navigation:  Reference > Main Screen > Menu > Edit if Folder Selected >

Delete Folder

Click to delete a folder.

Note: You can only delete an existing Folder if there are no Articles assigned to it. If there are Articles assigned, you have 
to remove them first before you can delete the Folder

Navigation:  Reference > Main Screen > Menu > Edit if Folder Selected >

Expand Tree

Click on EXPAND to open all subgroups.

Main Screen



This option allows the user to close all groups and subgroups in the selected Mainstore with one click.

Collapse Tree: 

Properties displays the system information related to the folder and allows the user to assign markups for all items belonging to the 
selected folder.

Navigation:  Reference > Main Screen > Menu > Edit if Folder Selected >

Collapse Tree

Click to close all open subgroups.

Navigation:  Reference > Main Screen > Menu > Edit if Folder Selected >

Edit -> Properties

Main Screen



Folder Properties:

Folder Name:

Type: 

Location:

Contains:

Modified:

Markup:

Attributes:

Name of the folder.

Folder Type.

Sub folder of .... 

Shows how many Articles belong to this 
folder.

Shows when the last changes were 
made to the folder.

Default Markup for the whole group in 
%.

If locked, the individual Markup per 
Article can't be changed.

Allows the user

Main Screen



***

Allows the user to enter alternative 
codes for the pre-defined interfaces.

Allows the user to assign security 
groups to the folder. Only users within 
the assigned users group may modify 
the folder and its content.

Navigation:  Reference > Main Screen > Menu >

Menu -> Edit

Main Screen



This menu contains the basic file options for creating, opening and copying articles. In addition to this, the File menu also contains the 
options for statistical information. Most of the options have corresponding buttons in the Toolbars, and several have keyboard shortcuts 
assigned to them.

Edit Article: 

See Also:

Selecting 'Add' will create a new article file.  The system will open the Article window, displaying a series of folders containing all the 
available article settings. Here you will enter all the necessary information regarding this item. Many of the fields are optional and serve 
to enhance the article detail such as Images, Notes and Documents. 

Add: 

The Article window appears as follows:

Add:

Delete:

Copy:

Paste:

Show Purchase 
History:

Show Consumption 
History:

Show on Order 
Details :

Show item summary :

Properties:

Clicking Add will insert a new 
Article row and open a new 
popup window on the General 
setup ready for entry.

By selecting an item and then 
selecting DELETE the user will 
delete the item from the 
system.

By selecting this icon the user 
will be able to copy the item 
and all its details.

By selecting this icon the user 
is able to insert an article which 
has been copied to the 
clipboard before.

Shows the Purchase History 
per Article.

Shows the Consumption 
History per Article.

Shows the On Order details per 
Article.

Shows the Item Summary per 
Article.

Shows the item properties/ 
article details screen..

 Add a new Article
 Article View

Navigation:  Reference > Main Screen > Menu > Edit if Article Selected >

Add

Create a new Article.

Main Screen



See Also:

Delete will remove an existing Article. The same function can be accessed with a right mouse click in the right item list, or as a 
keyboard shortcut SHIFT+DEL

Delete: 

Once you click 'Delete', the system will prompt the message below to make sure you are happy to continue:

The same function can be accessed with a right 
mouse click in the item list.

 Article view
 How to create a new Article

Navigation:  Reference > Main Screen > Menu > Edit if Article Selected >

Delete

Main Screen



This option copies an existing article setup. The same function can be accessed with a right mouse click in the right item list or, as a 
short key CTRL+C

Copy: 

This option pastes an existing article setup which has been copied. The same function can be accessed with a right mouse click in the 
item list or, as a keyboard shortcut CTRL+P.

Note: If you pressed YES by mistake, you are still able to restore your Article from the Deleted Items within the Article 
Manager.

Select System Configuration.

Select Deleted Articles.

Here the user can see all the items that have been 
deleted. Select the article to be restored, once 
highlighted select either 'Restore' the item or 'Purge' it 
from the database.

Navigation:  Reference > Main Screen > Menu > Edit if Article Selected >

Copy

You first have to select the article you want to copy, then click on copy and select the final destination for pasting.

Navigation:  Reference > Main Screen > Menu > Edit if Article Selected >

Menu -> Edit -> Paste

Main Screen



Paste: 

This option shows the user the purchase history for the selected item, for a specified period of time, a selected vendor and selected entities.

Show Purchase History

After you have clicked on 'Copy' and selected the final destination folder, click paste to place the article into the folder.

Navigation:  Reference > Main Screen > Menu > Edit if Article Selected >

Show Purchase History

ENTITES:

FROM 
DATE:

TO DATE:

FILTER 
VENDOR:

Use the 
drop down 
to select 
one or 
more 
entities. 
Within the 
drop down 
menu you 
have the 
option to 
mark ALL 
or to 
CLEAR all 
entries.

Select the 
start date.

Select the 
end date.

Use the 
drop down 
to the 
select one 
or more 
vendors. 
Within the 
drop down 
menu you 
have the 
option to 
mark ALL 
or to 
CLEAR all 
vendors.
When the 
requested 
data is 
shown the 
user can 
select to 
export the 
data into 
Excel, 
PDF or 
Text.

Main Screen



This option shows the user the consumption history for the selected item for a specified period of time and selected entities.

Show Consumption History:

This option shows the user the pending requests for the selected item for a specified period of time and selected ships.

Show On Order Details:

Selecting this will open a window with information as shown below:

Navigation:  Reference > Main Screen > Menu > Edit if Article Selected >

Show Consumption History

ENTITES:

FROM 
DATE:

TO DATE:

Use the 
drop 
down to 
select one 
or more 
entities. 
Within the 
drop 
down 
menu you 
have the 
option to 
mark ALL 
or to 
CLEAR all 
entries.

Select the 
start date.

Select the 
end date.

When the 
requested 
data is 
shown the 
user can 
select to 
export the 
data into 
Excel, 
PDF or 
Text.

Navigation:  Reference > Main Screen > Menu > Edit if Article Selected >

Show On Order Details

VESSELS: 

FROM DATE: 

TO DATE: 

Use the 
drop down 
to select 
one or 
more 
vessels. 
Within the 
drop down 
menu you 
have the 
option to 

Main Screen



This option shows the user product statistics for the selected item, like the current stock on hand in the warehouses or onboard the vessels.

Show Item Summary:

mark ALL 
or to 
CLEAR all 
entries.

Select the 
start date.

Select the 
end date.

Navigation:  Reference > Main Screen > Menu > Edit if Article Selected >

Show Item Summary

Main Screen



This option opens the article details.

Properties: 

Navigation:  Reference > Main Screen > Menu > Edit if Article Selected >

Menu -> Edit -> Properties

Click to open Article properties.

Main Screen



See also

When creating a new item or opening an existing one, MMS opens the Article Details window.
This is where all the necessary information regarding the article is entered. 
Certain fields are compulsory, others are optional such as alternate language description, images etc. 
The folder icons in the right window represent various pieces of information that relate to the article. 
Each time the user clicks on a different folder he will be presented with a new set of fields to add to the description and setup of that article. 
With these options it is possible to make the configuration as simple or as detailed as required. 
The users can, for example, set up to 5 language descriptions, upload 3 different images and also create notes and even attach other documents if 
relevant. 
All of the folders are broken down individually in this help section and, for ease of use, we refer to them as tabs. 

General Properties:

When first opened, the window defaults to the 'General' settings for the primary setup as shown in the screenshot below. Move your mouse over the image 
and you can click on certain parts to jump to the help information. 

 Article View

Navigation:  Reference >

Article Details
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Article Details show general information about the item.

Article Details:

Navigation:  Reference > General Properties >

Article Details

Status: Is article enabled for use? 
Only articles matching certain criteria can be enabled. 
As an absolute minimum the article must be assigned a code, description and unit of measure before it can 
be enabled. 
Additional requirements may include specifying a GL code, taxation class or certain custom properties.

Article type:        MMS utilizes following article types: Grouping code, Parent code, Child code.
Article Code:        Each article must be assigned a code, which can be assigned manually but also automatically using a 

sequential number. 
For the system to auto assign the code the user should press "…" button.

Article 
Description:

Primary description of the article. It is recommended to keep the language in English. The description can be up
to 250 characters long.
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.

Secondary languages allow the user to enter customized translations for the selected item in pre-defined languages.

Secondary languages:

Alternative Coding allows the user to enter alternative codes for the selected item for pre-defined interfaces.

Alternative Coding:

Navigation:  Reference > General Properties >

Secondary Languages

Language: Shows the pre-defined languages.
Description: The user can enter the translation of the article description for the selected language.

Navigation:  Reference > General Properties >

Alternative Coding

Interface: For the purpose of exchanging data with various systems, MMS can store defined type of codes utilized 
by 3rd party system. The list of those interfaces is predefined.

Code: An article code must be unique per interface and can be utilized in the search engine to locate necessary 
items.

Navigation:  Reference > General Properties >
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Article Properties allows the user to activate shelf life control, to assign a tax group, enable tracking and other options for inventory or customs 
properties.

Article Properties:

PURCHASING:

PRODUCT LOT AND SERIAL NUMBER TRACKING

Enabling this control will allow the system to track the item back to its place of origin

Article Properties

Shelf Life Control:       Enabled: Does the article need to have indicated on the PO specific expiry date?
Range (# of Days): How many days counted from the date of the delivery is requested as a expiry 
date of the product?

Order Group:        Items can be part of order groups for easy purchasing.
Order Lead Time:   The number of days it takes to have the item delivered.

Bid Specifications:   Information is utilized to provide supplier more detailed information about the article. Used in PO, 
Bids, PO confirmations.

Product Tax Group:     The tax group the product belongs to.

General Ledger 
Account:        

Where the item is accounted for.

Tracking Type:        Items can be tracked either by serial number or by batch.
Control Type:        The system may be set to force the user to always enter a serial number.

Note:

If the Product and Serial 
number tracking is enabled 
and the control type is set 
to force the item can be 
recognized in the receiving 
module - loading details by 
the hand in front of the 
item line.
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Under the Inventory tab the user may modify several inventory and custom options.

Inventory:

Customs declaration:

Navigation:  Reference > General Properties >

Inventory

Stock 
Inventoried: 

If the item is a physical item then this option should always be enabled.

Consumption 
Type:        

Type of consumption can be chosen either per passenger per day or per passenger per cruise.

Days Reserve 
Stock:

The number of days the item is available from the reserve stock.

Customs 
declaration:

Enabling this option will tell the system whether the item needs to be declared at customs.

Customs Group: Which customs group the item belongs to.
Factor: The conversion factor between based unit of measure and the unit of measure of the category.
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Custom properties can be grouped for easier maintenance. This can be based on brand, color, material etc.

Custom Properties:

Allows the user to specify per ship the maximum and minimum amount of stock allowed/ required.

Maximums and Minimums:

Navigation:  Reference > General Properties >

Custom Properties

Navigation:  Reference > General Properties >

Maximums and Minimums

Main Screen



Units refers to 'Units of Measure'. This is where the base unit of measure for the article is defined. If you receive the article in a different 
unit, the system will always convert this back to the base unit. 

Unit Properties:

Any additional comments can be added regarding the item.

User Notes

Vessel: Minimum and Maximum values have to be defined per ship.
Show all POC: By default includes only stock locations.
Location:  When main store - the min max apply to Requests, when POC - the values apply to issues.
Maximum: Maximum quantity of stock allowed.
Minimum:        Minimum quantity of stock that main store/ POC should have.
Enforce:  If enforced, the transaction will be canceled, otherwise a warning will be displayed.

Navigation:  Reference > General Properties >

Unit Properties

Article Unit:         Base unit of measure of the article. It is recommended to utilize the smallest issuing/sales unit of 
measure that has a meaning of quantity. Once the article has been enabled, this value cannot be 
changed.

Fixed Price HQ: Fixed cost used by Headquarters.
Store Markup: Calculates in % how much this item is being marked up in price. This number is being taken from the 

folder settings this item belongs to.
Fixed Price Ship: Fixed cost to be utilized by the ship.
Gross Unit 
Weight:

Article weight reflected in KG.

Navigation:  Reference > General Properties >

User Notes
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The fleet range option allows the user to activate items only for certain ships and warehouses or for all.

Fleet range:

The Fleet Range shows which vessels are authorized to request the particular item.

Under the tab barcodes  the user can enter several barcodes assigned to the product.

Barcodes:

Navigation:  Reference > General Properties >

Fleet Range

Navigation:  Reference > General Properties >

Barcodes
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A barcode can also be entered for each item which is then used by the search engine.

Lockers are defined onboard storage locations. 

Lockers: 

Navigation:  Reference > General Properties >

Lockers

Navigation:  Reference >

RPOS Properties
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Under the RPOS Properties the user can find all options and configuration bits that are specific for the items use within Retail POS.

General:

Under the RPOS properties the user may enable the item for use on the till, assign the item a shorter check name and define other RPOS specific 
conditions. Furthermore the RPOS properties are used to define check name and Article Lookup ID usd in the MICROS export.

Retail POS properties:

Navigation:  Reference > RPOS Properties >

Properties
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Under the grouping the user needs to assign the item certain groups, like sales group, promotion group and tax group.

Grouping:

RPOS Status: If enabled the item will appear on the RPOS workstation.
Article Lookup 
ID:        

If menu item numeric look up should be used, the menu item number must be entered in this field.

Check 
Description:

The item description which will be printed on the guest check. There is a limitation of 20 characters for 
the check description.

Age 
Restrictions:

This field will be in use for Tobacco and Alcohol items. It states the age the buyer to be to be able to 
purchase the selected item.

Selling Units: Contains the amount of units which are included in one sale.
Quantity by 
Scale:    

If enabled this item is being sold by weight.

Stock Control:     If this option is enabled and the item is being posted on the workstation, the POS will display a warning 
if the stock goes into negative.

Discountable: If checked the item may be discountable. Uncheck if this item should never receive any discount.
Maximum 
Discount%:

The maximum amount of discount that can be given on the selected item.

Fixed Price HQ: Fixed cost at Headquarters.
Mark Up Factor: Calculates in % how much this item is being marked up in price. This number is being taken from the 

folder settings this item belongs to.
MRSP: Manufacturer suggested retail sales price.

Navigation:  Reference > RPOS Properties >

Grouping
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The tab price lists should be used for assigning various prices to the same item. Price Lists can be used if the item will be sold under several 
currencies.

Price Lists:

Sales Group:        This field defines the sales group this item is part of. The sales group defines under which button 
this item will be located in the POS.

Promotions Group: States the promotion group this item is part of.
Tax Group: States the tax group this item is part of.
Service Charge 
Group:

States the service charge group this item is part of.

SPMS Posting Group: States posting group of the item which is used by Fidelio Cruise SPMS.
Status Discount 
Group:

Show the status discount group the item belongs to.

Navigation:  Reference > RPOS Properties >

Price Lists
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The tab Active Promotions gives the user a quick overview to which promotion(s) the article is assigned.

Active Promotions:

Under this tab users are able to upload pictures and documents regarding the item.

Images and Documents:

Navigation:  Reference > RPOS Properties >

Active Promotions

Navigation:  Reference >

Images and Documents
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FC Medical Interface

The Modification Logs window will show you every step since the item has been created including all the modifications in the meantime.

Modification Logs:

It provides information about when the item was created, or whether if anything has been changed. 

Each modification is logged by its date, time, windows user, the user of the application, the computer, and of course the exact description of the modification.

Navigation:  Reference >

Interfaces

Navigation:  Reference >

Modification Logs
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The System Modification button will lead to a submenu which offers the user options for general system configuration like modification of the unit 
setup, restoring of deleted items, automated article import and tax group setup.

Access to each of those sections should be securely controlled, as modification of core system dictionaries may have negative impact on system 
performance. Please consult Fidelio Cruise if not sure about modifying any values in that menu.

General:

Navigation:  Reference >

System Configuration

Navigation:  Reference > System Configuration >

Article Import
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The Article Import has been designed in order to streamline the process of creating new items in large quantities. The import works a bit different as 
the article manager has its own part of application to create items. The functionality is based on pre-setup article lists in Excel. Once the articles 
have been imported from Excel they can be reviewed and modified in the Article Manager.

General functionality:

Preparation of Excel Import File:

The preparation of the Excel File is the First step in the work flow to import items. The Excel File does not require a certain layout but the presence of some 
information in some fields is required. The most important and required columns are: 

Will revert the screen layout to its default state and refresh it with current updated information.

Opens the 'search engine' where you can look up an item by entering full or partial data.

Starts the process of defining the properties of a new Article Import.

:

Will delete the selected Article Import properties. The user will not be able to reuse this article import definition. 

Displays the properties of an existing Article Import and will allow you to modify them.

Will log off the current user.

Closes the Article Manager.
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In addition there are some fields which must be contained in the Excel Sheet in order to use the Auto Enable functionality.
These Fields are:

If Prices (Bids) from the suppliers should be imported some more fields need to be added in the import file. 
These Fields are: 

Creating a new article import definition:

 Tree Folder Location
 Item Description Primary
 Item Unit
 Item Gross Weight
 Item Code 

 Item Tax Group
 General Ledger Code

 Bid Price
 Bid Currency
 Bid Units

Click on ADD to define the details for the article import.

Specify a name for the import. Good naming conventions make 
the life of all users more easy.
Specify the amount of  master data columns in the Excel Sheet. 
Also include columns that will be skipped during the import.
Define the first data row. We would recommend to have always 
a column header within the excel file. This will make the work in 
excel certainly much easier. Upon importing such a line the 
Application will skip the information in the column header and 
directly import the article from the first data row as specified. 
Allocates the items to a certain vendor. 

Allocates the items to a certain retail price list as per definition in
the RPOS Setup.
A free text field which may contain information about the article 
Import definition.

Within the second Tab the user can define what exact 
information is contained in each of the Columns of the Excel 
File.

The user should open the drop down menu and select the 
appropriate data field.

Upon completion APPLY will save the settings for this import 
definition and the window will close.
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Import of the Excel File:

The user should select the import definition which he wants to run and click on IMPORT.

The Article Import Process window will open.
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Once all the settings have been selected click on the  Button to import the excel sheet.

File Location: Specifies the path of the File: 
Excel Sheet Name: Name of the Worksheet within the excel file.First row of data: First Row within the excel sheet which 

contains the data.
Default Mainstore: Items to be imported in which Mainstore. Please select from the drop down menu.
Auto Create Folders: If the name of the folder/ category or Item class would not exist the Folder in the tree view will be auto 

created
Update existing Items: Add information to existing items if they already exist? 
Auto Enable Items: If all required settings are present the items can be set to "enabled" in the system.
Auto Generate Custom 
List values: 

If Custom value fields are not present they will be auto generated.

Auto Number Codes: Enabling this function will auto generate the MMS Item Code. Only select this option if your system is 
configured to handle auto  numbering.

RPOS Pricelist: Choose from the different Retail price lists to be imported.
Bid Vendor: Bids prices to be assigned to which vendor?
Bid default Start Date: 
Bid default end date: 
Bid Currency: Select the currency with which the item will be imported.
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The system will perform a pre-check of the data, once this does not show any errors the users may proceed by clicking on .

Once finished there will be a notification that the import is finished.

The option Unit Setup contains core information about units of measure. 

Unit Setup:

Navigation:  Reference > System Configuration >

Unit Setup

  Note: Changing any information in the unit setup may result in damage of the system. Please DO NOT perform 
any changes without prior consultation of Fidelio Cruise MMS support/ installer.
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Available sections within the tax group setup:

Tax setup is split into 3 sections.

Once this dictionary will be setup, it will be used for calculation of necessary tax on per invoice/PO level.

Under the Region and Item Tax groups the Edit button allows to define the code and the description or each group.

This option can be utilized to copy Fleet range (allocation of ships to articles) from one ship to another. 
Please note that before copying the Fleet range, the system will clear the Fleet range of the destination ship.

Navigation:  Reference > System Configuration >

Tax Group Setup

1. The top one identifies the region that tax calculations will be performed for;
2. The bottom one identifies the Groups of articles particular tax will be defined for;
3. On the right side, per each Region and each Item Tax Group, a tax rate and % deductible can be defined.

Navigation:  Reference > System Configuration >

Clone Fleet Range
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Clone Fleet Range:

Select as Source ship the ship you want to copy the information from.

Select as Destination ship the ship that should receive all the item information from the Source ship.

Setup of General Ledger Accounts (Item Class), once initially done and verified, is a static setup, which is mirrored in the accounting system. 
Values presented here should always be checked against the accounting system.

Each GL Account (Item Class), contains a Name (for easy distinguishing), and code split into 3 sections, while the only section required is CODE 1.

General Ledger Accounts

Navigation:  Reference > System Configuration >

General Ledger Accounts     
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The option Deleted Item offers the user the ability to restore or purge previously deleted items.

Restore or Purge deleted items

Application Settings:

Navigation:  Reference > System Configuration >

Deleted Items

Select System 
Configuration.

Select Deleted Articles.

Here the user can see all 
the items that have been 
deleted. Select the article to 
be restored, once 
highlighted select either 
'Restore' the item or 'Purge' 
it from the database.

Navigation:  Reference > System Configuration >

System Configuration
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General Settings:

Navigation:  Reference > System Configuration > System Configuration >

General Settings

Navigation:  Reference > System Configuration > System Configuration > General Settings >

Entity Setup
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The General Settings - Entity Setup is used to maintain the list of company entities. Each unit that utilizes the MMS software is considered an entity. 
Normally entities consist of a headquarters, individual vessels and perhaps a warehouse.

Each ship or other entity (HQ, warehouse etc) must have an entry on this list including a valid license for the software.

Application Settings - Entity Setup

Main stores are the outlets that physically receive the various types of articles that are in use onboard. Typically each main material type is 
assigned a store such as food items, beverage items, consumable items, etc. The categorization can vary from operation to operation and MMS 
software has the ability to adjust to each particular way of working

Application Settings - Mainstore Setup

Navigation:  Reference > System Configuration > System Configuration > General Settings >

Mainstore Setup
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The user may delete mainstores as 
long as they do not have any 
subcodes assigned to them.
The user can add new mainstores.

By clicking on Edit the user may 
modify the current configuration of 
the mainstore.

Code:

Name:

Currency: 

GL Code:

Fixed Markup:

Insert a unique code for numbering 
the main store to be created.

Insert the name of the main store to 
be created.

Select the storeroom currency from 
the drop down list.

Assign a GL code to the mainstore.

Each store can be assigned a 
markup factor that is used to 
calculate the vessel's fixed cost. 
If any is used, insert the factor in the 
field provided. If none is used leave 
the default value intact.

Main Screen



Shipboard departments are pieces of the onboard organization, within which the outlets (Points of Consumption) exist. Typical main departments in 
a normal shipboard organization are the Hotel, Deck and Engine departments. Each one of these can then contain several sub-departments 
depending on how the organization is set up. One of the peculiarities of the Hotel department is that it may house several sub-departments, 
whereas the Engine and Deck departments normally only have points of consumptions under them. 

Application Settings - Departments Setup

Select the user groups that have 
should access the main store by 
selecting the group on the left to 
select all the users as assigned to 
the new store.

Navigation:  Reference > System Configuration > System Configuration > General Settings >

Departments Setup

From the dropdown menu select the 
vessel you want to define the 
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departments for.
The user may delete departments as 
long as they do not have active 
POC´s assigned to them.
The user can Add new departments.

By clicking on Edit the user may 
modify the current configuration of 
the department.

Code:

Name:

PPD Target
Minimum:

PPD Target
Maximum:

GL Code:

Use a short (max 6 characters) code
for a unique identification of the
department.

Insert the common name of the
department.

(Passenger Per Day Minimum
Target) Insert the minimum sales
target range for the department in
this field if required.

(Passenger Per Day Maximum
Target): Insert the maximum sales
target range for the department in
this field if required.

Assign a GL code to the department.

Under the security tab of the
Department Properties you can
define user groups who can access
(users to create material issues) the
department. 
Two types of security need to be
setup: Users and Managers. 

Users are able to create issues.
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The Points of Consumption consist of the different shipboard outlets within each main department. 

Application Settings - Point of Consumption Setup

Managers authorize issues.

Note: Special kind of department with description “Accounts” must be created, in order to be
able to create “Account” type of POC.

Navigation:  Reference > System Configuration > System Configuration > General Settings >

Point of Consumption Setup

From the dropdown 
menu select the vessel 
you want to define the 
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departments for.
From the drop down 
menu select the 
department you want to 
define the Point of 
Consumption for.
The user may delete 
points of consumption as 
long as they are not in 
use in the current period, 
there are no movements 

for this POC and all the 
stock on hand is zero.
The user can Add new 
points of consumption.

By clicking on Edit the 
user may modify the 
current configuration of 
the point of consumption.

Code:

Name:

Department:

Closing Type:

Currency:

Group:

GL Code:

Use a short (max 10 
characters) code/name 
for a unique identification 
of the POC. 
All these Codes will later 
appear on various 
Reports and especially in 
the Sales Import Module. 

Insert the common name
of the POC.

Select the department
under which this POC will
be categorized.

Select one of the 5
predefined closing types.
For more information
about closing types see
CLOSING TYPES .

Select the base currency 
of the POC to be created.

The group refers to which 
group division the POC is 
referring. There are only 
options for passengers or 
crew.

Assign a GL code to the
point of consumption.

Mainstores:

Reporting 
Groups:

Price List:

PPD Target 
Minimum:

PPD Target 
Maximum:

Select the mainstores the
new POC will have
access to. 
By clicking on the arrow a
selection box will open
where the user may
select one or multiple
mainstores.

Select the reporting
groups to which the POC
should have access to/
appear in.
By clicking on the arrow a
selection box will open
where the user may
select one or multiple
reporting groups.

Select a price list of
alternative sales price
lists are used in the POC.

(Passenger Per Day
Minimum Target) Insert
the minimum sales target
range for the department
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Closing types:

General information regarding stock transfer from the period to be closed into the new period:

The following events are not considered when assigning a Closing Type and apply for all the Closing Types:

The System can be configured in two ways how to handle negative Stock on Hand figures:

They will be transferred with the current Stock on Hand and the current negative price.

Closing Types of the Points of Consumptions:

in this field if required.

(Passenger Per Day
Maximum Target): Insert
the maximum sales target
range for the department
in this field if required.

1. Negative Stock on Hand Quantities

a) Not allow negative Stock: Negative Stock on Hand in Points of Consumption will stop the Period Reset Process. These Stock Values need to be corrected 
by conducting a Inventory. This is the recommended System Setting in order to check for the actual physical Stock on Hand in the Point of Consumption.

b) Allow negative Stock: In Cases were Stock on Hand Level is negative the System automatically generate an Inventory to correct these values to zero. The 
disadvantage of this option is that Stock on Hand is set to zero despite the fact that there might be physical stock present in a Point of Consumption.

In any Case the System will not transfer negative Stock on Hand figures into the new Period.

2. No negative Prices of Items will be corrected during the Period Reset Process.

Automated Stock 
Deduction

The stock (inventory) of this outlet will be deducted automatically using the 
stock deduction function which considers the sales in the Micros Point of 
Sale system and automatically deducts the sold items from the current stock 
of the selected outlet (POC).
In order to have full control over the Stock deduction process the system 
allows the stock for Points of Consumption to go into negative values. 
Possible reasons for this events might be that an item is poured in  a lower 
quantity than indicated in the recipes or a different item than in the recipe is 
physically handed out.
In any case negative Stock on Hand needs to be corrected before the Reset 
can be done.
Closing Stock on Hand for the old Period will be the current Stock on Hand 
reduced by the Stock Deduction from Micros POS System. The remaining 
Stock will be carried over into the new Period as Opening Stock.

Carry Over The carry over option does a complete transfer of the items in inventory 
directly to the next period without applying any corrections. This does not 
include negative Stock on Hand Figures.

Manual Processes a closing of the inventory considering all items consumed and 
starting with zero stock for the new period. 
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Most commonly this Option is used for Points of Consumptions like Galley, 
Food Courts etc. where the Stock on Hand is not deducted by Recipes. In 
these cases it is assumed that all stock of all the issues in the current period 
within the current period have effectively been consumed. 
During the Period Reset Process the present Stock on Hand will be set to 
zero. These Figures will appear in the corresponding Period Reports under 
the column "Consumption". Closing Stock on Hand will be zero as well as the 
Opening Stock of the new Period.

Period End 
Inventory

The setting needs to be applied for all Points of Consumptions where a End 
of Period Inventory needs to be conducted before a Period Reset can be 
done.
During the Period Reset Process the system requires a confirmation from the 
user in order to proceed. This confirmation is applied by a special button 
within the Period Reset Module. Further on this confirmation is logged under 
Period Reset Events and can be traced back to the specific user in the Event 
Viewer Module.
After conducting the Inventory the current Stock on Hand will be transferred 
into the new Period as Opening Stock.
The system will not correct negative Stock on Hand values and will not carry 
these values over into the new Period.

Deduction plus 
Inventory

This closing method is a combination of Automated Stock Deduction and 
Period End Inventory and conditions for both apply on this closing type
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This chapter will guide you through creating a new article step by step. As mentioned 
elsewhere in the help, many of the fields are optional and do not need to be completed 
immediately during the initial setup. You can return to the setup at a later date and add in 
new information or change the current details as and when required. 

Create a new Article: 

Before you begin to create a new article, make sure you have all the necessary details to hand. You don't 
want to start creating an item and then have to run down to the fish freezer to see what size your haddock 
fillets are or how many napkins are in the newly delivered box.
Once you have all the required information on your new article, you can begin to create it in Article 
Manager.
First decide in which group and subgroup the article belongs and select the group from the list.

From here, we can create a new record in a variety of ways. The easiest is to simply click the toolbar 
button ADD. 

Navigation:  How to ... >

How to create a new Article
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Alternatively, you can right click in the article list above and select ADD from the popup menu.

The system will open the article screen as below.
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By default, the article status is disabled, its default type is 'Parent'. By enabling the item, it will be visible 
for POC users and will be able for ordering. 
Enter the description of the article. After entering the description you may enter the article code manually 
or by pressing "..." the system will automatically generate a code.
Before enabling the item, you must also allocate:

Your new article is now setup and ready for use in its most basic form. At a later point in time, you can add 
extra details such as images, notes, documents etc. to make a more in depth description of the article. 

See Also:

General 
Ledger 
Account
Article 
Unit

Gross 
Unit 
Weight

 Article View
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If an article is accidentally deleted, it can be restored from the recycle bin.

How to restore a deleted article

Refer to the page Edit if Article Selected: Delete

The Article Import has been designed in order to streamline the process of creating new items in 
large quantities.

How to run the Article Import

Refer to the page: Article Import

Navigation:  How to ... >

How to restore a deleted article

Navigation:  How to ... >

How to run the article import
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Navigation: »No topics above this level« 

Frequently asked questions

Currently the options in the Language Tabs only include support for English, Spanish, Italian, French and German. 

Unfortunately the export function currently only supports that to the pre-defined formats and does not include exporting graphical information. 

As you eventually will be issuing whole bottles during usage, the solution is to set up both articles with the corresponding units in the system. This way the 
recipe calculation and other transactions will always be precise

The Cost factors can be set up in Article Manager / Article properties / Units / Costa Factors to be what is in use.

Each item has to be individually corrected checking the cost price. After completing the correction for all articles you may run the re-calculate period module 
that will consider the changes made to the closed periods as well.

You will need to disable the article first which activates the grey box.

 Is it possible to add Tagalog (Phillipines) as a language tab in article manager ?

 I Added pictures to articles in MMS. How do you export them to send to suppliers?

 If we have in the main beverage stores Liter bottles and receive 70 cl bottles,  how should we load the received
quantity ? Is the system converting this directly to Liter or do we have to do it manually ?

 I added a new article but base and ship unit cost are in Euros. How do you change this to another currency ?

 For some items in hotel store  the cost prices are wrong. As a result the stock value is very high How can I
correct this ? Some periods are already closed and we have used these items with the wrong price.

 We need to change some units of measure but the drop down box is greyed out.
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The Container Module was designed to simplify the loading process. 
It enables the user to collect all the supplies for a ship at a specified location. 
The collection of supplies and loading it into the container will "merge" the 
deliveries from different vendors into a single container transaction. 
It has to be mentioned that the implementation of the container module into a 
companies supply chain will also heavily relocate the controlling responsibilities 
from shipside receiving to the consolidation address where the goods will be 
collected and the stuffing of the actual container will take place. 
The Container Module will greatly simplify the internal logistics and assure the on 
time ships supply more than before.
The Container Modules function is to create and specify containers so they can 
be handled within the other Material Management modules. These Modules are: 
Receiving, Purchasing and the Warehouse Module.

Main Screen: 

The below is an image of the Containers Module main screen as it looks once opening it. 
On the top is located the buttons toolbar and the menu. 

Below these are located the main areas : 

By double clicking a container the Container View will open with detailed information about the containers contents. 

At the very bottom of the screen are displayed vessel information, date & time, current user and the workstation name.

Navigation:  Reference >

Containers Main Screen

 Note:
Please note that the assignment of goods to containers is done in the Purchasing 
Module because the purchasing process has a closer connection to the delivery 
date and the corresponding consolidation address. For this reason many container 
related tasks will be found in the matching modules.

 Calendar showing all container related activities in orange color, The color tagging is intended to help users to quickly
see for which dates containers have been created.

 An overview providing detailed information about the containers that are in the system for the selected day.
 Containers grouped by Type or by Size.

Main Screen



The below is an image of the Container View screen as it looks once opening it. This 
screen provides an overview of the contents of container in detail. As in other modules 
on the top of the screen are located the buttons toolbar and the menu. 

Container View: 

 The columns displaying information for the main screen are the following :

S Status of the Container.
ID Transaction ID. This number is created by the system to uniquely identify the container.
Vessel Vessel Name.
Size Container size.
Type Container type.
Comment Free comments for the delivery.
Serial Serial Number of the container.
BOL Bill of Lading Number of the container.
Count Number of items in the delivery.
Value Total value of the container shipment.

Navigation:  Reference >

Container View
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The buttons toolbar contains the basic and most frequently used options for 
creating containers, searching existing containers and printing reports.

 On the left hand side is located an overview screen of the product groups of the container.
 On the right hand side are listed the complete article list of the container.

 The columns displaying information for the container view are as follows :

Code Article Code.
Description Article Description.
Amount Total quantity shipped.
Unit Article´s unit of measure.
Price Article´s unit price.
Sub Total Sub total.
Discount % Discounts received.
Vat % Value added tax.
Total Total value of article.
Source Source of article (Original PO number and Vendor or Warehouse ID).

Navigation:  Reference >

Buttons

Main Screen



Buttons: 

Clicking the buttons below or the links will open more information and instructions on the 
usage of these functions.

Most of the options have corresponding tools in the menu, keyboard shortcuts assigned to 
them, or are available with a right mouse click.

The Container search option provides the possibility while in the main screen, 
view to search and locate a specific container. This can be achieved by 
specifying certain search criteria.

Search: 

Search Opens the document search engine.
New Container: Starts the process of creating a new container.
Refresh Refreshes the screen layout to default.
Print: Opens the report manager module.
Exit: Closes the container module.

Navigation:  Reference > Buttons >

Button: Search

Click the search button to initiate this function.

 Once activated the following fields for specifying the search criteria will open:

A container may be searched on the basis of the ID number if
known and can be recognized from the scroll list of all
container request stored in the system.

By activating the search by vessel, the system will only 
consider orders for the specified vessels in the search. 

By activating the search by status the system will only 
consider the requests that meet the specified status.

By activating the search by size, the system will only consider 
orders for the specified size in the search.

By activating the search by type, the system will only 

Main Screen



consider orders for the specified type in the search.

By activating the search by BOL ID, the system will only 
consider orders for the specified BOL ID in the search.

By activating the search by serial number, the system will 
only consider orders for the specified container serial 
numbers in the search.

 Upon having specified the criteria for the search the search may be initiated by pressing
 The results will be displayed in the Main Screen.

 The search engine will be left open in the background when leaving the search tab.

 To leave the search tab click on the overview tab . This returns the user back to the items view page.

 Any time a new search is needed the tab can be re-opened by clicking .

Main Screen



This option starts the wizard for creating a new container primarily by inserting 
the required basic information concerning the container.

New Container

A container creation window will open. In this window the basic information regarding the 
container needs to be inserted. 

Date of arrival to ship

Insert the date on which the container is scheduled to arrive at the destination vessel.

Destination Vessel

Select the destination vessel to which the container is to be delivered to. 
After the selection the system will by default find port and country in which the target vessel will be on the selected arrival date 
of the container (according to the information in the itinerary planner).

Navigation:  Reference > Buttons >

Button: New Container

Click to start the new container shipment wizard.
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Destination Country

If the delivery date has been set, this field will be filled in automatically by the system 
according to the selected date and the itinerary planers detail.

Destination City

Select the destination city to which the container is delivered to.

Name of Local Agency

Select the name of the local port agent in the destination country and port.

Container Size

Select the container size from the predefined sizes.

Container Type

Select the container type from the predefined types.
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Container Stuffing Start Date

Select the date on which the container will opened for packing (stuffing). 
This date will open the date range during which articles can be added to the packing list of the container.

Container Stuffing End Date

Select the date on which the container will closed and sealed.
This date will close the date range during which articles can be added to the packing list of the container.

Container Departure Date

Select the date on which the container will start its voyage to the selected destination.

Container arrival in destination Date

Select the date on which the container is supposed to arrive at the selected destination.
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Name of Stuffing Agent

Select the name of the agent that will handle the packing/ stuffing work.

Name of Freight Forwarder

Select the name of the Freight Forwarding Agent.

Bill of Lading number

Insert the Bill of Lading Number.

Container Serial Number

Insert the serial number of the container that is used.

Name of Shipping Vessel

Select the name of the transportation vessel.

Comments

In this space any additional comments can be inserted.
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This option refreshes the screen layout. For example, having sorted the columns by their heading or resized 
them, then clicking refresh will reset the layout to the default view.

Refresh: 

This option opens the Print Manager. This option will be also available in the Menu; File ->Print.

 After inserting all the required information, please select to continue.

 The created container will now appear in the container view tab of the Purchasing Module for the day of the selected date of
arrival at the ship.

Navigation:  Reference > Buttons >

Button: Refresh

Click to refresh your screen layout.

Navigation:  Reference > Buttons >

Button: Print
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Print: 

This option will close the Container module. 

Exit: 

This menu contains basic options which are also represented in the toolbar and often 
available also with a right mouse click.

Menu:

By moving your mouse over the screenshot you will be able to activate 'hotspots' identified with the 

cursor changing to a  .

Click on  these to jump to more detailed information about that particular button or window.

Click to open the Report Manager and select a report.

Navigation:  Reference > Buttons >

Button: Exit

Click to close container module. 

Navigation:  Reference >

Menu
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See Also:

This menu provides the basic and most frequently used options in the Container 
Module, such as generating New Container Requests and Exporting to Excel 
spreadsheets. In addition to this the file menu contains the option to open the 
report manager, and to exit the module.

File:

This menu contains the options for opening a container request, sending a container and changing its status. 
In addition it contains the options for deleting, printing and showing the properties of a container request. 

Edit: 

The windows menu allows to change how the windows and screens are displayed.

 File Menu
 Edit Menu
 Windows Menu

Navigation:  Reference > Menu >

Menu: File

New Container:
Export:
Print:
Exit:

Creates a new container.
Exports the current main screen view into Excel.
Opens the Report Manager for printing options.
Exits the Container Module.

Navigation:  Reference > Menu >

Menu: Edit

Open:

Status:

Set in Transit:

Print:

Delete:

Properties:

Opens a container entry.

Changes the status of a container.

Sets a container to status "in Transit".

Opens the Print Manager for printing options.

Deletes a selected container entry.

Views properties of the selected container.

Navigation:  Reference > Menu >

Menu: Windows
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Windows: 

Arrange All:

Split:
Rearranges the windows back to the default view.
Splits the selected views equally across the screen.

Main Screen



The Cost Viewer module enables you to view and print the food & beverage related costs. In addition, you can check FIFO prices and have the 
ability to export the information to Excel for more detailed analysis.

Cost Viewer Main Screen: 

The main part of the screen is composed of the Passenger Counts window. Here the information will be populated automatically from 
various sources divided by a blue vertically separator. The left side of  the separator provides detailed information provided by the 
Fidelio SPMS System and the Itinerary Planer. In the right of the separator the Passenger and Crew Counts have to be finally 
confirmed to get exact cost figures. This needs to include all guests, co-workers, Customs and any other people onboard that is catered 
for and therefore causing Food and Beverage related cost. The not considering of these figures might lead to a increased Food and 
Beverage Cost.

When opening the cost viewer the system defaults is set to display the current day highlighted.

Input of Total Crew and Passengers

In the Columns Crew and Passengers located right of the blue Separator the daily figures have to be finally confirmed by entering them 
into the designated cells to acquire all Food and Beverage related Cost and thereby creating exact figures for the calculation.

Navigation:  Reference >

Cost Viewer        

Date: Shows the Date the figures are referring to. 
Port: Shows Ports and Sea days taken from the SPMS System
Pax: Amount of Adult Passengers
Crew: Crew count
Children: Children onboard
Total: sum of Pax + Crew + Children

Main Screen



The main functions in the Cost Viewer can be accessed by the buttons in the toolbar.

Buttons toolbar: 

On the image below, you can click the buttons to move to the related topic in the help.

This option refreshes the screen layout. For example, when you have sorted columns by their heading or resized them, then clicking refresh will 
reset the layout to the default view.

Button Refresh 

Crew: Exact Crew Count for specific Date
Passengers: Exact Passenger Count including: Guests, Visitors, Costums, Co- Workers etc.
Total: Sum of Columns Crew and Passenger ( no entry necessary; calculated  automatically)

Navigation:  Reference > Main Screen >

Buttons

Refresh: Resets the screen to the default layout
New Window: Opens another viewing window
Export to Excel: Exports the current information directly to an Excel worksheet
Print: Opens the Report Manager module
Direct Print: Print out a Food Cost Report which is linked in the OPTIONS Module
Verify FIFO Price: Will check and correct FIFO (First in first out) Price
Exit: Closes the Cost Viewer

Navigation:  Reference > Main Screen > Buttons >

Button: Refresh

Click to reset the screen layout to the system defaults.
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The New Window option is very straightforward in the fact that it opens an additional viewing window. You can then arrange multiple windows to 
compare different months. 

Button New Window 

See Also:

If you are familiar working with spreadsheets and would like to create your own analysis or statistics, you may use the Export to Excel function 
to do this. 

Button Export to Excel 

As soon as you click 'Export the process will commence immediately.

Navigation:  Reference > Main Screen > Buttons >

Button: New Window

Click to open another Passenger Count window.

 Windows

Navigation:  Reference > Main Screen > Buttons >

Button: Export to Excel

Click to export the current Passenger Count window to an Excel worksheet.
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This option opens the Report Manager. This option will be also available in the Menu; File ->Print.

Button Print 

Direct Print is linked in the Direct Print settings to a report.

Button Direct Print

Navigation:  Reference > Main Screen > Buttons >

Button: Print

Click to open the Report Manager module.

Remember:
Before printing any Food and Beverage Reports, make sure all the required 
Data is entered and FIFO Prices were checked with the Verify FIFO Price Button.

Navigation:  Reference > Main Screen > Buttons >

Button: Direct Print
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You can use this option to check & correct the FIFO (First In, First Out) price. If, for example, a loading has been carried out and, at the time of 
the loading, there were prices missing or unavailable for items, then this would affect the FIFO price. Consequently the daily food cost figures 
would be incorrect as transfers may have been completed without prices. 

Button Verify FIFO Price 

The system will prompt you to confirm if there are transfers and if you wish to recalculate.

This option will close the Cost Viewer. You can also select from the Menu; File -> Exit.

Button Exit 

Use the Calendar window to navigate to your chosen dates. Once selected, you will see them updated in the main Passenger Counts window. 

Click to open Direct Printing.

Remember:
Before printing any Food and Beverage Reports, make 
sure all the required 
Data is entered and FIFO Prices were checked with the 
Verify FIFO Price Button. 

Navigation:  Reference > Main Screen > Buttons >

Button: Verify FIFO Price

Click to verify the FIFO price.

Navigation:  Reference > Main Screen > Buttons >

Button: Exit

Click to close and exit the Cost Viewer module.

Navigation:  Reference > Main Screen >

Calendar Window
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Calendar Window: 

The Calendar window:

You can view the individual costs per day based on the respective P.O.C or Point Of Consumption. 

Cost per P.O.C.: 

Clicking the drop down arrow under the calendar window, allows you to select the Cost per P.O.C

As shown below, you will then see the costs broken down into their various departments. 

Navigation:  Reference > Main Screen >

Cost per P.O.C. Window
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At the top of the screen is the menu bar. The options contained are explained in further detail in the following section of the help.

Menu: 

The File menu contains the most basic cost viewer options. These are also available in the buttons toolbar and with keyboard shortcuts where 
indicated.

File: 

Click on the parts of the image below to jump to the relative help information.

Navigation:  Reference >

Menu

Navigation:  Reference > Menu >

Menu: File
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With the ability to view multiple months on screen for comparison, the 'Windows' menu allows you to display these in a more convenient way for 
viewing the information.

Windows:

Click Windows in the menu toolbar for this drop down:

Clicking New Window, initially nothing seems different on the screen. However, the system has opened an extra window on top of the current 
one. It defaults to the same month as you are already looking at. 

Arrange All: 

Here we actually have two windows open. We can see both windows listed in the Windows menu* (see second screenshot below), but in the main screen they are 
layered on top of each other.

Navigation:  Reference > Menu >

Menu: Windows

Navigation:  Reference > Menu > Windows >

Windows: Arrange All
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You can select one of the windows and change dates using the calendar window to show a different month. To view extra months, follow the New Window procedure 
and use Arrange All to cascade them in the display:

Click:
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To compare separate months together in the display, we can use the 'Split' view. This will resize the currently open windows, dependant on how 
many are open at the time, and arrange them together in the display.

Split: 

At the moment, we still have our three windows open for July, August and September. Instead of switching between each one to view the information, we can arrange 
them all on screen at once to compare the data.

Navigation:  Reference > Menu > Windows >

Windows: Split
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Now all of 3 of our windows are arranged on screen simultaneously.

Click:
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Note: It will depend on your monitor size and resolution, as to how much of the data you actually see in the 
display.

Main Screen



Navigation: »No topics above this level« 

Frequently asked questions

You may set one of the port values into zero this way not over booking the daily passenger and crew count.

 When having more than one port in one day, I need to fill in pax and crew count numbers in both port fields. The
case is that the system adds both those values to the total count for that cruise and since it is the same day it
should only add one value. How should I solve this ?

Frequently Asked Questions



The Event Viewer module allows authorized users to view all system activity. The system tracks user activity in realtime, i.e. 
adding an article, changing a price, or creating a recipe, and  this information can be displayed via Event Viewer.

Event Viewer Main Screen : 

This menu contains the basic options for various functions in the Event Manager. 

Buttons:

Navigation:  Reference >

Event Viewer Main Screen 

Navigation:  Reference > Main Screen >

Buttons:

Search: - Opens the search engine
Print: - Opens Report Manager
Refresh: - This option refreshes the screen layout.
Exit: - Closes Event Viewer
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The Search function allows you to look for a specific event within a defined date period, by user, or by event type.

Button Search: 

Navigation:  Reference > Main Screen > Buttons >

Button: Search

Click to open the Search Engine.

Results of the filtering/searching will be shown in the 'Events' window.

This way, you can easily see what an individual user has actioned over a certain period of time.

Selecting -ALL- in the 'By Activity' menu will display all related events. Alternatively, clicking an individual activity will filter out the rest

Note: Selecting 'All Events' may take a long time to display the results, due to the large amount of data involved. 

Remember: Once you have clicked 'Search' it appears as the Search Order tab next to the Grouping tab. You can now 
switch between the two windows by clicking on the tabs. Clicking 'Search' again will close the tab.
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This option opens the Report Manager, which provides a selection of pre-defined and customized reports for printing.   It is 
also available in the toolbar; File -> Print.

Button Print: 

This option refreshes the screen layout and restores any sort criteria to default values. 

Navigation:  Reference > Main Screen > Buttons >

Button: Print

Click to open Report Manager.

Navigation:  Reference > Main Screen > Buttons >

Button: Refresh
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Button Refresh: 

This option will close the Event Viewer. It is also available in the toolbar; File -> Exit.

Button Exit: 

The list or 'tree' of folders represents all the groups of events in Event Viewer.

Tab Grouping: 

Click to refresh your screen layout.

Navigation:  Reference > Main Screen > Buttons >

Button: Exit

Click to close the Event Viewer.

Navigation:  Reference > Main Screen >

Tab: Grouping 

The folder tree on the left is a list of all available events types you can filter. Clicking on the 
different 

folders will automatically adjust the display in the 'Events' window.

Above the list you can see a drop down which allows you to set the time filter accordingly. By 
default, 

the system starts with the last seven days.

Click on the drop-down arrow to display the other options.

This way, you can find the information you require quickly 
and easily by selecting from the available options and 
clicking

Main Screen



The Events Window shows you the results of your selection in the Grouping Tab.

Events Window: 

Note:   Selecting 'All Events' may take a long time to display the results, 
due to the large amount of data involved.

Navigation:  Reference > Main Screen >

Events Window

The following columns are always visible:

 Date - shows the date when the event occurred
 Time - shows the time of the event
 Group - shows the Windows login username
 User - shows the username logged in to the Materials Management System
 Work Station - shows the name of the workstation user has been using
 Event - detailed description of what event took place

Main Screen



The Export function allows to export the current view to Excel for further analysis.

Export: 

From the toolbar select File -> Export.

Navigation:  Reference > Main Screen > Menu > File >

Export

Main Screen



Once you click the 'Export' button, the system will generate an Excel spreadsheet containing the current Event Window and open it on your screen.
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Navigation:  Reference > Main Screen > Buttons >

Button: Search

The Search function allows you to look for a specific event within a defined date period, by user, or by event type.

Button Search: 

Click to open the Search Engine.

Results of the filtering/searching will be shown in the 'Events' window.

This way, you can easily see what an individual user has actioned over a certain period of time.

Selecting -ALL- in the 'By Activity' menu will display all related events. Alternatively, clicking an individual activity will filter out the rest

Note: Selecting 'All Events' may take a long time to display the results, due to the large amount of data involved. 

Remember: Once you have clicked 'Search' it appears as the Search Order tab next to the Grouping tab. You can now switch 
between the two windows by clicking on the tabs. Clicking 'Search' again will close the tab.

Button: Search



Navigation:  Reference > Main Screen >

Events Window

The Events Window shows you the results of your selection in the Grouping Tab.

Events Window: 

The following columns are always visible:

 Date - shows the date when the event occurred
 Time - shows the time of the event
 Group - shows the Windows login username
 User - shows the username logged in to the Materials Management System
 Work Station - shows the name of the workstation user has been using
 Event - detailed description of what event took place

Events Window



Navigation:  Reference > Main Screen > Menu > File >

Export

The Export function allows to export the current view to Excel for further analysis.

Export: 

From the toolbar select File -> Export.

Once you click the 'Export' button, the system will generate an Excel spreadsheet containing the current Event Window and open it on your screen.

Export



Navigation:  Reference > Main Screen >

Tab: Grouping 

The list or 'tree' of folders represents all the groups of events in Event Viewer.

Tab Grouping: 

The folder tree on the left is a list of all available events types you can filter. Clicking on the different 

folders will automatically adjust the display in the 'Events' window.

Above the list you can see a drop down which allows you to set the time filter accordingly. By default, 

the system starts with the last seven days.

Click on the drop-down arrow to display the other options.

This way, you can find the information you require quickly and 
easily by selecting from the available options and clicking

Note:   Selecting 'All Events' may take a long time to display the results, due to 
the large amount of data involved.

Tab: Grouping



This section covers some problems that are frequently encountered by our users. The 
questions are organized by category and, where necessary, links are provided to relevant 
sections of the help.

When I click on the event category, why does the application takes such a 
long time to respond?

The amount of data the program has to analyze is very large. Try selecting a smaller query period e.g. 
'Last 7 days'.

Navigation: »No topics above this level« 

Frequently Asked Questions

Navigation: Frequently Asked Questions >

General Questions

 When I click on the event category, why does the application takes such a long time to respond?

Frequently Asked Questions



Physical inventories are completed to assist with effective management of materials and are one of the strongest tools for property control and 
accountability. On a practical level, the primary purpose of a physical inventory is to determine if the person responsible can account for all items on the 
inventory list. With this information the management can reconcile the physical items with the inventory records and update the financial records 
accordingly.

Inventory operations normally function in three phases. These are : 

The inventories module is used onboard the ships for all inventory control and stock adjustment related operations. These tasks include displaying 
information on articles currently stocked onboard and processing inventory checks on the various main stores and sub-stores. The module also has a very 
important role prior to the closing of periods as complete inventories are a requirement before any turnover operations can be completed.

Inventory Main Screen : 

The image below represents the inventory module main screen as it would look during a normal day. At the top are located the function buttons and function menu and below, the 
screen is divided into three main sections displaying a calendar, the inventory transactions overview and the departmental recaps.  At the very bottom is information on the operational 
unit, date & time, current user, computer name, database in use and the module version number. 

The inventory transaction column headers below the date give the following information : 

Upon creating any new inventory document, the system will automatically assign a 12 digit 
ID number to the transaction for verification purposes.

The date column will indicate the date that was selected during the creation process.

This column will indicate the inventory document type. The following types are in use : 

Spot Check Inventory
All documents created within the inventory module will be categorized under this type.

Cruise End Inventory
If the POC (Point of Consumption) properties in the setup module have been set to "end of cruise inventory" 
the system will automatically create inventory documents for all POCs containing this option. During the period 
closing process the system will verify if these documents have been correctly processed and closed.

The status column will indicate the state of the inventory document. The status can be: 

Closed
The inventory has been closed and can no longer be modified.

Open 
The Inventory is open and can still be modified and deleted by those users that have rights assigned.

The name of the vessel will be automatically placed into this column by the system.

Navigation:  Reference >

Inventories Main Screen 

1. Physical count of items against a inventory count sheet
2. Verification of inventories though spot checking the accuracy
3. Closing of inventory and confirming adjustments

Main Screen



This column will indicate the location of the inventory that was selected during the creation process.

The system will indicate the total value of the inventory under this column heading.

The calendar in the inventory module will display a pink color on each day that has inventory transactions. The color is always the same regardless if the 
transactions are with closed or open status.

Calendar: 

By selecting a day and clicking on the selection the system will display the transaction contents on the main screen.

The buttons toolbar contains the basic and most frequently used options. 

Buttons: 

Clicking the buttons below or the links will open more information and instructions on the usage of these functions.

Most of the options have corresponding options in the menu, keyboard shortcuts assigned to them, or are available with a right mouse click.     

what need to be changed :

Navigation:  Reference > Main Screen >

Inventories Main Screen 

Navigation:  Reference > Main Screen >

Buttons:

Search: Search for a specific product
New Spot 
Check: Create a new inventory control spot check
Print: Opens the report manager module
Refresh: Will return the screen layout to its default state
Exit: Closes the movements module

Main Screen



inventory 

The search button provides the option to search inventory transactions from the main screen. 

Button : Search 

You may locate inventory documents by entering the ID number in the search engine field.

Activate additional search criteria by checking or un-checking the check boxes provided by the filter options.

     Filter not activated   

Filter Activated

NOTE : After the first activation, the search engine will remain active during the session. You may hide and re-activate the search options from the tabs on the bottom left of the screen.

Navigation:  Reference > Main Screen > Buttons >

Button : Search

Click on the search button to open the search engine.

 Search Inventory documents by store type :

 Search inventory documents by item

 Search inventory documents by status Open or closed

 Search inventory documents within a specified date range.

Navigation:  Reference > Main Screen > Buttons >
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The Create New Spot check option is used when a new inventory transaction needs to be created.

Button : Create New Spot Check

Clicking this button opens a windows into which all the necessary information should be inserted.
Work your way downwards, inserting all the required information.

Date
Enter the date on which the inventory control will be made. The current date is circled in red.

Area Type
Select the main area type from 

Area
Select from the drop down list. 
The options are dependent on how the articles have been categorized by company policy. 

Type
Select the spot check type from the available options.

Button : Create New Spot Check

Click to create a new spot check document

 Main Stores - Storage areas such as food, beverage, uniforms, technical items.
 Sub Stores - Sub stores and POCs (Points of Consumption) such as bar outlets, housekeeping departments etc.

Main Screen



This option selects 20 products from the inventory list of the selected POC at random and places them on the 
inventory document. The option is useful in cases where time does not permit checking the full physical 
inventory but a spot check needs to be made for verification purposes.

This option selects 50 products from the inventory list of the selected POC at random and places them on the 
inventory document. The option can be used in cases where inventory maintenance is being made but time 
does not permit a full inventory.

This option is used in cases where a full physical inventory is made and all products need to be included.

Locker
If the main store was selected as the area, this enables the option to target a specific product locker for the inventory.

Select  to continue. 

The system will create the spot check document using the selected options and return to the main screen where the document may be selected.

Select the newly created document and open it by DOUBLE CLICKING

This will open the contents of the actual inventory control sheet into which the actual inventory results need
to be inserted. See the below example:

 Random 20

 Random 50

 Standard
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The values in the columns represent the following: 

Code
Product code as described in article manager

Description
Product description

Base Unit
Base product unit that is used for counting the items

SOH 
Stock on hand. The actual quantity currently registered in the system prior to the inventory.

Counted
In this space the physically counted items need to be inserted. For example.

SOH        COUNTED        VARIANCE
1200    1190       -10

Variance
The quantity variance between stock on hand and physical count.

Price
The unit price of the single article in the document

Value
The value variance found as a result of the inventory. 
This number is calculated from the total variance multiplied by the set item price. 

VARIANCE       PRICE       VALUE
10           1.5       15  

This option opens the Report Manager. This option is also available in the Menu; File ->Print.

Button Print: 

Navigation:  Reference > Main Screen > Buttons >

Button : Print

Click to open the Report Manager.
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This option refreshes the screen layout. For example, if you have sorted columns by their heading or resized them, clicking refresh will reset the layout to 
the original view.

Button Refresh: 

This option will close the Inventories module. You may also select from the Menu; File -> Exit.

Button Exit: 

Navigation:  Reference > Main Screen > Buttons >

Button : Refresh

Click to refresh your screen layout.

Navigation:  Reference > Main Screen > Buttons >

Button : Exit

Click to close the Inventory Module

Main Screen



The menu bar on the top of the screen contains the most common options for creating 
Inventory transactions. Note that the screen has different views depending on which sheet is 
active. 

Menu: 

Navigation:  Reference >

Menu:

Menu



File Menu options: 

See following sections.

This menu contains the most common options for creating Inventory transactions. Note that 
the screen has different views depending on which sheet is active. 

File Menu options: 

This menu contains the most common options for creating inventory transactions. The menu is 

Navigation:  Reference > Menu >

Main Inventory Screen

Navigation:  Reference > Menu > Main Inventory Screen >

File Menu 

New Spot 
Check

Export

Print

Exit

Create a new spot check

Export the active sheet to an Excel spreadsheet

Opens the report manager

Closes the inventory module

Navigation:  Reference > Menu > Main Inventory Screen >

Edit Menu 

Menu



also available in the main screen by right clicking on the document grid.

File Menu options: 

The closing and locking function firstly closes and secondly locks a completed inventory 
permanently. After closing a transaction it may no longer be modified.

Closing and Locking an Inventory: 

Once the physical count of the inventory has been verified, to close the inventory, proceed as follows: 

By choosing the  option the system will change the document  from open 
to closed.
After this point the document may no longer be modified and may only be eliminated with the appropriate 
user rights.

The windows menu allows to change how the windows and screens are displayed during 
various phases of using the software.

Windows Menu Options : 

Open

Close & Lock 
Inventory

Print

Delete 

Open an existing inventory document

Closes and locks an inventory

Opens the report manager

Deletes an inventory transaction

Navigation:  Reference > Menu > Main Inventory Screen > Edit Menu >

Close & Lock Inventory

Navigation:  Reference > Menu > Main Inventory Screen >

Windows Menu

Menu



Edit Menu options: 

See following sections.

This menu contains the most common options for creating Inventory transactions. Note that 
the screen has different views depending on which sheet is active. 

File Menu options: 

Arrange 
All

 Split

Rearranges the windows 
back to the default view

Splits the selected views 
equally across the screen

Navigation:  Reference > Menu >

Inventory Document Screen

Navigation:  Reference > Menu > Inventory Doc Screen >

File Menu 

New Spot 
Check

Export

Print

Create a new spot check

Export the active sheet to an Excel spreadsheet

Opens the report manager

Closes the inventory module

Menu



This function exports the contents of the active screen to an external Excel spreadsheet. 

Exporting to Excel: 

An Export window will open

Click   to continue

The exported data is displayed in Excel as shown below:

Exit

Navigation:  Reference > Menu > Inventory Doc Screen > File Menu >

File Menu

Click to export the information on the active screen to an Excel 
spreadsheet.

Menu



File Menu options: 

Clicking the SHOW ITEM HISTORY, opens the product data sheet from the article manager where all product 
related data can be found for deeper analysis.

Navigation:  Reference > Menu > Inventory Doc Screen >

Edit Menu 

Show Item 
History

Open the item properties sheet to view item details 
and history

Menu



This menu contains the options for sorting the views on the active document.

View Menu options: 

Navigation:  Reference > Menu >

View Menu

Sort 
Description

Sort by Code

Sort by Group 
and Description

Sort by Group 
and Code

Sort document by product description

Sort document by product code

Sort document by product group and 
description

Sort document by product group and 
code

Automatically returns the line

Menu



The windows menu allows to change how the windows and screens are displayed during 
various phases of using the software.

Windows Menu Options : 

Auto Line 
Return

Refresh

Refreshes the screen layout to the 
original

Navigation:  Reference > Menu >

Windows Menu

Arrange 
All

 Split

Rearranges the windows 
back to the default view

Splits the selected views 
equally across the screen

Menu



Navigation: »No topics above this level« 

Frequently Asked Questions

It is always suggested to enter the inventory counts as you go. As a cruise ship never comes to a complete stand still, item inventories will continue to change and values 
to vary. For this reason a count will become out of date as soon as transactions are made.

After setting the lockers, the items need to be assigned into each locker accordingly. This is done in Article Manager / Article Properties and by selecting the corresponding
store.

this :

status with the icons screenshoots to be refreshed

new search capabilities

3088 Inventories Enhancement
Added search capabilities to the Inventory Module so that now user can search inventories
by the following criteria
1) by mainstore Food, beverage, etc.
2) by Item show all inventory including a specific item
3) by type Spotcheck/cruise end
4) by Status Open/closed
5) by Date range From
6) by date range To
7) by Id Number

3277 Inventories Bug Fix
Remove PERIOD END inventory types and renamed spot-check inventory to Inventories.

 What are the Basic reqiurements for a proper INventory within MMS

therefore we 













 Will there be a problem with the stock in the outlets if I input the inventories the next day after the cruise ends.?

 We set up some items in lockers but 'count sheet by locker' report is blank.

Frequently Asked Questions



The Invoicing module is used as a Headquarter module within MMS. The module functions as a tool for maintaining the entire life span of an invoice from 
the moment it 
is registered to the system, up to the moment it is concluded as paid. This module also covers managing credit notes, variances in deliveries, and other 
discrepancies.

Invoicing : 

Below is an image of the Invoice Control screen as it would look during normal operation. On top are located the function buttons and the 
Toolbar Menu.  Below these are located several main screen areas: 

At the bottom of the screen the vessel information, date, time, current user and computer name are displayed..

The buttons toolbar contains the frequently used options for accessing the invoicing tools.

Buttons: 

Clicking the buttons below or the links will open more information and instructions on using these functions.

Navigation:  Reference >

Invoicing

 Calendar showing all invoicing activity on a monthly basis.
 Transactions display area on the right hand side of the screen listing all the invoices for the selected date.
 Below the calendar view is a summary screen of invoices for that date grouped either by vendor or currency.
 Below the transaction display area is a tab for listing invoices.

Navigation:  Reference > Main Screen >

Buttons

Search Search for an invoice with given criteria
Print Opens the Report Manager for printing options
Refresh Refreshes the screen to default view
New Invoice Registers a new Invoice to the system
New Credit Note Registers a new credit note to the system

Main Screen



Most of the options have corresponding tools in the menu, keyboard shortcuts assigned to them, or are available with a right mouse click.    

The search option is used to locate a specific invoice within the module by defining specific search criteria.

Search: 

Once activating the Search Engine, the fields for specifying the search criteria open. 

Exit Exits the invoicing module

Navigation:  Reference > Main Screen > Buttons >

Button : Search

Click the Search button to initiate the function.

An invoice may be located on the basis of its number and can be chosen
from the scroll list of all orders in the system.

By activating the search by Vendor, the system will limit the 
search to an invoice of a specific vendor (supplier) 

By activating the search by Vessel, the system will limit the 
search to the specified vessel.

By activating the search by status the system will only consider the 
invoices that meet the specified status selected in the drop down list.

An invoice can be located on the basis of its Purchase Order Number and can be selected from the scroll list 
of all orders in the system.

Main Screen



After entering the desired search criteria click on the 'Search' button and the results will be displayed in the main screen.

The Search tab can be left open while working in other areas of the Invoicing Module.  Any time a new search is needed the tab can be re-opened
by clicking the Overview tab at the bottom of the search area.

This option opens the Report Manager. It is also available in Menu; File ->Print.

Print: 

By activating the search by Paid Status the system will only consider the 
invoices that meet the specified selection in the drop down list.

Navigation:  Reference > Main Screen > Buttons >

Button : Print

Click to open the Report Manager.

Main Screen



This option refreshes the screen layout. For example, once having sorted columns by their heading or resized them by clicking refresh will reset the layout to 
the default view.

Refresh: 

The New Invoice function covers the process of creating an invoice in the system once it has been received from a Vendor.

New Invoice : 

Navigation:  Reference > Main Screen > Buttons >

Button : Refresh

Click to refresh the screen layout.

Navigation:  Reference > Main Screen > Buttons >

Button : New Invoice

Click to start the New Invoice registration wizard.

The 'Register New Invoice' window opens which guides the user through the process of creating a new invoice.

Main Screen



The first step is to complete the Invoice Type field. The system is using 'invoice' as the default selection, but this can be changed by 
choosing another option from  the drop down list  Credit note or rebate are the other options.

The Vendor sending the invoice is selected from the list in the field's drop down list.

The purchase order relating to the invoice received can be entered in the Purchase Order field by clicking on the drop down list.
All purchase orders available in the system are shown, click on the desired one.  The information can also be manually entered if needed.

If the invoice carries an individual reference number that has to be recorded for any specific purpose, this number can be entered
into the field called Invoice ID   This id may be any combination of numbers or characters.

The total dollar amount of the invoice is entered into the Amount field. The number can contain six places to the right of the 
decimal if required.  Select the currency of the invoice from its drop down list as well..

The populate the Date Received field click on the drop down arrow and a calendar appears.  Simply click
on the required date. Close the calendar by clicking on the red X in the top right of the calendar.

      The date on which the supplier is requesting the invoice to be paid is entered in the Date Payment Requested  field
      in the same manner as the receive date.

Main Screen



     The 'Terms' field is the agreed upon payment terms with which the purchase order was issued.These terms are also printed on
the suppliers invoice. If the terms are entered in Vendor Manager they will show automatically otherwise select the correct term 
from the drop down list. 

After entering the Terms information, the program will offer a default payment date by automatically populating the Payable On
or After field.  The date appearing here depends on the term that was chosen.  However this can be changed to what is needed.

NOTE:  The following three fields - Account Reference, Document Reference, and Notes are fields that may be needed but not 
required, depending on the entity's business needs.  For example bank payments, g/l numbers for accounting departments, or special 
documents and notes can be entered here.  The fields are alpha-numeric.

If it is necessary to view already closed and controlled purchase orders and make them visible in the 'Purchase Order' space this option
is available by ticking the option at the bottom of the window.

Complete the invoice wizard by clicking on the     button.

After this the invoice can be opened and viewed  from the main screen by selecting the corresponding date

The New  Credit note function covers the registration process of entering a Credit note to the system once it has been received from a Vendor.

New Invoice : 

Navigation:  Reference > Main Screen > Buttons >

Button : New Credit Note

Click to start the New Credit Note registration wizard

 A 'Register New Credit Note' window opens which will take through the process of New Credit Note.
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New Credit Note option was selected but this may be changed from the drop down list selecting the suitable option.

list of purchase orders available and selecting the correct one or inserting the Number of the Purchase order 
in the space provided

this number may be carried into the space 'Invoice ID' This number may carry any types of numbers, characters or
a combination of the two. 

 The first step is to set the Invoice type. The system is using 'Credit' as the default in this option since the Create 

 The Vendor sending the Credit Note is selected from the list of vendor opening in a drop down list.

 The Purchase order relating to the Credit Note received is set in the 'Purchase Order' Column by opening the 

 In the case that the Credit Note carries an individual reference number that has to be recorded for any specific purpose,

Main Screen



that remain on the right hand side of the decimal separator.

calendar and thereafter closing the calendar view by clicking  the  at the right hand side corner or the calendar

space by selecting the date from the calendar and thereafter closing the calendar view by clicking  the  at the 
right hand side corner or the calendar.

of the wizard by selecting the correct term from the drop down list. After setting this information the program will 
offer a default payment date for the invoice depending on the length of the term however this may be changed to
be what is needed.

On or After' Space from the available three options.

into the space 'Accounts Reference' . This number may carry any types of numbers, characters or
a combination of the two. 

 space this option is available by ticking the option at the bottom of the window.

the corresponding date

 The Total amount of the Credit Note is entered in the corresponding column. The total holds six decimal digits

 The currency of the Credit Note is set by selecting the correct currency from the drop down list.

 The Date on when the Credit Note was received, is set in the 'Date Received' space by selecting the date from the 

 The Date on which the Supplier has printed the Credit Note to be settled is entered in the 'Date Payment requested'

 The Payment term on which has been agreed upon the issuance of the Credit Note is set on the 'Terms' space 

 Payment Term that has been agreed upon issuing the Purchase order for the articles is set in the 'Payable 

 An Accounts Department reference number that may be needed for Bank transactions or other may be carried

 If it is necessary to vie already closed and controlled Purchase Orders and make them visible in the 'Purchase Order'

 Complete the Credit Note creation by clicking 

 After this the Credit Note can be opened and viewed by selecting it from the main screen by selecting

Navigation:  Reference > Main Screen > Buttons >

Main Screen



This option will close the invoicing module. You may also select Menu; File -> Exit.

Exit: 

The Menu bar on the top of the screen contain basic options which are also available in the Toolbar. The same options are also available by right clicking 
the Invoice view.

Menu: 

This menu contains options for exporting and printing invoice information.  The program can also be exited from here.

File: 

The Edit menu contains program options such as creating invoices and credit notes,  changing Invoice status, as well as assigning them to different 
departments. Some of these options are also available in the Buttons Toolbar.

Edit: 

Button : Exit

Click to close the module. 

Navigation:  Reference > Main Screen >

Menu

Navigation:  Reference > Main Screen > Menu >

Menu : File

Export 
Print

Exit

Export the current view to an Excel Sheet
Open the Report Manager for printing options.
Closes the Invoicing Module

Navigation:  Reference > Main Screen > Menu >

Menu : Edit

Creates a New Invoice
Creates a New Credit Note
Opens a selected document
Change the status of an Invoice ( options 1-3)
Set invoice as pending credit note
Set the invoice to Invoice is Paid
Set the invoice to Invoice is Pre-paid
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The Windows menu changes how the windows are displayed on the screen.

Windows : 

Block Payment of invoice

Delete a selected transaction
Assign invoice to a specific position from the drop down list
Properties of the selected invoice allows editing

Navigation:  Reference > Main Screen > Menu >

Menu : Windows

Arrange All
     Split

Rearranges the windows back to the default view.
Splits the selected vieqs equally across the screen

Navigation:  Reference > Main Screen >

Main Screen



    Open an Invoice by double clicking on it from the main screen.  Many types of information become available for viewing and working with the active 
invoice in a details view.

Invoice View : 

At the top are located the Invoice view Tool Bar buttons and the Menu for the options in this view.

The buttons toolbar in the active invoice view contains the most frequently used functions for for managing invoices. Most of the options are also available 
with a right click in the details screen.

Buttons Invoice View : 

The search option  provides a possibility to locate a specific invoice within the module by defining specific Search Criteria.

Search: 

Invoice View

Navigation:  Reference > Main Screen > Invoice View >

Buttons Invoice View : 

Search Search for an invoice with different criteria
Print Opens the Report manager for printing a specific invoice or report
Refresh Refreshes the screen back to default view
New Invoice Creates a new invoice in the system
New Credit Note Creates a new credit note in the system

Validate Validates the item amounts in the active invoice
Force Balance To balance the invoice
Print Summary Prints a summary of invoices
Exit Exits the invoice module

Navigation:  Reference > Main Screen > Invoice View > Buttons Invoice View >

Buttons Invoice View : Search

Click the Search button to initiate the function.

 Once activating the Search engine. The Fields for specifying the search criteria open. 

An Invoice may be located on the basis of its number should this be known and can be recognized 
from the scroll list of all orders in the system.

Main Screen



will be displayed in the Main Screen.

This is done by clicking the Overview Tab that returns the user back to the Items View Page.
Any time a new search is needed the tab can be re-opened.

By activating the search by Vendor, the system will limit the 
search for an invoice of a specific Vendor (Supplier) 

By activating the search by Vessel, the system will only 
consider order for the specified vessels in the search.

By activating the search by Status the system will only consider the 
Invoices that meet the specified status listed in the drop down selection.

By activating the search by Purchase Order Number, the system will only 
consider Invoices for the specified Purchase Orders in the search.

By activating the search by Paid Status the system will only consider the 
Invoices that meet the specified payment status listed in the drop down selection.

 Upon having selected the criteria for the search the search may be initiated by pressing   and the results 

 The Search engine may be left open in the background by leaving the Search tab open. 
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Buttons Invoice View :
This option opens the Report Manager. This option is also available in Menu; File ->Print.

Print: 

This option refreshes the screen layout. For example, once having sorted columns by their heading or resized them, clicking refresh will reset the screen 
layout to the default view.

Refresh: 

Navigation:  Reference > Main Screen > Invoice View > Buttons Invoice View >

Buttons Invoice View : Print

Click to open the Report Manager.

Navigation:  Reference > Main Screen > Invoice View > Buttons Invoice View >

Buttons Invoice View : Refresh

Click to refresh the screen layout.

Main Screen



The New Invoice function covers the process of creating an invoice in the system once it has been received from a vendor.

New Invoice : 

Click to start the New Invoice registration wizard.

The 'Register New Invoice' window opens which guides the user through the process of creating a new invoice.

The first step is to complete the Invoice Type field. The system is using 'invoice' as the default selection, but this can be changed by 
choosing another option from the drop down list Credit note or rebate are the other options.

The Vendor sending the invoice is selected from the list in the field's drop down list.

The purchase order relating to the invoice received can be entered in the Purchase Order field by clicking on the drop down list
of purchase orders available in they system and selecting the correct one.  The information can also be manually entered if desired.

If the invoice carries an individual reference number that has to be recorded for any specific purpose, this number can be entered
into the field called Invoice ID   This id may be any combination of numbers or characters.

The total dollar amount of the invoice is entered into the Amount field. The number can contain six places to the right of the 
decimal if required.  The currency type will be populated automatically from the information off the PO once the Purchase Order
information is entered.  This can be changed by choosing a different currency from the field's drop down list.

Navigation:  Reference > Main Screen > Invoice View > Buttons Invoice View >

Buttons Invoice View : New Invoice
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The populate the Date Received field click on the drop down arrow and a calendar appears.  Simply click
on the required date. Close the calendar by clicking on the red X in the top right of the calendar.

      The date on which the supplier is requesting the invoice to be paid is entered in the Date Payment Requested field
      in the same manner as the receive date.

     The Terms field is the agreed upon payment terms with which the purchase order was issued. These terms are also printed on
the suppliers invoice. Select the correct term from the drop down list. 

After entering the Terms information, the program will offer a default payment date by automatically populating the Payable On
or After field.  The date appearing here depends on the term that was chosen. However this can be changed to what is needed.

NOTE:  The following three fields - Account Reference, Document Reference, and Notes are fields that may be needed but not 
required, depending on the entity's business needs.  For example bank payments, g/l numbers for accounting departments, or special 
documents and notes can be entered here. The fields are alpha-numeric.

If it is necessary to view already closed and controlled purchase orders and make them visible in the 'Purchase Order' space this option
is available by ticking the option at the bottom of the window.

Complete the invoice wizard by clicking on the     button.

After this the invoice can be opened and viewed  from the main screen by selecting the corresponding date

   The New Credit Note function covers the process of entering a credit note to the system once it has been received from 
   a vendor.  It is created the same way as a new invoice, except the Invoice Type field will be 'credit note' rather than invoice.

Navigation:  Reference > Main Screen > Invoice View > Buttons Invoice View >

Buttons Invoice View : New Credit Note

Main Screen



New Invoice : 

The Register New Invoice window opens which guides the user through the process of creating a credit note..

The first step is to set the Invoice type. The system is using 'invoice' as the default in this option but this can be changed by 
choosing another option from the drop down list  In this case choose 'credit note'.

The Vendor sending the credit note is selected from the list in the field's drop down list.

The purchase order relating to the credit note can be entered in the Purchase Order field by clicking on the drop down list
of purchase orders available in they system and selecting the correct one.  The information can also be manually entered if desired.

If the credit note carries an individual reference number that has to be recorded for any specific purpose, this number can be entered
into the field called Invoice ID   This id may be any combination of numbers or characters.

The total dollar amount of the credit note is entered into the Amount field. The number can contain six places to the right of the 
decimal if required.  The currency type will be populated automatically from the information off the PO once the Purchase Order
information is entered. This can be changed by choosing a different currency from the field's drop down list.

The populate the Date Received field click on the drop down arrow and a calendar appears.  Simply click
on the required date. Close the calendar by clicking on the red X in the top right of the calendar.

Click to start the New Credit Note registration wizard

Main Screen



     The date on which the supplier is requesting the invoice to be paid is entered in the Date Payment Requested field
     in the same manner as the receive date.

The Terms field is the agreed upon credit note terms with which the purchase order was issued.  These terms are also printed on
the suppliers invoice.   Select the correct term from the drop down list. 

After entering the Terms information, the program will offer a default payment/credit date by automatically populating the Payable On
or After field.  The date appearing here depends on the term that was chosen.  However this can be changed to what is needed.

NOTE:  The following three fields - Account Reference, Document Reference, and Notes are fields that may be needed but not 
required, depending on the entity's business needs.  For example bank payments, g/l numbers for accounting departments, or special 
documents and notes can be entered here.  The fields are alpha-numeric.

If it is necessary to view already closed and controlled purchase orders and make them visible in the 'Purchase Order' space this option
is available by ticking the option at the bottom of the window.

Complete the Credit Note creation by clicking the  button.

After this the credit note can be opened and viewed by selecting it from the main screen by selecting the corresponding date.

The validation button is available once the user double clicks on a line item in the invoice overview screen. This brings up the details
of the item. 

Validate: 

Navigation:  Reference > Main Screen > Invoice View > Buttons Invoice View >

Buttons Invoice View : Validate

Click to Validate the selected invoice
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After clicking on the validate button, the system checks the purchase order (PO) value against the invoice value, and will attempt to close the invoice.
An warning message may appear :

Click on OK, then a   -/+   variance appears at the screen bottom:
Items with different Loading Price then Invoice Price or Items with different Loading Quantity then Invoice Quantity

The system is complaining due to settings in the OPTIONS module, beneath the Invoice Settings. A maximum quantity and a maximum total
are set here.  The system will not close the invoice if the quantity has a difference greater than the system values set here. ( Note: these values are
set at configuration time by an administrator type functionality.)

At this point click on the PO button above the main screen area:

This will bring the screen back to the items listed in the PO. Now the user should check what is the difference between the Purchase Order and the Invoice.

The invoice amount now matches the received amount.  If you now click on the validate button, the invoice will be closed with the following information button:

Finally, the invoice icon will now have a green check mark to show that is was successfully closed.
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The Force Balance button is available once the user double clicks on a line item in the invoice overview screen.  This brings up the details of the item. 

Force Balance: 

After clicking on the validate button, the system checks the purchase order (PO) value against the invoice value, and will attempt to close the invoice. The system may complain due to 
settings in the OPTIONS module, beneath the Invoice Settings.  A maximum quantity and a maximum total are set here. The system will not close the invoice if the quantity has a 
difference greater than the system values set here. ( Note: these values are set at configuration time by an administrator type functionality.)

However, by clicking the Force Balance button, the system will force close the invoice, regardless of the quantity and maximum totals and will create a Line entry.

This option opens the Report Manager. This option is also available in Menu; File ->Print.

Print Summary: 

Behind this button is a Summary Report linked which was set up in the Options Module->Direct Print

This option will close the Invoicing module. You may also select Menu; File -> Exit.

Exit: 

Once opening an invoice by double clicking it, the tabs at the bottom of the screen become visible and provide access the following areas of an individual 
Invoice : 

Tabs Invoice View : 

Navigation:  Reference > Main Screen > Invoice View > Buttons Invoice View >

Buttons Invoice View : Force Balance

Press the Force Balance button to force the invoice to balance.

Navigation:  Reference > Main Screen > Invoice View > Buttons Invoice View >

Buttons Invoice View : Print Summary

Click to print a summary of the invoice.

Navigation:  Reference > Main Screen > Invoice View > Buttons Invoice View >

Buttons Invoice View : Exit

Click to close the module. 

Navigation:  Reference > Main Screen > Invoice View >

Tabs Invoice View :

 Order List for viewing the contents of an invoice that are listed in the corresponding purchase order
 Invoice that is related to the delivery being viewed
 Summary of the invoice
 Log of all events that have been collected in the system during use.
 Loading Evaluation rates the quality of the delivery information
 Loading Comments  is information commenting on the quality of the loading
 Other Comments on other non -listed topics concerning the delivery of the items
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The Order List allows to view the contents of an order, listing all the products that were present in the original Purchase Order that was issued.

Order List: 

The below is an image of the Order List Tab as it looks once opening it. On the top are located 
the Buttons Toolbar and the Menu. Below these are located these main areas : 

On the left hand side is the product grouping list, displaying all those product groups that are included in the purchase order.
Clicking on a particular product group folder will display its item contents on the right side of the screen.

Navigation:  Reference > Main Screen > Invoice View > Tabs Invoice View >

Tab Invoice View : Order List
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The columns displaying information for the receiving order details are as follows : 

The Invoice Tab allows to view the contents of an invoice what comes to the single articles being invoiced.

Invoice: 

The below is an image of the Invoice Tab as it looks once opening it. On the top are located 
the Buttons Toolbar and the Menu. Below these are located the main areas : 

Code Article code
Description Article description
Unit Article unit of measure
Ordered Quantity ordered
Confirmed Quantity confirmed by supplier
Received Quantity received at delivery
Invoiced Quantity invoiced
Price Ord Article unit price used during ordering
SubTotal Subtotal price of delivery
Discount % Discount percentage received
VAT Value Added tax
Total Total price of delivery for article

 By Right Clicking the items details area will open a short cut menu for Order List, which are also available in the Menu bar.

Move item to another Invoice
Auto Alocate this Invoice to a Document Reference Number if entered
Set Global Discount to the selected invoice
Set Global Tax to the selected Invoice
Select All items in view
Refresh the view
Scan Loaded Amounts for the selected Invoice

Navigation:  Reference > Main Screen > Invoice View > Tabs Invoice View >

Tab Invoice View : Invoice

 On the left hand side, the product grouping list, displaying all those product groups that are included in the original order.
 On the right hand side are listed all the products present in the Invoice registered to the system.
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The columns displaying information for the Receiving Order details are as follows : 

After validate an Invoice the Tab Summary will display the items with differences to the Purchase Order in Quantity or Price

Summary: 

Code Article Code
Description Article description
Invoiced Quantity Invoiced
Unit Article unit of Measure
Price Article unit price invoiced
SubTotal Subtotal price of delivery
Discount % Discount percentage received
VAT Value Added tax
Total Total price of delievery for Article

 By Right Clicking the Items area, will activate further options for Invoice View which are also available in the Menu bar.

Set Global Tax to the selected Invoice
Set Global Discount to the selected 
Invoice
Delete a selected Article or invoice

Navigation:  Reference > Main Screen > Invoice View > Tabs Invoice View >

Tab Invoice View : Summary
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The columns displaying information for the receiving order details are as follows : 

The Log tab houses the list of all activity that has been collected during system operation. The tab is active normally only for administrators.  Information 
such as document creation, modification, module access, and many more. This information may be particularly useful if  tracking differences or other 
variances, or to confirm which user is doing a particular activity in the system.

Log: 

Code Article code
Description Article description
Unit Article unit
Amount OD Amount ordered for article
Amount IN Amount received at delivery
Difference Difference between purchase quantity and quantity received
Price OD Article price ordered for article
Price IN Article price received at delivery
Total OD Total ordered for article
Total IN Total received at delivery

Navigation:  Reference > Main Screen > Invoice View > Tabs Invoice View >

Tab Invoice View : Log

Main Screen
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The columns displaying information are as follows : 

The Loading Evaluation tab allows the user to view the loading comments and information for a particular loading.   

Loading Evaluation: 

The loading evaluation information is divided into three main groups within the window : 

Event The actual event that has occurred.
Date Date 

if 
the 
log 
entry

Time Time of the log entry
Group User Group of the user that has created the log entry
User User from whose action the log entry has been created from
Workstation Workstation from which the log entry transaction has been created.

Navigation:  Reference > Main Screen > Invoice View > Tabs Invoice View >

Tab Invoice View : Loading Evaluation

 The evaluation groups and relevant categories
 Vendor evaluation questions
 Vendor evaluation grade.

Main Screen



The evaluation is done on the basis of groups that have initially been defined by the headquarters of the operating line.

Vendor evaluation questions have been designed to give a standard evaluation criteria. The range column in the questions defines
the evaluation range and the result column the score achieved for each category.

Based on the results, the vendor is evaluated and the grade is shown in the lower part of the screen in a pie chart.

Main Screen



The Loading Comments tab allows the user to view comments regarding the loading the active invoice is referring to. These comments may be different 
than what has been entered under the Loading Evaluation.

Loading Comments: 

The space where the Loading comments can be entered is positioned at the center of the screen.

Navigation:  Reference > Main Screen > Invoice View > Tabs Invoice View >

Tab Invoice View : Loading Comments

Main Screen



The Order Comments Tab allows the user to view comments regarding the order the active invoice is referring to. These comments may be different than 
what has been entered under the Loading Evaluation or what has been entered regarding the Loading Comments

Order Comments: 

The space where the Order comments can be entered is positioned at the center of the screen.

The Menu bar on the top of the screen contain basic options which are also available in the Toolbar. The same options are also available by right clicking 
the Invoice information

Menu Invoice View: 

Navigation:  Reference > Main Screen > Invoice View > Tabs Invoice View >

Tab Invoice View : Order Comments

Navigation:  Reference > Main Screen > Invoice View >

Menu Invoice View

Main Screen



This menu contains options for exporting and printing invoice information, as well as exiting the program.

File: 

The Edit menu contains program options such as moving items to another invoice, setting global and discount taxes, as well as scanning loaded amounts. 
Some of these options are also available in the Buttons Toolbar.

Edit: 

Navigation:  Reference > Main Screen > Invoice View > Menu Invoice View >

Menu Invoice View : File

Export 
Print   
Exit

Export the current view on the right to an Excel Sheet
Open the Report Manager for printing options.
Closes the Invoicing Module

Navigation:  Reference > Main Screen > Invoice View > Menu Invoice View >

Menu Invoice View : Edit

Main Screen



The Windows menu changes how the windows are displayed on the screen.

Windows : 

Move item to another Invoice
Auto Alocate the Invoice to Document References if entered
Set Global Discount to the selected Invoice
Set Global Tax to the selected Invoice
Select All items in view
Refresh the view
Scan Loaded Amounts for the selected Invoice

Navigation:  Reference > Main Screen > Invoice View > Menu Invoice View >

Menu Invoice View : Windows

Arrange All
     Split

Rearranges the windows back to the default view.
Splits the selected views equally across the screen

Main Screen



The Itinerary Planner is used to setup and view the itinerary of a specific vessel or the entire fleet. It displays the itineraries of 
multiple or selected ships on a parallel chart allowing users to view a vessel's location at any given moment of time. It also 
contains an overlap search making it possible to find when vessels are in the same port or region at the selected time range. 
The views of the module are highly customizable allowing to display the required information. The module is a powerful tool in 
long term planning for the departments that require this type of information. 

Itinerary Planner Main Screen: 

The image below represents the Itinerary Planner main screen as it looks once opened. The screen is 
dominated by the itinerary calendar with columns, each dedicated to a vessel and its relevant itinerary.  On the 
top left are the main function buttons and below are the 'Month' and 'Search for Overlaps' tabs. 

The buttons toolbar contains the most frequently used options for basic operations such as searching overlaps, copying and 
pasting data, and printing search results. 

Buttons: 

Clicking the buttons below or the links will open more information and instructions on the usage of these functions.

Navigation:  Reference >

Itinerary Planner Main Screen

Navigation:  Reference > Main Screen >

Buttons:

Main Screen



Most of the options have corresponding tools in the menu, keyboard shortcuts assigned to them or, are available with a right mouse click.  

The Search button activates the Overlap Search function. This makes it possible to find when vessels are in the same port or 
region at the selected range of time. The views of the module are highly customizable allowing the user to decide what 
information is to be displayed.

Button Search: 

Select the starting date for the search range.

Select the ending date for the search range.

Select the vessels that are to be considered in the search by checking the box immediately to the left of the ship name.

To initiate, click the  button and the the results of the search will be displayed on the main screen.

Search The Search button will open the overlap search function.
Copy Copies data within the Itinerary Planner
Paste Pastes data within the Itinerary Planner
Delete Deletes a selection within the Itinerary Planner
Print Opens the Report Manager module.
Year Selects a year in which to view the itinerary.
Exit Closes the Itinerary Planner module

Navigation:  Reference > Main Screen > Buttons >

Buttons:

Click to open the overlap search function.  The following field appear:

Main Screen



If the date column shows the same port of call for any of the selected vessels, the search has resulted in a 
matching overlap. This might prove useful for transferring goods from one vessel to another. If overlaps cannot 
be located the next option is to find same ports of calls on different days, which allows transfers with a few days
in between the port visits.

To start a new search, first click  , proceed to change the search criteria if necessary and then

click 

Clicking this button copies data to the Windows clipboard so it can be placed in the desired destination using the paste
function  This  can be helpful if a vessel wants to use an identical itinerary at a later date in the year. Copy the original 
itinerary, and paste it to the different date range.

Button Copy: 

´

The Paste function allows data copied to the Windows clipboard with the copy function, to be pasted somewhere else in the 
main screen calendar. 

Button Paste: 

Navigation:  Reference > Main Screen > Buttons >

Buttons:

Click the Copy button to copy any data on the main calendar area

Navigation:  Reference > Main Screen > Buttons >

Buttons:

Click on the Search button to initiate the Search Engine

Navigation:  Reference > Main Screen > Buttons >

Main Screen



The Delete button removes any selected information from the main screen. Use this button with care, you are able to remove 
ports with this functionality!

Button Delete:

This option opens the Report Manager. This option is also available in the Menu; File ->Print.

Button Print: 

Buttons:

Click on the Delete button to eliminate any selected information.

Navigation:  Reference > Main Screen > Buttons >

Buttons:

Click to open the Report Manager.

Main Screen



The year button allows  the default current year displayed in the main screen calendar to be changed.  This would be useful 
for setting up itineraries for an upcoming season or year.

Button Year: 

Scroll down the options and click on the desired year to be displayed in the itinerary calendar.

This option closes the Itinerary Planner module. You may also select from the Menu; File -> Exit.

Button Exit: 

The Menu bar on the top of the screen contains the most common functions useful to the Itinerary Planner. 

Menu: 

Navigation:  Reference > Main Screen > Buttons >

Buttons:

Click the drop down list next to the Year icon.

Navigation:  Reference > Main Screen > Buttons >

Buttons:

Click to close the Itinerary Planner module

Navigation:  Reference > Main Screen >

Menu:

Main Screen



This menu contains the the export / import of Excel spreadsheets, as well as printing and exiting the module. To import/export 
Excel spreadsheets, Excel must be installed locally.  Otherwise other format options are available as well.

File Menu options: 

Navigation:  Reference > Main Screen > Menu >

File Menu

Export:

Import:

Print:

Exit:

To export a chosen itinerary to a file.

To Import a pre-defined sheet and information to the Itinerary Planner

Opens the Report Manager.

Closes the program.

Main Screen



The Export function allows to export a chosen itinerary to a file using several different  formats.

File Menu : Export

To export an itinerary complete the required information in the Export Itinerary window.

From Date
Select the starting date of the itinerary to be exported

To date
Select the ending date of the itinerary to be exported

Format
Select the format of the export file. The following types are available : 

File Location
Select the destination directory of the file to be exported. Please note that if Excel is selected as the file 
format this option will not be available.  Instead the system will open an active Excel sheet which can be saved 
to the desired target directory outside of MMS.

Vessels to be exported
Select the vessels to be included in the itinerary to be exported. Please note that if the Text file format is 
selected the only one vessel can be selected for the export at a time.

Once all the information is entered click on the  button. 
The system will create the requested files and return the view to the main screen. If Excel file format was 
selected the file will open in the requested format and the sheet will remain active.

Navigation:  Reference > Main Screen > Menu > File Menu >

File Menu

 Microsoft Excel
 (,) Separated Text
 (I) Separated Text
 XML

Main Screen



The Import function allows to bring a pre-defined file format containing an itinerary into MMS. The file needs to be in XML 
format which currently is the only type accepted by the system. To Import an itinerary follow the steps of the Import Itinerary 
wizard dialogue box.

File Menu : Import

First is the prompting for location of the file to be imported. Please note that the file needs to be in XML format or the system will not be able to 
accept it.

Click  to continue

The system will read and verify the contents of the import file, recapping the contents.
Verify the information is correct before proceeding with the next step of the wizard.

Navigation:  Reference > Main Screen > Menu > File Menu >

File Menu

Main Screen



Click to continue.

The import will continue with the actual content of the selected file.

Click   to complete the operation.

The Edit Menu contains basic file options for copying, pasting, deleting items.   In addition the Properties option is available, 
which will bring up the day and port details of a selected line item.

Edit Menu options: 

Navigation:  Reference > Main Screen > Menu >

Edit Menu

Copy

Paste

Copies data within the Itinerary Planner

Pastes data within the Itinerary Planner

Main Screen



Select a specific day and either right-click =>properties, or click on Edit => properties in the menu bar to let the system display 
all the relevant information on the selected day. From this screen the users who have permissions to do so, can access and 
modify the information if needed.. This screen is normally accessible only from the Headquarters module.

Port of Call Information Properties: 

To add a port of call or update the information click on the Add Port button.  If a vessel has more than one port stop on a 
given date, and the itinerary changes, a port can also be deleted from here.

The Windows menu allows to changes on views of  the main screen giving the option to select those views that are the most 
suitable for a particular task.

Delete

Properties

Deletes a selection within the Itinerary Planner

Opens the Properties Windows for the selected Port 

Navigation:  Reference > Main Screen > Menu > Edit Menu >

Edit Menu - Properties

Navigation:  Reference > Main Screen > Menu >

Enter topic name

Main Screen



Windows Menu Options : 

Show Times
 Show multi Lined
 Show Country 

Name 
   Show State and 
Provices   

 Select Year

 Vessel to Display

Displays the vessel ETA (estimated time of Arrival) and ETD (Estimated time of 
departure)

Displays the information on multiple lines

Display the country in which the port of call is located

Displays the State and province of the port of call.

Select the Year to display the itinerary information on.

Select the Vessels of the fleet, that need to be included in the viewing

Main Screen



Navigation: »No topics above this level« 

Frequently Asked Questions

The Itinerary planner supports a maximum of four ports of call for one day. This can be done by double clicking a selected port in Itinerary planner and selecting Add Port and adding the
corresponding information.

Once having selected the vessels to view, the system will show the matching days in parallel if the ships are in port any given day but it will not show specific criteria on the topic.

 When a ship is in 2 ports on the same day. Is it possible to enter this on itinerary planner?

 Should some search criteria show when both ships are in port on the same day?

Frequently Asked Questions



The Micros Export functionality is used especially for Shops items or any retail items that will be sold on a POS using barcodes or number look ups 
(NLU). 
In the Article Manager the user can assign the MICROS menu item number, description, barcode and sales price for the Micros POS. 
As a first step all or selected data is exported from Material Management and in a second step the information is imported with pre-configured 
autosequences into the Micros POS System. 
Large amounts of items can be imported in a relatively short amount of time. 
The MMS Micros Export is compatible with all Micros 9700 versions.

Micros Export: Main Screen

See also:

Article Manager

Navigation:  Reference >

Micros Export

 When opening the  module in the Launcher the Data Export main window appears:

 Field explanations:

 Path: Allows the user to select the path the export files should be created in.

 Store: Selection of the Main store the data should be exported from.

 Major Group: Requires a valid MICROS major group entry. 

 Family Group: Requires a valid MICROS family group entry. 

 Menu Levels: Selection of the number of menu levels.

 Price List: Selection for price lists for the prices to export.

 Price File C1: Entry of the appropriate number for the MICROS "Price#" (MICROS -
menu item maintenance - price tab) field.

 Price File C2: Entry of the appropriate number for the MICROS "Active on 
Level" field.

 Barcode: Selection of the price level to be used in the MICROS Barcode 
"Price#" field.

 Last Modified: "Include only items last modified on or after:": This option can be used to 
only export items which have been modified until the below specified date. If nothing is 
selected all items for the select group/ category will be exported.

 "Create Single set folder": This option should be selected to write all items into one .txt
file, e.g. one mi_master.txt, mi_pri.txt, etc. NOTE: This option should only be used if you 
are running Micros 9700 3.0 and higher. If this option is not selected several import sets 
will be created, each file with a maximum of 1000 items. 

 "Verify if the prices exist": This option will check all items prior to exporting if they have a 
price in the selected price list. If the system finds items with no prices for the selected
price list, it will export them with 0,00 price.

Main Screen



This section shows the correct procedure to create export files for importing into MICROS. 

Create Export Files

Navigation:  How to ... >

...create export files

Remember: Before you start with the creation of the export files, run the "Duplicate or Invalid Barcode" report and eliminate every erroneous 
entry.

 Specify the path where the export files for the MICROS import are to be stored. 
Simple is better, i.e. C:\TEMP.

Select the MMS Main store to export the data for. 

Use the  to open the drop down menu and select the Main store 
accordingly.

Type the MICROS Major Group number to insert these items into. 
Even though more than 2 digits can be entered, only 2 digit major group 
entries are valid. The major group number is provided by your MICROS 
installer/ supporter.

Type the MICROS Family Group number to insert these items into.
Even though more than 4 digits can be entered, only 4 digit family group 
entries are valid. The family group number is provided by your MICROS 
installer/ supporter. Default value would be 999.

From the Menu Levels drop down list, choose the appropriate number.

Use the  to open the drop down menu and select the Main store 
accordingly.
Depending on the selection of menu levels the export files will contain 
information for one, two or more MICROS definition and price levels.
Most MMS installations have one menu level, if this is the case than you 
can select "All Level Active". 
The number of levels is provided by your MICROS installer/ supporter.

Select the Price List to use. (For configuration of Price Lists see RPOS 
Configurator)

Use the  to open the drop down menu and select the Price List 
accordingly.

Enter the appropriate number for Price File C1, this field requires the 
MICROS "Price#" (MICROS - menu item maintenance - price tab) field 
information.
Enter the appropriate number for Price File C2, this field requires the 
MICROS "Active on Level" field information.
The settings should default to: 
C1=1 - Price #1
C2=0 - active on all definition levels

From the Barcode drop down list, choose the appropriate number.

Use the  to open the drop down menu and select the Main store 
accordingly.
The selection depends on the available price levels in MICROS. 
The number is provided by your MICROS installer/ supporter.

If desired, the option 'Last Modified' box can be checked, so the system 
will only export those items that were changed since the last export, or a 
specific date. 

On the left side of the screen, the product tree is available. 
Place a check mark in the box next to all the items that need to be 
exported. 
Note: A data export of 'ALL' is not recommended. 

...create export files



This section is explaining detailed impacts of the various settings in the DATA EXPORT screen.

Data Export Settings

You should use this setting if you only accept one currency in MICROS.

You can select this setting if you have 2 prices, e.g.: EUR and USD.

Depending on your MICROS version the option "Create Single set folder" 
needs to be enabled or disabled.
If you are running MICROS 9700 2.8 or LOWER run the export with the 
'Create Single Set Folder' NOT checked. That way the system will 
automatically create several smaller file sets that the MICROS system 
can import without issues.
If you are running MICROS 9700 3.0 or HIGHER run the export with the 
'Create Single Set Folder' checked. That way the system will 
automatically create one file set and the import needs to be run only 
once.

Click EXPORT to begin the export process. The export will generate the 
Import files in group(s) in the location specified above in the path field.

When the export is completed, follow the instructions from your MICROS 
installer/ supporter on how to run the import in MICROS.

Navigation:  How to ... >

...create export files

 Export with one menu item definition and one price.

 Export with 2 menu item definitions and prices. 

...create export files



You can refer to these settings in case you have to switch from once currency to another, e.g. you need to switch to the 3rd price level for the South American season.

 Export current barcode information depending on the active currency level.

...create export files



This section is describing the content of the export files.

Read Export Files

In case the option was not selected, there will be several folders (depending on the amount of data to be exported) called Records Group followed by a 
running number.

Contains 2 columns - family group number (according to the manual input in the DATA EXPORT) and a preset name "Export Folder".

Contains 4 columns - menu item number, menu item master name, major group (according to the manual input in the DATA EXPORT) and family group (according to the manual 
input in the DATA EXPORT).

Contains 3 columns - menu item number, report group (preset to 1) and F&B options (not in use!).

Contains 10 columns - menu item number, definition sequence, menu item name 1, menu item name 2, main level link, sub level link, SLU sorting, menu item class, NLU group, NLU 
number.

Contains 6 columns - menu item number, definition sequence number, price number, level activity, price and prep cost.

Contains 5 columns - barcode line number, barcode, menu item master link, menu item definition link and menu item price number link. 

This section shows the correct procedure to import the export files into MICROS using the pre-defined autosequences.

Create Export Files

Before you can start using this functionality it needs to be pre-setup by your MICROS installer/ supporter.

To import item data created from MMS into MICROS proceed as follows:

Navigation:  How to ... >

...create export files

 A full set of export (Records Group 01) files contains the following files:

famgrp.txt Family Group Information

mi_ma.txt Menu Item Master Data
mi_ma_rpt.txt Menu Item Master Report Data
mi_def.txt Menu Item Definition Data
mi_pri.txt Menu Item Price Data
bcode.txt Barcode Information

 famgrp.txt

 mi_ma.txt

 mi_ma_rpt

 mi_def.txt

 mi_pri.txt

 bcode.txt

Navigation:  How to ... >

...run the import on MICROS

Note the name of the import folder might vary in case your system is 
setup to run imports for different RVC´s. 

 Copy the created export files from the MMS client PC to the MICROS server to
D:\MICROS\LES\POS\9700\Scripts\import. 

 Log on to your MICROS server directly or use the recommended remote
connection.

 Open the EMC - Control Panel and make sure it is set to Server 
Application.

 Open RMC - Autosequences, highlight MICROS import and click on

...create export files



RUN.

 Wait for the import to finish and make sure there are no errors shown on the 
screen. Press any key to continue.

 At this point the system will remove the imported .txt in order to make sure they 
are not imported again by accident at a later point. Press any key to continue.

 When all imports are finished open the MICROS control panel and set it back 
to WORKSTATION OPERATIONS.

...create export files



Navigation: »No topics above this level« 

Frequently Asked Questions

This section covers some problems that are frequently encountered by our users. 

What can I do when the imported prices are incorrect?

Make sure the correct price list is selected.

Run the export again and re-import into MICROS.

How can I find duplicate or invalid barcodes?

Open Print Manager and run the duplicate and invalid barcode report.

What can I do if the MICROS import fails with duplicate barcodes?

When you receive this error, let the import finish.

Run the MMS "duplicate or invalid barcode" report and make sure you eliminate every duplicate.

When the report is clean, run the export again, followed by the import in MICROS.

What can I do if I have selected "All Level Active" but the system is not exporting all levels?

Note: The MICROS export module does not have a direct connection to the MICROS database and can not see what levels are existing on the MICROS database.

This option does not mean to export all active levels but to export one entry per item which is active on all MICROS levels no matter how many exist.

Frequently Asked Questions



Navigation>Reference

Movements Top Next

The Movement Module can be considered the central module that organizes the flow of all articles managed by the Material Management System from 
the initial loading into the stores, issuing to the designated points of consumption and transferring between them.
Returns to vendors can also be handled via the movement module as well as transfers from warehouses, ship to ship movements and uniform 
handling. 

Movements main screen 

The image below represents the movements module main screen as it looks once opening it. On the top are the main Function Buttons and below, the 
screen is divided into three main sections displaying a calendar which displays different colors depending on which Overview has been selected. At the 
very bottom is displayed information on the operational unit, date & time, current user, computer name, database in use and the module version 
number.

Moving the mouse over the screenshot 'hotspots' will change the cursor into a 
Clicking on these links will provide more detailed information on the particular topic.

Overview Top Previous Next

The view in the main screen can be changed to contain only selected types of items and for selected departments. By default, the system shows all 
movements.

Movement Type View: 

Main Screen



Once opening the view selection drop down list, the program has the following views available

Movements
The system will show all movement related transactions on the main screen and the calendar will display days with transactions in brown.

Uniforms
The system will show all uniforms related transactions on the main screen and the calendar will display days with transactions in red.
Once the desired view is set, the transactions may be viewed by selecting a day, whereupon the corresponding transaction information will be 
displayed on the main screen details window.

Main Screen



If it s desired to see only the transactions related to a particular department, the information can be filtered to a specific department by selecting from 
the box directly under the view type (see also department selection)

A detailed breakdown of the chosen transaction type for the day will be displayed on the right hand side of the screen, while under the calendar view, a 
summary can be selected by various options - for example loadings can be summarized by vendor.

Double click on a line in the main display window (i.e. on a movement) and the screen will then display the full document associated:

Main Screen



After double-clicking on one of the transactions the following screen will appear:

When using the 'Movements' display, after clicking once on a line in the main display window, click on Quick View in the bottom left of the screen, and 
a 'quick view' of items in the corresponding document will appear on the left of the screen:

Main Screen



Department Selection Top Previous Next

The overview selection can also be limited to contain transactions only for a selected department. This is done by selecting a specific department from 
the drop down list indicated.

Department Selection View: 

By default the system shows all transactions. By selecting a single department only those movements will be displayed that are corresponding to 
selected department.

Main Screen



By selecting department "BAR" (as shown and described above) only those transactions that correspond to a "BAR" will be displayed.

Main Screen



Buttons Top Previous Next

The buttons toolbar contains the basic and most frequently used options for creating movements, opening existing documents and printing reports.

Buttons: 

Clicking the buttons below or the links will open more information and instructions on the usage of these functions.

Search:               Opens the document with the search engine
Refresh:              Will return they layout of the screen to its default state
New Task:               Starts the process of creating a new transaction
Open Document:                Opens an existing transaction
Print:             Allows the use of a pre-saved list of products
Export to Excel:       Exports the active information related to loadings
Exit:             Closes the movements module

Most of the options are corresponding tools in the Menu, keyboard shortcuts assigned to them, or are available by a right click with the mouse

Button: Search Top Previous Next

This option opens the search engine, allowing to search for a document in the movement module.

Button Search:

        Click to open the document search engine

The article can then be searched by entering the article ID number or by any of the above filters. One or more filters can be chosen in order to narrow 
your search. 

In this case the filter "Status: 1 - Authorized" has been selected, therefore only those transactions are displayed that are in "Status 1" 

After making selections, and clicking the search button, the documents meeting the search criteria will be displayed.

Buttons



Button: Refresh Top Previous Next

This option refreshes the screen layout. For example, having sorted columns by their heading or resized them, clicking refresh will reset the layout to 
their original view.

Button Refresh: 

       By clicking here you will be able to refresh the screen layout.

Button: New Task Top Previous Next

Selecting 'New Task ' will open the 'create or modify transaction' window.

Button New Task: 

By clicking here you will be able to create a new movement transaction

Buttons



The functions can be briefly described as follows. Please click on the corresponding topic link for further details.
Issue to POC
This option is used for issuing any item to a POC (point of consumption) for usage
Issue to Account
Issuing items to accounts involves transferring the articles to an account through which they will be directly expensed (consumed) without the necessity 
to pass through a point of consumption.
Issue to Uniform Allotments
This module is used to assign (issue) uniforms in cases when a crew member embarks and needs to be given uniform items. It links the items issued to 
the specific crew member.
Return to Mainstore
This option is used to return any item that has already been received in a POC to the main store.
Return Uniforms
The Return uniforms module is used when a crew member disembarks and returns the issued uniform items.
Transfer between POC
Transfers between POC allows the user to move items between departments.
Transfer POC to Account
This module may be used to issue items from a POC directly to an account without having to pass through the main store, thereby expensing the items 
directly to the selected account.
Reverse Issue to Account
This module may be used to reverse falsely transferred items to an account. Please note that in this case there is no physical movement of inventory

Issue to POC Top Previous Next

When an onboard department or any outlet needs to issue a routine internal requisition to a store (F&B, hotel, shops etc) it is called an Issue to POC 
(Point of Consumption. Regardless of the material type, the procedure for making these requisitions is explained below:

Issuing of Items to POC

Buttons



      Click to initiate the creation of a new issue to POC

Select "Issue to POC"

Double-click on Issue to POC or select Issue to POC and then click open to create a new movement

The following details must be completed for the transfer to take place

When the above fields have been filled in, the following screen will appear. Here is where you are to choose which item you would like to request:

By clicking in the "Code" field the user is able to search for an article by giving the code number or by entering a few letters of the description of the 
article

Source: When creating an issue to POC, the 
system will automatically select the Mainstore 
as source.

Destination: this is where the POC can be 
selected where the item is to be transferred or 
moved to

Cause: The reason for the request of the item. 
This can be either of the following:

Additional Request: used to supplement a 
standard request

Emergency request: Used in cases of an 
immediate / urgent need

Price Correction: If the wrong price is entered 
for an item, this option will recalculate the costs

Standard Request: Routine internal requests

Pickup Date: Date of the items pick up

Pickup Time: the exact time of pickup. This 
option in the software will keep track of all the 
requisitions in the system for all departments 
and assign available time slots according to 
availability.

Buttons



Select the corresponding product by double-clicking on the description. The selected article will then appear on the main screen.

Continue by inserting required quantity in the amount column and confirm by pressing enter. 

Buttons



Move the cursor to the code cell on the next line and proceed to enter the next article. Complete all the articles that are included in the movement.

After completing the requisition close the window by clicking the  on the right hand side.

In order to authorize, discharge and to receive an Issue to POC see also Approve Requisitions topic.

Issue to Account Top Previous Next

In cases where it is required to expense the required articles directly to an account (specific reason for consumption rather than issuing to a regular POC) 
and write them off from the main store inventory it is possible to use the 'Issue to account' function. 

Issuing articles to an Account

Buttons



Click to initiate the creation of an "issue to an account"

Select Issue to Account as below

Double-click on Issue to Account or select Issue to Account and then click open to create a new movement

Complete the following fields:

When the above fields have been filled in, the following screen will appear.

By clicking in the code field the user is able to search for an article by giving the code number or by entering a few letters of the description of the article

Source: When creating an issue to Account, the 
system will automatically select the Mainstore 
as source.

Destination: this is where the Account can be 
selected where the item is to be transferred or moved 
to

Cause: Depending on which account was 
selected, there can be several causes set up for 
each account based upon the ship's operation. 
Most common causes are the following:

Breakage

Spoilage

Welcome Drinks

Beverage for Captain's Table

Items for Authorities

Pickup Date: Date of the pick up

Pickup Time: the exact time of pickup. This 
option in the software will keep track of all the 
requisitions in the system for all departments 
and assign available time slots according to 
availability.

Buttons



Select the corresponding product by double-clicking on the description and it will appear on the main sheet.

Continue by inserting required quantity in the amount column and confirm by pressing enter. 

Buttons



Move the cursor to the code cell on the next line and proceed to enter the next article. Complete all the articles that are included in the movement.

After completing the requisition close the window by clicking the  on the right hand side

In order to authorize, discharge and to receive an Issue to Account see also Approve Requisitions topic        

Issue to Uniforms Alotments Top Previous Next

The issue to uniform allotments module is used when a crew member embarks the ship and needs to be issued uniform items. This transaction will issue 
the required uniforms to the crewmember directly using the uniform items store.

Issuing Uniforms to Crew 

      Click to create a new issue to uniform allotment transaction

Select issue to uniform allotments

Buttons



Double-click on Issue to Uniform Allotments or select Issue to Uniform Allotments and then click open to create a new movement

Complete the following fields:

When the above fields have been filled in, the following screen will appear. Here is where you are to choose which item you would like to request:

By clicking in the code field the user is able to search for an article by giving the code number or by entering a few letters of the description of the article

Source: When creating an issue to Uniform 
Alotments, the system will automatically select 
the Mainstore as source.

Destination: the name of Crew member

Cause:

Full dressing

A full catalogue of uniform items is issued to the 
crew member. This is the most common, and it 
is normally used when the crew member 
embarks

Replacement

This option may be used as uniform items need 
to be re-issued to a crew member as 
replacement for worn-out items

Return

The return option in this case is used when 
single uniform items need to be returned for a 
non-specified reason

Selling

In cases where company policy requires the 
specific crew members are to pay for uniform 
items, this option may be used

Pickup Date: Date of the items pick up

Pickup Time: the exact time of pickup. This 
option in the software will keep track of all the 
requisitions in the system for all departments 
and assign available time slots according to 
availability.

Buttons



Select the corresponding product by double-clicking on the description and it will appear on the main sheet.

Continue by inserting required quantity in the amount column and confirm by pressing enter. 
Move the cursor to the code cell on the next line and proceed to enter the next article. Complete all the articles that are included in the movement.

After completing the requisition close the window by clicking the  on the right hand side.

In order to authorize, discharge and to receive an Issue to Uniform Alotments see also Approve Requisitions topic

Return to Mainstore Top Previous Next

In cases where it is necessary to send goods back to the main store for any reason, this option may be used. This might be necessary where goods have 
already been issued from main store prior to realizing that they are damaged or when too many articles have been withdrawn initially.

Returning Items to Main Store: 

      Click to create a new return to main store transaction

Select Return to Main Store

Double-click on Return to Main Store or select Return to Main Store and then click open to create a new movement

Buttons



Complete the following fields:

When the above fields have been filled in, the following screen will appear. Here is where you are to choose which item you would like to return:

By clicking in the code field the user is able to search for an article by giving the code number or by entering a few letters of the description of the article

Select the corresponding product by double-clicking on the description and it will appear on the main sheet.

Source: this is where the POC can be 
selected where the item is to be transferred 
from

Destination: When creating a Return to 
Mainstore, the system will automatically select 
Mainstore as destination

Cause: The reason for the return of the 
item. This can be either of the following:

Return Damaged: select if the stock is 
damaged, however damaged stock is also 

Return Over Stock: selecting this cause 
gives the opportunity to return additional stock 
that is not required in the POC

Pickup Date: Date of pick up

Pickup Time: the exact time of pickup. 
This option in the software will keep track of 
all the requisitions in the system for all 
departments and assign available time slots 
according to availability.

Buttons



Continue by inserting required quantity in the amount column and confirm by pressing enter. 

Move the cursor to the code cell on the next line and proceed to enter the next article. Complete all the articles that are included in the movement.

Buttons



After completing the requisition close the window by clicking the  on the right hand side.

In order to authorize, discharge and to receive a Return to Mainstore see also Approve Requisitions topic

Return Uniforms Top Previous Next

The return uniforms module is used when a crew member disembarks the ship and he/she needs to return those uniform items that were issued upon 
original embarkation.

Returning Uniforms : 

      Click to create a new Return Uniforms transaction

Select Return Uniforms

Double-click on Return Uniforms or select Return Uniforms and then click open to create a new movement

Complete the following fields:

Source: The name of the crew member will 
be available in the Source drop down 
selection

Destination: The system will automatically 
assign the main store to the destination

Cause: The following causes may be 
selected

Full dressing

A full catalogue of uniform items is issued to 
the crew member. This is the most common, 
and it is normally used when the crew 
member embarks

Replacement

This option may be used as uniform items 
need to be re-issued to a crew member as 
replacement for worn-out items

Return

Buttons



When the above fields have been filled in, the following screen will appear.

By clicking in the code field the user is able to search for an article by giving the code number or by entering a few letters of the description of the article

Select the corresponding product by double-clicking on the description and it will appear on the main sheet.

Continue by inserting required quantity in the amount column and confirm by pressing enter. 
Move the cursor to the code cell on the next line and proceed to enter the next article. Complete all the articles that are included in the movement.

After completing the requisition close the window by clicking the  on the right hand side.
        In In order to authorize, discharge and to receive 

a Return Uniforms see also Approve Requisitions topic         

The return option in this case is used when 
single uniform items need to be returned for 
a non-specified reason

Selling

In cases where company policy requires the 
specific crew members are to pay for 
uniform items, this option may be used

Pickup Date: Date of the items pick up

Pickup Time: the exact time of pickup. 
This option in the software will keep track of 
all the requisitions in the system for all 
departments and assign available time slots 
according to availability.

Buttons



Transfer between POC Top Previous Next

When it is necessary to transfer items between two points of consumption, this option may be used. The function transfers articles from one outlet to 
another without passing them through a main store.

Transferring items between POCs (Points of Consumption)

      Click to create a new Transfer between POCs

Select Transfer between POC

Double-click on Transfer between POC or select Transfer between POCs and then click open to create a new movement

Complete the following fields:

When the above fields have been filled in, the following screen will appear.

By clicking in the code field the user is able to search for an article by giving the code number or by entering a few letters of the description of the article

Source: Select POC where the item is to be transferred from

Destination: Select POC where the item is to be transferred to

Cause: The reason for the request of the item. This can be 
either of the following:

Additional Request: used to supplement a standard request

Emergency request: Used in cases of an immediate / urgent 
need

Price Correction: If the wrong price is entered for an item, this 
option will recalculate the costs

Standard Request: Routine internal requests

Pickup Date: Date of the items pick up

Pickup Time: the exact time of pickup. This option in the 
software will keep track of all the requisitions in the system for 
all departments and assign available time slots according to 
availability.

Buttons



Select the corresponding product by double-clicking on the description and it will appear on the main sheet.

Continue by inserting required quantity in the amount column and confirm by pressing enter. 

Buttons



Move the cursor to the code cell on the next line and proceed to enter the next article. Complete all the articles that are included in the movement.

After completing the requisition close the window by clicking the  on the right hand side.
In order to authorize, discharge and to receive a Transfer between POC see also Approve Requisitions topic

Transfer POC to Account Top Previous Next

Sometimes it is necessary to transfer items from a POC (Point of Consumption) to an account directly. This type of a case could be, that a bottle is taken 
from a bar as gift item and it needs to be charged to the corresponding account. For this a transfer transaction has to be created.

Transferring Articles from POC to an account

Click to create a new movement from a POC to an account

Select Transfer POC to Account

Buttons



Double-click on Transfer POC to Account or select Transfer POC to Account and then click open to create a new movement

Complete the following fields:

When the above fields have been filled in, the following screen will appear.

By clicking in the code field the user is able to search for an article by giving the code number or by entering a few letters of the description of the article

Source: Select POC where the item is to be transferred from

Destination: Select the Account where the item should be 
recorded

Cause: Depending on which account was selected, there can 
be several causes set up for each account based upon the 
ship's operation. Most common causes are the following:

Breakage

Spoilage

Welcome Drinks

Beverage for Captain's Table

Items for Authorities

Pickup Date: Date of the items pick up

Pickup Time: the exact time of pickup. This option in the 
software will keep track of all the requisitions in the system for 
all departments and assign available time slots according to 
availability.

Buttons



Select the corresponding product by double-clicking on the description and it will appear on the main sheet.

Continue by inserting required quantity in the amount column and confirm by pressing enter. 

Buttons



Move the cursor to the code cell on the next line and proceed to enter the next article. Complete all the articles that are included in the movement.

After completing the requisition close the window by clicking the  on the right hand side.

In order to authorize, discharge and to receive a Transfer from POC to Account see also Approve Requisitions topic

Reverse Issue to Account Top Previous Next

In some cases you will have to reverse an issue that has been allocated to an account. Below are the instructions how a reverse to an account should be 
carried out.

Reverse Issue to Account

      Click to create a Reverse Issue to Account

Select Reverse Issue to Account

Buttons



Double-click on Reverse Issue to Account or select Reverse Issue to Account and then click open to create a new movement

The following window will appear:

As soon as these fields are completed the transaction will be located in the Movement Overview screen at status 2 (item has been discharged)

Issue ID: Here you will have to enter the item´s issue ID 
number in order for the system to find the transaction

Once the issue ID has been added the system will 
automatically locate it and select the account and the cause 
of the transaction

Date: Date of the transaction

Buttons



In order to authorize, discharge and to receive a Reverse Issue to Account see also Approve Requisitions topic

Button: Open Document Top Previous Next

The open document button is used to access any existing movement transaction.

Opening an existing transaction

by clicking on this you will be able to open an already existing movement
Select movement type from "Look for" drop down menu

Click on "Open" to view selected Movement

Buttons



Button: Print Top Previous Next

This option opens the Print Manager

Button Print: 

      Click on this icon to open the Print Manager

Button: Export to Excel Top Previous Next

This function enables to export the contents of the active screen to an external Excel spreadsheet. 

Exporting to Excel: 

       Click here when the desired document for exporting is open on the screen

Buttons



Following this an export window will open

To continue click "Export"

As soon as this had been done the selected screen with the items will appear in an excel sheet as below:

This data can now be saved, manipulated, etc according to user's needs

Button: Exit Top Previous Next

This option will close the movements module.

Button Exit: 

Click here to close the movements module

Buttons



Menu Top Previous Next

The menu bar on the top of the screen contains basic options which are also represented in the toolbar and often also 
available with a right mouse click.

Menu: 

File Edit Windows Help

Menu: File Top Previous Next

This menu contains the most common options for creating, re-opening movement transactions and export / import Excel 
sheets. 

File : 

New Task: will open the 'create or modify transaction' window

Open: will open movement that is highlighted in the display window 

Export: will create an excel sheet of the display window         

Print: opens the print manager

Exit : closes the movements module     

Menu: Edit Top Previous Next

The edit menu contains among the most common options, the possibility to is menu contains the basic file options for 
Creating, Re-opening Movement transactions and Export / Import Excel Sheets. In addition to this the File menu also 
contains the option to open the Report Manager. 

Edit : 

Open: will open movement that is highlighted in the display window 

Status: users are able to view and authorize transaction statuses using this drop down

Print: opens the print manager

Recalculate Costs: will recalculate cost prices for movement in current period

Delete: deletes movement and all items

Menu



Menu: Windows Top Previous Next

The Windows menu allows the user to change how the windows and screens are displayed on the layout.

Windows : 

Arrange All:     Arranges the windows back to the default 
view

Split:     Splits the selected views equally across the 
screen

Menu: Help Top Previous Next

The Windows menu allows the user to change how the windows and screens are displayed on the layout.

Help : 

Contents 

Search

About

Menu



How to... Top Previous Next

In this section specific step by step guidelines can be found in order to effectively utilize the Movements Module

Approve Requisitions Top Previous Next

Approval process for requisitions and issues: 

Approving requisitions / issues
After this operation, the transaction still has three stages to completion . These are:

Each step needs to be completed by the named responsible person:
By right clicking on the mouse the menu below will be displayed

1 - Authorize by Head of Department - Once the transaction has been entered into the system, the head of 
department must approve the movement. At this authorization stage the quantities can still be changed

2 - Discharged from stores - This status must be selected once the goods have been dispensed from the stores. 
This is the approval level that changes the stock on hand in the main store (or the source of the items)

3 - Received at destination - The third stage will be confirmed once the goods have been received at the 
destination. This level closes the transaction and it may no longer be modified.

 Authorization by head of department
 Discharged from stores
 Received at destination

How to...



The changes made in the status can also be viewed through the status menu accessible directly on the products 
sheet or the edit menu 

See Also:
 Issue to POC
 Issue to Account
 Return to mainstore
 Transfer between POC
 Transfer POC to Account

Issue Articles to POC using Template Top Previous Next

Issuing items using a Template

Click to initiate the creation of a new issue to POC

Select Issue to POC

Complete the following fields working downwards

How to...



After clicking "Apply", click on and the template selection window will open:

By double-clicking on the desired template the system will then add the items into the movement request and will be displayed 
on the screen

How to...



Proceed downwards inserting the amount for all products that are required in this particular requisition. If a product is not 
needed, the amount may be left as zero.

Upon completion of all the items that are required, Right Click the requisition area to open a drop down list. From this list 
select "Delete Items With Zero Balance"

This will adjust the requisition to include only those items with a quantity

See Also:

 Issue to POC

How to...



Issue Articles to POC using Loading Document Top Previous Next

With this tool the user is enabled to add an entire loading document to a Movement by following the steps below

1. Create "New Task"

Insert movements details: destination, cause, pickup date, pickup time, then click "Apply"

How to...



2. Click on Edit in the menu at the top left of the screen

Select "Insert Loading" from drop down menu

3. Enter Loading document ID

In order to enter items from a loading, the ID number of the respective loading document must be entered

Please follow the steps below in order to retrieve the loading document ID

1. Go to Receiving Module

How to...



2. Select date of loading in the calendar on the left side of the screen

3. Click on "Receivings" tab at the bottom of the display window

4. Loading Document ID is found under the third column of the Loading overview display screen (Doc#)

How to...



After finding and entering the Document ID number, all items in the loading document will then be added to the 
movement request and their quantity can be edited as per operational needs.

Upon completion of all the items that are required, Right Click the requisition area to open a drop down list. From 
this list select "Delete Items With Zero Balance"

This will adjust the requisition to include only those items with a quantity

NOTE: loading documents can be added more than once to a movement request, however the system will always 
take into consideration the available stock on hand from the store or POC.

Issue Articles to POC using Recipe Top Previous Next

With this tool the user is enabled to add the ingredients of a recipe to a Movement by following the steps below

1. Create "New Task"

How to...



Insert movements details: destination, cause, pickup date, pickup time, then click "Apply"

2. Click on Edit in the menu at the top left of the screen

How to...



3. A Recipe can be chosen either by searching for its code, description or from the tree folder view.

After selecting desired recipe, the system will show all ingredients and quantities of selected recipe

How to...



When finished click on "Add Items". All ingredients of selected recipe will then be added to the movement request

Use Logs Top Previous Next

Using logs is an effective and useful tool in order to summarize and monitor various actions of users in regards to specific 
movements

Please follow the below steps in order to view logs for a specific movement;

1. In movements display screen double-click on a movement

How to...



2. At the bottom of the display screen click on the tab "Logs"

3. The following screen will appear

How to...



The following information can be retrieved:

Date:          Displays the date of an event

Time:           Displays the exact time of event occurrence

Group:           Displays the user group

User:           Displays the name of the user

Work Station:        Displays the name of the workstation/PC where the event was entered 

Event:           Displays the description of the event

How to...



The options module is the setup and configuration manager of the software and allows authorized users or installers to setup relevant program variables, 
functionalities, options, and data structures such as setting up periods, users, user rights and other operational variables. 

Options Main Screen : 

The main screen of the options module will display the information on the right hand side. 
Above the tree using the headquarter module it is possible to select the setting of particular 
vessels. In vessel mode this option is disabled.

The option tree on the left hand side of the screen has two main options which are : 

+ Ship Specific Options

+ Administrator Options

The ship specific options contain individual settings for a ship and can only be modified by those with the appropriate user rights, either onboard 
administration or shore side.

Applications : Executables 

The application options can be found by opening the branch of the applications tree.

In this section all the different program components can be found divided into three types: 

Standard Applications
All executable files of Fidelio Software are housed in this folder.

Navigation:  Reference >

Options Main Screen

Navigation:  Reference > Main Screen >

Ship Specific Options

Main Screen



Right clicking an individual program icon opens the individual properties of an executable. 
In this screen the file can be updated and the corresponding icon changed.

Special Applications
All special applications are housed in a separate folder.

System Files
The system files can be found in a dedicated folder.

Main Screen



The article setup tree contains the folder for article information related maintenance.

Article Setup: 

Click on the folder heading to see details of the selected topic.

The article settings folder tree contains options for setting up article descriptions. Note that this area of settings controls how the articles will eventually be 
shown and handled in the article manager module.

Article Settings (1): 

The article setup function has an option to set articles by auto generation. In this article settings window the auto generation variables can be set. This formatting uses the standard 
Visual Basic formatting.

The second article settings folder tree contains additional options for setting up article descriptions. Note that this area of settings controls how the articles 
will eventually be shown and handled in the article manager module.

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Article Setup

Navigation:  Reference > Main Screen > Ship Specific Options > Article Setup >

Article Setup : Article Settings (1)

Navigation:  Reference > Main Screen > Ship Specific Options > Article Setup >

Article Setup : Article Settings (2)

Main Screen



Article Settings (1): 

In this window it is possible to set up to five translations for article descriptions. The first option sets the number of translations and the second part lists the languages that have 
been set.
One language has to be selected as the default primary language and it will always appear in the articles main screen. 

In every port, in order to gain clearance from the local authorities the ship needs to present a customs declaration form for articles specified by local law.
Normally these articles include alcoholic beverages by category, cigarettes, cigars, and certain food items among others. Specific requirements vary from 
port to port but a guideline can be obtained from IMO (http://www.imo.org) standard forms.

In the MMS, it is possible to define custom declaration groups which will include the relevant items in order to be able to print an accurate custom 
declaration report.
In this section of the options tree the categories can be defined (food, beverage, cigarettes etc).

Custom Declaration Groups: 

1. Categories creation
In order to define the articles that need to be included in the customs declaration reports, it is necessary to firstly define the groups under which the products will be reported.
This information is available from the list of requirements for each port.

Navigation:  Reference > Main Screen > Ship Specific Options > Article Setup >

Article Setup : Custom Declaration Groups

Main Screen



Click  to add a category

Assign a category code to the group to be added and press ok.

Add the description to the new category to be added and finish the insert by clicking 

2. Assigning Articles
The second phase of the operation is to assign the articles that need to be included in the customs declaration report under the categories previously created.

Open the from Fidelio Cruise launcher

Select the mainstore under which the article is categorized.

Locate the product that needs to be included.

Right click on the description to open properties window. This will open the product data sheet in article manager.

Select 'Shelf Life / Customs / Other' Option

Main Screen



Enable option “article listed in declaration” and select the category under which this specific product should appear on the customs declaration.

Click on  button to complete the creation process.

General ledger codes can be used for accounting purposes.  Any item in article manager can be linked to a set general ledger code which provides the 
possibility to print specific reports for the accounting department. Reports could be created and printed by store, group and subgroups. In addition it is 
possible to create special report groups and link items to them.

General Ledger References: 
GL categories creation
In order to define the articles that need to be included in the general ledger related reports, 
it is necessary to firstly define the general ledger groups under which the products will be
reported.

Navigation:  Reference > Main Screen > Ship Specific Options > Article Setup >

Article Setup : General Ledger References

Main Screen



To add a general ledger group select 

A line will be added to the bottom of the window. Insert the corresponding codes in the columns Code 1 and Code 2 and the 
relevant name in the Name column.

Each product in the article manager database can be linked to a specific report group.  Reports can be created and printed by store, group and 
subgroups. 
In addition it is possible to create special report groups and link items to them.

Report Groups: 

Report groups creation

To add a report select 

Navigation:  Reference > Main Screen > Ship Specific Options > Article Setup >

Article Setup : Report Groups

Main Screen



A line will be added to the bottom of the window. Insert the corresponding codes to the Code column and a name in the Name column.

This folder branch covers all the currency related settings.

Currencies: 

Click on the folder heading to see details regarding the selected topic.

The currency exchange rates are updated in this option tree folder.

Currencies Exchange Rate: 

In most cases the exchange rates are updated from the main office and for this reason this data is not modifiable by most users. If this is the case the system has an option to 
replicate the changes made to all units that use the software. If this option is not used the changes will only apply to that particular unit.

To edit an exchange rate click on the corresponding cell.

In the sales currencies option tree folder, the system keeps track of all the currencies that are used in sales operations throughout the fleet.

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Currencies

Navigation:  Reference > Main Screen > Ship Specific Options > Currencies >

Currencies : Currencies Exchange Rate

Navigation:  Reference > Main Screen > Ship Specific Options > Currencies >

Currencies : Sales Currencies

Main Screen



Sales Currencies: 

To add or edit any of the currencies select 

A sales currencies window will appear. The left hand side window contains all currencies available in the system.
The right hand side window contains a list of those currencies that are presently set in the system as fleet sales currencies.

Use the  buttons to move the selected currencies between these two windows.

Upon completing the operation click  the button.

Under the options for database and hardware the system stores the information on how averages will be calculated.

Averages: 

The MMS system uses two different types of average prices that can be set by the users.
The system will calculate these averages using the system date less the number of days specified.

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Database / Hardware

Main Screen



The vendor evaluation questions can be set in the system to start the process of evaluating suppliers (vendors). The purchasing department may use this 
information in future bidding processes to verify the track record of a selected vendor. It is recommended that the evaluation process is started as soon as 
the system is operational in order to ensure an accurate vendor quality registry at an early stage.

Evaluations: 

In order to set up the evaluation process it is necessary to set up the desired question Groups. Upon setting up the categories, the actual Questions can be set.

Click on the folder heading to see details regarding the selected topic.

The groups are the categories in which the actual vendor evaluation questions are set. 

Groups: 

The system has the following pre-set groups by default. The list may be modified according to individual needs.

E1        General packing
E2        Condition of supplies
E3        Documentation
E4        Vendor
E5        Security

This grouping can be modified by adding to or deleting from the list.

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Evaluations

Navigation:  Reference > Main Screen > Ship Specific Options > Evaluations >

Evaluations : Groups

Main Screen



The actual vendor evaluation questions are set inside this module after having completed the groups for the questions.

Questions: 

To add questions to any group press 

A new line will be added to the list of questions.

Bring the cursor into a cell in the newly created line and press the key “E” which will open a selection 
box according to the previously created categories in the space below . 

Choose the category that you wish to use and accept by pressing ENTER

Navigation:  Reference > Main Screen > Ship Specific Options > Evaluations >

Evaluations : Questions

Main Screen



In the next column insert the corresponding question for the category selected and accept by 
pressing ENTER

By pressing the key “B” a drop down list will open for choosing what type of answer the question 
is supposed to have.  Please choose Boolean or Numeric and accept by pressing ENTER.

Choose the last column value depending on your selection type value : 

Boolean        5
Numeric    1

Close the question addition box by choosing 

The general options folder tree is used to maintain the list of company entities (CET). Each unit that utilizes the MMS software is considered an entity. 
Normally entities consist of a headquarters, individual vessels and perhaps a warehouse.

Company Entities (CET): 

Each ship or other entity (HQ, warehouse etc) must have an entry on this list including a valid licence for the software.
The following generic information can be included : 

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : General
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In the options tab, each entity is provided a space for the licence code and the option for an individual 
type of purchase order.

All interfaces that link the MMS to other Fidelio sytems are located in this folder.

Interface: 

Click on the folder heading to see details regarding the selected topic.

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Interface

Main Screen



The Micros configuration window contains the information linking the Micros POS (Point of Sale) system with MMS.

Micros Configuration: 

9700 setup Requirements:
* Micros server joined to the domain
* Telnet enabled on the server with NTLM = 1
* Micros import user created on the server and given either administrator rights or added to telnetusers group.
* Exp directory shared on Micros server and full permissions given for the users performing sales import
* F&B scripts (MM Interface) installed on Micros server.

The stock deduction is dependent on the links that are created between the POCs (Points of Consumption) and the Micros Revenue Centers.
This linking ensures that that all sales that are registered in the Micros Point of Sales system correctly transfer for stock deduction in the MMS system.

Revenue Centers Link: 

The window contains a list of MMS POCs and the second column contains the POC links.

Navigation:  Reference > Main Screen > Ship Specific Options > Interface >

Interface : Micros Configuration

Navigation:  Reference > Main Screen > Ship Specific Options > Interface >

Interface : Revenue Centers Link
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Clicking an empty link cell opens a selection window where all the POCs appear. Select one from the list.

Press   to close the module and complete the linking.

In some specific cases (promotional cruises etc) the Micros base currency may be changed to something different than the MMS base currency (home 
currency). To cope with these rate differences in the sales import, the system needs to know the exchange rate between the two currencies.

Import Exchange Rate: 

To insert the import exchange rate, use the space provided. 

Navigation:  Reference > Main Screen > Ship Specific Options > Interface >

Ship Specific Options : Interface
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In order for any kind of material accounting to take place, the shipboard materials management organization has to be setup in the MMS Software. This 
setup depends on the type of onboard organization that is in use and can vary in each particular case. This section of the Options tree is used for setting 
these preferences.

Inventory : 

Click on the folder heading to see details regarding the selected topic.

Main stores are the outlets that physically receive the various types of articles that are in use onboard. Typically each main material type is assigned a 
store such as food items, beverage items, consumable items, etc. The categorization can vary from operation to operation and MMS software has the 
ability to adjust to each particular way of working.

Mainstores: 

A typical example of a storeroom type division is shown below.

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Inventory

Navigation:  Reference > Main Screen > Ship Specific Options > Inventory >

Inventory : Main stores
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To add a main store click 

The add new main store wizard will appear.

Complete the information required on the fields : 

Code
Insert a unique code for numbering the main store to be created.

Name
Insert the name of the main store to be created.

Currency
Select the storeroom currency from the drop down list

Period
Select the management period which the storeroom will use.

Click  to proceed to the next screen.

Each store can be assigned a markup factor that is used to calculate the vessel's fixed cost. 

Main Screen



If any is used, insert the factor in the field provided. If none is used leave the default value intact.

Click  to proceed to the next screen.

Select the user groups that have should access the new store by selecting the group on the left and clicking 

or to select all the users as assigned to the new store.

To complete the new store creation wizard please click 

Shipboard departments are pieces of the onboard organization, within which the outlets (Points of Consumption) exist. Typical main departments in a 
normal shipboard organization are the Hotel, Deck and Engine departments. Each one of these can then contain several sub-departments depending on 
how the organization is set up. One of the peculiarities of the Hotel department is that it may house several sub-departments, whereas the Engine and 
Deck departments normally only have points of consumptions under them. 

The following is a typical organizational division of a cruise vessel. 

Pursers Office
Bar Department
Housekeeping Department
Restaurant
Galley
Crew Areas
Duty Free Shops
Beauty Salon
Casino
Shore Excursions
Cruise Department (Entertainment)
Photo Shop

Navigation:  Reference > Main Screen > Ship Specific Options > Inventory >

Inventory : Departments

 HOTEL DEPARTMENT
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Departments: 

To commence the department setup, proceed as follows :  

Click  button which opens the creation wizard.

At this point it will be required to fill in the following information: 

DEPARTMENT CODE
Use a short (max 6 characters) code for a unique identification of the department.

DEPARTMENT NAME
Insert the common name of the department.

PPD Target Minimum (Passenger Per Day Minimum Target)
Insert the minimum sales target range for the department in this field if required.

PPD Target Maximum (Passenger Per Day Maximum Target)
Insert the maximum sales target range for the department in this field if required.

Click  to proceed to the next screen.

The next step of the wizard allows to select user groups who can access (create material issues) the new department. 

 ENGINE DEPARTMENT

 DECK DEPARTMENT

Main Screen



Select the user groups that have access to the new department by selecting the group on the left and clicking 

or to select all the user groups as assigned to the new department.

Click  to proceed to the next screen.

In the next screen it is required to choose the User Groups who have manager privileges for the department.

Click  to proceed to the next screen.

The final step requires linking the department to a shipboard manager position and to enable it in the system.

From the drop down list of positions select a person who will be the assigned manager of the new department. 

Main Screen



To enable the department in the system, select “Department is Enabled”. 
If left disabled, it will not be possible to use the department within the MMS system.

Click  to close the wizard

The Points of Consumption consist of the different shipboard outlets within each main department. POCs on a medium size vessel could be as shown 
below : 

HOTEL 
DEPARTMENT

Pursers Office         Bar Department
- Reception          - Panorama Lounge
- Printing Room         - Main Lobby Bar
- Administrative Offices                - Pool Bar

- Crew Bar

Housekeeping Department        Restaurant
- Cabins                 - Main Restaurant
- Crew Areas         - Buffet
- Outer Decks
- Lounges & Public Areas

Crew Areas                 Galley
Duty Free Shops                 - Main Galley
Beauty Salon                 - Crew Galley
Casino          - Provision Areas
Shore Excursions          - Cold Pantry
Cruise Department         - Buffet Preparation
Photo Shop          - Coffee Station

- Pastry
- Bakery
- Butcher

DECK 
DEPARTMENT

- Bridge Watch
- Bosun 
- Garbage Room
- Carpenter
- Upholsterer
- Radio Room

ENGINE 
DEPARTMENT

- Engine Watch (ECR) 
- Plumber 
- Reefer 
- Hotel Engineer

ACCOUNTS:

- Breakage
- Spoilage
- Water for Excursions
- Senior Officers Treatment
- Crew Treatment
- Prepaid Packages

Navigation:  Reference > Main Screen > Ship Specific Options > Inventory >

Inventory : Points of Consumption
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- Passenger Treatment
- VIP Party

Points of Consumption: 

Prior to starting to create points of consumptions please choose which type of POC is to be created and click on 
the corresponding link to open the specific instruction on creating your selection : 

Normal Points of Consumption are most normal outlets onboard.

The Uniforms Point of Consumption has specific requirements. 

Points of Consumption: 

To create a new POC (Point of Consumption) proceed as follows : 

Select the Department under which the new POC will be created : 

The POC list for the department will open in the space below the drop down list.
If none have previously been created the list will appear empty.

Click  button to open the POC creation wizard.

The first screen of the creation wizard will open. In this screen it is necessary to select the type of POC that will be created. 
The three options available are as follows :

Standard
Bars, galley outlets, sub-stores, etc.

 Normal POC (Point of Consumption)

 Uniforms Point of Consumption

 Account

Navigation:  Reference > Main Screen > Ship Specific Options > Inventory > Points of Consumption >

Inventory : Points of Consumption
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Uniforms
Crew clothing items, company assigned effects.

Accounts
Items that are expensed directly to an account without passing through a POC. 

Select Standard as your option and click  to proceed to the next screen.

Complete the fields required working downwards : 

Code
Use a short (max 10 characters) code/name for a unique identification of the POC. 
All these Codes will later appear on various Reports and especially in the Sales Import Module.  Therefore it is 
recommended to assign sophisticated codes only  which allows all Users to easily identify the POC by the 
Code. 

Name
Insert the common name of the POC

Department
Select the department under which this POC will be categorized.

Closing Type

Choosing one of the 5 Closing Types will define the way of how the System calculates the Opening Stock on Hand for the new 
Period based on the current Stock on Hand.

Changing the Closing Type of existing Points of Consumption might have effects to the regular Period Reset Procedure. Due to 
this fact the impact to the closing of the Period in the Period Reset Module is mentioned in this Manual.

General Information regarding Stock Transfer from the Period to be Closed into the new Period

The following Events are not considered when assigning a Closing Type and apply for all the Closing Types:

1. Negative Stock on Hand Quantities
The System can be configured in two ways how to handle negative Stock on Hand Figures:
Not allow negative Stock:
Negative Stock on Hand in Points of Consumption will stop the Period Reset Process. These Stock Values need to be 
corrected by conducting a Inventory. This is the recommended System Setting in order to check for the actual physical
Stock on Hand in the Point of Consumption.

Allow negative Stock:
In Cases were Stock on Hand Level is negative the System automatically generate an Inventory to correct these Values to
Zero. The Disadvantage of this Option is that Stock on Hand is set to Zero despite the fact that there might be physical 
Stock present in a Point of Consumption.
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Closing Types of the Points of Consumptions are selected in the Drop Down Menu:
The available options are:

Automated Stock Deduction
The stock (inventory) of this outlet will be deducted automatically using the stock deduction function which considers the sales in the 
Micros Point of Sale system and automatically deducts the sold items from the current stock of the selected outlet (POC).

In order to have full control over the Stock deduction Process the System allows the Stock for Points of Consumption to go into 
negative Values. Possible reasons for this events might be that an Items is poured in  a lower quantity than indicated in the recipes or 
a different Item than in the recipe is physically handed out.
In any case negative Stock on Hand needs to be corrected before the Reset can be done.

Closing Stock on Hand for the old Period will be the current Stock on Hand reduced by the Stock Deduction from Micros POS System. 
The remaining Stock will be carried over into the new Period as Opening Stock.

Carry Over
The carry over option does a complete transfer of the items in inventory directly to the next period without applying any corrections. 
This does not include negative Stock on Hand Figures.

Manual
Processes a closing of the inventory considering all items consumed and starting with zero stock for the new period. 

Most commonly this Option is used for Points of Consumptions like Galley, Food Courts etc. where the Stock on Hand is not deducted 
by Recipes. In this Cases it is assumed that all Stock of all the Issues in the current Period within the current Period have effectively 
been consumed. 

During the Period Reset Process the present Stock on Hand will be set to Zero. These Figures will appear in the corresponding Period 
Reports under the Column "Consumption". Closing Stock on Hand will be Zero as well as the Opening Stock of the new Period.

Period End Inventory
The Setting needs to be applied for all Points of Consumptions where a End of Period Inventory needs to be conducted before a 
Period Reset can be done. 
During the Period Reset Process the System requires a confirmation from the User in order to proceed. This Confirmation is applied by 
a special Button within the Period Reset Module. Further on this Confirmation is logged under Period Reset Events and can be traced 
back to the specific User in the Event Viewer Module.

After conducting the Inventory the current Stock on Hand will be transferred into the new Period as Opening Stock.

The System will not correct negative Stock on Hand values and will not carry these Values over into the new Period.

Deduction plus Inventory 
This closing method is a combination of Automated Stock Deduction and Period End Inventory and conditions for both apply on this 
closing type.

Currency
Select the base currency of the POC to be created.

PPD Target Minimum (Passenger Per Day Minimum Target)
Insert the minimum sales target range for the POC in this field if required.

PPD Target Maximum (Passenger Per Day Maximum Target)
Insert the maximum sales target range for the POC in this field if required.

Click  to proceed to the next screen.

In this screen it will be necessary to define into which stores the new POC will have access. 
Select the stores by checking the corresponding boxes on the left.

In any Case the System will not transfer negative Stock on Hand figures into the new Period.

2. No negative Prices of Items will be corrected during the Period Reset Process. They will be transferred with the current 
Stock on Hand and the current negative price.
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Click  to proceed to the next screen.

The next step of the wizard allows the selection of user groups who can access (create material issues) 
the new POC.

Select the user groups that have access to the new department by selecting the group on 

the left and clicking    or   to select all the user groups as assigned to the new department.

Click  to proceed to the next screen.

In the final step of the wizard, following information should be given:

Count Group
The count group refers to which group division the POC is referring. There are only options for passengers or crew.

Report Groups
The report groups are the basic reporting categories.
´

Main Screen



Click  to close the wizard

The last step of the creation process is to enable the POC that was created. 

By double clicking the created POC in the main screen, the following detail window will open : 

This screen will recap the information that was inserted using the creation wizard.
To enable the POC for usage, select the status drop down and change it to “Substore (POC) is Enabled”. 

To save the information click the  button and  to close the window.

Points of Consumption: Uniforms

To create a new uniform POC (Point of Consumption) proceed as follows : 

Click  button which opens the POC creation wizard.

The first screen of the creation wizard will open. In this screen it is necessary to select the type of POC that will be created. 
The three options available are as follows:

Standard
Bars, galley outlets, sub stores, etc.

Uniforms
Crew clothing items, company assigned effects.

Accounts

Navigation:  Reference > Main Screen > Ship Specific Options > Inventory > Points of Consumption >

Inventory : Points of Consumption
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Items that are expensed directly to an account without passing through a POC. 

Select uniforms option and click  to proceed to the next screen.

Here, it is necessary to assign crewmembers to this new POC.
This information is acquired by the software directly from the Fidelio Property Management System and the user
will typically see the crew list in the space provided.   

Click  to proceed to the next screen.

In this screen it will be necessary to define to which stores the new POC will have access. 
Select the desired stores by clicking your selection on the left.

Click  to proceed to the next screen.

The next step of the wizard allows selection of user groups who can access (create material issues) 
the new POC. 
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Select the user groups that have access to the new department by selecting the group on 

the left and clicking    or   to select all the user groups as assigned to the new department.

Click  to close the wizard

Points of Consumption: Accounts

Click  button which opens the POC creation wizard.

The first screen of the creation wizard will open. In this screen it is necessary to select the type of POC that will be created. 
The three options available are as follows:

Standard
Bars, galley outlets, sub stores, etc.

Uniforms
Crew clothing items, company assigned effects.

Accounts
Items that are expensed directly to an account without passing through a POC. 

Select accounts as your option and click  to proceed to the next screen.

Complete the fields required working downwards : 

Navigation:  Reference > Main Screen > Ship Specific Options > Inventory > Points of Consumption >

Inventory : Points of Consumption
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Code
Use a short (max 10 characters) code/name for a unique identification of the POC

Name
Insert the common name of the POC

Department
Select the department under which this POC will be categorized.

Closing Type
Select the closing type of the POC. The options are :

Automated Stock Deduction
The stock (inventory) of this outlet will be deducted automatically using the stock deduction function which 
considers the sales in the Micros Point of Sale system and automatically deducts the sold items from the 
current stock of the selected outlet (POC).

Carry Over
The carry over option does a complete transfer of the items in inventory directly to the next period. 

Manual
Processes a closing of the inventory considering all items consumed and starting with zero stock for the new period. 

Period End Inventory
The system automatically creates a spot check inventory document in the inventory module for the items in the POC 
and this document has to be closed in the corresponding module before any period reset can take place.

Currency
Select the base currency of the POC to be created.

PPD Target Minimum (Passenger Per Day Minimum Target)
Insert the minimum sales target range for the POC in this field if required.

PPD Target Maximum (Passenger Per Day Maximum Target)
Insert the maximum sales target range for the POC in this field if required.

Click  to proceed to the next screen.

In this screen it is necessary to define to which stores the new POC will have access. 
Select the desired outlets by checking the corresponding boxes on the left.
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Click  to proceed to the next screen.

The next step of the wizard allows selection of user groups who can access (create material issues) 
the new POC. 

Select the user groups that can access the new department by selecting the group on 

the left and clicking    or   to select all the user groups as assigned to the new department.

Click  to proceed to the next screen.

In the final step of the wizard, the following information should be given:

Count Group
The count group refers to which group division the POC is referring. There are only options for passengers or crew.

Report Groups
The report groups are the basic reporting categories.

Main Screen



Click  to close the wizard

The last step of the creation process is to enable the POC that was created. 

When double clicking the created POC in the main screen, the following detail window will open : 

This screen will recap the information that was inserted using the creation wizard.
To enable the POC for usage click the status drop down and change it to “Substore (POC) is Enabled”. 

To save the information, click the  button and  to close the window.

The causes are needed to state a justification for a movement to accounts and assign the destination of the issued articles. The system has the option to 
insert a set of default causes but in most cases users of MMS assign the causes to match those required by their accounting department and other 
reporting requirements.

Causes: 

To assign causes for the accounts, firstly select the account under which the causes will be set.

Navigation:  Reference > Main Screen > Ship Specific Options > Inventory >

Inventory : Causes
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The selection will open the corresponding detail sheet for the account.

To add a cause for the account select . 

A three step cause creation wizard will open. Complete the required fields : 

Cause Name
Name of the cause to be created. 

Account
Name of the main account to which the cause will be linked.

Price List 
Optionally if this account needs a specific price list it should be stated in this option.

Click  to proceed to the next screen.

The next option allows to state if service recap letters need to be printed at the end 
of each period and if they should be printed showing the item prices. The service letters 
recap the complete list of the articles that have been inserted into the system using the 
particular cause.

At the bottom of the service letter print out, there is the possibility for two signature spaces
if so required.
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Click  to proceed to the next screen.

The next step of the wizard allows selection of user groups who can access cause of the 
account.

Select the user groups that can access the new department by selecting the group on 

the left and clicking    or   to select all the user groups as assigned to the new department.

Click  to close the wizard

The invoice settings folder contains the options to set up invoicing details.

Invoice Settings: 

The decimal places field sets the number of decimals that the system needs to take into 
consideration when checking received invoices against purchase orders.

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Invoice Settings
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The maximum quantity and maximum totals are used to define the maximum value differences
that will be allowed when closing an invoice.

The direct printing option selects the invoice cover and invoice summary that will be available in the 
direct printing function of the invoicing module.

In order for the MMS to function, the system needs to be set up with what type of material is in which onboard store. Within the software these storage 
locations are called lockers. Each product used in the system needs to be assigned to the stores that have that product in the inventory.

Lockers: 

STEP 1
To assign products to lockers, the first step is to create and define the shipboard storage lockers.

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Lockers
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To create a new locker click 

The system will ask for a unique identification code for the new locker.
This ID must consist of six characters and can not contain spaces. If this criteria is 
not followed the system will display an ID error message

Insert this ID in the space provided and press 

The locker ID will appear on the main creation window where it will then be necessary to insert the locker description.
Type the information in the space provided : 

Press ENTER to complete the creation of a locker.

STEP 2
Once all the lockers have been created it is still necessary to assign products to the appropriate lockers.
This operation is done in 

Select the product category folder that contains the products that need to be assigned to a locker.

Select the correct vessel.
Select the appropriate storage locker .
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Locker ID Mismatch: Warning

The system will ask for a Unique identification Code for the new locker to be created.
This ID must consist of six characters and can not contain spaces. If the code entered
does not meet the system requirements, a warning will be displayed:

Press  to try again

´

All information relating to the purchasing operation is set here.

Purchasing: 

Click on the folder heading to see details regarding the selected topic.

Cruises worldwide normally involve purchases worldwide. For this purpose it is possible to set electronic purchase orders for each specific geographic 
region in order to trace bidding on that particular area. 

Bidding Zones: 

The bidding zones are set in the corresponding window. All the zones in which purchasing takes place should be included.

Navigation:  Reference > Main Screen > Ship Specific Options > Lockers >

Lockers : ID Mismatch

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Purchasing

Navigation:  Reference > Main Screen > Ship Specific Options > Purchasing >

Purchasing : Bidding Zones

Main Screen



Cover Page: 

The purchase order layout and other information on the cover page may be inserted in the space provided.

Orders : 

The variables of the purchasing module may be inserted in the spaces as follows : 

Navigation:  Reference > Main Screen > Ship Specific Options > Purchasing >

Purchasing : Cover Page

Navigation:  Reference > Main Screen > Ship Specific Options > Purchasing >

Purchasing : Orders
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Payment Terms: 

Payment conditions may be set in the system as dictated by company policy.
By default the system has the below terms pre-set, which may be modified as necessary.

Seasons: 

The seasons are set to track transaction activity in different geographical regions and set seasons. 
MMS will collect consumption data based on the set seasons and utilize this information in the order requests. 

Navigation:  Reference > Main Screen > Ship Specific Options > Purchasing >

Purchasing : Payment Terms

Navigation:  Reference > Main Screen > Ship Specific Options > Purchasing >

Purchasing : Seasons
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Sending: 

This field may contain company specific information that may be included and sent with the order.

The system can hold the generic order terms and conditions. If the standard terms and conditions are not available to be printed on purchase order it is 
possible to define a code, name and link to specific conditions per supplier and only these will be printed on the purchase order.

Terms & Conditions: 

Navigation:  Reference > Main Screen > Ship Specific Options > Purchasing >

Purchasing : Sending

Navigation:  Reference > Main Screen > Ship Specific Options > Purchasing >

Purchasing : Terms & Conditions

Main Screen



The conditions may be created in a chronological order.

By double clicking on a single condition, the system will display the contents as text for easy modification.

The maintenance of recipe related information is managed through the recipe settings folder tree. Please note that most of these options can also be 
managed directly in the recipes module of MMS during the creation process.

Recipe Settings: 

Click on the folder heading to see details regarding the selected topic.

Category Types: 

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Recipe Settings

Navigation:  Reference > Main Screen > Ship Specific Options > Recipe Settings >

Recipe Settings : Category Types
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The recipe categories list may be managed in this option.

Cuisine Types: 

The cuisine types list may be managed in this option.

Main Ingredient Types: 

The ingredients list may be managed in this option.

Navigation:  Reference > Main Screen > Ship Specific Options > Recipe Settings >

Recipe Settings : Cuisine Types

Navigation:  Reference > Main Screen > Ship Specific Options > Recipe Settings >

Recipe Settings : Main Ingredient Types
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Menu Types: 

The menu list may be managed in this option.

Serving Descriptions: 

The serving description list may be managed in this option.

Navigation:  Reference > Main Screen > Ship Specific Options > Recipe Settings >

Recipe Settings : Menu Types

Navigation:  Reference > Main Screen > Ship Specific Options > Recipe Settings >

Recipe Settings : Serving Descriptions
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The regional settings folder contains the basic information on the countries, cities and telephone codes of the world. Though the software already 
recognizes most countries and cities, this option may be utilized to add and delete as necessary.

Regional Settings: 

Click on the folder heading to see details regarding the selected topic.

Cities: 

The cities are managed in two phases, firstly by selecting the country, after which the system displays the available cities.

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Regional Settings

Navigation:  Reference > Main Screen > Ship Specific Options > Regional Settings >

Regional Settings : Cities
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Countries: 

The countries list is set by default but may be modified through this option.

Telephone Codes: 

The country telephone codes may be maintained through this module.

Navigation:  Reference > Main Screen > Ship Specific Options > Regional Settings >

Regional Settings . Countries

Navigation:  Reference > Main Screen > Ship Specific Options > Regional Settings >

Regional Settings : Telephone Codes
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This part of the folder tree handles report groupings and printing options.

Reports: 

Click on the folder heading to see details regarding the selected topic.

Cost Report Groups: 

This option allows to specify the reporting groups according to company needs and must be decided and set when installing the software for the first time.

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Reports

Navigation:  Reference > Main Screen > Ship Specific Options > Reports >

Reports : Cost Report Groups
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Direct Printing: 

Direct printing options may be set in this module.

Direct Printing formulas: 

Navigation:  Reference > Main Screen > Ship Specific Options > Reports >

Reports : Direct Printing

Navigation:  Reference > Main Screen > Ship Specific Options > Reports >

Reports : Direct Printing formulas
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The options of shipboard material requests (orders to shore side) can be managed though this option. The options include the number of users needed to 
approve an order request and who will perform this task.

Request Options: 

By selecting  the system will allow modification of the users and user groups that have access to approve an order request.

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Requests
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Add a User  

Remove a User   

Add all Users  

Remove all Users    

The templates groups can be added, modified and deleted in this part of the options tree.

Template Groups: 

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Templates
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This module has options for maintaining information about the suppliers.

Vendors: 

Click on the folder heading to see details regarding the selected topic.

The email options that will be used when communicating with the vendors may be managed in this module

Email: 

Message Vendor

Navigation:  Reference > Main Screen > Ship Specific Options >

Ship Specific Options : Vendors

Navigation:  Reference > Main Screen > Ship Specific Options > Vendors >

Vendors : Email
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Options: 

Vendor Quotes: 

Navigation:  Reference > Main Screen > Ship Specific Options > Vendors >

Vendors : Options

Navigation:  Reference > Main Screen > Ship Specific Options > Vendors >

Vendors : Vendor Quotes
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The Period Reset module handles the period turnover procedure in MMS. 
This sequence covers the phases of encapsulating and organizing data in periodical order, 
based on set monthly or cruise periods. This allows to report all aspects of a purchasing and 
inventory operation onboard the ships and ashore. 

An obligatory part of the proper usage of the MMS software is that a closing is made on a
regular basis. In most cases the periods are reset on per cruise and monthly basis in order to 
have 
all the relevant reporting data available to the various operational functions. All this is 
dependent 
on individual company policies.

Period Reset Main Screen: 

The period reset sequence is organized in seven steps.
Prior to a period reset it is necessary to verify that at least three future periods are set in the system, as 
referred to in the periods help topic. This is a generic requirement for proper functioning of the software.

Navigation:  Reference >

Period Reset
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Phase 1

To start the PERIOD RESET first ensure that no pending issues exist in the system. This aspect involves 
checking that : 

entered in the MMS system.

Select the period to be closed by clicking on it and select 

 All necessary transactions have been processed by all departments related to the period to be closed.

 The transaction approvals have been made and completed to level three in the movements module

 All movements that are needed within the period to be closed have been entered in the system.

 End of cruise inventory in all POCs (Points of consumption) has been physically completed and the results
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NOTE : It is necessary to click on the closed period so that the selection turns blue. 
Otherwise the system will display an instruction message.

Phase 2
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Confirm the period information. At this point it is still possible to change the naming of the season to include 
the period to be closed under a specific account group ; season etc. To change this information open the
drop down list and select the corresponding one.

Select  to continue

Phase 3

At this point if there are any open transactions, the system will display a notification of this and it is necessary 
to 
return to correct the pending issues.
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Click  and return to the   module and complete all the pending transactions that need 
adjustment.

Upon completing all necessary transactions, return to the Reset Period module and the system will continue 
to the next phase.
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Select  to continue

Phase 4

In phase four the system will require a confirmation that a physical inventory count has been made in all 
relevant 
POCs (Points of Consumption).

This part of the closing sequence is dependent on whether under the POC settings, the 'end of cruise 
inventory' 
option has been selected, meaning that the system will in this case automatically create end of cruise inventory 
documents in the inventory module for the chosen POCs. For continuing from phase 4 onward, it is necessary 
to 
close these inventory documents first.
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Select  to continue.

The confirmation will be recorded in the system by a notification of this.

Select  to continue

Phase 5

Phase five will verify if there is negative stock in any POC.
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Select  to continue

Phase 6

Phase six starts the actual reset process which may take a while to process. Ensure that the system is 
not used from any workstation during the time this phase is running.
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After ensuring that the software is idle at all users, select to continue.

Main Screen



Phase 7
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Upon successful completion, the system will display a notification that the Period Reset has been made.
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Select to exit the Period Reset module and proceed to verify that all aspects of the turnover 
have 
been made correctly.
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The Periods module is where the standard operating timeframes for the vessel
(s) are defined. Once the dates 'Open' and 'Close' (effectively 'from' and 'to') are 
defined, it is possible to produce reporting documentation for purchasing, 
movements, sales, inventories etc for that specified date range. The most 
obvious choice for periods is that they are created on a cruise basis, but there is 
also the option to define Summaries for different circumstances and time 
frames, like on monthly basis or quarterly for Accounting. The Cruise based 
periods then integrate with the details entered in Itinerary Planner.

Periods Main Screen: 

The Below image represents the main periods screen: 

Here the user will enter the passenger forecast for the next cruises. This is important as the
system will take these figures to calculate the 

suggested Quantity in the Order Request.

PERIOD TYPES

Navigation:  Reference >

Periods

 At the top are located the function buttons for the most common option.

 The Periods are listed on the left hand side in time order

 Once a cruise is selected on the left the Itinerary is shown on the right hand side in detail
together with the passenger and crew column.
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Below the function buttons is located the period type selection. 

The type of Periods : 

The type of Management period should be setup during the first installation of the software.

The buttons toolbar contains the most frequently used options for quick and easy access. 

Buttons: 

This option opens the Report Manager. This option will be also available in the Menu; File ->Print.

Print: 

 Cruises (Cruise Based Management Period)
 Summaries (Virtual Periods)

Navigation:  Reference > Main Screen >

Buttons

Search: Search for a specific period
Print: Opens the Report Manager.
Refresh: This option refreshes the screen layout.
New: Create a new Period.

Exit: Closes Periods.

Navigation:  Reference > Main Screen > Buttons >

Button: Print

Click to open the Report Manager.

Navigation:  Reference > Main Screen > Buttons >
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This option refreshes the screen layout. For example, when you have sorted columns by their headings or 
resized them, clicking Refresh will reset the layout to the default view.

Refresh: 

Click 'New' to begin creating a new period. The new period wizard will start and 
guide you through the necessary steps. 

New: 

First it is important to ensure that the correct period type has been selected from the period type 
drop menu in the Main screen.:

When you want to add a new period, you have the choice of two options. Firstly, and most 
commonly, you can add a new period at the end, after the last period. This is normally how you 
will define each period you set up. The system defaults the opening date to the day after the last 
period closing date. You then choose when your new period will close, assign it an Id and 
choose a cruising season for this period. 
The second option available it to insert a new period between two already existing ones. In this 
case you you will select the 2nd choice in the wizard and follow the steps detailed here.

The system defaults to the first option on list: 

Button: Refresh

Click to refresh your screen layout.

Navigation:  Reference > Main Screen > Buttons >

Button: New

Click to create a new period. You can also right click in the Period list window and select 
new from the popup menu. 
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If you choose the option and click 'Next', the system will skip to Step 3 and prompt you for a 
Period Id, the closing date for the new period and also a cruising season. 

Once you've made your selection, click 'Finish' to add the period. 
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The new period is inserted on the end of the list as shown above.

Inserting between two existing periods.

If you choose the 2nd option, to insert a period between two existing ones, clicking 'Next' will 
take you to the Step 2 screen. Here you need to choose the period that your new one will 
appear after. Read the on screen instructions carefully, in order to insert your new period in the 
correct place.
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Highlight the desired period and click 'Next'...

Now you need to assign the new period an Id, like before, and choose the closing date and 
season. As indicated, the opening date defaults to the day after the period you choose to insert 
after, and the closing date must be at least one day less than the closing date of the following 
period. 
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Complete the creation process by selecting 

This option will close the Periods. You can also select from the Menu; File -> Exit.

Exit: 

Note: Remember: changing periods that are already created, particularly adjusting the 
dates, will cause a 'knock on effect' with the remaining periods. This means each 
subsequent period will have to be either amended or deleted and created again. 

Navigation:  Reference > Main Screen > Buttons >

Button: Exit

Click to close the Periods module. 

Navigation:  Reference > Main Screen >
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This window shows a concise list of the current periods. The available columns 
show the Period I.d. and opening and closing dates. 

Period List : 

Below you see an example of the Period List window.

In the main window, you will see the detail from entered in the Cruise Planner module for the dates of the 
defined period.

Period Detail: 

Period List

Navigation:  Reference > Main Screen >

Period Detail Window
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In the image below you can see the date, current location and the estimated Passenger and Crew figures for the day.

At the top of the screen is the menu bar. The options contained are explained in further detail in the following 
section of the help. 

Menu: 

The file menu offers some basic options.

File: 

Navigation:  Reference > Main Screen >

Menu

Navigation:  Reference > Main Screen > Menu >

Menu: File

Main Screen



The file menu includes one option not represented in the toolbar, Export. 

With this option you an export the contents of the main window to an Excel Sheet

Export: 

The data appears in a new Excel spreadsheet as shown below:

Navigation:  Reference > Main Screen > Menu > File >

File: Export

Select to Export. 
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The Edit menu contains the same options that can be accessed by performing a right click in the period list 
window.

Edit: 

Navigation:  Reference > Main Screen > Menu >

Menu: Edit

New

Delete

Properties

Creates a new period

Deletes a selected period

Displays the properties of the selected period

Navigation:  Reference > Main Screen > Menu > Edit >
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If you need to delete a period for any reason, this is how.

Delete: 

If you delete a period, there is no 'Undo' function. The period will have to be recreated.

Properties allows you to view and amend certain fields of the period. 

Properties: 

You can amend the Period Id (Reference), cruising season and the Closing Date. 

Edit: Delete

   Click to delete a period.

Navigation:  Reference > Main Screen > Menu > Edit >

Edit: Properties

Click to view the period details.
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The Windows menu allows to changes on how the windows and screens are 
displayed on the layout during various phases in using the software.

Windows Menu Options : 

Navigation:  Reference > Main Screen > Menu >

Menu: Windows

Arrange All

 Split

Rearranges the windows back to the default view

Splits the selected vies equally across the screen
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Click 'New' to begin creating a new period. The new period wizard 
will start and guide you through the necessary steps. 

New: 

First it is important to ensure that the correct period type has been selected 
from the period type drop menu in the Main screen.:

When you want to add a new period, you have the choice of two options. 
Firstly, and most commonly, you can add a new period at the end, after the 
last period. This is normally how you will define each period you set up. The 
system defaults the opening date to the day after the last period closing 
date. You then choose when your new period will close, assign it an Id and 
choose a cruising season for this period. 
The second option available it to insert a new period between two already 
existing ones. In this case you you will select the 2nd choice in the wizard 
and follow the steps detailed here.

The system defaults to the first option on list: 

Navigation:  Reference > Main Screen > Buttons >

Button: New

Click to create a new period. You can also right click in the Period list 
window and select new from the popup menu. 

Button: New



If you choose the option and click 'Next', the system will skip to Step 3 and 
prompt you for a Period Id, the closing date for the new period and also a 
cruising season. 

Once you've made your selection, click 'Finish' to add the period. 

Button: New



The new period is inserted on the end of the list as shown above.

Inserting between two existing periods.

If you choose the 2nd option, to insert a period between two existing ones, 
clicking 'Next' will take you to the Step 2 screen. Here you need to choose 
the period that your new one will appear after. Read the on screen 
instructions carefully, in order to insert your new period in the correct place.

Button: New



Highlight the desired period and click 'Next'...

Now you need to assign the new period an Id, like before, and choose the 
closing date and season. As indicated, the opening date defaults to the day 
after the period you choose to insert after, and the closing date must be at 
least one day less than the closing date of the following period. 

Button: New



Complete the creation process by selecting 

Click 'New' to begin creating a new period summary. A period 
summary is a virtual period, the system is collecting data from 
existing closing
periods for a specific Date Range, mostly used for Accounts 
purposes eg. monthly or quarterly. The new period wizard will start 
and guide you
through the necessary steps. 

Note: Remember: changing periods that are already created, particularly 
adjusting the dates, will cause a 'knock on effect' with the remaining 
periods. This means each subsequent period will have to be either 
amended or deleted and created again. 

Navigation:  How to ... >

Create a New Period Summary

Button: New



New Summary: 

First it is important to ensure that the correct period type has been selected 
from the period type drop menu in the Main screen.:

  The system will prompt for a Period ID, select the Date Range.

  Select one or more Stores for which the system should generate a Summary.

the system 
  would not slow down and other user won't recognize it.

Click to create a new period summary. You can also right click in the Period list window and 
select new from the popup menu. 

Button: New



  Complete the creation process by selecting OK.

  The whole procedure will take a while according what you select as Date Range and how many stores
  you select.
  When the Summary is finished you are able to run the same Reports as for cruise based Periods.

Button: New



Button: New



The Purchasing module is used for all sourcing related operations that involve keeping track of the supply chain and the information that is needed for the 
chain to function effectively. These operations involve keeping a registry of preferred suppliers, issuing of quotation requests, evaluating the received quotes 
and subsequently tracking delivery information and requests from the vessels. 

Purchasing: 

The below is an image of the Purchasing Manager main screen as it looks when opening it. On the top are located 
the Function Buttons and then the Toolbar Menu. Below these are located the main areas : 

At the very bottom of the screen is displayed vessel information, date & time, current user and the workstation name.

The buttons toolbar contains the basic and most frequently used options for working with the purchasing module for creating new purchase orders, viewing 
information and printing reports.

Buttons: 

Clicking the buttons below or the links will open more information and instructions on the usage of these functions.

Navigation:  Reference >

Purchasing

 Calendar showing all purchasing related activity regarding purchase orders, warehouse transfers, ship to shore requests and containers
 Function tabs for accessing the options for detailed viewing of purchase orders, warehouse activity, ships requests and container activity

Navigation:  Reference > Main Screen >

Button

Search Search for an order request with different criteria
Print Print purchase order and other reports
Refresh Refresh the screen view
Ownership Changing ownership of a purchase order from one user to another
Authorize Authorize a purchase order
New Order Create a new purchase order

Order Preview      Create a temporary order as preview without affecting request status
Templates Open the templates for placing an order request

Verify Order     Verify a created purchase order
Statistics View statistical for selected article
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Most of the options have corresponding tools in the menu, keyboard shortcuts assigned to them, or are available with a right mouse click.    

This option refreshes the screen layout. For example, having sorted columns by their heading or resized them, clicking refresh will reset the layout to the 
default view.

Button Refresh: 

The search option can only be activated while in the purchase order view. It provides the possibility to search and locate a specific purchase order that has 
already been created in the system. This can be made by defining specific search criteria.

Button Search: 

Bids View bidding information for selected article
Exit Exit the purchasing module

Navigation:  Reference > Main Screen > Buttons >

Button : Refresh 

Click to refresh the screen layout.

Navigation:  Reference > Main Screen > Buttons >

Button : Search

Click the search button to initiate the function.

 After activating the search engine, the fields for specifying the search criteria open. 

A purchase order may be searched on the basis of the 
purchase order number if this number is known and can be recognized 
from the scroll list of all orders in the system.

By activating the search by vendor, the system will limit the 
search to orders of a specific vendor. 

By activating the search by vessel, the system will only 
consider orders for the specified vessels in the search.

By activating the search by status the system will only 
consider the requests that meet the specified status.

By activating the search by code the system will only 
consider the requests where this code is used.

By activating the search by item description the system will
   only consider the requests where this description is used.

   By activating the search by date range the system will 
only consider the requests within the specified date range.
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will be displayed in the Main Screen.

This is done by clicking the Overview Tab that returns the user to the items view page.
Any time a new search is needed the tab can be re-opened.

This option opens the Report Manager. The option is also available in the Menu; File ->Print.

Button Print: 

 Upon having selected the criteria for the search the search may be initiated by pressing 'Search' and the results

 The search engine may be left open in the background by leaving the search tab open.

Navigation:  Reference > Main Screen > Buttons >

Button : Print 

Click to open the Report Manager.
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The button Ownership allows the user to transfer ownership from one user to another.

Button Ownership: 

The button Authorize allows the user to authorize a purchase order after it has been created from a order request (status 1).
Only users with the appropriate user rights can authorize purchase orders.

Button Authorize: 

Navigation:  Reference > Main Screen > Buttons >

Button : Ownership

Click the Ownership button to initiate the function.

 Select the purchase order you want to assign a new ownership.
 When the dialog box opens you can find the user by scrolling through all users in the system or you can type the user name in the Filter field:


 When the correct user is found, select Assign to save and close the dialog.
 Furthermore the window offers an  overview about the ownership history.

Navigation:  Reference > Main Screen > Buttons >

Button : Authorize
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The New Order function will open the step by step wizard for creating a New Purchase Order.

New Order: 

Click the Authorize button to initiate the function.

 Select the purchase order you want to authorize.
 When the dialog box opens you can either only authorize the PO. 

 Or authorize it and in the same step assigning it to a new user.

Navigation:  Reference > Main Screen > Buttons >

Button : New Order 

Click the New Order button to initiate the function.

 After clicking the 'New Order' button the 'Create New Purchase Order' wizard opens.
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The available options will be visible in the list according to what has been set up.

the time aside if necessary.

 Select the destination (vessel or warehouse) to which the order will be delivered from the drop down list.

 Select the date of the purchase order from the calendar by clicking the corresponding date and selecting
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Otherwise select the destination country to which the delivery of the order will be made. In other words if the destination is a vessel, 
the delivery country will be the port in which the ship will be on the date of the delivery.

 If the customer has added information to the Itinerary Planner, the country, city and agent will be displayed automatically. 

 Select the destination city according to the delivery country into which the delivery of the order will be made. 
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 Select the agent according to the delivery destination.

 Select the entity which should be invoiced for the purchase.
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supplier to deliver to the ship, select the appropriate option: 

Disabled = Delivery is NOT made through a local agent
Enabled = Delivery is made through a local agent

 If the delivery will be made through a local agent in the destination country or a vendor who will collect from another

 If the delivery is made though a local agent or vendor, select the name of the agent or vendor from the drop down list provided.
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preparing to deliver to the destination vessel.
 Select the delivery date and time for the local agent. This date is the time which the ordered items will be delivered to the local agent for

 Select the corresponding order request number that the vessel has forwarded for the material.

Main Screen



By Default Vendor : Use the preferred vendor (set as default in the Quote Manager).

 The processing priority order for checking the Quote Manager for prices is selected from the available options:

User has the Option to override the selection and take a different Quote Date or even assign item to the

default Vendor regardless if the items has a current valid bid via the Options Tab.
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By Default Vendor then price : Use the preferred vendor as a reference then cheapest price in the system as criteria.

By Price : Use price as criteria for selecting the products for the purchase order.

If selected by Default Vendor:

 Select the bidding zone of the Default Vendor.
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In case process as "default supplier then price" or "by price" was chosen:

The system open a new window summarizing the items within the purchase order. This is only intended as an overview and nothing can be changed here.

 Click on   and the purchase order will be generated.

 The system will create the purchase order with the selected criteria to the corresponding date that was selected.

 Select NO zone the system will take the cheapest available price in the system.

 Select one zone.
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In case it is required to make a purchase order without a request from ship:

 Select Add Zone (to add all Vendor assigned to this Zone)
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In case it is desired to create the new purchase order and first check the warehouse for stock on hand:

list and clicking the button

The screen will switch to the items view window where the properties of the newly created purchase order may be
observed by using the tabs at the bottom of the screen. Now you may add the item to the order.

 Select a vendor to whom the purchase order will be awarded to by selecting it from the drop down 

 If a default Vendor needs to be selected it may be activated by selecting it from the drop down list provided.

 Click the  button to continue the purchase order creation process.
 The system will create the purchase order with the selected criteria to the corresponding date that was selected.

 When clicking the 'New Order' button the 'Create New Purchase Order' wizard opens.
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The available options will be visible in the list according to what has been set up.

the time aside if necessary.

 Select the destination (vessel or warehouse) to which the order will be delivered from the drop down list.

 Select the date of the purchase order from the calendar by clicking the corresponding date and selecting
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select the destination country to which the delivery of the order will be made. In other words if the destination is a vessel, 
the delivery country will be the port in which the ship will be on the date of the delivery.

 If the customer has added information to the itinerary planner, the country and city will displayed automatically. Otherwise

 Select the destination city according to the delivery country to which the delivery of the order will be made.
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supplier to deliver to the ship, select the appropriate option : 

Disabled = Delivery is NOT made through a local agent
Enabled = Delivery is made through a local agent

 If the delivery will be made through a local agent in the destination country or a vendor who will collect from another

 If the delivery is made though a local agent or vendor, select the name of the agent or vendor from the drop down list provided.
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preparing to deliver to the destination vessel.
 Select the delivery date for the local agent. This date is the time which the ordered items will be delivered to the local agent for

 Select the corresponding order request number that the vessel has forwarded for the material.
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By Default Vendor : Use the preferred vendor
By Default Vendor then price : Use the preferred vendor as a reference then price as criteria
By Price : Use price as criteria for selecting the products for the purchase order.

 The processing priority order for checking the Quote Manager for prices is selected from the available options : 

 Select the bidding zone of the purchase order
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The Order Preview function will open a wizard exactly the same as New Order but instead of creating, it is a preview stored
only as a temporary file. This function gives you an overview how the system will assign the request to a PO. The 
purchasing department can review before they create the final purchase order. 

If Stock is available the system will generate a Transfer from Warehouse and for outstanding quantity a Purchase Order.

 Click on Warehouse

 And select the Warehouse where the system should check to see if there is stock available.

 Click the  button to continue the purchase order creation process.

 The system will create the purchase order with the selected criteria to the corresponding date that was selected.

Navigation:  Reference > Main Screen > Buttons >

Button: Order Preview
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Order Preview

Select the Order Preview button to initiate this function.

 When clicking the 'Order Preview' button the 'Create New Purchase Order' wizard opens.

 To complete the order preview wizard is similar as doing a PO.
 Select the destination and delivery date and time, if the itinerary planner is up to date the country and city will be filled out automatically, otherwise select a country and city.
 Select the order request for which you want to make a preview for. (Please note that this is different from the PO creation wizard, as the system will not open the search engine but

the user needs to select the request from the drop down menu.
 Select Process As.
 Select Zone.
 And click on PREVIEW.

 The system will create the preview purchase order with the selected criteria to the corresponding date that was selected.

 Here you have options to select by Default Vendor Then Default Price.
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A purchase order may also be prepared and sent using a pre-programmed template. This may be the case in some companies where order grids are pre-
defined and may not be altered by content. In other cases it may prove useful to have specific ordering templates for suppliers that deliver only certain types 
or articles such as fruit and vegetables only. In these cases the grids can be programmed into the system and used for the ordering process when needed.

Templates: 

 Or by selecting the Vendor, detailed information by Vendor is available.

 By changing the Price Method and the Refresh option, the system will recheck and re-evaluate the Vendor.

 Or Export to Excel for further calculations.

Navigation:  Reference > Main Screen > Buttons >

Button : Templates 
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However the request basics needs to be prepared as normal after which the information may be inserted using a pre-programmed template : 

These items can now be inserted directly using a template.

 When opening the template manager the pre-programmed templates can be located and used in the purchase order preparation process.

 Complete the New Order for a purchase order by not selecting an order request for the PO. This will ensure that the order grid does not have any articles in it.

 Locate the created purchase order on the calendar and open it by double clicking it.

 When opening the order there are no articles visible since an empty purchase order was created.

Click to open the Template Manager.

 Locate the correct request template that is to be used for this request and select it by double clicking the description.
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in the quantity column or updated by the system though the Edit Menu.

The order verification option allows to work with an order file for verifying the order information once it has been updated by a vendor. This includes an 
import and export possibility which creates an exchange of the purchase order information in the program without the necessity to re-enter it manually.

Verify Order: 

 The system will bring the contents of the PO template and make them part of the purchase order. After this the quantities can be inserted 

 Once the purchase order has been prepared the option may be closed by selecting the from the upper right corner.

Navigation:  Reference > Main Screen > Buttons >

Button : Verify Order 

Click the Verify Order button to initiate the function.

 An additional toolbar will appear on the top of the item view.
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The available options are as follows : 

1. Click the  button to import a purchase order file to the program.

completed the system will display a confirmation asking if the order needs to be viewed.

 A separate window will appear to locate the file to be opened. Select the correct file and click 

 The  button in the main screen will activate. Click this button to read the contents of the file selected. The import process will begin.

 Once the import is complete the file is ready to be processed. To start the processing click the . Once this is

 By selecting 'yes' the purchase order will be displayed on the items view window.
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2. Click the button to export a purchase order file to an Excel spread sheet.

The statistics button is active only in the items view when individual products are being analyzed. While in this mode it is possible to find information 
concerning purchase history, consumption and pending requests for the item.

Statistics: 

A window will open with four separate tabs which each hold different types of information about the selected product. Most of the tabs have the date range selection option available 

meaning that it is possible to define a specific date range to locate the data. After setting this information please press the  button to refresh the data.

DETAILS

The details window contains the basic product details including code, description and unit. Below this are located 
the pricing details including the fixed and average price details. The window also displays the current stock on hand 
for the warehouse and vessels for those users to whom the view has been enabled.

Navigation:  Reference > Main Screen > Buttons >

Button : Statistics 

While in the items view click to open the statistics module
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DETAILS - COLUMN DESCRIPTIONS

Warehouse
Name of warehouse

Available
Available stock

SOH
Stock on Hand

PURCHASE HISTORY

Opening the purchase history tab provides the possibility to view complete purchase history for the selected product 
and the selected vessels. This information is organized in columns as described below and may be viewed within 
a specified date range. 

PURCHASE HISTORY COLUMN DESCRIPTIONS

Delivery
Delivery date of the purchase

Destination
Destination of the delivery

Requested
Quantity requested from vessel

Ordered
Quantity ordered 
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Received
Quantity received upon delivery at destination

Price
Price of article upon delivery

Total
Total value of delivery

Vendor
Name of vendor

PO
Purchase order reference number relating to the delivery.

CONSUMPTIONS

The consumptions tab provides the possibility to view the consumption figures for the selected item for specified vessels
and date range. The information is organized by columns which are described below :

CONSUMPTIONS - COLUMN DESCRIPTIONS

Ship
Name of ship

From
Period starting date

To
Period ending date

Season
Name of season

Closing SOH
Period closing stock on hand

Corrections
Corrections made to stock during period

Consumption
Net consumption during period

Pending Requests

The pending requests tab provides the possibility to view the pending request figures for the selected item for specified vessels
and date range. The information is organized by columns which are described below :
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PENDING REQUESTS - COLUMN DESCRIPTIONS

Ship
Name of ship

Id
Request ID

Date
Date of request made

Status
Progress status 

PPD
Quantity requested from vessel

SOH 
Actual stock on hand

Days Reserve
Days reserved stock entered in article manager 

Reserve
Quantity that should be in reserve

Comment
Comment per item

Charts

The charts tab is visualizing the purchase quantity history, the purchase price history, consumption history and consumption history per ship in 2D or 3D charts..
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The bids option can be used to view the bidding information for the selected article to be used as the basis of a purchasing decision.

Bids : 

displaying the bidding information for the selected item.

All the bids for the selected item are listed organized in columns as follows : 

This option will close the purchasing module. You may also select from the Menu; File -> Exit.

Navigation:  Reference > Main Screen > Buttons >

Button : Bids 

Click the Search button to initiate Bids function

 When activating bids button the system will open a new window on the upper left part of the screen 

Local Price in local currency of vendor
Cur Local vendor currency
Vendor Name of vendor
Valid From Bid valid from date
Valid To Bid valid to date
Unit Unit of measure of selected article
Vendor Code Vendor product code
Brand Product brand
Case Case packing unit
Comments Comments on bid
Minimum Minimum supply quantity of product
Date Date of bid

Navigation:  Reference > Main Screen > Buttons >

Button : Exit 
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Button Exit: 

The Edit Menu contains the most common program options including the possibility for opening, changing the status and finalizing purchase order 
transactions.

Menu: 

This menu contains the most common options for verifying, exporting and printing purchase orders.

File: 

Click to close the Purchasing Module. 

Navigation:  Reference > Main Screen >

Menu PO View

Navigation:  Reference > Main Screen > Menu PO View >

Menu : 

Verify Order
Export 
Go To Date
Print
Exit

Verify a purchase order
Export the current view on the right to an Excel sheet
Allows the user to quickly navigate to a specific date in the past or the future.
Open the report manager for printing options.
Closes the purchasing module
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The edit menu in purchase order view contains options for managing the purchase orders. Most of these options are also available with a specified function 
button that is noted next to each function.

Edit : 

Navigation:  Reference > Main Screen > Menu PO View >

Menu : 

Note: As you can see on the screenshot below, certain options are greyed out. They will only become active if the purchase order is in the correct 
status to perform the operation and when the user has the appropriate rights to perform this action.

Open:  Select the order you want to open and click on Edit -
Open.

Clone:

 Select the purchase order you wish to clone and click 
on Edit - Clone.

 The Clone Order window will open.
 Fill in the fields and click on clone.
 The system takes a moment and and then the same 

order was created for a different entity or a different 
date.

 Please keep in mind that a cloned order will be put in 
status 1.

Partial Delivery:
 It is possible to receive purchase orders only partially.
 Instead of receiving the purchase order in multiple 

receivings it is possible to receive a order only 
partially.
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 This is done with this option.
 The system will keep a link to the current PO and the 

future PO containing the same order.

Status:  Here the statuses can be changed manually.

Ownership:  Transfer ownership from one user to another.

Authorize Order:  Authorize a Purchase Order in Status 1.

Flag Received by 
Supplier:

 Once the order is in status 3 (Order send) the PO can 
be flagged as received by the supplier.

 The order will then change to status 4.

Flag confirmed by 
supplier:

 Once the order is in status 4 (Order confirmed 
received) the PO can be flagged as confirmed by 
supplier.

 The order will then change to status 5.

Block Payment:

 The user with appropriate user rights can block the 
payment of a purchase order.

 From the status drop down box the user can select to 
3 - Block or 0 - Unblock the payment.

 The field "Reason" offers the possibility to enter 
comments.

 A PO with blocked payment can be identified in the 
purchase order overview by the red font color.

Ship via Container:

 The option Ship via Container allows the user to flag 
a PO to be sent within a container.

 The red container icon identifies all container 
deliveries.

Print:

 The print functionality from the Edit menu will (if set 
up accordingly) print the currently selected purchase 
order.

 Before the printing starts the user can select pre-
defined terms and conditions to be printed on the 
order.

 The purchase order can be previewed before finally
printing.

Send E-Mail:

 The user can e-mail the selected purchase order to 
the Vendor.

 Recipient information if maintained in the Vendor
module will be filled in automatically.

 Please note that the e-mail will not be sent right away 
but once clicked on SEND the system will transfer the 
e-mail to your default e-mail program and from there 
it will be sent out under the users name.
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The windows menu allows to change how the windows and screens are displayed on the layout.

Windows : 

While in the item view, the menu bar on the top of the screen contains basic options some of which are also represented in the Buttons Toolbar. 

Menu: 

 The purchase order will be attached to the e-mail and 
terms and conditions are available in the e-mail body.

Cancel:

 Each order can be canceled until it received status 
level 5.

 All canceled orders are set to status 0 and can be
found under canceled orders.

Delete:

 Each order can be deleted until it received status 
level 5.

 A deleted order is completely deleted from system
and once deleted cannot be found anywhere.

Select All:  This function will select all order in the currently open 
view.

Navigation:  Reference > Main Screen > Menu PO View >

Menu : 

Arrange All
   Split

Rearranges the windows back to the default view.
Splits the selected views equally across the screen.

Navigation:  Reference > Main Screen >

Menu Item View :
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This menu contains the most common options for verifying, exporting and printing purchase orders.

File: 

The Edit Menu contains many program options for managing purchase orders and editing single items in them. These options include among others the 
possibility to transfer and delete articles from a purchase order as well as viewing bids and statistical information for the selected item.

Edit : 

Navigation:  Reference > Main Screen > Menu Item View >

Menu Item View : File

Verify Order
Export 
Go to Date...
Print
Exit

Verify the contents and quantities of a purchase order
Export the current view to an Excel sheet
Allows the user to quickly navigate to a specific date in the past or the future.
Open the report manager for printing options.
Closes the purchasing module

Navigation:  Reference > Main Screen > Menu Item View >

Menu Item View : Edit

Transfer Item
Delete
Delete Items with Zero Balance

Import from Excel
Insert Template
Scale Order
Show item bids
Validate Quantities

Convert Requested Amount to Vendor Unit

Transfer an item to another purchase order
Delete a selected line or selected item
Delete items on the purchase order with a zero quantity.

Importing items from an Excel sheet into a purchase order.
Insert template information on a purchase order
Upscale or downscale order quantities with a percentage
Show the available bids for a selected item

Validate the quantities of a purchase order to match the 

vendor case size
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This option allows to transfer articles from one purchase order to another, or to a New Purchase Order.

Transfer Item: 

To transfer a selected item to another purchase order or a new one, proceed as follows: 

Update Vendors Bid for This item
Update Order with Vendors Bid for all items
Update Order with Vendors Bid for selected items

Show Item Statistics
Show Item Consumptions
Show Historical Purchases
Use Quantity Ordered to Total
Use Quantity Confirmed to Total
Use Quantity Received to Total
Use Quantity Invoiced to Total
Row Multi Select

Scan Loaded Amounts
Refresh

Convert requested amount to vendors order unit

Update vendors bid for the selected item
Update order with vendors bid for all items in the PO
Update order with vendors bid for the selected items in PO

Show statistics for selected item
Show item consumptions for selected item
Show historical purchases for selected item
Use quantity ordered as total of PO
Use quantity confirmed as total of PO
Use quantity received to total of PO
Use quantity invoiced as total of PO
Select multiple rows in PO

Scan the loaded amounts
Refresh the screen layout to the default view.

Navigation:  Reference > Main Screen > Menu Item View > Menu Item View : Edit >

Menu Item View : Edit

 Select the vendor from the drop down list or directly by entering the correct vendor in the vendor code column.

 Insert the quantity to be transferred in the space provided
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Upon completing the information click  to proceed. 

This will complete the article transfer with the information selected.

This option will delete all the articles in a purchase order that have an order quantity of zero. The option is helpful to clear off items that unnecessarily take 
space on the document.

Delete items with Zero Balance: 

To delete zero balance articles proceed as follows : 

 Select the purchase order into which the selected article will be transferred to or alternatively select Create new Purchase Order which will start the creation wizard.

Navigation:  Reference > Main Screen > Menu Item View > Menu Item View : Edit >

Menu Item View : Edit

 Open the document that has zero balance articles that need to be eliminated

 Right click on the product description area which will activate the edit menu. Select 'Delete Items with Zero Balance'
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This option will allow the user to import items into a purchase order from an Excel sheet.

Import item from Excel into a PO:

Pre-requisites: 

Before starting to import from an Excel spreadsheet make sure that the spread sheet that you are trying to import meets the minimum requirements:

5 columns:

Item Code Column: MMS Code or any of the pre-defined alternative codes (maintained in the Article Manager)
Item Unit Column: Valid MMS unit, e.g.: KG
Quantity Column
Price Column
Comments Column

Example:

 The system will ask for confirmation on deleting the zero balance articles from the document. Accept the selection by choosing 

 After the processing has finished, the system will display the updated information on the screen with the zero balance articles eliminated from the view.

Navigation:  Reference > Main Screen > Menu Item View > Menu Item View : Edit >

Import from Excel
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The user has the option to import the excel sheet into an empty order or into an existing order.

The following import wizard will open:

Excel File:           Use the ... button to open the Excel file you would like to read the information from.        
Sheet Name:       Enter the name of the sheet within the Excel spreadsheet that contains the data to be imported.
Item Code Column:        Select the column which contains the item code information.
Item Unit Column:       Select the column which contains the unit information.
Quantity Column:            Select the column which contains the quantity information.
Price Column:        Select the column which contains the price information.
Comments Column:        Select the column which contains the column information.
Code type:      Select which code is used MMS code or alternative code.

When all is linked correctly click on LOAD FILE.
The system will load the file and check it for any errors.
In case the system finds any errors it will show. You need to correct the error before you can successfully import the file.

Navigation:  Reference > Main Screen > Menu Item View > Menu Item View : Edit >

Menu Item View: Statistics
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The bids option can be used to view the bidding information for the selected article to be used as the basis of a purchasing decision.

Bids : 

displaying the bidding information for the selected item.

All the bids for the selected item are listed organized in columns as follows : 

This option will allow the user to scale the quantities of a purchase order by the means of a scale bar that either increases or reduces the global purchase 
order quantities.

Scale Order: 

To scale the purchase order quantities, proceed as follows : 

Click the Search button to initiate Bids function

 When activating bids button the system will open a new window on the upper left part of the screen 

Local Price in local currency of vendor
Cur Local vendor currency
Vendor Name of vendor
Valid From Bid valid from date
Valid To Bid valid to date
Unit Unit of measure of selected article
Vendor Code Vendor product code
Brand Product brand
Case Case packing unit
Comments Comments on bid
Minimum Minimum supply quantity of product
Date Date of bid

Navigation:  Reference > Main Screen > Menu Item View > Menu Item View : Edit >

Menu Item View : Edit
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be scaled (increased or decreased) accordingly.

the quantities updated on the order accordingly.

 Open the document that needs to have order quantities scaled

 Right Click on the product description area which will activate the edit menu. Select the 'Scale Order Option'

 The system will open a scroll bar with which the global order quantities may

 Select the appropriate quantity by the means of the scroll bar and click to continue

 After the processing has finished, the system will display the updated information on the screen with
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The quantity validation process will update the order quantities on the purchase order to match them with those of the vendor and the relevant delivery case 
sizes.

Validate Quantities: 

To validate the ordered quantities with the delivery case size of the vendor, proceed as follows : 

Select the 'Validate Quantities' option

Navigation:  Reference > Main Screen > Menu Item View > Menu Item View : Edit >

Menu Item View : Edit

 Open the document that needs the order quantities to be validated

 Right Click on the product description area which will activate the edit menu.

 The system will open a window in which the options may be set
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the quantities validated on the order accordingly.

This option allows to convert the item quantities of a purchase order into the preferred unit of a vendor. The function has two options in processing : 

Convert Requested Amount to Vendor Unit: 

To convert the item quantities of a purchase order into the preferred unit sizes of a vendor, proceed as follows : 

This option allows to manually update bidding information for a selected item. The option may be used in cases where a bid is updated by the vendor and 
needs to be updated in the system as well.

Update Vendor Bid for item: 

To update a bid for a selected item please proceed as follows : 

 Validate the quantities with the selected options by clicking the button

 After the processing has finished, the system will display the updated information on the screen with

Navigation:  Reference > Main Screen > Menu Item View > Menu Item View : Edit >

Menu Item View : Edit

 Using the quantities that the vessel has requested
 Using current quantities that are entered on the purchase order

 Select the preferred option and click  to continue.

 After the processing has finished, the system will display the updated information on the screen with the quantities updated on the order accordingly.

Navigation:  Reference > Main Screen > Menu Item View > Menu Item View : Edit >

Menu Item View : Edit

 Open the document that contains the article that needs the bidding information to be updated.
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the quantities validated on the order accordingly.

The Tabs at the bottom of the screen access the following areas of the purchasing module : 

 The vendor bid will open where you can enter the new bid price and validation.

 After the processing has finished, the system will display the updated information on the screen with

Navigation:  Reference > Main Screen >

Tabs PO View
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Tabs: 

The 'list purchase orders' tab provides a complete list of all the purchase orders that have been issued for the selected day in blue color.

List Purchase Orders: 

Below is an image of the list purchase orders screen as it would look when opening it. The purchase orders for the selected day are listed on the right 
hand side of the screen where they may be selected for further viewing by double clicking the corresponding document or for a quick view of the purchase 
order just click on the tab Quick View

 List Purchase Orders for listing the purchase orders of the selected day on the calendar.
 List warehouse transfers for listing all inbound/outbound warehouse transfers for the selected day
 List ship to shore transfers for listing all ship issued material requests.
 Container for listing all container orders of the selected day on the calendar

Navigation:  Reference > Main Screen > Tabs PO View >

Tabs PO View: List Purchase Orders
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 The columns displaying information for the purchase orders are as follows :

Destination Destination of the purchase order
OS Status of the purchase order
PON Purchase order number
VID Purchase order identity number
Vendor Name of vendor
Value Value of purchase order in local vendor currency
CURR Vendor Currency
Value (CUR) Value in system currency

Authorized for Authorized Amount of Purchase Order
Gross Weight Total weight of Items belonging to this purchase order
Delivery Date Date of delivery
Blocked by If the PO is set to block payment the system will display by whom
Reason And why

 The edit menu for editing the contents of the selected purchase order is also accessible by Right Clicking the list area.

Open a selected purchase order
Status of a purchase order
Authorize a purchase order
Set flag received by supplier on purchase order
Set flag confirmed by supplier on purchase order
Block the payment of a purchase order
Enable the option to ship via container
Open the report manager for printing options
Send an email to the selected supplier
Delete a selected transaction or line
Select all active information on the screen.

 The  is an overview of which items belong to this purchase order without opening the whole purchase order 
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Authorization is configured on a defines monetary value set for each user. Purchase Orders that exceed the user's set monetary purchasing allowance
require authorization by a user with a higher allowance.

Authorize Order: 

 The columns displaying information for the purchase orders are as follows :

Description Item description
Ordered Order quantity
Confirmed Quantity confirmed by supplier
Unit Item unit
Price Item price
Subtotal Total of the item

Navigation:  Reference > Main Screen > Tabs PO View > Tabs PO View: List Purchase Orders >

Tabs PO View: List Purchase Orders

Select Authorize Order the PO changes to Status 2 - Authorized

If "Authorize Order" option is grayed out, that means either order has been

authorized (is at status 2), or current user does not have required authorization power to complete the task.

   NOTE:
Operational circumstances may require modifications be made to an authorized purchase order. When changes are made and PO value is lower than original 
authorized value, 
the purchase order does not require re-authorization. When changes are made and PO value exceeds the original authorized value, it will result in the purchase 
order requiring
re-authorization.
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See Also:

The via container option allows the user to send material with a container to the vessels. The system combines purchase orders
from different suppliers into one container. 

Via Container: 

 Security Module (Buyers Limit)
 Link 2
 Link 3

Navigation:  Reference > Main Screen > Tabs PO View > Tabs PO View: List Purchase Orders >

Tabs PO View: List Purchase Orders

 Access this function via the edit menu or right mouse click and select Ship Via Container

 By activating this function a new tab in the purchase order detail screen will appear "CONTAINERS"
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 By selecting this tab the below view will appear and with edit or right click, the add container function will appear

 By selecting add container, a selection of all open containers will appear, select one or more if you need to divide the purchase order into more then one container.
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 The system will add the container and add also one more column to the items on the right side

 By right clicking on the added container, select add all items to container, and the system will add all items to it

 All item quantities will be automatically transferred to the container and total column

 NOTE: If you have more then one container you will have more then one column available and could enter the quantity manually.

  Add a container to the purchase order
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The block payment function will block the selected purchase order for payment.

Block Payment: 

Status :      0  Unblocked
   3  Blocked

  Remove the container from the selected purchase order

  Add all items to the selected container

  Remove all items from the selected container

Navigation:  Reference > Main Screen > Tabs PO View > Tabs PO View: List Purchase Orders >

Tabs PO View: List Purchase Orders

 Selecting the block payment function will set the purchase order overview to a red color

 A blockage definition will pop up where the user will select a status and enter the reason for the blockage
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See Also:

Within the Purchasing Module the user has the option to send the Purchase Order via Email system.

Send Email: 

 On the list purchase overview, the details will appear showing who blocked this purchase order and why

   NOTE: If you register a blocked purchase order in the invoicing module, a flag is shown as blocked payment.

 Invoicing

Navigation:  Reference > Main Screen > Tabs PO View > Tabs PO View: List Purchase Orders >

Tabs PO View: List Purchase Orders

Main Screen



Email new message screen will appears for review and editing. 

attachment to the Vendor. Modifications to the Email text can still be done.

Select "Send Email" will open the internal Email engine

The send Email function is only available after the Purchase Order was authorized, otherwise the feature is grayed out.

   NOTE:
Vendor Code is required to send the purchase order via email. If no Vendor Code is present system will give a warning
"System cannot send order where the Vendor Code is Zero or empty. Please call your system administrator for assistance" 

Send Zipped This is set to default. Automatically the attachments will be zipped. 

Send as PDF This is set to default. Automatically the Purchase Order is generated as PDF File.
Send as Excel This is set to default. Automatically the Items get exported to an Excel sheet.
Lock File The attached Excel File is locked by default. Locked for certain columns in the Sheet. Unlock would aloud the Vendor to change all columns even description and 

codes.
Allow Price Edit This is by default disabled. So Prices can't changed by the Vendor

 The Purchase Order is being prepared and included to the Email as an attachment. The "Send" Function will send the Email with
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See Also:

The list warehouse transfers displays a complete list of all the transfers that have been issued for the selected day in green color. These include all 
warehouse in and outbound traffic either to or from the vessels. 

List Warehouse Transfers: 

Below is an image of the list warehouse transfer screen as it would look when opening it. The warehouse transfers 
for the selected day are listed on the right hand side of the screen where they may be selected for further viewing 
by double clicking the corresponding document or select quick view for a quick overview.

 Option Module (Email setting)
 Vendor Module
 Link 3

Navigation:  Reference > Main Screen > Tabs PO View >

Tabs PO View: List Warehouse Transfers
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 The columns displaying information for the Warehouse Transfers are as follows :

Source Name of source warehouse
OS Status of transfer
Destination Destination of transfer
Port Destination port of transfer
Via Via the port agent name or company
Value (CUR) Value of transfer in system currency
Gross Weight Total weight of the transfer

 The menu for editing the contents of the selected warehouse is accessible by Right Clicking the list area.
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Open a selected purchase order
Change the status of a warehouse transfer with the available options
Finalize a warehouse transfer
Delete a selected warehouse transfer
Refresh the screen view to default
Display the properties of a warehouse transfer

 The  is a quick overview of which items belong to this transfer.
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The list ship to shore requests provides a complete list of all the requests issued from the ships to the headquarters for the selected day in yellow color.

List Ship to Shore Requests: 

Below is an image of the list ship to shore requests screen as it would look when opening it. The ship to shore requests 
for the selected day are listed on the right hand side of the screen where they may be selected for further viewing by 
double clicking the corresponding document or select quick view for a quick overview

 The columns displaying information for the transfer from warehouse are as follows :

Description Item description
   Sent Item quantity which sent/receive to/from ship
   Unit Item unit
   Price Item price
   Total Total value of the item transfer

Navigation:  Reference > Main Screen > Tabs PO View >

Tabs PO View: List Ship to Shore Requests
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 The columns displaying information for the ship to shore requests are as follows : 

S Status of transfer
ID Identification number of transfer
Headquarter Name of headquarters
Vessel Name of vessel transmitting request to headquarter
Type Request type
Description Main category description of request
Create Date Request creation date
Items Number of items in request
Cost HQ Cost of request
Comment Comments per request
Gross Weight Total item weight of the transfer
CHK Count Items System checksum
CHK Sum Items System checksum
LOC Sum Items Sum of items in local currency if delivery made in other region/country

Open a selected ship to shore request
Process the request as Purchase Order
Change the status of a ship to shore request
Authorize a ship to shore request
Split a ship to shore request
Open the report manager for printing options
Delete a selected ship to shore request.

 The  is a quick overview of which items belong to this ship to shore request. 
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The split request option allows users to divide a ship to shore request into two separate requests.

Split Request : 

This window divides into two separate sections in which the splitting process can be made.

 The columns displaying information for the request are as follows :

Description Item description
Order Quantity ordered by the ship
Unit  Item unit
Comment Item comment

Navigation:  Reference > Main Screen > Tabs PO View > Tabs PO View: List Ship to Shore Requests >

Tabs PO View: List Ship to Shore Requests

 By selecting split request from the edit menu a splitting wizard window will open.
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 Select the product that need to be transferred to a new order request by clicking on it and selecting the  button to transfer the article to the other window. Should it be necessary 

to remove articles from the new order request they may be moved back to the other side by selecting the  button.
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The list container view provides a complete list of all the containers that will be delivered for the selected day in red color.

List Container: 

Below is an image of the container screen as it would look when opening it. The containers for the selected day are listed on the right 
hand side of the screen where they may be selected for further viewing by double clicking the corresponding document or select quick view
for a quick overview.

 Once the contents of both requests are completed, select the  button.

 Both requests will be visible on the ship to shore main screen.

Navigation:  Reference > Main Screen > Tabs PO View >

Tabs PO View: Container
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 screen

S Container status  0= Open   1= Container in Transit  2= Container Received 4= Container posted to Accounting 
ID Container ID
Vessel Destination vessel for the container
Size Container size
Type Container type
Comments Comments per container
Serial Serial number
BOL Bill of lading number
Count Item count
Value Total value of items inside the container

 By double clicking on a container document, the detailed information screen will appear.

 Below is an example of how the detail screen looks with the item details on the right and the grouping on the left of the
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See Also:

Action Events are intended for the ship to report issues during the loading that might need a shoreside representative to become active and follow up with the vendor.

Action Events:

Below is an image of all currently open action events.
The action events are not separated by date.
The action events will show depending on the user selection.

The menu in the action lists view offers several options to open, resolve or close a action event.

Open:

  Use this button to open an existing action event for editing the comments.

Resolve:

 Use this button to resolve an action event.

When the button is pressed the following window opens and offers the user to specify details how the action event was resolved.

Use the drop down box for Resolution Type, if required comments can be entered. To complete click on Apply Resolve to finally resolve the Action Event.

A resolved action event cannot be reopened.

Delete:

Use this button to delete an existing action event.

Confirm the warning to finally delete the event.

Code Item code
Description Item description
Amount Quantity loaded in container
Unit Item unit
Price Item price
Subtotal Item subtotal
Discount % Item discount
VAT % Item VAT
Total Item total
Source Supplier and PO number 

 Container Module

Navigation:  Reference > Main Screen > Tabs PO View >

Tabs PO View: Action Events

ID Unique Action Event ID.
Date Date when the action event was entered.
Status Destination vessel for the container
Type Shows whether the action event is open or closed. The status will change to close once the user selected to resolve the action event.
Item Name of the item for which the action event was created.
Assigned User When creating an action event the user needs to assign it to a responsible person. The selected user will show in this column. You can also work on 

other users action lists.
Comments This field shows the comments the user who created the action event has entered.
Resolve Date Date when the action event was resolved.
Resolve Shows the selected resolution type.
Comments This field shows the comments the user who resolved the action event has entered.

Navigation:  Reference > Main Screen > Tabs PO View > Tabs PO View: Action Events >

Menu: Action Events
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Action Event view:

  Use this dropdown box to see either all your open, all your closed or all users open or closed action events.

The tabs at the bottom of the screen provide the possibility to access the following areas of the purchase order : 

Tabs Item View: 

The below is an image of the first screen as it would look when opening a purchase order. 

The order list shows the detailed list of item which are ordered in the selected purchase order.

Navigation:  Reference > Main Screen >

Tabs Item View

 Order List for listing all Items included in this purchase order
 Order properties with create criteria such as delivery date, delivery port etc
 Comments for comments per purchase order
 Logs for recording who did what within the purchase order
 Container only displayed if the Via Container function is enabled
 Document Reference only displayed if the field document reference is used in Order Properties
 Loading Log only displayed if this purchase order status is higher then status 6 (received on board)

Navigation:  Reference > Main Screen > Tabs Item View >

Tabs Order List
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Tabs Order List: 

The view of a purchase order list is related to which current status the purchase order has. Up to status 4 the view detail
will be the same. With status 5 the detail screen will get an additional column "Confirmed" which will be the quantity confirmed by the
vendor. With status 6 another column will appear "Received" which is the quantity received on board. With status 7 the column "Invoiced"
will be added which is the final quantity which was invoiced in the Invoice Module

The order properties reflect criteria which was selected when the user created the purchase order or entered information in the vendor manager

Order properties: 

Code Item code
Description Item description
Ordered Order quantity from ship
Confirmed Confirmed quantity from supplier
Received Final received quantity on board
Unit Item unit
Price Item price     = The Price is automatically assigned from the quote manager = There was no bid price or the price was modified
Subtotal Item subtotal
Discount % Discount per item
VAT % VAT per item
Total Item total
Expire Date Expiration date (automatic if expire date is enabled in article manager)
Comments Comments per item
Gross Weight Item gross weight 

Navigation:  Reference > Main Screen > Tabs Item View >

Tabs Order Properties

 The red boxes are criteria which was selected when the purchase order was made. On the right side is an overview by group with actual cost and fixed cost and final variance in %.
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where the user can assign the item to a Doc Ref.
 The Doc Ref field could be used for delivery note of the supplier etc. If you enter a doc ref or more then one, a new TAB will appear with Document Reference

 By double clicking on the line a drop down box will appear to select the document reference number
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This tab is only shown if the VIA CONTAINER function is enabled.

Container: 

Navigation:  Reference > Main Screen > Tabs Item View >

Tabs Container

 By activating the function Via Container a new tab in the purchase order detail screen will appear "CONTAINERS"

 By selecting this tab, the below view will appear and with edit or right click, the add container function will appear

Main Screen



  Add a container to the purchase order

  Remove the container from the selected purchase order

  Add all items to the selected container

  Remove all items from the selected container

 By pressing add container, a selection of all open containers will appear, select one or more if you wish to divide the purchase order into more then one container.

 The system will add the container and add also one more column to the items on the right sight

 By selecting the Container and then right click on the added container, select add all items to container and the system will add all items to it or enter it manually.
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This tab is only shown if a document reference number is entered.

Document Reference: 

 where the user can assign the item to a Doc Ref.

 All item quantities will be automatically transferred to the container and total column

   NOTE: If you have more then one container you will have more then one column available and could enter the quantity manually.

Navigation:  Reference > Main Screen > Tabs Item View >

Tabs Document Reference

  The Doc Ref field could be used for delivery note of the supplier etc. If you enter a doc ref or more then one, a new TAB will appear with document reference
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This tab is only shown if the status of the purchase order is 6.

Loading Log: 

 By double clicking on the line a drop down box will appear to select the Document Reference Number

   NOTE: If you have more then one select the number to which the item belongs. 

Navigation:  Reference > Main Screen > Tabs Item View >

Tabs Loading Log
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If the purchase order was loaded on board, the status of the purchase order will change automatically to 6 and another tab
will appear. The purchasing department has now an overview who loaded or what was changed.

Enter topic text here.

Date Date
Time Time
Group User group
User User logged in
Workstation Which workstation logged in
Event Modification was done

Navigation:  Reference > Main Screen >

Action Lists
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This chapter describes the structure and procedures of the purchasing process in 
Material Management.  It enables the user to understand the method of operation 
and thus to customize his own company procedures into the Material Management 
work flow in order to use the full functionalities of the system and benefit from them 
by time and cost saving effects.

General Preparation

The Material Management System splits the whole procurement process into far smaller pieces 
which involves other modules such as Movements, Requests, Quote Manager and the Invoicing 
Module to be able to focus with the Purchasing Manager just on the purchasing related functions 
such as Generated Orders, Verify Quantities, authorize the orders and forward the orders to the 
suppliers.

So whenever the purchasing module is used it is in fact the follow up the process of a couple of 
events which happened before the use of the purchasing module is indicated.

The most direct related process is the Quote Manager that helps administrating bids in order to 
make them work with the Purchasing Module as automatically as possible and thereby benefit from 
time saving effects. 
Effective preparation in the Quote Manager is also of high importance in order to have the exact 
purchasing figures available for the concerned departments such as Controlling or Accounting.

Based on a well-organized purchasing department with clear defined module responsibilities and 
authorizations the whole procurement process will experience great benefits from orientating to the 
Material Management work flow as described here.

General
MMS Purchasing process distinguishes between 2 different kinds of purchase 
orders.

Request Based Purchasing:

Orders referring to ship requests:

Will process shipside requests into a purchase order.
This method will provide much more safety in quantity planning because the requests are 
considering information like:

The Purchase Order will then be processed according to the bids specified in the quote manager

Navigation:  How to ... >

Introduction to Purchasing with Material Management

Navigation:  How to ... > Introduction to Purchasing with MMS >

Purchasing with Material Management

1. Purchasing based on ship's request
2. Freely generated purchase orders

 Consumptions statistic:
Consumption during past cruises, time ranges and or seasons.

 Expected future consumption starting with day of request
 Passenger per day
 Actual Stock on Hand
 Quantity already expected
 Days Reserve Stock
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Proceeding like this also assures the quantities purchased are based on exact facts, figures and 
quantities
These purchase orders might have the ship stores as well as a warehouse as destination. 

Fidelio Cruise recommends this way of proceeding except when the company is currently in set-up 
mode.

Free Purchase Orders :

Free Orders:
Purchase Orders without having a shipside request this can be done in order to:

See Also:

This chapter describes the exact procurement process with all related modules and functions:

The Purchasing Work flow: 

 Benefit from special time limited offers
 Order of material that has to be especially produced due to companies specifications
 Long term procurement for special events, seasons
 Order of high quantities to benefit from increased discount
 Order high quantities when items have a high minimum quantity and storing the bulk amount in a

warehouse.

These purchase orders might have the ship stores as well as a warehouse as destination.

 The Material Management Work flow
 Set Up Mode

Navigation:  How to ... > Introduction to Purchasing with MMS >

The Purchasing Workflow

Step 1 
Daily Business 
Stock 
Decreasing 

Stock Level is Decreasing by Task

 any issues being made on board

 transfer to Account: Officers, breakage spoiling
etc

 reducing the Stock Level through recipe based
quantities

 check Stock Level

 compare Movements with actual stock
balance

 detect total consumption of cruise or
period
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Will Lead to Low Stock 
Supply needed

Step 2

Order will be processed Shore side
to Headquarter and/ or Purchasing Department

All Bids for all requested Items present
Purchase order needs to be placed

Users intention responsible Module in 

Material Management 

Task

Daily Business 
Stock Decreasing 

Generates a request in consideration of:

 Past Consumptions

 Delivery Date

 Next Delivery

 Days Reserve Stock

 Zones and Seasons

 Affected Headquarter

 estimated future consumption

 B

 transfer to Account: Officers, breakage spoiling
etc.

Users intention responsible Module in 
Material Management 

Task

Check Vendors Prices and get 
missing Bids

Generate Bids Excel Bid Files

receive Prices from the vendors 
and import the Prices
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Order arrived Shipside or at Warehouse
Receipt of Quantities to be placed in
Material Management

Check Invoice 
Advice Payment

Users intention responsible Module in 
Material Management 

Task

Place Purchase Order  create Purchase Order

 Receive confirmed Quantities
(step changes Status)

Users intention responsible Module in 
Material Management 

Task

load Stock into System
check 

 receipt of quantities

 confirm quantities as recieved

Users intention responsible Module in 

Material Management 

Task

Check Invoice  check of invoice if according to delivery note(s)

 approve payment if invoice is essentially and
technically correct

Navigation:  How to ... > Introduction to Purchasing with MMS >

Set Up Mode
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This chapter describes the procurement process during the implementation time in headquarter until all 
the master data is entered into the system and is ready for installing fleet wide. This is required in order to 
have present and current bids in the system.

The Purchasing Work flow in Set Up Mode:

Step 1

Request is Created 

Step 2

Send Request to Ship (e-mail) 

Step 3

Place responsible Module in 
Material Management 

Task

Headquarter

Generates a Request in Standard Mode for a 
designated Store in Standard Mode 
containing all the Articles. (Request will 
contain zero(0) quantities)

Place responsible Module in 

Material Management 

Task

Headquarter
Select Request and 
choose Export Request 
from the right Click 
Menu.

Export the Request into an Excel File and store 
it locally.

Place responsible Program Task
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Send Request to Headquarter (e-mail) 

Step 4

Check and/ or Change
Order Quantities

Step 5

Ship
Microsoft Excel

Insert Required Quantities into Excel Sheet 

Place responsible Module in 

Material Management 

Task

Headquarter

Import the Shipside Completed Request into 
Headquarters Database

Place responsible Module in 
Material Management 

Task

Headquarter

Authorize Request to enable 
access in Purchase Manager
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Step 6

Send Bid File to Vendor (s)
receive processed Bid File

Place responsible Module in 
Material Management 

Task

Headquarter

Generate Excel Bid File by using 
the Option: 
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Step 7

Send Bid File to Vendor (s)
receive processed Bid File 

Step 8

Place responsible Module in 
Material Management 

Task

Headquarter

Verify Excel Bid File using the 
Open, Verify and Import Bid 
Functions

Place responsible Module in 
Material Management 

Task

Headquarter

Task appears in Tab List Ship To 
Shore Requests

Process Order Request by 
marking the desired Request.

Introduction to Purchasing with MMS



Introduction to Purchasing with MMS



Navigation: »No topics above this level« 

Frequently Asked Questions

We raised a purchase order but not all of the article descriptions are displayed on the line.  Is it possible to 
extend the field for long descriptions?

Is it possible to default purchase orders to unzipped when sending by email? 

I opened a PO and changed the ship name under properties but the change will not take affect. How should I 
change it?

Would it be possible to have order conditions in vendors displayed in alphabetical order by code?

I Imported a bid but do not know the request number. I also checked the tab name on the excel bid but it just 
says Hotel. How can I search for this request?

When raising a purchasing order and selecting a date when the ship is at sea the system asks for a port 
agent? What should I use in this case?

The ships buy a number of local fish at different prices, which the Chef requests as 'local fish' from Hotel 
Controller. If we add a new article as 'Local fish' we will need to enter an average price and expensive fish will raise 
cost. How should we manage this ?

When you raise a purchase order and manually add terms and conditions, do these selections get added to 
the vendor under order conditions?

You may temporarily extend the columns to display the information but by pressing the refresh button the view 
will return back to its original state.

The zipping has been selected as the preferred way to send purchase orders in order to optimize data traffic by 
quantity. 

For this reason it is suggested to ensure that the suppliers run appropriate software to open the purchase order 
files.

At this point it is safer and clearer to delete the prepared purchase order and re-create it with the appropriate 
name to avoid mismatches in the database.

In this case it is easier to insert the conditions in alphabetical order once setting them to the system This way 
they will be correctly displayed each time in the future as well.

You may search for the bid in Quote Manager by setting the criteria on the import date.

In the case there is not an option for ‘at sea’ you may also leave this option blank.

It is suggested to add an item code for each type of fish purchased in different regions due to the fact of rather 
high price variance.

These do not automatically update on the conditions document but need to be added there if they are needed in 
that context in the future.

Frequently Asked Questions



The Quote Manager plays a very important role in the Material Management Process 

According to the individual purchasing policies of your company it is highly recommended 
to have more than one quotation for an item available and to update them on a regular basis!

Quote Manager Main Functions 

Quote Manager Main Screen: 

The image below represents the Quote Manager main screen as it appears during normal operation. We can see the main function buttons on the toolbar and, 
below this, we have multiple windows showing the store, grouping and product detail. We can also see the 'path' of the selected article.

The toolbar has the common Material Management look, accompanied by 3 new functions explained in this manual.

By moving your mouse over the screenshot you will be able to activate 'hotspots' identified with the cursive lining changing to a Click on these to jump to 
more detailed information about that particular button or window.

See Also:

Navigation:  Reference >

Main Screen:

 It enables the purchasing department to maintain up to date information from the vendors related to quotations for items and
services in the system.

 It simplifies the purchasing process.
 It helps to manage price offers from vendors and makes them accessible for possible price verifying tasks with other vendors.
 It generates the best possible cost savings if used on a regular basis and prior to the start of the actual purchasing process.

This is especially relevant for:

 Purchasing high value, high volume items and articles with variable prices.
 Taking advantage if the price has decreased (Otherwise the 

purchase order will only contain the old bid price).
 Having the final total of each purchase order amount on the invoice

In the Quote Manager we find the usual functions: Search, Refresh, Export to 
Excel and Print,
accompanied by a few new, essential functions that control the bidding 
process. 

 Quote Manager Toolbar
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Quote Manager Main Functions 

The buttons toolbar has the common Material Management look, accompanied by 3 additional Quote Manager specific functions:

See Also:

If we want to check if there is a bid for an article available, the search engine is available for this purpose.

Button: Search

Before we start the search a Vendor has to be selected first in the Drop Down Menu on the left hand side.

Navigation:  Reference > Main Screen >

Buttons

To use the Quote Manager and to work with its functions the correct order for the bidding process (as described in a 
following topic) must be used!

 Bidding Procedure
 Generate Excel Bid File
 Verify Bids
 Defaults

Navigation:  Reference > Main Screen > Buttons >

Button: Search

Click on Search and the Bid Search Engine will appear on the screen
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Double-clicking on the item will then take you to the section where the Article is located.
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History:  If you have previously searched for an item, the system remembers the last item you looked for. Click on the History icon and the system will jump to that last searched 
location

This option refreshes the screen layout. For example, when you have sorted columns by their heading or resized them, then clicking refresh will reset the 
layout to the default view.

Button Refresh: 

This Button will opens the Generate Excel Bid File dialog that will guide the user through the creation of an Excel Bid File. 

Pre-selection for generating the Excel Bid File: 

Before the Excel Bid File can be generated the system requires certain information:
All this information is provided to the system via the drop down menu on the left hand side.

This Chapter works with Hotspots for further explanations of certain topics.

  Note: The system will only show articles that are enabled!! If you require the system to look for all articles, you have 
to click the  Show Disabled Items checkbox at the bottom on the Search Engine.

Navigation:  Reference > Main Screen > Buttons >

Enter topic name

Click to refresh your screen layout.

Navigation:  Reference > Main Screen > Buttons >

Button: Generate Excel Bid File
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Vendor
This field is necessary in order to name the file correctly. Material Management names the vendors bid files in order to assign 
the bids in the following processes correctly to the vendors.

Back to Top

Store
Required to have the right items in the bid.

Back to Top

Zone
Necessary to assign the proper zones to the vendors bids and items.

Back to Top

Article Folders
Required to specify items for which you request bids to avoid requesting bids for all items in the store. What is also of 
importance is that some article groups have more frequent changes in price than others and therefore new prices are 
requested more frequently. Additionally, most of the suppliers are specialized in supplying certain article groups only.
This keeps the bid files small and clearly arranged

Once a store has been selected the tree of article folders will appear with all articles folders selected by default:
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Back to Drop Down Menu

Generate Excel Bid File: 

To go to the Excel Bid File Generating Process simply press the Generate Excel Bid File Button in the Toolbar.

and a new Window will pop up in the center of the screen. Here we will enter information as follows, and which can be accessed by 

selecting the 'hotspot'
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Save the Sheet as follows:
Describes the path where the Excel file is saved.

The generated Excel bid files are the most important elements in this task. It is 
recommended to store the output bid files, as well as the ones returned from vendor, in a 
clear and easy to search structure in case is becomes necessary to refer to these files again.

Here is one example of a how a windows folder structure might look:
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Starting Date & Ending Date
This will specify when the validity of a bid starts and ends. After the completion of this entire process these validity dates will be used by the system in order 
to see when a bid is about to expire and new bid has to be requested. 

This can be done for the present date range and for the future as well in order to be prepared for special seasons (i.e. Christmas or Easter) and events (i.e. 
a new ship.) This enables the user to go from one valid bid to the next valid bid without interruptions.

To select a Starting Date proceed as follows:

Lock Date Range will protect the cells that contain the date range from any changes by the users (especially vendors) as the Excel Bid File is using a 
specific date format. 

See also: How to understand the Excel Bid File

Protect Excel Sheet:
Enabling this function will protect the cells using a Material Management Entry in order to import the file properly. Any changes made to these cells will 
prevent the Excel File importing properly and the entire task beginning with the creation of the Excel Bid File would need to be repeated.

Open Document in Excel:
Will open the Excel Bid File after creating it.

Include Disabled Items:
Will include disabled items as well.
This could be a useful option if an item is going to be activated and listed on board. 

Create Bid File Using Order-Request
Will open the Excel Bid File after creating it. Therefore the Items Tab will be disabled and the Excel Bid File will contain only the items from the selected 
Request.

Choosing the Verify Bids button will open up a new toolbar that will provide a few new functions.

After clicking on the Verify Bids button, a new toolbar will appear underneath the main tool bar in the main window on the right.
You can click on the buttons below or the links to see more information and instructions on the buttons usage.

Navigation:  Reference > Main Screen > Buttons >

Button: Verify Bids

Clicking on the Verify Bids Button will 
open the Verify Bids toolbar:
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Most of the options have corresponding tools in the menu, keyboard shortcuts assigned to them or, are available with a right mouse click.

See Also:

The Defaults button is an option that displays all the defaults bids with item and zone for a single vendor selected in the left hand 
drop down menu.

Displaying Vendors Defaults

After placing bids and default vendors for items into the system the 'defaults' button on the top 
of the toolbar can be used to show all the default items per Vendor, Store or Zone

As an example in the picture below it shows all default items per vendor for the food store in all zones:

This Option will export the bids to an Excel worksheet.

Open: Opens a bid file received from a vendor
Verify Bids:        Evaluate bids if the data is according to system requirements.
Import: Imports the prices into the system.
Ignore Zero Prices: Ignores bids with empty or zero bid price. 

 more about the bidding procedure:

Navigation:  Reference > Main Screen > Buttons >

Button: Defaults

Navigation:  Reference > Main Screen > Buttons >

Button: Export to Excel
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Exporting to Excel:        

Depending on the current window, the Export to Excel function converts various views from the Quote Manger into an Excel file.
Some of the more useful reports for exporting may be the following:

To start exporting the selected view:

After selecting 
a vendor, all 
the defaults 
will be 
displayed. 
This can be 
used to store 
snapshots of 
the vendors 
defaults at 
frequent 
intervals or to 
compare 
vendors 
defaults etc.
View 
Example:

In cases 
where 
purchasing 
procedures or 
policies 
requires strict 
documentation 
of purchasing 
decisions for 
high value and 
high volume 
items, the 
price 
comparison 
selected via 
the tabs 'Bids 
Overview 
Current' and 
'Bids 
Overview all 
Bids' can be 
exported to 
Excel as well. 
From the 
Excel file it 
can be easily 
used to 
evaluate 
potential 
savings etc. 
View 
Example:
After 
completing 
the import the 
new bids can 
be exported to 
Excel and 
used for 
example as a 
master for 
certain 
vendors, 
article groups 
etc.
View 
Example:

Click to open the export dialog.
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Export of Defaults Overview

Depending on the selection in the drop down menu, the view could be as follows:

In this example we see the entire vendors defaults containing all stores and all zones because in the drop down menu there was only a vendor selected. 
To narrow the export to only food items for the zone Europe for example, simply specify this in the drop down menu. 

Export of Bids Current

If the price comparison is exported, it will result in the following file:

Export of Bid Import

Exporting the imported prices will show the following Excel data. This might be useful in cases where the import needs to be documented and could be 
kept in the same Windows location as the original received bid file.
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This option opens the Report Manager. This option will be also available in the Menu; File ->Print.

Button Print: 

After clicking on the open button, a new toolbar will appear underneath the main tool bar in the main window on the right.

Navigation:  Reference > Main Screen > Buttons >

Button: Print

Click to open the Report Manager and select the Report.

Navigation:  Reference > Main Screen > Buttons >

Buttons on Verify Bid Toolbar
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The Verify Bid Toolbar:

The Verify Bids Toolbar will provide the functions that are used to generate, verify and import bids.

See Also:

After we have received the completed Excel bid file it can be further processed with the Quote Manager.
Before we can work with the received bids we need to import them into the system.

Opening a received Bid File:

After selecting the file from the Windows folder location the opened bid file from the vendor will 
appear in the main window just below the toolbar. It will already contain the received bids:

After this action the data is present in the system for further use.

Back to Buttons Verify Bids

See also:

Open: Opens a bid file received from a vendor
Verify Bids: Evaluate bids if the data is according to system requirements. 
Import: Imports the prices into the system.
Ignore Zero Prices: Will ignore bids with empty or zero bid price. 

 Excel Bid File
 Quotation Procedure

Navigation:  Reference > Main Screen > Buttons > Buttons on Verify Bids Toolbar >

Button: Open

By pressing the OPEN Button the received Excel file 
can be read by the system.

This will not import the prices into the system so far

 Button: Verify Bids
 Button: Import
 Button: Ignore Zero Prices
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The verification process is a very important task for the system because it checks the validity of the bids before it actually imports 
the data into the Material Management Systems database. This is in order to prevent possible errors in the follow up process.

Before Bids can be verified they must first be already loaded into the system using the Open Button. (Process described here)

Verifying the Bids

The function will now check if all the bids are according to the requirements of the Material Management System. 

The function will check all the bids for each item in the list to confirm if they are valid or not.

Important information regarding Excel bid files

Invalid entry or deleted entry in the bid file: Can be avoided by using the protect Excel data sheet option (This function is enabled 
by default!)

The Excel bid file will appear as shown in a regular Excel workbook and all cells with mistakes are marked in red so there is no 
need to look into the file itself.

It could be possible however that an entry appears as a negative figure. Therefore all the relevant conversions such as unit and 

Navigation:  Reference > Main Screen > Buttons > Buttons on Verify Bids Toolbar >

Button: Verifiy Bids

To verify the Bids simply press associated button: 

Valid bids are marked 
with a green check mark

.

Invalid bids are marked 
with a red cross.

On the 
first view 
the invalid 
bids 
attract 
attention 
as they 
are 
marked 
with a red 
cross 
instead of 
a green 
check 
mark.

The cell 
that 
caused 
the error 
will be 
highlighted 
in red as 
well, as 
shown in 
the image. 
 There are 
two 
reasons 
why a bid 
may be 
invalid.

In this 
example 
the unit is 
missing in 
the bid file.
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currency have to be checked for existence and accuracy in the master data. In this case, we recommend to re-send the blank bid 
file to the supplier and ask him to redo the bids.

See also:

The import button will actually import the correct prices into the Material Management database to make them available for the purchasing 
process.

Verifying the bids

Unless the Excel bid file is 100 % free of mistakes, the Material Management System will not import the prices into the system and the Import 
button will not work.

After importing, the bid prices from the vendors are available for use, for example to determine default vendors for items and zones.

Back to Buttons Verify Bids

See also:

The Ignore Zero Prices button is an option that prevents importing items with zero price into the system.

Ignore Zero Prices enabled

If the Ignore Zero Prices button is clicked once it will be highlighted in light blue. This will show that the function is enabled and will be used 
when importing bids into the system. 

Ignore Zero Prices Disabled:

Pressing the button again will remove the highlighting and show that the option is disabled and will not be used while importing bids. 

Especially when working with detailed excel sheets the use of this function is highly recommended.

Back to Buttons Verify Bids

See also:

 Button: Open
 Button: Import
 Button: Ignore Zero Prices

Navigation:  Reference > Main Screen > Buttons > Buttons on Verify Bids Toolbar >

Button Import 

To import the bids into the system 
simply press the button on the toolbar:

 Button: Open
 Button: Verify Bids
 Button: Ignore Zero Prices

Navigation:  Reference > Main Screen > Buttons > Buttons on Verify Bids Toolbar >

Button Ignore Zero Prices

 Button: Open
 Button: Verify Bids
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After the bids have been requested and imported into the system, they can be further processed especially for price comparison and 
determining of default vendors. This chapter explains how the prices can be compared and default vendors can be determined:

What is a Default Bid?

When referring to purchasing, the default bids are what tells the system what item is going to be purchased from whom. This information is required for the 
system to process purchase orders automatically.

Tabs View and Edit Bids:

At the bottom of the main window are the tabs for viewing bids. These tabs enable the user to utilize the received bids and determine the default vendors per 
item:

See Also:

The Current Bid tab will display the current bid from the selected supplier. 

Current Bid: 

Selecting an item from the item list will show the current bid from the selected supplier in the bid window below. 

 Button: Import

Navigation:  Reference > Main Screen >

Tabs View and Edit Bids

 Bids Current
 Bids History
 Bids Overview Current
 Bids Overview All Bids

Navigation:  Reference > Main Screen > Tabs View and Edit Bids >

Tab: Current Bids
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By selecting the item and right clicking it, a new context menu will appear, providing the following functions:

Insert and Properties will display the following window where a bid can be modified or newly created.

See Also:

The Tab Bids History will display the entire price history of the selected item from the selected vendor

Tab Bids History

will insert a bid for an item

delete the bid

shows the properties of the bids

 Bids History
 Bids Overview Current
 Bids Overview All Bids

Navigation:  Reference > Main Screen > Tabs View and Edit Bids >

Tab: Bids History
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By selecting this tab, the bid history of a single item can be viewed and analysed. In contrast to the Current Bid Tab it shows only expired bids from the 
selected vendor . 

Column Description are shown below the image:

See Also:

The Bids Overview Current will display the bids from all vendors for the item that was selected in the window above and that are 
currently valid.

Bids Overview Current

The Tab Overview Current is, along with the Bids Overview All Bids Tab, the function that enables the user to do price comparisons, and to decide, based on 
this comparison and other purchasing related questions which will be the standard supplier for the item.

Valid From: Date from which bid was valid
Valid To: Expiration date of bid
Bid Price: Bid price in vendors currency
Unit: Shows item base unit
Currency: Shows bid currency
Estimated: Original estimated quantity
QTD: Quantity purchased until expiration date
Vendor Code: Vendor's item code
Brand: Item brand
Comments: Comments
Minimum: Minimum quantity per order
Date: Date bid was created or bid's properties were changed

 Bids Current
 Bids Overview Current
 Bids Overview All Bids

Navigation:  Reference > Main Screen > Tabs View and Edit Bids >

Tab: Bids Overview Current
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The items or articles are selected the same way as in Bids Current and Bids History.
The bids will then appear in the detail window with the cheapest  bid always listed on top and the most expensive at the bottom.

Default Vendors are those that during the automatic purchasing process, these bids will be selected to place an order with the 
assigned vendor.

After the assignment is done the default bid for each zone will appear in the small split window to the left of the bid view. 

See Also:

By selecting an article and then right 
clicking, the following context menu 
appears:

With these options we can assign the 
defaults as follows:

Set the selected bid as default for all zones.
All purchases will be placed with this vendor.
Will unset the bid and it will no longer be the default for all zones.

Will set the selected bid as default bid for one zone only, in this 
case Europe.

 Bids Current
 Bids History
 Bids Overview All Bids

Navigation:  Reference > Main Screen > Tabs View and Edit Bids >

Tab: Bids Overview all Bids
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The difference between this option and Bid Overview Current is that this option is used for assigning bids to a future starting date.

Bids Overview all Bids: 

The Tab Bids Overview all Bids is, along with the the Tab Overview Current, the function that enables the user to do price comparisons, and to decide, based 
on this comparison and other purchasing related questions which will be the standard supplier for the item.

This function enables a well organized purchasing department to switch vendors on specified dates and to ensure that the bid function can be used without 
interruptions caused by periods without bids.

Double Clicking on a Bid will guide you to the following Dialogue:

See Also:

This Menu contains basic options which are also represented in the toolbar and often available with a right mouse click.

 Bids Current
 Bids History
 Bids Overview Current

Navigation:  Reference > Main Screen >

Menu:
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Menu:

By moving your mouse over the screenshot you will be able to activate 'hotspots' identified with the cursor changing to a Click on  these to jump to 
more detailed information about that particular button or window.

See Also:

This menu provides the basic and most frequently used options in the quote manager, such as generate Excel bid file and verify 
bids.
In addition to this the file menu also contains the option to open the report manager, and to exit the module.

File Menu:

This Button will opens the Generate Excel Bid File dialog that will guide the user through the creation of an Excel Bid File. 

Pre-selection for generating the Excel Bid File: 

Before the Excel Bid File can be generated the system requires certain information:
All this information is provided to the system via the drop down menu on the left hand side.

This Chapter works with Hotspots for further explanations of certain topics.

 File Menu
 Edit Menu
 Windows Menu

Navigation:  Reference > Main Screen > Menu >

File Menu

Generate Excel Bid File

Verify Bids

Print

Exit

Function for initiating bid request process.

Function for ensuring that bids meet system requirements.

Open the Report Manager.

Closes the module.

Navigation:  Reference > Main Screen > Menu > File Menu >

File Menu: Generate Excel Bid File
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Vendor
This field is necessary in order to name the file correctly. Material Management names the vendors bid files in order to assign 
the bids in the following processes correctly to the vendors.

Back to Top

Store
Required to have the right items in the bid.

Back to Top

Zone
Necessary to assign the proper zones to the vendors bids and items.

Back to Top

Article Folders
Required to specify items for which you request bids to avoid requesting bids for all items in the store. What is also of 
importance is that some article groups have more frequent changes in price than others and therefore new prices are 
requested more frequently. Additionally, most of the suppliers are specialized in supplying certain article groups only.
This keeps the bid files small and clearly arranged

Once a store has been selected the tree of article folders will appear with all articles folders selected by default:
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Back to Drop Down Menu

Generate Excel Bid File: 

To go to the Excel Bid File Generating Process simply press the Generate Excel Bid File Button in the Toolbar.

and a new Window will pop up in the center of the screen. Here we will enter information as follows, and which can be accessed by 

selecting the 'hotspot'
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Save the Sheet as follows:
Describes the path where the Excel file is saved.

The generated Excel bid files are the most important elements in this task. It is 
recommended to store the output bid files, as well as the ones returned from vendor, in a 
clear and easy to search structure in case is becomes necessary to refer to these files again.

Here is one example of a how a windows folder structure might look:
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Starting Date & Ending Date
This will specify when the validity of a bid starts and ends. After the completion of this entire process these validity dates will be used by the system in order 
to see when a bid is about to expire and new bid has to be requested. 

This can be done for the present date range and for the future as well in order to be prepared for special seasons (i.e. Christmas or Easter) and events (i.e. 
a new ship.) This enables the user to go from one valid bid to the next valid bid without interruptions.

To select a Starting Date proceed as follows:

Lock Date Range will protect the cells that contain the date range from any changes by the users (especially vendors) as the Excel Bid File is using a 
specific date format. 

See also: How to understand the Excel Bid File

Protect Excel Sheet:
Enabling this function will protect the cells using a Material Management Entry in order to import the file properly. Any changes made to these cells will 
prevent the Excel File importing properly and the entire task beginning with the creation of the Excel Bid File would need to be repeated.

Open Document in Excel:
Will open the Excel Bid File after creating it.

Include Disabled Items:
Will include disabled items as well.
This could be a useful option if an item is going to be activated and listed on board. 

Create Bid File Using Order-Request
Will open the Excel Bid File after creating it. Therefore the Items Tab will be disabled and the Excel Bid File will contain only the items from the selected 
Request.

Choosing the Verify Bids button will open up a new toolbar that will provide a few new functions.

After clicking on the Verify Bids button, a new toolbar will appear underneath the main tool bar in the main window on the right.
You can click on the buttons below or the links to see more information and instructions on the buttons usage.

Navigation:  Reference > Main Screen > Menu > File Menu >

File Menu: Verify Bids

Clicking on the Verify Bids Button will 
open the Verify Bids toolbar:
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Most of the options have corresponding tools in the menu, keyboard shortcuts assigned to them or, are available with a right mouse click.

See Also:

This option opens the Report Manager. This option will be also available in the Menu; File ->Print.

Button Print: 

This option will close the Quote Manager module. 

Button Exit: 

Open: Opens a bid file received from a vendor
Verify Bids:        Evaluate bids if the data is according to system requirements.
Import: Imports the prices into the system.
Ignore Zero Prices: Ignores bids with empty or zero bid price. 

 more about the bidding procedure:

Navigation:  Reference > Main Screen > Menu > File Menu >

File Menu: Print

Click to open the Report Manager and select the Report.

Navigation:  Reference > Main Screen > Menu > File Menu >

File: Exit

Click to close Quote Manager module. 

Navigation:  Reference > Main Screen > Menu >

Edit Menu

Main Screen



This menu contains the options for inserting a bid, deleting a bid and showing the properties of a bid.
All of these functions are also available in the bid window by opening the context menu (right mouse click).

Edit Menu: 

This option is used to add a bid manually, bypassing the regular purchasing and quotations procedure.

Insert Bid:

This option would be used especially in cases when :

When the Insert Bid Button is clicked, the following window will appear on the screen requiring the entries as described below.
This is the same information that is requested when a bid file is generated.

Insert Bid

Delete

Properties

Insert a bid

Delete selected bid. 

Open the properties of the bid.

Navigation:  Reference > Main Screen > Menu > Edit Menu >

Menu: Insert Bid

 Bids and quotations are received via facsimile
 Bid is negotiated via telephone
 Only single prices are missing from a vendors catalogue.

Before the option insert bid can be used, a vendor, a store and a valid item need to be selected as shown below:
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See Also:

The Button Delete gives the opportunity to delete vendors bids in case of double entries, wrong bids or bids with zero prices.

Menu Delete: 

The delete function requires the same information as insert bid before a bid can be actually deleted:

Valid Date: Function is disabled because manual entry always has immediate effect for purchasing
Vendor Code: Vendors article code / number
Brand: Brand of the item
Case Size: Indicates case content quantity
Minimum Is a minimum order quantity required? If yes, amount can be specified here
Price Bid / quotation for the item per base unit
Currency Vendor's preferred currency or headquarter home currency
Estimated Estimated order quantity for the validity of the bid.
Case Dimensions Calculates the case volume based on the entry of: height X depth X width

 more about the Excel Bid File

Navigation:  Reference > Main Screen > Menu > Edit Menu >

Menu Delete

If bids are to be deleted, this must be done in the chronological order in which they were entered. In 
this case you will see the following message that advises the user to delete the last bid first.
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This option allows the user to view and change the properties of the bids using the same data as described with the insert bid button.

Bid Properties: 

This option might be used in cases when:

Article / item is selected the same way as when inserting and /or deleting a bid.
The following screenshot and table provide further information:

Once an article is selected the properties window opens, and the data can be edited.

Navigation:  Reference > Main Screen > Menu > Edit Menu >

Menu: Bid Properties

 Case unit changes 
 Expected quantity is under / overestimated and prices change
 Market situation changes and price increases or decreases
 Brand changes
 Etc.
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The windows menu allows to change how the windows and screens are displayed.

Windows: 

Arrange All: 

Any time a new function is chosen and opens, the windows appear on top of each other.
The arrange all function can therefore be used to:

Single Window View 

In case only one function is presently opened the view will as follows:

Valid Date: Function is disabled because manual entry always has immediate effect for purchasing
Vendor Code: Vendors article code / number
Brand: Brand of the item
Case Size: Indicates case content quantity
Minimum Is a minimum order quantity required? If yes, amount can be specified here
Price Bid / quotation for the item per base unit
Currency Vendor's preferred currency or headquarter home currency
Estimated Estimated order quantity for the validity of the bid.
Case Dimensions Calculates the case volume based on the entry of: height X depth X width

Navigation:  Reference > Main Screen > Menu >

Menu Windows

Arrange All
  Split

Rearranges the windows back to the default view.
Splits the selected views equally across the screen.

 shrink the present window
 cascade the windows if more than one is opened
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Multi  Window View 

In cases where more than one function is opened, the view will as shown below.
This view can be helpful in cases where the bids and the vendors defaults need to be displayed together.

Split Windows:

The split function is used to arrange the opened bid manager windows. Using the split function enables the user to work in one window and to display the 
data in another: When using this functionality the refresh button needs to be pressed from time to time in order to display all the edited data in both of the 
windows.

Use the Windows List

The windows list in the drop down menu enables the user to switch between the opened windows. When opening the windows menu it displays all windows 
that are presently opened within the quote manager.
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To handle all the information in the bid manager, a complex view of the items and the assigned bids is provided.

Main Item List and Window

Once a vendor, store and zone are selected, all the items in the selected store are displayed in the item list no matter whether or not bids are available.

For further explanations, simply click on the areas of the window below using the hand Symbol: 

Item List is responsible for showing all default vendors for all the existing purchasing zones.

Once a vendor, store and zone are selected, all the items in the selected store are displayed in the item list no matter whether or not bids are available.

Explanations of all the column names can be found below this screenshot:

Navigation:  Reference > Main Screen >

Item List
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Back to Top: Item List

Zone Window

The zone window is responsible for showing all default vendors for all the existing purchasing zones.
This window is for information only, and no data can be edited. 

In the left column the zone window lists all available zones.

Referring to the selected item in the item window, it will list all the default vendors for each zone.
If there is no entry, it means that for the current time period no vendor is specified.

Back to Top: Item List

Bid Window

The bid window shows all available bids for the selected item. It is where we actually select items, and the prices can be seen in a view that directly 
compares the bids from the vendors and lists the cheapest bid on top.

The bids appear with all the details that have been entered into the system via the Excel bid file or by using the insert bid function. 

Columns in Bid Window::

Code Material Management item number as assigned in the article manager
Description Item description as defined in the article manager
Unit Shows the item base unit
Fixed Cost (left column) Base unit cost
Fixed Cost (right column) Vessel cost (vessel cost = base unit cost + store markup)

Code Vendors code as defined in vendor setup
Vendor Vendor
Valid from Show the date from which the bid is valid
Valid Date Shows the expiration date of the bid
Price Euro Price in company's home currency
Bid Price Vendors preferred currency price according to vendor master data settings
Unit Item base unit
Currency Currency of base unit
Estimated Estimated order quantity for the validity of the bid.
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See Also:

QTD Quantity purchased from selected vendor until today
Vendor Code Vendor item/ article number
Brand Item brand
Case Unit Case unit referring to base unit
Comments Manual comment regarding this bid
Minimum The minimum order quantity for a single purchase order 
Date Shows the exact time the bid was created

 More About the Bid Window and how to set Defaults
 Back to Top: Item List
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How to get new bids and manage the bidding process:

The usual way of proceeding in order to have accurate bids within the system will include the 
5 following steps:

Here you can learn more about the Excel bid file. 

The Excel bid file:

After opening the Excel file it will appear as in the example below:

Navigation:  How to ... >

Bid flow in the Material Management System

Step 1 Function in Quote Manager Tasks
Create Excel bid file Creates an Excel file for a certain 

vendor in order to get quotations 
for specified products

↓
E-mail the created Excel file to the vendor

↓
Vendor will fill in required bids and send 

the e-mail back to purchasing department

↓
Step 2 Function in Quote 

Manager
Tasks

Import of the 
Excel bid file

Opens the quotation toolbar

The toolbar will appear right underneath the main toolbar

↓
Step 3 Function in Quote 

Manager
Tasks

Import the 
Excel bid file

Imports the bid file into the 
evaluation window

↓
Step 4 Function in Quote 

Manager
Tasks

Verification 
of bid file

Checks if bids meet system 
requirements

↓
Step 5 Function in Quote 

Manager
Tasks

Import of bids Imports the prices into MMS for 
further processing

Navigation:  How to ... >

Learn more about the Excel bid file
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Structure of the Excel bid file: 

The columns contained in this excel sheet are described as follows:
In order to avoid problems with the further processing of the Excel 
bid file it has cell protection activated by default.

Column description Explanation Status
CODE MMS item code Protected

DESCRIPTION MMS  item 
description

Protected

SPECIFICATIONS MMS Item 
additional specs.

Protected

UNIT MMS unit Protected
VENDOR PRICE To be filled in by 

Vendor
Unprotected

VENDOR UNIT To be filled in by 
Vendor

Unprotected

CURRENCY MMS currency Protected
VENDOR CODE To be filled in by 

Vendor.
Item code will 

then appear on 
purchase order

Unprotected

VENDOR BRAND To be filled in by 
Vendor

Unprotected

VENDOR 
COMMENTS

To be filled in by 
Vendor

Unprotected

VENDOR CASE 
UNITS

To be filled in by 
Vendor

Unprotected

VENDOR MINIMUM 
QUANTITY

To be filled in by 
Vendor

Unprotected

CASE HEIGHT To be filled in by 
Vendor

Unprotected

CASE WIDTH To be filled in by 
Vendor

Unprotected

CASE DEPTH To be filled in by 
Vendor

Unprotected

VALID FROM Pre entered, Unprotected
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After the completion of the previous processes the bids have been imported into the system and can be 
further analysed by the purchasing team. 

This decision-making process covers questions such as what is going to be purchased from which vendor 
because this is more a question of vendor contracting and purchasing policies than an MMS function, and 
these decisions remain the responsibility of the purchasing department.

Depending on the purchasing policies the revision of the vendors bids should be done at frequent 
intervals. 

In order to reach the full functionality and to fulfill various purchasing policies it is recommended  to have 
more than just one bid per item available especially for the most common / high volume items as well as 
for the high value article groups. 

See Also:

After the bidding process the quotes for the articles can be compared and a standard vendor for each item, zone and period can be 
defined.

Evaluate prices

Selecting an item from the item list will show the current bid from the selected supplier in the bid window

To initiate the price evaluation, at minimum a vendor and a store must be selected from the drop down menu located on the left of the screen. 

How to work with bids and the bidding tabs

When looking into the bids, a vendor and a store must be selected in order to do a bid comparison as 
described above. Depending on the selected store and item group all the relevant articles will be listed as in 
the screenshot below.

Once an item is selected by clicking it, the bidding details will appear in the window below.

however vendor 
may change

VALID TO Pre entered, 
however vendor 

may change

Unprotected

Navigation:  How to ... >

Working with bids

This is the point where the automation stops for a while, and we process manually as there are

purchasing decisions to be made by the purchasing department, however this will simplify the 

subsequent purchasing process.

 Price Evaluation

Navigation:  How to ... >

Price evaluation
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When looking into the main quote manager window, we see some tabs at the very bottom of the lower 
window: 

By moving your mouse over the screenshot you will be able to activate 'hotspots' identified with the cursor changing to a Click on 
these to jump to more detailed information about that particular button or window.

The Current Bid tab will display the current bid from the selected supplier. 

Current Bid: 

Selecting an item from the item list will show the current bid from the selected supplier in the bid window below. 

These tabs offer the user a way to display the bids from various points of view.
Depending on the choice and the users intention they will filter required information regarding:

Current bid from the selected vendor

Bid history from current vendor

Bid overview for all current bids from all zones and vendors 

Future bids overview for all current bids from all zones and vendors 

Shows the records of users actions (requires special security rights) 

Navigation:  How to ... > Evaluate Prices >

Bids Current
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By selecting the item and right clicking it, a new context menu will appear, providing the following functions:

Insert and Properties will display the following window where a bid can be modified or newly created.

See Also:

The Tab Bids History will display the entire price history of the selected item from the selected vendor

Tab Bids History

will insert a bid for an item

delete the bid

shows the properties of the bids

 Bids History
 Bids Overview Current
 Bids Overview All Bids

Navigation:  How to ... > Evaluate Prices >

Tab Bids History
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By selecting this tab, the bid history of a single item can be viewed and analysed. In contrast to the Current Bid Tab it shows only expired bids from the 
selected vendor . 

Column Description are shown below the image:

See Also:

The Bids Overview Current will display the bids from all vendors for the item that was selected in the window above and that are 
currently valid.

Bids Overview Current

The Tab Overview Current is, along with the Bids Overview All Bids Tab, the function that enables the user to do price comparisons, and to decide, based on 
this comparison and other purchasing related questions which will be the standard supplier for the item.

Valid From: Date from which bid was valid
Valid To: Expiration date of bid
Bid Price: Bid price in vendors currency
Unit: Shows item base unit
Currency: Shows bid currency
Estimated: Original estimated quantity
QTD: Quantity purchased until expiration date
Vendor Code: Vendor's item code
Brand: Item brand
Comments: Comments
Minimum: Minimum quantity per order
Date: Date bid was created or bid's properties were changed

 Bids Current
 Bids Overview Current
 Bids Overview All Bids

Navigation:  How to ... > Evaluate Prices >

Bids Overview Current
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The items or articles are selected the same way as in Bids Current and Bids History.
The bids will then appear in the detail window with the cheapest  bid always listed on top and the most expensive at the bottom.

Default Vendors are those that during the automatic purchasing process, these bids will be selected to place an order with the 
assigned vendor.

After the assignment is done the default bid for each zone will appear in the small split window to the left of the bid view. 

See Also:

By selecting an article and then right 
clicking, the following context menu 
appears:

With these options we can assign the 
defaults as follows:

Set the selected bid as default for all zones.
All purchases will be placed with this vendor.
Will unset the bid and it will no longer be the default for all zones.

Will set the selected bid as default bid for one zone only, in this 
case Europe.

 Bids Current
 Bids History
 Bids Overview All Bids

Navigation:  How to ... > Evaluate Prices >

Bids overview all Bids
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The difference between this option and Bid Overview Current is that this option is used for assigning bids to a future starting date.

Bids Overview all Bids: 

The Tab Bids Overview all Bids is, along with the the Tab Overview Current, the function that enables the user to do price comparisons, and to decide, based 
on this comparison and other purchasing related questions which will be the standard supplier for the item.

This function enables a well organized purchasing department to switch vendors on specified dates and to ensure that the bid function can be used without 
interruptions caused by periods without bids.

Double Clicking on a Bid will guide you to the following Dialogue:

See Also:

The Defaults button is an option that displays all the defaults bids with item and zone for a single vendor selected in the left hand 

 Bids Current
 Bids History
 Bids Overview Current

Navigation:  How to ... > Evaluate Prices >

The Defaults Button
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drop down menu.

Displaying Vendors Defaults

After placing bids and default vendors for items into the system the 'defaults' button on the top 
of the toolbar can be used to show all the default items per Vendor, Store or Zone

As an example in the picture below it shows all default items per vendor for the food store in all zones:
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Navigation: »No topics above this level« 

Frequently Asked Questions

This can be made provided that you have updated the exchange rate under Options / Currencies Exchange rate accordingly.

The articles on the Bid file are exported in a pre-defined format and this includes the sorting order of articles. Currently this is not possible.

By clicking the description Column header the system will display the articles in alphabetical Order.

Currently the Notes entered are not considered in the Search query criteria.

No actual template files exist but you may export an empty file without data to simulate a file that can be imported into MMS.

Quantity that has been purchase until Expiration date of Bid

This column indicated the estimated consumption for the selected article.

 We want to have all the bids from a vendor in Brazilian Reals and then the day that we make the PO apply the
exchange rate in the system to €uro. Is this possible ?

 When creating bids, is it possible for the articles on the Excel spreadsheet to be in alphabetical order i.e. same
as on the screen? This would make it easier for vendors to quote on.

 Is it possible to have the description field displayed in alphabetical order in Quote manager ?

 We are adding vendors to MMS but do not always order from them or add quotes. Would it be possible to search
for a supplier by details entered in to the Notes / Comments tab? e.g. if we entered plumbing in this tab, we
could search for all plumbers on MMS.

 Are Excel template files available, which could be used to import items in to MMS?

 What does QTD mean in quote manager?

 When you raise a new bid for an item in quote manager there is a field 'Estimated'. What is this field used for?
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Receiving Module Top Next

The Receiving Module is mainly used by the vessels and warehouses to load/offload goods. 

Receiving main screen 

The image below represents the receiving module main screen as it looks once opening it. On the top are the main Function Buttons and below, the 
screen is divided into three main sections displaying a calendar which displays different colors depending on which Overview has been selected. At 
the very bottom is displayed information on the operational unit, date & time, current user, computer name, database in use and the module version 
number.

Moving the mouse over the screenshot 'hotspots' will change the cursor into a 
Clicking on these links will provide more detailed information on the particular topic.

Menu Bar Top Previous Next

The menu bar contains the basic and most frequently used options for searching, exporting into Excel and printing reports.

Available functions in the menu bar
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Search:    Opens the document with the search engine.
Refresh:     Will return they layout of the screen to its default state.

OwnerShip: Will allow the transfer of the ownership of a receiving from one user to another.

Print: Allows the user to print loading documents.

Export to Excel: Exports the active information related to loadings into Excel.

Exit: Closes the Receivings module.

Button: Search Top Previous Next

This option opens the search engine, allowing to search for a document in the receivings module.

Button Search:

Click to open the document search engine.

A Purchase Order can be searched by entering the PO number or by using any of the pre-defined filters. One or more filters can be chosen in order 
to narrow your search. 

After making selections, and clicking the search button, the documents meeting the search criteria will be displayed.

Note: The search engine will stay active as long as it is not deactivated! If your search is
finished make sure you press the search button once more to end the search!
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Button: Refresh Top Previous Next

This option refreshes the screen layout. For example, having sorted columns by their heading or resized them, clicking refresh will reset 
the layout to their original view.

Button Refresh: 

By clicking here you will be able to refresh the screen layout.

Button: Ownership Top Previous Next

The function Ownership allows one user to assign the ownership of an open receiving to another user.

Transferring the ownership for a receiving to another user

Find the open Receiving and select it.
Once selected the option Ownership in the menu bar becomes active.
Click on OwnerShip, select the new owner from the list and click on Assign.
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Button: Print Top Previous Next

Depending on your system configuration it is possible to print the loading documents using the print functionality directly within the 
receivings module.
If you system is not preset up with a link to the loading documents it will open the print manager for your convenience.

Button Print: 

Open a loading document.
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Click on Print.

As explained before depending on the setup of your system the report manager will open and allow the user a free selection of the loading 
document.

Or the pre-setup report will open and the user can print the report directly.
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Button: Export to Excel Top Previous Next

This function allows the user to export the contents of the active screen to an external Excel spreadsheet. 

Exporting to Excel: 

Click here when the desired document for exporting is open on the screen.

In the following an export window will open.

Main Screen



To continue click "Export".

As soon as the export has finished an Excel spreadsheet with the selected items will appear on your screen.

This data can now be saved, manipulated, etc. according to user's needs.

Button: Exit Top Previous Next

This option will close the Receivings module.

Button Exit: 

Click here to close the Receivings module

Menu: File Top Previous Next

This menu offers the option to open the order details of a loading, the option to export to Excel and printing the currently open loading 
document.

File : 

OPEN:   

EXPORT:

PRINT:

Will export the current view to an Excel sheet.

Depending on the setup of MMS using the print button will open a 
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EXIT:

predefined loading document or it will open the print manager.

Will close the Receivings module.

Menu: Edit Top Previous Next

The Edit menu contains options to open a current receiving, re-assigning ownership, deleting and finalizing the loading. Furthermore 
loading properties can be edited. 

Edit : 

OPEN:        

OWNERSHIP:

CLOSE AND LOCK:

DELETE:

PROPERTIES:

Will open the order details. 

Allows the current user to assign the ownership of the 
order to another user.

Allows the user to close and lock the loading. Please 
keep in mind that only orders that have matching values 
between the order and the receiving can be closed and 
locked.

Allows the user to delete an open loading.

Allows the user to edit the properties of the loading 
document.

Menu: Help Top Previous Next

Help : 

CONTENTS:   

SEARCH:

ABOUT: Open a window which provides the user with background 
information about the software of the receivings module, e.g.: the 
software version and which company it is registered to.

Menu: Windows Top Previous Next

The Windows menu allows the user to change how the windows and screens are displayed on the layout.

Windows : 

Arrange All: All windows will be arranged in order.
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Split: All windows will be split and all shown on 
the screen.

Entity Selection Top Previous Next

Here you can select the entity for which you want to receive the goods for.

Entity selection:

Open the drop down menu and select the entity you want to receive goods for.

Depending on your setup this can be a container, a warehouse or a ship.
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Depending on your security rights you might not see the entire fleet but only your ship.

Calendar Top Previous Next

The Calendar is intended to give the users a good overview of all receiving activities for the current month.

By scrolling through the calendar it is possible to look at future as well as past dates.

Calendar - coloring schema

Open the drop down menu and select the entity you want to receive goods for.

Depending on your setup this can be a container, a warehouse or a ship.

Light Blue shows the currently selected date.

Orange for past dates indicates CLOSED RECEIVINGS and WAREHOUSE TRANSFERS.

Orange for current and future dates indicates outstanding PURCHASE ORDERS and WAREHOUSE TRANSFERS.

Yellow for past and current dates indicates outstanding PURCHASE ORDERS.

Loadings View Top Previous Next

The loadings overview is giving the user a quick navigation tool to all.

Loadings
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My Receivings - gives an overview about the currently logged in user's receivings which are open or within the current period.
All Receivings - gives an overview about all receivings, currently open and within the current period. 

Summaries

Quick View

The Quick View allows the user to get a quick and brief overview of the content of each purchase order, receiving, warehouse transfer or container.

Receiving Overview
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The Receiving Overview is showing the details for the currently selected purchase order and the linked loading documents. 

Purchase Order Overview Top Previous Next

The Purchase Order overview provides the user a good overview over all existing Purchase Orders for the selected date.

From this view the user can open a Purchase Order in order to create the loading document and process the receiving.

Overview of Purchase Orders for selected date:
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In order to receive items for an existing PO on status 5 double-click the PO or click the right mouse button and select Open.

The information about the purchase order in the receivings module is purely informational. In case you need to modify a Purchase Order please go 
to the Purchasing Module.

  Note:

Only Purchase Orders in status 5 (Order confirmed Quantities) can be received! 

Order Details Top Previous Next

Double-clicking a purchase order in status 5 or a loading on the receivings tab will open the order and loading details. Only those 
purchase orders can be opened that are in status 5 and converted into a loading document.

Within this screen users are able to view in detail the items belonging to the purchase order.

Order Details:

Code: Unique item code.

Description: Item description.

Unit: Unit of measurement for the item.

Ordered: Quantity ordered from vendor.
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Confirmed: Quantity confirmed by vendor.

Received: Quantity received on board.

Price Ord: Item price as confirmed by vendor.

SubTotal: Total value of items order.

Total Disc%.: Total applicable discount in percentage.

VAT%: Value added tax in percentage.

Total: Total value including taxes and discount.

Tax Group: Name of tax group item belongs to.

Posting Group: Name of the posting group this item belongs to.

Tax%: Percentage of tax on the item.

Deductable%: Applicable percentage for price deduction.

Loading Details Top Previous Next

Within this screen users are able to view items in detail which have been added to the loading document. 

Loading Details:

S: Once this column shows the  sign you are required to enter a Product LOT or Serial Number. In the article manager the item is enabled to 
force the logging of a tracking of a serial number or a LOT/ batch number. Please see Article Manager.

Code: Unique item code.

Description: Item description.

Unit: Unit of measurement for the item.

Vendor Amount: Total amount of received goods, according to delivery note or invoice.
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Vendor Price: Final price of the delivered item according to the delivery note or invoice.

SubTotal; Subtotal of the delivery for the selected item.

DISC: Is a discount applicable for the item.

Item Discount: Total value of item discount in %.

Total Discount: If multiple discounts apply for the item, the total discount in % is shown.

Tax%: Percentage of tax on the item.

Total: Total amount for the selected item reduced by discounts and tax added.

Tax Group: Name of tax group item belongs to.

Posting Group: Name of the posting group this item belongs to.

Tax%: Percentage of tax on the item.

Deductable%: Applicable percentage for price deduction.

Expire Date: Expiry date of the loaded item.

Serial/Lot: This field requires the user to enter the Serial or batch/ lot tracking number. Depending on the setting of the article the system will not 
allow to leave this field blank.

Comments: Free entry field for user comments.

By right clicking on one of the items in the Loading Details screen the following window will appear:

Transfer Item

By right clicking on the item in the Loading Details screen and selecting "Transfer Item", the following screen will appear:

Add New Loading Document: by selecting this option it is possible to create a new 
loading document

Manually Add Item: by selecting this, items can be added via the search engine by 
entering their specific code or description

Transfer Item: the quantities of the selected item can be transferred to another 
product (see detailed description below)

Delete: deletes selected item

Refresh: updates the screen with the latest information

Insert from Purchase Order:

Update Quantities using Scanned Amounts: will update the number of items 
according to the amount that has been scanned via MMS Mobile

Add Action Event: by selecting this an event can be created regarding the standard 
of the delivered item or whether the delivered goods are incorrect (see below for 
further details)
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Either by selecting the unique code for the item or entering its description, the search engine will find the item in question.

The quantities will then be transferred from the original item to the item that has been searched.

The original item will still be seen in the loading document, however with 0 quantity.

The newly added item will have the quantity of what the original item had in the first place.

Add Action Event

By right-clicking and selecting "Add Action Event", the user will be able to add a detailed evaluation of the received items

Type:

Item Delivered Damaged

Poor Product Standards

Short Delivered

Wrong Item Delivered

Assigned To: to whom the event is allocated to

PO ID: identification number of purchase order

Received: when and where the goods were received

Resolution Type:
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Comments: additional comments can be entered here

Further information can also be found under the topic Action Events.

Vendor Evaluations Top Previous Next

The tab Vendor Evaluations allows the user to evaluate the performance of the vendor by answering predefined questions. Performance 
related details and questions can be customized according to ship operation.

Vendor Evaluations:

Depending on the question, users are able to answer with "1" or "0" meaning "Yes" and "No", respectively

Evaluation Groups View

By selecting the specific evaluation group, only corresponding entries will appear in the right side of the screen.

Vendor Evaluation View

A pie chart view of overall "performance" of the vendor. (Yellow: Unsatisfied; Green: Satisfied)

Question View

List of questions considering vendor evaluation.

Action Events Top Previous Next

Action Events are intended for the ship to report issues during the loading that might need a shoreside representative to become active 
and follow up with the vendor.

Action Events:
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In order to send an action event the user should open the Loading Details view and select the item for which the event should be recorded with a 
right mouse-click.

Select Add Action Event.

Shoreside the Action Event needs to be processed in the Purchasing Module. For processing of the action event please refer to Purchasing -
Action Events.

  Note: The field resolution type will stay blank as this is filled in shoreside by the assigned 
employee!

Logs Top Previous Next

The tab logs is intended to provide the users and administrators a quick overview of all movements that happened from the moment of 
registering the loading document.

Logs:
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Date: Date when the action was done.

Time: Time when the action was done.

Group: Group to which the user belongs.

User: User logged on to the MMS module who performed the action.

Workstation: Name of the PC on which the user accessed the module to perform the action.

Event: More or less detailed explanation of what kind of action happened.

Receivings Overview Top Previous Next

The loading overview gives the user a quick overview over all open and closed loadings for the selected date.

Overview Loadings for selected date:
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Type: the form of which the items have been received

Status:

Open: Items have not yet been loaded on board 

Closed: Items have been loaded on board

Doc#: unique number of the document

Vendor: name of the supplier

PO: unique number of Purchase Order

DC Value: total value of document in the currency of the supplier

RC Value: total converted value of document in the default currency of MMS

CUR: the abbreviation of the set MMS currency (USD, EUR, GBP etc)

Owner: name of the user creating the document.

By double clicking a Receiving, the Order Details screen will appear.

A right mouse-click on a loading offers you the following options:

Open:

Ownership:

Close and Lock:

Delete:

Properties:

Will open the order details.   

Allows the current user to assign the ownership of the 
order to another user.

Allows the user to close and lock the loading. Please 
keep in mind that only orders that have matching values 
between the order and the receiving can be closed and 
locked.

Allows the user to delete an open loading.

Allows the user to edit the properties of the loading 
document.
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Warehouse Transfer Overview Top Previous Next

Within this screen the details of all warehouse transfers show that are to be received on the selected date.

Warehouse Transfers:

Source: the origin of the warehouse transfers where the items are sent from

Status: shows the current position of WHT

Transit

Posted

Open

Received

Destination: shows the target of the WHT

Port: according to the date this column will be updated automatically depending on the ship's location

Via: whether the loading has arrived via container

Value: total value of WHT

Gross Weight: total weight of the WHT in kilograms 

By right-clicking on one of the WHT the following options will be available.

Process: opens a new window for creating a New Warehouse Document

Print:

Delete:
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New Warehouse Document Top Previous Next

New Warehouse Document:

LOADING DETAILS

Date: day of the loading

Source: the origin of the warehouse transfers where the items are sent from

Transfer Id: unique identification for the specific warehouse transfer

Type: type of transfer

Document Reference: reference number of document

Document Type: There are 4 possible types of documents to choose from

None

Delivery Note

Invoice

Receipt

Store: major group of where items belong to

Actual Cost: the total real cost of the items

Fixed Cost

Variance%

Once the loading details have been entered, by clicking on "Apply" the new Warehouse document will be created. 

PROPERTIES

On the top right hand side of the screen "Doc Number: xxxxxxxxxx" in red will appear.

When the new warehouse document has been created only after then will the rest of the tabs be available on the bottom part of the screen as well 
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as more information in the properties screen.

DETAILS

By opening this tab the items and their details from the warehouse transfer will appear in the window

LOGS

Within this tab users are able to view what changes (by whom, where, time etc) have been made. 

Code:unique code of item

Description: full name of item in 
MMS

Vendor Amount: number of 
items vendor is able to issue

Vendor Unit: unit of 
measurement

Vendor Price: price per item

SubTotal: total value of items 
ordered in vendor currency

Discount%: percentage of 
discount (if applicable)

VAT%: percentage of value 
added tax

Total: Total value of items 
ordered in the default currency of 
MMS

Expire Date: date of expiration of 
items

Comments: messages that have 
been added when creating the 
warehouse transfer
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COMMENTS

Within this tab users are able to enter comments in regards to the warehouse transfer document.

Date: Day of the event

Time: exact time of the event

Group: name of users group

User: name of user creating 
event

Work Station: computer name 
where the event was created

Event: exact description of the 
event

Container Overview Top Previous Next

Container Overview:
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Status: shows current status of container (Open/Closed)

Id: Unique identification number of container

Vessel: Destination of container

Size: Container size

Type: Type of container:

Frozen - 20 C

Non Refrigerated

Refrigerated 5 C

Comment: any message can be entered in this window

Serial: Container serial number

BOL: Bill of Ladings Number

Count: Number of Items

Value: total value of container

By right-clicking on one of the containers the following display will appear:

Process: will allow the user to process a loading document

Print

Delete

New Container Document Top Previous Next

New container document:

Main Screen



LOADING DETAILS

Date: day of the loading, will fill in automatically.

Container ID: unique identification for the specific container transaction.

Document Reference: reference number of document

Document Type: There are 4 possible types of documents to choose from

None

Delivery Note

Invoice

Receipt

Store: major group of where items belong to

Actual Cost: the total real cost of the items

Fixed Cost:

Variance%:
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How to... Top Previous Next

Under this topic users will find useful information in consideration of how to effectively use the Receivings 
module

How to...

... load a Purchase Order

... receive goods to load a container

... receive a container

...load a purchase order Top Previous Next

This ...how to is intended to explain basic steps on how to convert a Purchase Order in status 5 into a 
loading which is being received.

Open an existing PO:

there are several options to open an existing purchase order:

1) Double-click on the line of the PO.

2) Right-click on the line of the PO and select open.

3) In the menu bar select File - Open.
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As soon as the purchase order is open two menu buttons become active:

Add loading document:

When selecting Add loading document the following entry mask will open and needs to be filled in.

DATE:

DOCUMENT 
REFERENCE:

DOCUMENT 
TYPE:

LOADING TYPE:

Select the date 
for which you 
are receiving 
the loading. By 
default it will be 
today.

Enter a 
document 
reference. 
According to 
your operational 
guidelines 
provide a clear 
document 
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GLOBAL 
DISCOUNT:

VAT:

TOTAL PER 
DOCUMENT:

CURRENCY:

TRANSFER TO 
POC:

SHIP VIA 
CONTAINERS:

reference.

Select the kind 
of document 
you were 
receiving with 
the delivery 
(delivery note, 
invoice, 
receipt).

Select the type 
for the loading. 
(Received from 
vendor, 
received from 
other ship, etc.) 

Please note 
document and 
loading types 
might vary from 
site to site as 
this is 
customizable 
information!

Enter the global 
discount 
amount if any. 
The discount 
will be applied 
to every item 
within the 
loading 
document which 
is set in the 
DISC column to 
YES.

Select the VAT 
that applies to 
the delivery.

Enter the total 
value for the 
loading 
according to the 
delivery 
document. 
Please keep in 
mind that in 
case you are 
entering a 
return the 
entered amount 
needs to be 
negative, 
e.g.: -123.12.

Select the 
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currency in 
which the 
loading 
document was 
issued.

Each loading 
entered with a 
loading 
document can 
automatically be 
transferred to a 
POC instead of 
the main store.

Check this 
option if the 
items are being 
received for 
being inserted 
into a container. 
When receiving 
a PO which is 
flagged as Ship 
via Container 
the field is 
checked by 
default.

ADD ALL ITEMS 
FROM PO TO 
THIS 
DOCUMENT:

ADD ALL ITEMS 
THAT HAVE NOT 
BEEN RECEIVED 
YET:

DO NOT ADD 
ITEMS 
AUTOMATICALLY
TO THIS 
DOCUMENT:

Selecting 
this option 
will 
automatically 
transfer all 
the items on 
the PO to 
the newly 
created 
loading 
document.

Selecting 
this option 
will add all 
the items 
from the PO 
that are not 
on any 
previous/ 
other loading 
document to 
the newly 
created 
document.

Selecting 
this option 
will not add 
any items to 
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the newly 
created 
document. 
The user 
needs to 
manually 
add (e.g.: by 
dragging 
and 
dropping or 
doing a right 
mouse-click 
in the order 
details view) 
the received 
items to the 
newly 
created 
document.

...receive a container to load Top Previous Next

This ...how to is intended to explain the procedure on how to receive goods in order to load them into a 
container

Prerequisites:

All requested items to be shipped with a container need to flagged in the purchasing module as Ship via 
Container.

How to...



All purchase orders flagged Ship via Container within the purchasing module can be found in the Receivings 
Module when selecting containers from the Entity Selection.
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The container in which the purchase orders are to be inserted needs to be created in the Container module.

How to...



Receive items on the purchase order:

In the next step the items from the purchase orders need to be received for the entity container.

The same procedure applies as explained in ...load a purchase order.

Open the purchase order and create a loading document.

Attention: Before completing the loading document make sure the option  is checked!

Create the container:

To create a container click on the Add Container button.
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A dialogue box opens which allows the user to select which container the items should be added.
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As soon as the container shows, the items that are to be inserted into the container can be added by dragging 
and dropping from the loading details of the loading document into the newly created container.
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When all purchase orders have been received and inserted into the container, the content of the container can 
be seen in the Container Module.

...receive a container Top Previous

This ...how to is intended to explain the procedure on how to receive a container onboard the vessel.

Prerequisites:

Before a container can be received onboard it must be flagged in the head office as status 1 - in transit.
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Receive a container:

In order to receive a container double-click the line on the containers tab and a new container document will 
open.

How to...
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The Recipe Manager is used for setting up recipes to be used in the various Food & Beverage outlets (Points of Consumption). 
The library may contain recipes for both Food and beverage items and may not only contain the necessary ingredients and 
related quantities required to prepare a specific product (ie Gin & tonic, club sandwich) but can also store additional preparation 
instructions, photographs and cost calculations among others. This information may be used to maintain set company standards 
accessible to those who need references in preparing the various items.

The setup of recipes performs a stock deduction in the specified amounts once an article is sold via the Point of Sales System 
making real time stock victualling possible. This option is called the Sales import. 

Recipe Manager Main Screen: 

The Main screen of the Recipe manager is divided into three main sections as follows : 

Moving the mouse over the screenshot you will be able to activate 'hotspots' identified with the cursive lining 

changing to a . Click on these to jump to more detailed information about that particular button or window. 

Navigation:  Reference >

Recipe Manager : Main Screen

 At the top left area of the screen are located the main function Buttons and the toolbar through which the most common functions are accessible.

 On the right hand side of the screen are located the folders for the Recipe for Beverage Articles related library and Menu for managing entire series
of items as Menus..

 The main screen is dominated by the Recipe Details list from which individual preparation details are accessible.
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The buttons toolbar contains the basic and most frequently used options for Recipe related operations such as Searching Items, 
Creating New entries and printing items.

Buttons: 

Clicking the buttons below or the links will open more information and instructions on the usage of these functions.

Most of the options have corresponding tools in the menu, keyboard shortcuts assigned to them or, are available with a right mouse click.  

To locate a specific piece of information, the Recipe manager is connected with the software database though a search engine, 
that allows to search for a specific Recipe or Menu with different categories.

Button : Search

1. Inserting a known barcode or product code the search engine will list those recipes that contain the
specific ingredient

2. Inserting a description or a cocktail name the search engine will list those recipes meeting that criteria.

3. Selecting one of the available categories, the software allows to browse through the specific recipe 
descriptions to locate a specific one.

Navigation:  Reference > Main Screen >

Buttons

Search The Search module will open the Search engine for Recipes.
New Start the creation of a new recipe
Print Opens the report manager
Refresh Refresh the screen layout
Exit Exit the Recipe Manager module

Navigation:  Reference > Main Screen > Buttons >

Button : Search

Click to open the Search engine

 The search engine allows to locate a created recipe or Menu with three different search criteria :
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In order for the system to deduct items from the POC (Point of Consumption) inventories, it needs information pertaining to the 
ingredients of each cocktail. For this reason every cocktail recipe needs to be entered into the system before running the Sales 
Import.  To create the recipes and for general recipe maintenance, follow the sequence outlined below. : 

Create a New Recipe

 Upon finding a suitable match the system will bring the search results on the right hand side of the Search engine screen.

Navigation:  Reference > Main Screen > Buttons >

Button : New

 Open the recipe manager in the Launch Panel and select the correct recipe folder before initiating the process.

Click to Create a New Recipe

 The Creation Wizard will open
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Code 
The system categorizes and further recognizes the recipes using individual codes. Assign each created recipe
with a unique identification. Please note the recipe codes are different from the product codes.

Description 
Insert a description for the recipe. (Bloody Mary, Tom Collins etc.)

Category 
Assign the drink recipe to a specific category from the drop down list..

Main Ingredient
Select the main ingredient of the drink from the drop down list..

To make a new addition, scroll to the end of the Main Ingredients drop down list until "..." appears. 
Clicking on these three dots opens a "Customize Lists box".

 Insert the minimum required information about the cocktail - Code, Description, Category and Main Ingredient

 If the main ingredient is n.1ot in the list, it can be added 'on the fly' during the creation process.
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To add an article click 

after the last one in the list. Click on the Code column to sort the codes from low to high. 

Cuisine Type
If a food recipe is created, assign a cuisine type (French, Japanese, Oriental etc)

Number of Servings
Insert the number of servings (portions) the recipe has been calculated to cover.

 The system requires a unique code.  Normally, the most practical way is to choose the next available number

 Type the desired number in the field provided and press

 Then click the field next to the new item number and type in the description.

 Return to the creation process and select the item that was added to the items list.
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Serving Description
If there are any particular serving instructions which must be followed, insert this information here.

Selling Price
Insert the sales price into this field.

Preparation Time (HR)
Insert the estimated time needed for preparation in this field.

Cooking Time (HR)
Insert the estimated time for cooking needed in this field.

The Cocktail will appear in the main category that was selected prior to the creation process.

ingredient quantities are inserted. 

Adding items to the Recipe.

selection menu for the drink type. 

Disabled

 Upon having completed the standard information Click

 Double clicking on the created description will open the ingredients screen where the

 Positioning the Cursor on the first cell of the first column and pressing a key on the keyboard will open a 

 The options in this menu are :
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Recipe or item is not currently in use or not needed

Item
An individual item is used as an ingredient of the drink or cocktail.  This is the most common case in creating 
cocktail recipes.

Recipe
If a complete other recipe is used as a component of the drink to be created, and you wish to locate this recipe,, 
you can start the Search Manager by pressing the “+” button and the search engine will open to locate the recipe.

Make your selection by double clicking the entry or pressing enter. This will move the cursor to the next column.
In this field it is necessary to locate the individual products from the Article Manager that are components of the 
drink or cocktail to be created. Type the component name in the search field and select the correct ones from the 
search results.

After inserting the items into the Cocktail Components list, it is necessary to insert the quantities. 
At this point the bottle size and in which proportion it will be needed must be defined.
Start the Search Manager by pressing the “+” button and the Search Engine will open to locate the articles.

The Formula for calculating the correct amount with the right conversion factor follows the formula : 

Required Quantity in centiliters
   Bottle size in Centiliters       = AMOUNT NEEDED

For example. 

If 4 centiliters are needed and a Bottle of 1 LTR of the ingredient is used the quantity may be calculated as follows:

4 CL 
100 CL: 0.04

However if the bottle is 75CL and the 4 CL is still needed then the calculation will be as follows:

4CL
75 CL: 4 / 75 = 0.05333

Provided that the cost prices in the Article Manager and the conversion units are correct, the 
price per unit will appear in the corresponding column.

Besides the ingredients, the system allows for additional information regarding the recipes to be added. 
These categories can be found by opening the tabs on the lower part of the screen.

are needed in connection to the recipe created.

Please note that it is recommended to keep the photograph resolution on a low level in order not to overload
the system with unnecessary data traffic over the satellite uplink.

Date of change, workstations where the changes have been made can also be viewed within this tab.

 Under the Preparations & Notes tab, text can be pasted regarding specific preparation information.

 Under the Documents Tab the system allows different types of supporting files to be attached, that perhaps

 Under the images tab photographs of the recipe can be added to assist in the creation / production phases.

 Under the logs tab users will be able to see changes that have been made, as well as the users making the changes.
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This option opens the Report Manager. This option is also available in Menu; File ->Print.

Button Print: 

This option refreshes the screen layout. For example, ónce having sorted columns by their heading or resized them, clicking 
refresh will reset the layout to the original view.

Button Refresh: 

Navigation:  Reference > Main Screen > Buttons >

Button : Print

Click to open the Report Manager.

Navigation:  Reference > Main Screen > Buttons >

Button : Refresh
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This option will close the Recipes Manager. The option is also available at Menu; File -> Exit.

Button Exit: 

The folder tree represents the groups and subgroups for items within Recipe Manager. The groups act as the main category of 
recipes or menu types which then again house each independent Drink recipe or Food menu. 

Tree of Folders: 

To view the ingredients, first select the recipe type.

Click to refresh the screen layout.

Navigation:  Reference > Main Screen > Buttons >

Button : Exit

Click to close the Recipe Manager Module

Navigation:  Reference > Main Screen >

Tree of Folders
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...then select the recipe group

By selecting a folder and then using a right mouse click, the following menu will appear:

Open Cut a folder to move it
New Create a New Recipe
Delete Delete an existing folder
Properties Display selected folder 

information

Most of these options are also available as keyboard shortcuts or can be found in the Toolbar.

You can drag and drop folders the following way :

Left click on the folder you wish to move to select it, hold <SHIFT> on the keyboard and then drag the folder to the desired 
location.
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By selecting "Recipe" from the drop down list will activate the folder library for Creating a base for accessing the recipes for both 
Food and Beverage articles.

Recipe Management: 

decided according to company policy as by default the recipe folders do not exist and have to be created.

This will open a selection window for the most common operations for handling 
the information.

Insert Folder: 

Navigation:  Reference > Main Screen > Tree of Folders >

Recipe Manager : Food and Beverage

 The folders may be created by categorizing the recipes by product type or other criteria. This may be

 The folders may be managed by right clicking any area of the folder list.

Insert Folder

Rename Folder

Delete Folder

Expand Folders

Collapse Folders

Insert a new folder or Sub-folder in the selected Category

Rename an existing Folder or Sub-folder

Delete a selected folder

Expand the view to show all existing folders

Shrink the view to show only main Folders without sub-folders

Navigation:  Reference > Main Screen > Tree of Folders > Recipe >

Recipe : Folders
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Rename a Folder: 

Select the desired name and press Enter to confirm the entry.

 To insert a new folder in the Library Right Click pointing the cursor in the Folder in which you wish to create a new Sub-folder.

 This will open a selection window. From this list select Insert Folder.

 The system will create new folder or sub-folder in the position selected waiting for the user to insert a name for this new folder.

 Select the desired name and press Enter to confirm the entry.

Navigation:  Reference > Main Screen > Tree of Folders > Recipe >

Recipe : Folders

 To Rename a folder in the Library Right Click pointing the cursor in the Folder which needs to be renamed.

 This will open a selection window. From this list select Rename Folder.

 The system will enable the user to insert a new nominative for the folder.
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Delete a Folder: 

In the case that the folder to be removed is not empty the system will display a notification that the folder needs 
to be empty prior to attempting to remove it. In this case the recipe items need to be emptied from the folder before 
continuing,

Expand Folders: 

Navigation:  Reference > Main Screen > Tree of Folders > Recipe >

Recipe : Folders

 To Delete a folder in the Library Right Click pointing the cursor in the Folder which needs to be deleted.

 This will open a selection window. From this list select Delete Folder.

 The system will ask for a final confirmation for removing the folder or sub-folder.

 To accept the selection please choose YES and the system will update the view with folder being eliminated.

Navigation:  Reference > Main Screen > Tree of Folders > Recipe >

Recipe : Folders

 To Expand the folder view in the Library Right Click in the folder area.

 Select expand folders
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Collapse Folders: 

 The initial view will be expanded to show all available folders existing in the library.

Navigation:  Reference > Main Screen > Tree of Folders > Recipe >

Recipe : Folders

 To Colapse the folder view in the Library Right Click in the folder area.

 Select collapse folders

 The initial view will be collapsed to show only the root folder of  the library.
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By selecting Menu from the drop down list will activate the folder library for creating a base for accessing the Food Menus. 

Menu Management: 

This may be decided according to company policy as by default the Menu folders do not exist and have to be created.

Insert Folder: 

Navigation:  Reference > Main Screen > Tree of Folders >

Recipe Manager : Food and Beverage

 The folders may be created by categorizing the Menus by a theme or other criteria all dependant on how the setup is.

 The folders may be managed by right clicking any area of the folder list. This will open a selection window for the most common operations for
handling the information.

Insert Folder

Rename Folder

Delete Folder

Expand Folders

Collapse Folders

Insert a new folder or Sub-folder in the selected Category

Rename an existing Folder or Sub-folder

Delete a selected folder

Expand the view to show all existing folders

Shrink the view to show only main Folders without sub-folders

Navigation:  Reference > Main Screen > Tree of Folders > Menu >

Recipe : Folders

 To insert a new folder in the Library Right Click pointing the cursor in the Folder in which you wish to create a new Sub-folder.

 This will open a selection window. From this list select Insert Folder.

 The system will create new folder or sub-folder in the position selected waiting for the user to insert a name for this new folder.
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Rename a Folder: 

Select the desired name and press Enter to confirm the entry.

Delete a Folder: 

 Select the desired name and press Enter to confirm the entry.

Navigation:  Reference > Main Screen > Tree of Folders > Menu >

Recipe : Folders

 To Rename a folder in the Library Right Click pointing the cursor in the Folder which needs to be renamed.

 This will open a selection window. From this list select Rename Folder.

 The system will enable the user to insert a new nominative for the folder.

Navigation:  Reference > Main Screen > Tree of Folders > Menu >

Recipe : Folders
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In the case that the folder to be removed is not empty the system will display a notification that the folder needs 
to be empty prior to attempting to remove it. In this case the Menu items need to be emptied from the folder before 
continuing,

Expand Folders: 

 To Delete a folder in the Library Right Click pointing the cursor in the Folder which needs deleted.

 This will open a selection window. From this list select Delete Folder.

 The system will ask for a final confirmation for removing the folder or sub-folder.

 To accept the selection please choose YES and the system will update the view with folder being eliminated.

Navigation:  Reference > Main Screen > Tree of Folders > Menu >

Recipe : Folders

 To Expand the folder view in the Library Right Click in the folder area.
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Collapse Folders: 

 Select expand folders

 The initial view will be expanded to show all available folders existing in the library.

Navigation:  Reference > Main Screen > Tree of Folders > Menu >

Recipe : Folders

 To Colapse the folder view in the Library Right Click in the folder area.

 Select collapse folders
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Upon selecting a Recipe or a Menu from the folder library the contents of the folder will display on the details window on the left 
hand side of the screen following the information that has been inserted during the menu creation process.

 The initial view will be collapsed to show only the root folder of  the library.

Navigation:  Reference > Main Screen >

Recipe Manager : Details

 The Recipe or Menu information within the detail window is divided by columns. This information is collected during the New recipe creation
process.

 Each Recipe or Menu may be viewed in detail by double clicking the corresponding line.

 This opens the actual Recipe Ingredients list or Menu details to the window in which the ingredients may be observed.

 On the lower part of the screen are the located the tabs that contain additional information that may be included in the recipes.
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The column headers contain the basic information on the recipes listed under each folder library. Each heading may be sorted 
by clicking the Column Header.

Column Descriptions 

The recipe details are listed by columns as follows : 

Unique code given to the Recipe or Menu during the creation process.

A description of the Recipe or Menu

Folder Category in which this particular item is stored in the folder library

The main ingredient needed in the preparation of the Recipe or Menu

Cuisine type : This may be the ethnic cuisine type : Japanese, Chinese, French etch

The number of servings that will be produced with the quantities indicated in the recipe or Menu

Serving Description : Particular serving instructions that need to be followed during serving.

Suggested sales price.

Recipe or Menu creator Name or Initials may be inserted in this space.

Preparation time. The time needed to prepare the specific Recipe or Menu item

Cooking time need to prepare the specific Recipe or Menu item

Once opening the Ingredients list, the contents of a recipe may be observed in detail.

Ingredients List: 

Navigation:  Reference > Main Screen > Recipe List >

Recipe Manager : Column Desciptions

Navigation:  Reference > Main Screen > Recipe List >

Recipe Manager : Ingredients List
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See Also:

This part of the recipe Manager can hold preparation instructions and other necessary notes regarding the cocktail or Menu 
selected. The screen is divided into two sections each corresponding to a topic.

Preparation & Notes: 

 At the lower part of the window, the Tabs will always remain visible and can be opened for to view other details of the recipe.

 Each Ingredient is listed with the details that have been inserted during the creation process.

 Adding items to the recipe

Navigation:  Reference > Main Screen > Recipe List >

Recipe Manager : Preparation & Notes

 At the lower part of the window, the Tabs will always remain visible and can be opened for to view other details of the recipe.

 The Upper part of the screen houses the Generic preparations instructions on how to prepare the specific item. This information can be pasted on
the area as text.

 The Lower part can contain any other information that may be necessary regarding the recipe or menu. For example this part can hold fact about
the history of the recipe or Menu or other information that otherwise would not be possible to remember. 
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The documents tab open the corresponding space for storing documents related to the recipe or Menu. In this space it is 
possible to attach documents that are for instance more useful as references than simple text pasted under the Preparation & 
Notes tab.

Documents: 

Navigation:  Reference > Main Screen > Recipe List >

Recipe Manager : Documents

 At the lower part of the window, the Tabs will always remain visible and can be opened for to view other details of the recipe.

 To open a document in this space it is necessary simply to double click the document. The system will ask a confirmation to open the selection or
alternatively save it to another location or the local hard drive.

 Select open file to Open the selection

 Select Save file to disk if it is necessary to save the file on a disk or local hard drive.

 In this case the system will require a destination to be selected.
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The pictures for each recipe can be housed under the Images Tab.

Images: 

 To save select Save.

Navigation:  Reference > Main Screen > Recipe List >

Recipe Manager : Images

 At the lower part of the window, the Tabs will always remain visible and can be opened for to view other details of the recipe.

 Each recipe or Menu can hold up to six photographs. The space reserved for each picture can be adjusted by dragging the frame with mouse to 
suite the correct resolution and form of the image.

 To add an Image click on an empty area
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Logs:

Under the logs tab users are able to view all changes (date, time, user group, user that made the changes, work station where 

 The system will open a window to locate the image for the selected space. Locate the correct image file

 Upon selecting the file and accepting by pressing open, the image will appear in the selected space.

 For removing an image it is necessary to click on the image selected and accept the option.

Navigation:  Reference > Main Screen > Recipe List >

Logs
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changes were        made, description of event) that have been made within the recipe module.

The Menu bar on the top of the screen contains basic options which are also represented in the Buttons Toolbar and, often 
available also with a right mouse click.

Menu: 

This menu contains the options for printing and exiting the program

File Menu options: 

Navigation:  Reference > Main Screen >

Menu

Navigation:  Reference > Main Screen > Menu >

Menu : File

Print:

Exit:

Open the Report Manager for printing a recipe or details

Close the program
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The Edit Menu contains among the most common options, this menu contains the basic file options for Creating, Re-opening 
Movement transactions and Export / Import Excel Sheets. In addition to this the File menu also contains the option to open the 
Report Manager.

Edit Menu options: 

The properties menu holds the possibility to edit contents of a selected Recipe or Menu.

Properties: 

Navigation:  Reference > Main Screen > Menu >

Menu : Edit

Open :

New : 

   Delete :

Properties :

Opens an already existing transaction

Starts the process of creating a new Recipe

Deletes a selected recipe

Displays the properties of a selected recipe

Navigation:  Reference > Main Screen > Menu > Menu : Edit >

Menu : Edit -> Properties

 By Right clicking the Details area in the Main screen the edit menu will open.
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This information is equal to that inserted during the creation process.

The Windows menu allows to change on how the windows and screens are displayed on the layout during various phases in 
using the Recipe Manager.

Windows Menu Options : 

 By selecting Properties, the program will activate an edit window in which the contents of a recipe can be edited with the from the half of the
selected details.

 Upon completing to modify the details please select

Navigation:  Reference > Main Screen > Menu >

Menu : Windows

Arrange All

  Split

  Active 
Documents

Rearranges the windows back to the default view

Splits the selected views equally across the screen

This line displays the active documents
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Search a Recipe or Menu : 

For further information please follow the link below : 

Search a Recipe or Menu

Manage Folders: 

For further information please follow the link below : 

Managing Folders

Create a New Recipe: 

For further information please follow the link below : 

Create a New Recipe

Navigation:  How to ... >

How to... Search a Recipe or Menu

Navigation:  How to ... >

How to... Manage Folders

Navigation:  How to ... >

How to... Create a New Recipe

Search a Recipe or Menu



All the reports that can be produced within MMS are housed in the report manager. The reports are grouped in folders that each contain certain types of 
reports. Within the folders the reports may be previewed, printed and exported. Additionally, the system can limit access to the Reports to those who need 
the specific information. 

Report Manager Main Screen: 

These are the main options once having chosen the desired report. 

Buttons: 

Navigation:  Reference >

Report Manager Main Screen

Navigation:  Reference > Main Screen >

Main Screen Buttons

Export: - Export current report to various formats
Preview: - Preview current report
Print: - Print current report
Exit: - Close Print Manager
Expand All: - Expands the Tree with all sub-folders

Navigation:  Reference > Main Screen > Buttons >

Button: Export
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With this option it is possible to export a report to several different formats including those used in Microsoft Office applications.

Export:

In the drop down box, select the type of export that is to be performed. 
By default the following choices of formats are available :

 Note: 

Exporting can be divided into the following types based on the layout of the exported objects:

All exported objects are projected into cells, and each cell contains only one object. This behavior means that overlapping objects are shifted and placed in separate cells. The 
exported layout is not exactly the same as the report (objects can be shifted vertically and horizontally to the closest free cell), but the relative positioning of objects is similar to that of 
the report (except for any overlapping objects).

Exporting to text or records formats

System exports to text in one of two ways: record-based or page-based. The export behavior differs between these methods because a record-based export is meant to create a 
record set of data, while a page-based export is meant to produce a document to be read by users.
Exporting a report to Separated Values (CSV), Tab-separated text, or one of the Record styles is usually done for programmatic reasons. You might treat this exported text file as a 
database. Therefore, the program exports a separate column for each object that exists in your report. If you don't have any visible information in the Details section of your report, 
these options still export multiple records. For example, if there is one date object in your reports' Report Header, this date element is exported as one column but with multiple rows 
depending on how many hidden Details sections you have. This is true for any other text object in your report.

Click on the Export button and an Export dialog box will appear on the screen.

 Adobe Format (PDF) 

 Crystal Reports (RPT)

 HTML 3.2 

 HTML 4.0 

 MS® Excel 97-2000 

 MS® Excel 97-2000 (Data only)

 MS® Word

 ODBC 

 Record style (columns no spaces) 

 Record style (columns with spaces)

 Report Definition

 Rich Text Format

 Separated Values (CSV)

 Tab-separated text 

 Text

 XML

 When exporting to Text format, the export is based on characters per inch. 

 When exporting to Adobe Format (PDF), the output file is rendered in untagged PDF format.

 When exporting a report to a file format other than Crystal Reports format (.RPT), a loss of some or all of the formatting that appears in your report is possible. However, the program 
attempts to preserve as much formatting as the export format allows. 

 Exact exports are exports that preserve the layout and formatting of objects in the exported document. The exported document looks almost identical to the display on the Preview 
tab of the report being exported. Adobe Format (PDF), Rich Text Format, MS Word, and HTML are exact exports. 

 Line exports are exports that split a report's areas into lines and then project all report objects into the lines created. Lines are created with a height equal to 255 twips (or to the 
shortest object's height). The exported layout is not exactly the same as the report (some objects might be shifted vertically), but relative positioning among objects is similar to that 
of the report. Text format is a line export. 

 Cell exports are exports that split a report's areas into cells. Column creation depends on export options; for example, constant column width or column width based on X offsets of
the objects in a specific report area. Line creation is based on Y offsets of objects in the report. 

 Data exports are exports that are not meant to preserve the layout and formatting of objects. The exported objects' layout is section based. Separated Values (CSV), XML, Excel
(Data Only) are data exports. 
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This option allows to view the selected report onscreen before printing

Preview: 

The program gathers the required data, makes the necessary calculations and displays the report in the Preview tab. With the data in place, it is possible to review the spacing and 
formatting of the report and see the actual results of all summaries, formula calculations and record and group selections.
In true WYSIWYG (What You See Is What You Get) style, one can work directly on this live data, fine-tuning it until the report has the exact look wanted.

This function prints the report to the printer defined in Printer Options.

Print: 

Navigation:  Reference > Main Screen > Buttons >

Button: Preview

Click on the Preview button and a Print Preview dialog box will appear on the screen.

Navigation:  Reference > Main Screen > Buttons >

Button: Print

Click to begin printing. 
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When finished working, this option closes the the Report Manager.

Exit: 

The tree folder structures the reports into various groups and subgroups within Report Manager.

Tree of Folders: 

Click on the relevant folder to display the available reports in the Reports List. 

Click the + boxes to expand the sub folders.

Before clicking print, it is always a good idea to check the printer options on the Details tab of the report.

Navigation:  Reference > Main Screen > Buttons >

Button: Exit

Click to close the Report Manager.

Navigation:  Reference > Main Screen >

Tree of Folders

The tree folder on the left is the folder setup. By right clicking with the mouse on a 
folder, the popup menu below will appear.   

Insert Add a new folder/sub-folder to the 
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See Also:

Reports List makes visible the contents of a selected folder.

Reports List: 

Clicking on a report will open it in the Main Screen for it to be configured with the various parameters on the Tabs.

 Hint: To see all reports installed on your system please click on "Reports" in the tree.

The tabs on the right of the screen are visible to users depending on security settings. They contain various functions for reporting configuration.

Tabs

Folder: current folder
Rename: Rename an existing folder
Delete 
Folder:

Delete an existing folder

Add 
Report:

Creates an empty space for the report 
to be imported.

Is is possible move one folder to a different folder by holding SHIFT on the keyboard and dragging the icon to destination.

 Expand All

Navigation:  Reference > Main Screen >

Reports List

You can move a report to different folder by pressing SHIFT on the keyboard and dragging the report to the chosen destination.

Navigation:  Reference > Main Screen >

Main Screen Tabs

Details allows user to select criteria (parameters) for the report and also the Printer Options.
Groups if enabled, allows the user to narrow down the list of items present on the report. The items are presented in tree structure, with ability to 

select specific nodes.
Selection 
Parameters

this function is used during report design for defining parameters in the report.

User Access in this tab you can specify which user groups have access to the selected report.
Import / Export used for importing new reports into the system, and exporting existing reports to file.
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This section of Report Manager allows  to select specific criteria (parameters) for the report to be printed.

Selection Options: 

Reports usually require some additional input from the user side to be printed. For example, it may require the user to select the ship to narrow down the information presented in the 
output. This means the screen layout will most certainly be different from one report to the next, and it would be impossible to list all the different variations. Therefore, the aim of this 
document is to provide guidelines on how to enter the necessary information.

As you can see on the screen above, the report requires various information: Ship, POC (Point of Consumption) and Date Range. All information must be provided in order for the 
report to print correctly.

Generally speaking the selections on this screen can have various types:

Keep in mind some tabs can be restricted for viewing in Security module (Security Groups -> Print Manager)

Navigation:  Reference > Main Screen > Tabs >

Tab: Details

 Free text entry - in this type of field you will be able to enter any type of text or numbers.
 Date entry - this type of field will usually be presented as a Combo Box (Drop Down), and when you click the arrow it will expand to show the calendar allowing easy date selection.
 Combo Box entry (called also Drop Down) - this is the most generic of all the fields. You cannot type any information, you can only select one of the presented options from the list. 

This may be a list of Warehouses, Vendors, Points of Consumption or Ships.

Keep in mind that the fields may be linked which means that in order to select the second parameter (as per above example "Transfer to:"), it will be 
necessary to select the first parameter beforehand (here "Select Ship").
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If there are parameters that haven't been selected, the following warning will appear, telling to make the selection.

In this option the printing options for the reports can be defined.

Printer Options: 

The top drop down allows to select any of the printers installed on the system. 

Printer options allow to change the following parameters of the print engine:

This tab, if available, allows the user to narrow down the amount of information returned by report.

Groups: 

Navigation:  Reference > Main Screen > Tabs > Tab: Details >

Printer Options

 the printer where to print the report. If it is required to control more over the print settings of that particular printer, click the button Properties which displays the printer system settings

 how many copies of the report is needed

 paper orientation: portrait  or landscape

 the first page (From page) and last page (To page) of the report to print

 collation (paper sorting option): 

 default Collation helps when several copies of the same report are needed
.

 collated, If selecting collated, it will print the 1st copy of all pages, then 2nd copy of all pages

 uncollated. If selecting uncollated, it will first print x copies of page 1, then x copies of page 2, so they need to be sorted manually

Navigation:  Reference > Main Screen > Tabs >

Tab: Groups
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As seen on the screen above, the tree contains check boxes that allow for easy selection of tree nodes (elements). The contents of the tree may vary for example; stores list, 
products folders, vendors list etc. It will depend on the specific report as to which information it requires.

Below some examples:

If the Report Grouping option is necessary for the report and a selection has not been made, the following warning will appear instructing you to make the selection.

This tab is used almost exclusively during report development and should be disabled for regular users to avoid corrupting the report.

Selection Parameters: 

The Selection Parameters tab is further divided into the following sections:

Navigation:  Reference > Main Screen > Tabs >

Tab: Selection Parameters

 General Options
 SQL Query
 Selection Formula
 Box Selection Settings
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This tab allows to view and change the basic information of the report.

General Options: 

 Please note: The above options show up as default in Printer Options when report is selected.

See Also:

 Group View Settings

Navigation:  Reference > Main Screen > Tabs > Tab: Selection Parameters >

Tab: General Options

 Code Id - is the unique number of the report used for a filename during report export.
 Display title - is the name of the report displayed throughout the system, and used for filename during exporting of report.
 Print Output - specifies what form of output the report can take. Selected from one of the following available options:

 No Output
 Print Only
 Preview Only
 Print & Preview
 Export Only
 Print & Export
 Preview & Export
 All Output

 Orientation - Paper Orientation

 Portrait
 Landscape 

 Collation - paper sorting option

 Default Collation helps when printing many copies of the same report
.

 Collated If selecting collated, it will print 1st copy of all pages followed by 2nd copy of all pages

 Uncollated If selecting uncollated, it will first print x copies of page 1 followed by x copies of page 2 and you will need to sort them manually

 Copies - how many copies of the report will be printed
 Page from - from which page the report should be printed
 Pages to - to which page number the report should be printed

 Printer Options
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In this tab, an SQL query can be pasted which will become the source of data for the report. It is used only during report development and should be 
disabled for regular users to avoid corrupting the report.

SQL Query: 

An advanced SQL query can be inserted in the text box in this tab and that query will become a source recordset for the report. Please note there is no syntax checking, so any errors 
will be shown at the runtime of the report.

You can use following parameter fields inside your query:

Please note the parameter fields names are CASE SENSITIVE.

See Also:

Selection formula allows to filter out records of the record source. As with the other tabs in this section, it is used only during report development and should 
be disabled for regular users to avoid corrupting the report.

Selection Formula: 

In here a WHERE condition is defined which filters out the results of the source recordset. One can substitute specific field names with user selection. 

 Please note: there is no syntax checking, so any errors will be shown at the runtime of the report. Also, the parameter field names are CASE SENSITIVE.

Navigation:  Reference > Main Screen > Tabs > Tab: Selection Parameters >

Tab: SQL Query

 <<Box_1>> to <<Box_10>>
 <<Text_1>> to <<Text_10>>
 <<Date_1>> to <<Date_10>>
 <<Group_1>> or <<Group_2>>

What is SQL and where does it come from?
Structured Query Language (SQL) is a language that provides an interface to relational database systems. SQL was developed by IBM in the 1970s for use in 
System R, and is a de facto standard, as well as an ISO and ANSI standard. SQL is often pronounced SEQUEL. 
In common usage SQL also encompasses DML (Data Manipulation Language), for INSERTs, UPDATEs, DELETEs and DDL (Data Definition Language), used for 
creating and modifying tables and other database structures. 
The development of SQL is governed by standards. A major revision to the SQL standard was completed in 1992, called SQL2. SQL3 support object extensions 
and are (partially?) implemented in Oracle8 and 9. 

 Oracle SQL FAQ
 Oracle FAQ: SQL Books
 Oracle FAQ: SQL code examples

Navigation:  Reference > Main Screen > Tabs > Tab: Selection Parameters >

Tab: Selection Formula
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One can use the following parameter fields inside your query:

 Remember: When using SQL query, the selection formula is ignored. If you use SQL query, please include selection formula in SQL query tab.

As with the other tabs in this section, Box Selection Settings are used only during report development and should be disabled for regular users to avoid 
corrupting the report.

Box Selection Settings: 

On the main screen (Details Tab) of the Report Manager, you can define several parameter fields which will ask the user for input necessary to gather the data from the SQL engine. 
The parameter fields are numbered from from 1 to 10 and their layout is as follows:

 <<Box_1>> to <<Box_10>>
 <<Text_1>> to <<Text_10>>
 <<Date_1>> to <<Date_10>>
 <<Group_1>> or <<Group_2>>

Navigation:  Reference > Main Screen > Tabs > Tab: Selection Parameters >

Tab: Box Selection Settings
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You are able to force the user to make a selection from another parameter box before he is able to select the current one, this functionality is called 'linking'. 

This proves useful if you depend on the previous box to populate content of the current one. For example your previous box contains ship selection, and the current one should display a 
list of Periods for that particular ship. Linking in this case is obligatory, otherwise an error exception will be created.

As with the other tabs in this section, Group View Settings are used only during report development and should be disabled for regular users to avoid 
corrupting the report.

Group View Settings: 

For the Group View (tree selection view), you have to build a custom SQL query which returns 3 fields: 

Within your SQL query, all the parameters on the Box Selection Settings tab can be used.

The following are the available types of parameter boxes in the system:

Free Text 
Entry -

allows you to ask the user for any type of text or numbers, without any 
syntax checking.

Combo Box 
Entry -

also known as a "drop down box", allows the user to make a selection 
from a range of items. This could be the selection of a ship out of the 
whole fleet or the selection of particular department. For this type of box 
you have to provide a Combo Box SQL populate formula, which has to 
contain two fields: sCaption as a text value used to display options in the 
combo box, vItemData as the return value for each item in the list.

Date Entry - this will display a calendar asking the user to make a date selection. You 
can force the selection to be inside a specific date range by using the 
Validate Dates option.

Below 'Status' of the current box, in the 'Linked:' drop down, you can select which box has to be selected first by the user. 

Navigation:  Reference > Main Screen > Tabs > Tab: Selection Parameters >

Tab: Group View Settings

 vitemdata - the value of the selection which is returned to report manager engine
 skey - the description of the node
 sparent - ID of the parent node
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In the User Access tab, you can select which user groups will have print and preview access to a specific report.

User Access: 

The following buttons are available:

Navigation:  Reference > Main Screen > Tabs >

Tab: User Access

Moves selected group from left side (Non Authorized Users) to the right side (Authorized Users)

Moves ALL groups from left side (Non Authorized Users) to the right side (Authorized Users)

Moves selected group from right side (Authorized Users) to the left side (Non Authorized Users)

Moves ALL groups from right side (Authorized Users) to the left side (Non Authorized Users)
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Basic operations in this tab will be to move appropriate user groups from the left side of the screen to the right side therefore giving them access to the current report.

This tab displays detailed information about the report and allows to export existing reports and import new ones into the system.

Import / Export: 

The following information is displayed on the screen:

 Importing a new report

From the list on the left hand side, select the report group where you would like to add the new report. 

Please note: 
All users will see the report in the list regardless of the security settings, but they won't be able to preview or print the report if they are declined that right.

Navigation:  Reference > Main Screen > Tabs >

Tab: Import / Export

 Report External Name - the filename of the report
 Report file size - provides information on disk size of the report (in KiloBytes and Bytes)
 Last modified - shows the timestamp of the last report modification
 Create Date - allows you to see when the report was originally created
 Date Last Saved - displays when the report was saved last (outside of the MMS system)
 Date Last Printed - shows when the last printout of the report occurred
 Total Editing Time - how much time, in minutes, has been spent on the development of the report
 Revision Number - provides information on how many revisions have been made to the report
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Right click the mouse on the destination report group and select Add Report.

In the section below the report groups an empty entry for a new report appears.

Click on it to select it, and switch to  tab on the right.
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Make sure the Load Variables from Report box is checked and click the Import... button.

Browse to the folder on your local computer where you have extracted your new report (.rpt file) and click Open to finish importing the new report.

Once the report is imported, please switch to the  tab and assign user groups which will have access to this report.

 Importing existing report

Importing existing reports is very similar to Importing New Report, the only difference is you skip step 2, and in step 3 you have to highlight an existing report.
Once you click import, the file will replace the selected report.

 Exporting the report

Please see the screen below for a step by step explanation of how to export an existing report.

 Once a report has been added, you can move it to different folder by pressing SHIFT key on the keyboard and dragging the report to the destination folder. By de
main folder "Reports". 

 Clicking on "Reports", at the top of the tree, shows all the reports in the system. Scroll down the list to find your newly imported report and then you can move it
described above.
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Once you click the export button, the Save As dialog appears.

See Also:

Note: Exporting the report inserts additional information necessary for the import inside the report. This information includes the definition of all 
parameters (criteria's), SQL queries etc.
Since editing the report in Crystal Reports will strip this information from the file, after editing the report in Crystal import it into existing report in 
Report Manager with option "Load Variables from the Report" UNCHECKED, and afterwards export it before sending the report out.

 How to: Add a new report
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Adding a new report. 

Navigation:  How to ... >

How to... Adding new report

 From the Fidelio Launcher, please go to  module. On the list on the left side, select which report group into which to add the new report to.

 Right click the mouse on the destination report group and select Add Report.

 In the section below the report groups, an empty entry for a new report appears.

 Click on it to select it, and switch to  tab on the right.

Add a new report



Exporting a report

 Make sure the Load Variables from Report box is checked and click the Import... button.

 Browse to the folder on your local computer where you have extracted your new report (.rpt file) and click Open to finish importing the new report.

 Once the report is imported, please switch to the  tab and assign user groups which will have access to this report.

 Once a report has been added, it may be moved to different folder by pressing SHIFT key on the keyboard and dragging the report to the destination folder. By defa
main folder "Reports". 

 Clicking on "Reports", at the top of the tree, shows all the reports in the system. Scrolling down the list to find the new imported report. It may then be movced to t
described above.

Navigation:  How to ... >

How to... Exporting the report.

 Please see below screen for the step by step explanation how to export existing report.
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 Once clicking the export button, the Save As dialog appears.

Note: Exporting the report puts inside the report additional information necessary for the import. Those information include definition of all 
parameters (criteria's), SQL queries etc.
Since editing the report in Crystal Reports will strip the file from this information - after editing the report in Crystal, import it into existing report in 
Report Manager with option "Load variables from the report" UNCHECKED, and afterwards export it before sending the report out.

Add a new report



Navigation: »No topics above this level« 

Frequently asked questions

The report has been opened in Crystal Reports editor and saved. This strips the file of the additional information which is necessary to pass the parameters to the Report Manager. If tha
created by Fidelio, please contact support to receive a corrected version. 

This warning will appear if there are missing parameters in the Details Tab or, if no selection has been made in the tree in the Groups Tab. The report requires all parameters to be chose
you have made the appropriate selections in both tabs.

The Purchasing Reports include reports that allow a user to print deliveries by Date, PO number and Total Quantity.

This can be made by changing your printing properties In the Printer Options under Windows Control panel and selecting the correct Paper size. 

By selecting Report Manager and activating the food cost Report Tab.

 I have imported a new report but the parameters section is blank. Why is this?

 I receive the following message:

 I Would like to print a report on everything that has been ordered for a particular day? Looked at Report Manager - Purchasing but
report.  Does it exist?

 My reports print in wrong paper format. Where is the setting for Paper Size.A4 paper in landscape?

 How do you print a food cost for a cruise?
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The Request Module is used to manage the materials ordering process between the ship and headquarters that does the central 
purchasing for all the ships of the fleet and all items. 

Therefore we need to distinguish exactly between a request and a purchase order.

Request: A  request is issued onboard to advise the purchasing department of the onboard supply requirements. This means the ship 
is requesting only items as defined in the Article Manager without prices and vendors.

Purchase Order: A purchase order can only be issued by the authorized purchasing department in order to buy goods for ships use.
As a consequence a request will finally result in a purchase order to supply the ship. In fact a request is the follow up process of other 
tasks completed by other modules, like movements and sales that have to be completed before a request can be created that meets 
all the Material Management requirements. 
In the case that a former task has not been fulfilled the Material Management System will prevent proceeding with the certain task and 
will not allow to bypass the procedure anyhow.

Requests Main screen 

The below image appears once opening the requests module. The module has different views depending on if a request is open or if a generic view is being used. 
In this manual we will refer to the request overview which will list all requests for the selected date, the items on order view and the order request detail view.
Located on the top part of the screen is the menu bar and the function buttons through which routine tasks can be reached.

The buttons toolbar contains the basic and most frequently used options for creating requests, viewing information and printing reports.

Buttons: 

Clicking the buttons below or the links will open more information and instructions on the usage of these functions.

Navigation:  Reference >

Requests: Main Screen

Navigation:  Reference > Main Screen >

Buttons:
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Most of the options have corresponding tools in the menu, keyboard shortcuts assigned to them or, are available with a right mouse click.

The search option can only be activated while in the items view. It  provides the possibility to search and locate a specific Order Request that has already 
been created in the system. This can be made by defining specific search criteria.

Button Search: 

Once activating the Search engine. The fields for specifying the search criteria open on the left side of the screen.

Refresh Updates information on screen.
Search Enables search engine to search for specific request.
Overview By clicking here user will always return to main screen.
Guest Counts Number of guests for corresponding day.
Ownership Current owner of request document.
Authorize Enables user to authorize request.
Cancel Cancels order. Comments can also be added why the request has been canceled. Can still be viewed 

under "Cancelled Requests".
Recalculate Updates request with current prices.
Delete Delete order requests permanently.
Add Opens New Order Request screen.
Options Opens the Options Module.
Lock Locks the Request Module, only person locking will be able to unlock.
Exit Exits Request Module.
Close View Closes screen view.

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Search

Click the Search button to initiate the function.

Date Ranges

A date range may be selected in order to narrow the search for a particular request.

Request Properties

Request ID: Identification number of the request.

Headquarter: Allows an restriction to which head quarter the request belongs.

Buyers Group: Allows the filtering by name of the group responsible for purchases.

Owners:  Allows filtering by user who is the owner of the request. It can be a different 
user than the user who created the request if the ownership has been changed.

Requests Contains

Item: A request can also be searched by selecting an item that belongs to it.
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Upon having selected the criteria, the search may be initiated by pressing   and the results will be displayed in the Main Screen Overview.

This option refreshes the screen layout. For example, once having sorted columns by their heading or resized them by 
clicking refresh will reset the layout to the default view.

Button Refresh: 

Button Overview:

Button Guest Counts:

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Refresh

Click to refresh your screen layout.

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Overview

By selecting this function the screen will return to the default main screen.

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Guest Counts

By selecting this function the passenger and crew counts, as well as the dates, ports and period 
IDs will appear depending on the date range selected in the menu on the left side of the screen.
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By selecting the "Add Range" button, the user is enabled to create a range and enter the passenger and crew counts corresponding to these days. After completing 
the fields, the new range will show up in the above list.

Button Ownership:

By selecting the above button or by right clicking on a selected request the following screen will pop up allowing the user to assign ownership from here.

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Ownership

By selecting this function the ownership of the request order can be assigned to a new user for 
editing or for authorization purposes.

Reason:

Depending on the setup of your system, 
define the reason for the re-assigning of 
ownership.

Reasons can be:

Request Authorization: By selecting this 
the user will request authorization from 
the user who the ownership is transferred 
to.

Decline Authorization Request:
Authorizations may also be declined and 
sent back for readjusting requests.

Transfer Ownership: Ownership can be 
transferred to another user.

Filter:

By typing the first few letters of a name in 
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By clicking on "Assign", the ownership of the document will then be transferred to the selected user.

Ownership History:

Button Authorize:

the filter enables to find users faster.

Date/Time: Actual time and date of the 
entry.

Type: Description of the action taken.

Assigning User: Name of the user 
responsible for the corresponding action.

Assigned To: Name of the user newly 
responsible for the document.

Comments: Detailed description of 
action taken.

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Authorize

By clicking this button the authorization for the request can be made.
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Authorization of the Request

Once the request has been verified and found correct in its content it can be authorized by the person in charge. Depending on the 
company's structure it is usually the F&B Manager and/ or the Hotel Manager responsible to authorize requests. 

Ownership of a document can also be transferred to another user in order for them to have the opportunity to adjust the order 
request

The authorization or transfer of ownership can be done by selecting the order request and right clicking on it or by clicking on the 

 and  buttons. By right clicking the following options will be available where authorization and transferring 
ownership is also possible.

Once the ownership of a document is passed on to a user with the rights to authorize the request and he verified correctness and authorized it, 
it then is sent on for a second authorization on board or directly on to HQ (depending on company structure).

Once the request has been authorized shipside, the box "AShip" in the overview next to the particular request will be marked as shown below.

Once the request has been authorized shore side, the box "AHQ" in will be marked as shown below.

At this point the request is ready to be converted to a Purchase Order.

DOCUMENT PROPERTIES

Users Comments: any message or 
comment can be added here

NEXT USER

Filter:

By typing the first few letters of a name 
in the filter enables to find users faster

YOUR COMMENTS

Any additional comment can be added 
here for next user to view

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Cancel
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Button Cancel:

When selecting this option the following window will appear

In order to cancel a request an explanation will also be required. By clicking on "Apply Cancel", the request will then disappear from the overview screen. 

Canceled requests can be found under  on the left hand side of the screen under the calendar view.

Button Recalculate:

Button Delete:

By selecting this function the order request can be cancelled, however it will not be entirely deleted. Cancelled 
requests can be found in the summary view under the folder "Other".

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Recalculate

By selecting this function the system will recalculate the points that are check-marked 
below with the most up-to-date data

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Delete
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When selecting this function, the system will ask for confirmation whether the user is sure to delete the record as shown below.

The Add function button covers the process of creating a new Order Request. The program will help the user to gather all the necessary information so 
that the Order Request may be transmitted to the Headquarters containing all information required. 

Add: 

The system will now open a Request Creation Wizard that guides the user through the requesting process. It will collect all necessary information while going through 
these 3 steps.

STEP 1

Headquarter This information indicates the Headquarters to where the Request will be forwarded to.

Buyers Group: The name of the group responsible for purchasing the items within the request.

Requested Delivery Date: First Choice as the Delivery date of the Request.

Days from Today: Number of days until first delivery. This field will automatically populate when entering the requested delivery date!

Following Delivery Date: Next date of delivery in case first delivery did not succeed.

Period Duration: Number of days between first date of delivery and second date of delivery. This field will automatically populate when entering the following 

By selecting this function the system will delete the selected request permanently.

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Add

Click on the Add button to create a new Request.

Main Screen



delivery date!

Generation Type: Select the type of the request. The system has three options available : 

Standard Request: The system will generate the order suggestion and place quantities on the Request based on the statistical information. This 
information may be altered at a later point.

Emergency: Generates an order with an emergency status but leaves the user decide on what articles are needed. 

Manual: The order request will be empty, therefore allowing the user to enter items manually (one by one).

Item Order Group: Requests can also be made by adding an entire item order group (e.g.: aperitifs, beer, fruits, vegetables, etc).

Template Request: Existing templates from the template manager can also be used when creating a new request.

Generation Method: Depending on the selected Generation Type the Generation Method field will populate. 

Standard: Selection of stores will appear.

Item Order Group: Selection of item order groups will appear.

Template Request: Selection of available templates will appear.

Pricing Method: Method of calculation for items requested.

Comments: Any additional comments may be entered here for the request.

STEP 2

The second step covers the consumption range mapping specifying which range and season will be used to create the request.

Consumption Start Range: Select the start date from which the system should use the historical consumption information.

Consumption End Range: Select the end date to which the system should use the historical consumption information.

Vessels: Specify which vessel will be considered in the preparation of the statistical data. Multiple selections are possible, depending on the security rights of the 
user multiple ship will be available for selection.

Seasons: Specific seasons can be chosen to be part of the calculated consumption figures for the request. The system will estimate the highs and lows for items 
consumed in those seasons thereby will calculate the request quantities.

Periods Filters: You can use additional filter to calculate the consumption by choosing some specific periods. 

STEP 3

Onboard Stock calculations.
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After clicking NEXT the following screen will appear. Now the system is ready to create the Order Request based on the information inserted.

Based upon the Generation Type and Generation Method, by clicking on NEXT the system will add all respective items and generate the new request.
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Once  the system has finished the creation process the screen will return to the Request Overview screen and the new request may be observed on the calendar on 
the date it was created for.

By double clicking on the Order Request the user will then be able to add new items or edit the quantities to be ordered.

Button Options:

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Options

By selecting this option the user will be able to access the Application Settings screen.

Navigation:  Reference > Main Screen > Main Screen: Buttons >
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Button Lock:

Button Exit: 

Button Close View: 

The order properties view contains all the generic information regarding the order that was inserted during the 
creation process. This information includes request details regarding delivery dates, statistical information as well as the estimated 
passenger and crew count figures of the selected period.

Request Properties:

Button: Lock

Selecting this key, the module can be locked by the user and can only be re accessed by entering user credentials 

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Exit

By clicking here the user will leave the Request Module. 

Navigation:  Reference > Main Screen > Main Screen: Buttons >

Button: Close View

The currently viewed screen will be closed by selecting this button.

Navigation:  Reference > Main Screen >

Request Properties

General Details

Request ID: Identification number of selected request.
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The Request View displays all the Order Requests that have been placed for the selected day in the calendar. 
The system lists all orders in this space in the order of the ID number. Each order can be opened by double 
clicking it on. This will open the Items View with the single request articles being displayed.

Overview: 

Vessel: Name of the ship which created request.

Headquarter: HQ responsible for purchase of request.

Buyers group: Group responsible for purchase of request.

Requested Delivery Date: Desired date of delivery of request.

Following Delivery Date: Next date of delivery in case first delivery did not succeed.

Generation Method: Method of adding items to the request.

Pricing Method: Type of price calculation.

Consumption Options

Consumption Start Range: Starting date of Consumption range that is to be 
considered while calculating the consumption estimates for the request

Consumption End Range: Ending date of consumption range.

Vessels: Usually in this field the consumption of the vessel requesting for is selected. 
In cases when a vessel is going to have a season it never had before, it can take the 
average consumption of other ships into consideration to calculate future 
consumptions by using other ships data.

Seasons: The user is requested to specify which past seasons are to be considered 
while calculating the consumption estimates. It is absolutely recommended to select a 
season in this field to calculate the consumption as exact as possible.

Periods Filters: The user is requested to specify which past periods are to be 
considered while calculating the consumption estimates.

Stock on Hand Options

Enabled POC stock Filter: Enables stock on hand statistics for specific POCs

Filter by Departments: Drop down selection of stores

Filter by POC: Stock on hand calculations can be filtered by POC

Comments: The user can add comments to the request

Navigation:  Reference > Main Screen >

Request Overview
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The overview column headers divide the information according to the following categories: 

AShip
This checkbox indicates whether the request has been authorized on board.

AHQ
This checkbox indicates whether the request has been authorized in headquarters.

ID
The individual identification number of the request. This number is automatically generated by the system.

Status

Open: Items can still be added or can be modified in the request. Awaits authorization.

Authorized: Request has been authorized both on board and in headquarters.

Processed: Request has been converted into a Purchase Order in headquarters.

Headquarter
The name of the company headquarters or the catering company is displayed.

Vessel
The name of the vessel placing the request is displayed.

Owner
Name of the person responsible for the request. The ownership of a request may change due to authorization procedures.

Description
Type of method in which the request has been generated: 

Standard Request: The system will generate the order suggestion based on the statistical information.

Emergency: Generate an order with an emergency status.

Manual: Items may be added individually (one by one) to the request.

Item Order Group: All items from a specific order group (e.g Aperitifs, Fresh fruits, Pasta) can be added to request.

Template Request: Items can be added via an existing template.

Buyers Group
The specific buyers group which is responsible for converting the Request into a Purchase Order.

Comment
Free space for comments that may be added during the creation process.(e.g if the person creating the request would like to give a message to the person 
authorizing it)

Items
Number of individual items within request

Value
Total value of order request document

Items On Order: 

On the following screen the list of items can be found that are on order for the upcoming days. This view can be personalized based upon which information the user 
wishes to retrieve by selecting and rearranging the tabs.
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Vendor:
Vendors' names.

Unit:
Unit of measure of the items.

Code:
Items codes.

Store:
Name of the mainstore where the items belong to.

Amount:
Quantities requested.

Item Group:
Name of the Item Group where the item belongs to.

Description:
Item descriptions.

Delivery Date:
Date when the items where delivered or will be delivered.

The items view screen displays the contents of an Order Request in great detail for every article. The default screen 
displays the order article details whereas opening the function tabs at the bottom of the screen opens further views for the 
order including order properties and other information for the same request.

Order Request Details: 

Navigation:  Reference > Main Screen >

Order Request Details
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Scrolling from left to right the following columns in the Order Request Details will appear. These columns are explained in detail below.

ITEM

Code
Article Code.

Description
Article Description.

Unit
Article unit of measure.

Price
Article Unit Price.

REQUIREMENTS

Minimum
The minimum amount of stock of the item required on board.

Maximum
The maximum amount of stock of the item required on board.

PENDING

On Request
Amount of the item requested in another request.

On Order
Amount of the item already ordered.

On Transfer
Amount of the item en route to ship.

PPD (passengers per day)

These figures can be made available in order to calculate accurate stock consumption.

PPD pax
Number of passengers per day.

PPD Crew
Number of crew per day.

STOCK ON HAND

Mainstore
Current stock available in mainstore.

Substores
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Total of current stock available in substores.

Total SOH
Total SOH = Mainstore SOH + Substores SOH

CALCULATIONS BEFORE PERIOD

Ext. Consumed
Estimate on the consumption per the period range that has been specified during the New Request preparation wizard.

Est. Expected
Estimated expected consumption of article within the range that has been specified for the request.

SOH DOD
The stock on hand on day of delivery. SOH DOD = SOH - Est. Expected consumption.

CALCULATION

Pax
Actual number of passengers.

Crew
Actual number of crew.

Required
Pax + Crew.

RESERVE STOCK

Days
The reserve range is specified on how long the stock should last prior to receiving more deliveries.

Amount
Total quantity of reserve stock.

PURCHASING DEPARTMENT

Comment
Messages concerning the request may be added here by the purchasing department.

REQUEST DETAILS

Suggested
Order quantity suggestion by system. This value is calculated on the basis on past consumption for 
the period that was ranged during the New Request preparation wizard.

Requested
Request quantity. This is the Quantity on the current order.

Value
Total value of items requested.

Expected Guest Counts:

In this screen the user is able to see the current date, the corresponding port, ID number of the current period, and also the corresponding 
passenger and crew count. The crew and passenger count can be edited in this view in order for more accurate consumption calculations.
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Logs:

Date: Date of event occurrence.

Time: Exact time of event occurrence.

Windows login: Name of user logged in on workstation.

User: User login for MMS.

Workstation: Name of PC where event has been created/edited.

Event: Description of event.

Within a request order, additional buttons are available on top of the screen. These functions are also accessible by right-clicking on the items in the 
list. 

Navigation:  Reference > Main Screen > Order Request Details >

Buttons

Refresh Updates information on screen.
Search Enables search engine to search for specific request.
Overview By clicking here user will always return to main screen.
Guest Counts Number of guests for corresponding day.
Item Statistics Provides detailed information concerning selected item.
Purchases Provides historical data of orders of item.
Consumption Provides history of consumption for item per cruise.
On Order Provides information of current and pending orders of the item.
Import Users are also able to import items from an excel file.
Export Users are able to create an excel file of requests.
Delete Will delete the currently selected item from the request.
Add Will open the search for article window in order to allow the search for another item to be added to the request.
Options Opens the Options Module.
Lock Locks the Request Module, only person locking will be able to unlock.
Exit Exits Request Module.
Close View Closes screen view.

Navigation:  Reference > Main Screen > Order Request Details > Buttons >

Button: Current Stock on Hand
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The Statistics button is active only in the Items View when individual products are selected. While in this mode 
it is possible among product details to find information concerning Purchase History, Consumptions and 
pending requests for the item.

Statistics: 

Item Code: Unique identification number.

Item Unit: Unit of measurement for the selected item.

Item Description: Description of the article.

Fixed Price #1: HQ cost price.

Last Purchase Price: Last price purchased of the selected item.

Fixed Price #2: Ship cost price. 

Current Bid Average: Average price according to available bids for current period.

Current Amount on Order: Quantity of item currently within a Purchase Order.

Current Amount on Request: Quantity of item currently within an Order Request.

Current Stock on Hand: Quantity of item available.

Opening the Purchase history tab offers the possibility to view complete purchase history for the selected product and the selected vessels. This information is 
organized in columns as described below and may be viewed within a specified date range.

Purchase History

While in the Items View click to open the Statistics Module on the current stock on hand tab.

Navigation:  Reference > Main Screen > Order Request Details > Buttons >

Button: Purchase History

By selecting this function the purchase history and its details will appear.

Depending on your security settings is it possible that you can not use this function.
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Entities: Depending on your security rights you will have several vessels for selection.

From Date: Starting period of retrieving data.

To Date: Ending period of retrieving data.

Filter Vendor: By selecting a specific vendor, only that particular vendor will appear in the details on the bottom part of the screen.

Purchase Overview

Navigation:  Reference > Main Screen > Order Request Details > Buttons >

Button: Consumptions

The consumptions Tab opens the possibility to view the consumption figures for the selected item for specified vessels
and date range. The information is organized by columns as described below
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Period: code for the period

Start: beginning day of the period

End: last day of the period

Season: name of season period belongs to

Closing Stock: stock on hand at end of period

Correction:

Passenger: consumption per passenger

Crew: consumption per crew member

Total: passenger consumption plus crew consumption

PPD Pax: consumption per passenger per day

PPD Crew: consumption per crew per day

PPD Total: consumption per passenger per day + consumption per crew per day

Navigation:  Reference > Main Screen > Order Request Details > Buttons >

Button: Pending Requests

The On Order tab lists down the pending requests for the selected item by vessel and selected date range.
The information is organized by columns which are described below.
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Request ID: Unique identification number of request.

Vessel: Shows the ships name.

Delivery Date: Request's day of arrival.

Amount: Quantity of item within order request.

Unit: Unit of measurement for item.

Mainstore: Stock on hand in mainstore for particular item.

POC: Total stock on hand in all Point of Consumptions.

Total Stock: Mainstore stock on hand + POC stock on hand.

The Import function may be used to import an Order Request on a pre-defined Excel work sheet into MMS.

Import: 

An import window will open.

Navigation:  Reference > Main Screen > Order Request Details > Buttons >

Button: Import

Click on the Import Button to start the import of an Order Request File
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When selecting the export option user will have to select the export path.

Select destination folder and then click on save.

Button Delete:

Navigation:  Reference > Main Screen > Order Request Details > Buttons >

Button: Export

The request order can be exported to an Excel document.

Navigation:  Reference > Main Screen > Order Request Details > Buttons >

Button: Delete

By selecting this function the system will delete the selected item from the order request..
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When selecting this function, the system will ask for confirmation whether the user is sure to delete the selected item as shown below.

By selecting "Add" the article search engine will appear where the required articles may be searched and selected. It is also possible to select multiple items to add to 
the Order Request. As seen below multiple items have been selected in order to add all of them to the Order Request.

Under the column "Requested" the quantity of the item can be entered as shown below.

Navigation:  Reference > Main Screen > Order Request Details > Buttons >

Button : Add

Click on the Add button to insert an additional item into the order request.
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When the necessary quantities have been entered, by clicking on  the order request overview screen will appear once again.

The Menu bar on the top of the screen contains different options while an Order Request is being viewed in the 
Items View space. 

Menu bar:

File: 

The Edit Menu in Order Request View contains further options for managing the order requests. Most of these 
options are also available with a specified function button that is specified aside each function and they can be 
via a right mouse click in case an article is selected.

Edit: 

Navigation:  Reference > Main Screen >

Menu

Navigation:  Reference > Main Screen > Menu >

Menu: File

Skins:

Exit

With the selection of skins users are able to select the 
background color of the module.

Exits the Request Module

Navigation:  Reference > Main Screen > Menu >

Menu: Edit
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The Windows menu allows to change on how the windows and screens are displayed on the layout.

Windows : 

This section covers some problems that are frequently encountered by our users. The questions are organized by category and where necessary links are provided to 
relevant sections of the help.

Delete: Delete a selected Item or Request

Delete Items with zero Balance: Delete all those articles on a Request 
that have the Order Quantity at Zero.

Show Item Summary: Shows the statistics for a selected item on an 
Order Request.

Show Purchase History: Shows the historical consumption of an Item on 
a selected date and ship fleet range

Show Consumption History: Shows the item consumptions per period 
per ship and date range 

Show On Order Details: Shows any pending Order Requests for the 
selected Article

Update Quantities Request with Suggested: Will use the suggested 
quantity on the Order request as the quantity to be place on order

Set All Quantities Suggested to Zero: will set all suggested quantities to 
zero

Expand all Groups: will show all items for individual groups

Collapse All Groups: will only show the main groups

Export to Excel File: exports the order request to an excel file

Import From Excel File: imports items form an excel file

Navigation:  Reference > Main Screen > Menu >

Menu: Window

Navigation:  Reference > Main Screen >

Frequently Asked Questions

Why can my order request not be processed in the head office?

As already mentioned the Requests Module is an element within the Material Management process that requires a few conditions to be met in 
order to assure smooth supply chain operation. This chapter describes these criteria that enables the user to understand the conditions and 
dependencies.
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Conditions that enable the Head office to access or "see" the Purchase Order

"I made an an Order Request but the Headquarter says they can not process it"

Introduction: Ship to Shore Purchasing Requests and Purchasing Orders are in fact very sensitive issues because the entire quality of the 
cruise line depends on a accurate procurement process. For this reason the Material Management System contains strict authorization and 
user limiting functions to enable any higher authorized user to control other users entries i.e. requests and to avoid mistakes that could 
result in financial issues.

For this reason any Request made onboard even by storeroom and hotel controlling staff has still to be authorized to enable the 
authorizing person to check for mistakes and discrepancies to avoid any serious issue and most possibly an emergency request afterward 
in case something important has not been considered while constructing request. 

Solution: Check the Order Status of the concerning request onboard if it has been set to the right authorization status. The following 
example shows a case where the Request can not be seen in the Purchasing Department:

In this case the Order Status is still 1 and needs to be set to 2 by authorizing the Request. Please ask your designated Area Manager or 
Department Leader for assistance in this case. 

Here is a Explanation of all the possible Order Statuses:

Status : 1-Open
Status Open means that a request has been created by the responsible and 
authorized persons. Any Changes i.e. in quantity can still be done by all authorized 
users. 

Status : 2-Authorized
The Request has been authorized by the User in Charge i.e. Hotel Manager, Food 
Manager etc.. No changes are possible anymore. From now on the request can be 

processed in the Purchasing Department Shore side.

Status : 3-Processed
The Request has been processed into a purchase order that has been forwarded to 
the supplier. From the Purchase Order Status ??? the user is able to see the ordered 
Quantity in the On Order Column in the detail View of the Request Window.

What does this Pink Color mean?
The color is a warning please not to open the request at the current time. In these 
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cases it might be possible that the Idea Interface started already the transfer for Ship 
to Shore while the Request is still being edited in the Headquarter. The pink color 
should disappear automatically after a while. 
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Overview Top Previous Next

Overview

The Sales Overview module gathers all information from Micros into MMS. By navigating within the Sales Overview many useful details in 
consideration to charges, revenues, revenue centers, checks, and other statistical information are available which summarize daily 
operations.

Sales Import Overview Top Previous Next

Sales Import Overview

Overview



Vessel: name of the ship currently viewed

By selecting a day, the corresponding details 
will be processed for view in the module

By holding down the left mouse button and 
dragging it across multiple days will be 
selected 

RVC Code: unique revenue center identification 
code 

Revenue Center: name of the Revenue center

Total: value of total sales for selected date for 
related Revenue Center

Sales percentage breakdown per 
Revenue Center

Sales chart based upon Revenue 
Center and sales value

Overview



Checks Top Previous Next

Checks

This overview enables the users to search for individual checks and their corresponding details that have been imported into MMS

Source: where the information is coming from (micros interface)

ID: the unique identification number of the check

Date:

Guest/Account: name of the person signing for check (this name is retrieved by swiping customer's card)

Nationality: nationality of person charged

Age: age of person charged

Sex: male/female

Value: total value of check charged

Revenue by Hour Top Previous Next

Revenue by Hour

Statistical information is provided in this chart in regards to sales by the hour. In the chart the bottom line (0,3, 6, 9 etc) represents the time, while the line on 
the left represents the value (500, 1000, 1500) 
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Revenue by Age: a breakdown of sales for individual age groups

Revenue by Nationality: sales breakdown for individual nationalities

Revenue by Gender: breakdown of sales between male/female

Revenue by Hour and RVC Top Previous Next

Revenue by Hour and RVC

Statistical information regarding sales by the hour per revenue center

Overview



Top 20 Sales Top Previous Next

Top 20 Sales

Information regarding the top 20 best selling items. The main screen displays a pie chart with the item names and individual sales value.

On the right side of the display a breakdown of items and their total share in percentage can be viewed

Demographics Top Previous Next

Demographics

In this view various statistical data can be retrieved. Each tab in the grid can be selected and moved in order to retrieve the corresponding 
information from them.

Overview



Item Sales Overview Top Previous Next

Item Sales Overview

Sales Imported

Sales Summary

Overview



Sales Breakdown Top Previous Next

Sales Breakdown

Items With Negative Stock Top Previous Next

Items With Negative Stock

All items that have a negative quantity in the POCs will be shown here, as well as further details of item transactions.
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POC: Point of consumption

Item Code: unique item code in MMS

Item Description: name of the item within MMS

Item Unit: unit measurement of item

Opening Stock: stock on hand at beginning of period

Transfer In: quantity received from mainstore or other POC

Transfer Out: quantity to be transferred back to mainstore or to other POC

Stock on Hand: current physical stock on hand

Stock Sold: sales of item sold

Pending Transfer In: quantity still to be received 

Pending Transfer Out: quantity still to be discharged

Available Stock: Stock on Hand - Pending Transfer Out

Interface Status Top Previous Next

Interface Status

Within this view users are able to view the status of the sales interface without having to access the interface server.
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System Configuration Top Previous Next

System Configuration

On the bottom left side of the screen the System Configuration is accessible

Overview



Sales Item Linking Top Previous Next

Sales Item linking

On this screen users are able to view the linking between Micros and MMS items. New links and changes may also be done here.

Linking of items is a key aspect of maintaining accurate stock on hand.

Interface: the system retrieves information based on which interface is selected

Filter by Group: various groups may be selected in order to narrow the search for the list below

Sales Item Code: The unique item code in Micros

Sales Item Description: description of item in micros (this is the name 
that is displayed on the Micros screen)

Link Type: 4 link types exist

New: this type of link informs the user that a new button has been 
created in micros but has not yet been linked to an item. No stock 
deduction will occur in this case

Item: type of link that corresponds to a single item 

Recipe: type of link that corresponds to a recipe where multiple items are 
deducted based on the recipe's ingredients 

Disabled: existing micros item that is disabled in MMS. No stock 
deduction will occur in this case

Linked Factor: the number of units that are to be deducted from MMS.

Linked Description: the description of the item in MMS.
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Unique ID: The unique item code in Micros

Description: description of item in micros (this is the name that is 
displayed on the Micros screen)

Link Type: 4 link types exist

New: this type of link informs the user that a new button has been created 
in micros but has not yet been linked to an item. No stock deduction will 
occur in this case

Item: type of link that corresponds to a single item 

Recipe: type of link that corresponds to a recipe where multiple items are 
deducted based on the recipe's ingredients 

Disabled: existing micros item that is disabled in MMS. No stock deduction 
will occur in this case

Link Factor: the number of units that are to be deducted from MMS.

Item: the description of the item in MMS. All items appear in this drop 
down list

Code: unique item code in MMS

Unit: measurement type of selected item

Description: the description of the item in MMS

Fixed Price 1: 

Fixed price 2:

On Order: quantity of item in existing Purchase Order

On Request: quantity of item existing in Order Request

Clear: clears all items from screen and sets Link Type to disabled

Apply: saves changes that have been made to current item

Force Full Stock Deduction Top Previous Next

Force Full Stock Deduction

When selecting a Force Full Stock Deduction the system will ask for confirmation to proceed

There is only one reason to run a Full stock deduction, when you change a link (or a recipe which is linked) and you would like to have this 
change in place from the beginning of the period. 

During the full stock deduction the system will recalculate all checks and deduct stock from the beginning of the period according to the changes 
that have been made..

Note: One thing to take into consideration before running a FSD, if there is a closed inventory in the open period for a sales POC, and items 
within that inventory will be affected by the change of the link, the variance in the inventory will stay. See example below:

Example 1:

Old link: Button "Coke" in Micros was linked with MMS item "Whisky Bourbon" and Factor 1

New link: Button "Coke" in Micros linked with MMS item Coca Cola Can and Factor 1

Sales in the current period of "Coke" is 5. (in this case because of the wrong link, 5 of item "Whisky Bourbon" has been deducted, and "Coke" 
remained the same 

If a FSD is run in this case, and there was no inventory containing "Whisky Bourbon" or "Coke", then the sales for 5 "Coke" will be deducted from 
"Coke" in MMS and stock on hand for "Whisky bourbon" will be set back to its original quantity

Example 2:

In the case of an inventory being made consisting these items the following will occur:
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In this case the variance between MMS and the Physical count would be the following

"Coke": - 5

"Whisky Bourbon": + 5

When running a FSD now, the following SOH will be shown:

"Coke": 0

"Whisky Bourbon": 5

This new (incorrect) value will be because of the fact that the system takes into consideration the variance of the SOH after the physical count

In such a situation another Inventory should be created and the two corresponding item quantities should be adjusted

SOH in MMS (Inventory Data):

"Coke": 10 

"Whisky Bourbon": -5

Physically counted SOH:

"Coke": 5

"Whisky Bourbon": 0

Auto Linking Top Previous Next

Auto Linking

This option enables MMS to automatically link Micros items to MMS items

See topic "How to auto link medical items" for further information
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How to... Top Previous Next

How to...

In this section of the manual several topics are listed in order to allow users to be able to use the 
Sales Overview module more efficiently.

...link or to edit items Top Previous Next

... link items or edit item links

Go to Sales Item Linking in System Configuration

Select Interface

Select item from list

How to...



Fill out following fields on right side of the screen as below

After selecting link type the tab "Item" or "Recipe" will appear

Link Type: Depending 
whether it is a recipe or 
item

Link Factor: the number of 
items should be entered 
here that should be 
deducted from MMS

Item: from this drop down 
menu the corresponding 
item in MMS can be 
selected what is needed to 
be linked to the Micros 
item

Code: the code will 
automatically be generated 
according to the item 
selected

Description: the same 
description will appear as 
from the item drop down 

How to...



Click Apply 

menu

Fixed price 1:

Fixed price 2:

On Order: quantity of 
items already in a PO

On Request: quantity of 
item requested from ship

...auto link medical items Top Previous Next

Step 1 

Receiving Master Data from Micros

In order to link Micros items to MMS first you must connect to the “MMS Sales Import Interface”

Click on the icon “Master Data” to retrieve the Micros Master Data. This will copy the menu items, 
major groups, family groups and revenue center from Micros. 

The following messages will appear at the bottom of the description column

When the message “Copying Micros Revenue Center” appears, continue with the next step

Step 2

On the bottom left hand side of the screen click on the icon  which is the system configuration
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Step 3

On the new screen on the left hand side please select the “Auto Linking” option

Step 4 

After clicking on the Auto Linking option, the “Micros Item Auto Linking” window will appear

How to...



In this window in order to link the medical items please select “Purchasing” from the “Select Store”
drop down menu

Step 5

Then select “Medical” from the “Micros Major Group” drop down

How to...



Step 6

Having selected this, please click in order for the Auto Linking to commence
When the Auto Linking is complete the following window will appear

How to...



Main Screen Top Next

When opening the Security Module the below screen will be visible. By filtering user names and by 
selecting one, the grey area will display general security information of the user selected.

Main Screen

When selecting (highlighting) a user on the right side of the screen, security details corresponding to that user 
will be shown on the right side as below.

General Properties Top Previous Next

General Properties

Please find the explanations for the different entries from the above screen below

Account Details

Login ID: name to be entered when logging into MMS

Account Type

Generic User Account: this type of account allows multiple users from one group (with the same credentials) to 
access MMS

Standard User Account: this type of account is personalized to one specific user 

Buyers Group: this is to determine which transactions will be visible to the user in regards to purchasing, 
ordering and viewing items (food, beverage, shops etc) 

Buyers Limit: a buyers limit can be set for each user on how much they are permitted to approve in the case of 
purchases from vendors or requests from ships

Onboard Crew Link: linking between MMS and SPMS

Email Address: email address of user
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Account Comments: additional comments considering the account can be entered here

Account Options

Password is Locked: when this box is marked users will not be able to change their passwords

Password Never Expires: when this box is checked password will not have to be changed on a regular basis

Account is Disabled: the account can also be disabled by checking this box. Users with disabled accounts will 
not be able to access MMS

Change password next Login: by selecting this box, the user must change their password the next time they 
log on

Can be Assigned an Action List: within the various modules users who have this box marked will be able to 
create action events

User Assigned Security Roles Top Previous Next

Various groups and security roles can be created according to operational needs. Within this box, 
by clicking edit, these security roles can be assigned to users. Multiple security roles can also be 
added to specific users.

User Assigned Security Roles

When clicking edit the following screen will show up

Security profiles to be added to the account may be selected from the list on the left hand side and can be added by 

clicking on the  button

Selecting  will add all security roles to the user account

Security profiles can also be revoked by selecting the profiles from the right side of the screen and clicking on the 
button.

Selecting  will revoke all security roles from the user account

When the selection is finished, by clicking on the  button the user account will be updated accordingly.

User Store Access Top Previous Next

User Store Access
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User Entity Access

This displays the list of ships and/or warehouses of which the user has access to and can view their details

Store access for the account may be selected from the list on the left hand side and can be added by clicking on the 

 button

Selecting  will add all stores to the user account

Store access can also be revoked by selecting the stores from the right side of the screen and clicking on the 
button.

Selecting  will revoke all store access from the user account

When the selection is finished, by clicking on the  button the user account will be updated accordingly.

User Entity Access Top Previous Next

User Entity Access

User Entity Access

This displays the list of ships and/or warehouses of which the user has access to and can view their details

Entity access for the account may be selected from the list on the left hand side and can be added by clicking on the 

 button.

Selecting  will add all entities to the user account.

Entity access can also be revoked by selecting the entities from the right side of the screen and clicking on the 
button.

Selecting  will revoke all entity access from the user account.

When the selection is finished, by clicking on the  button the user account will be updated accordingly.
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Account Statistics (Past 180 days) Top Previous Next

Under this tab various statistical information can be viewed such as who logged on, where, when, 
from which PC etc..

Account Statistics (Past 180 days)

Account Currently logged In

Here it is possible to view users that are currently logged in to MMS

Workstation: name of the PC where user is currently logged in

Windows User: name of the windows login on the machine where user is connected

IP Address: IP address of the PC where user is logged on

Application: the various modules that user is currently accessing

Recent Application Usages

Shows the history of accessing the modules

User recent application Hits

This graph represents number of times the different modules have been accessed recently

Account Activity (Past 72 Hours) Top Previous Next

Events of the last 72 hours are shown here in detail in regards to date, time, workstation etc...

Account Activity (Past 72 Hours)

Date: date of event occurrence

Time: exact time of event occurrence

Windows Login: name of user logged in to windows

User: entire name of user
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Workstation: name of PC user was logged on

Event: brief summary and description of event/activity 

Account Modification Logs Top Previous Next

Modification of different accounts and their details can be viewed here.

Account Modification Logs

Change password Top Previous Next

Change Password

By clicking on the button users will then be able to change their password.

After clicking on this button the following display will show up

In order to change the password users will have to enter their old password, then their new password, and 
reenter their new password in order to confirm it. By clicking "apply" the new password will be active the 
next time the user logs in.

Security Roles Main Menu Top Previous Next

Security Roles Main Menu

By selecting (marking one of the boxes) one of the security roles, the corresponding security rights to that 
particular role will be indicated in the right side of the screen (Security Roles Overview). 

Security roles can be set up and customized according to the operation and organizational hierarchy

Security Roles Overview Top Previous Next
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In this screen users are able to view the security rights that correspond to the previously selected 
security role. The security rights that are enabled are check-marked in the box on the right side of the 
screen.

Security Roles Overview

Filter security right: by entering the id number or the description of the searched security right, the system 
will filter the rights in the list below in order to search results faster

ID: this is the unique identification number of each individual security right

Description: full name of security role

Box: the box on the right side of the screen indicates whether this particular security right is enabled for the 
selected security role

Security Roles Access Top Previous Next

This screen displays which modules are accessible, and the opening screen details in MMS for the 
selected security role. 

Security Roles Access

Application Access

This screen shows which modules are enabled for the selected security role

Launcher Views Access

For each security role the main screen of MMS can be personalized based upon the criteria selected in this 
window

Security Roles Change logs Top Previous Next

Under this tab users can view all the changes and events that have occurred in regards to the 
Security Manager module.
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Security Roles Change logs

Date: date of event

Time: exact time of event

Windows Login: windows login name

User: full name of user

Workstation: name of the PC on which the event occurred

Event: brief summary and description of event

Buttons Top Previous Next

Buttons

Refresh: updates screen with current information

Users: by selecting this button the screen will return to the "users" screen view

Security Roles: when selecting this button the "security roles" menu will show up

Add: when selecting this function, a blank general properties sheet will appear in order to enter a new user

Delete: removes an already active user from the list

Copy Roles: this function enables users to copy the security roles from on user to another

Options: selecting this the application settings window will open

Lock: user can lock module by entering their credentials and only that user will be able to log back in

Exit: closes the security module

Close View: currently shown view will be closed

Button: Refresh Top Previous Next

Button: Refresh
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By selecting this button, screen will be updated with the newest information, changes etc

Button: Users Top Previous Next

Button: Users

This will return the users to the main screen view of the module as shown below

Button: Security Roles Top Previous Next

Button: Security Roles

This button will open the security role menu screen shown below

Button: Add Top Previous Next

Button: Add

After selecting this function the following screen "Add New System User" will appear. After entering all the 
necessary details and by clicking on "Add" the system will create the new user and save its newly entered 
security roles.

By selecting this button, new users and their security roles can be added. A new blank 
general properties view will show up, all details can be entered there

Button: Delete Top Previous Next

Button: Delete
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Permanently removes the selected user. The deleted user will no longer have access to MMS

Button: Copy Roles Top Previous Next

Button: Copy Roles

When selecting this option the following screen will show up allowing the user to be able to select the user 
whose security roles should be copied; and then the user to whom it should be copied to. See below:

Security roles can be copied from one user to another using this function.

Button: Options Top Previous Next

Button: Options

This button will open the "Application Settings" window

Button: Lock Top Previous Next

Button: Lock
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By entering the user ID and password the module will be inaccessible until the user who locked the module 
signs in again

Users will be able to lock the module by entering their credentials. Only the user who has 
locked the module will be able to reenter the module. 

Button: Exit Top Previous Next

Button: Exit

This button will close the Security module.

Button: Close View Top Previous Next

Button: Close View

Current screen view will be closed when this button is selected.

Menu Top Previous Next

File Top Previous Next

File
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Windows Top Previous Next

Windows
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The stock viewer is used only for the shipboard operation. It contains information regarding products currently in-use and in stock onboard. The 
options for viewing information include displaying stock on hand by store or point of consumption, displaying statistical information related to stores, 
sub stores or specific items, and viewing recent product movements (loadings, issues, transfers.) 

Main Screen: 

The below image represents the stock viewer main screen as it looks during normal operation. At the top are the function buttons and the toolbar menu. 
Below these are the main screen areas: 

At the very bottom of the screen, the vessel information, date & time, current user and computer name are displayed.

Moving the mouse over the screenshot, 'hotspots' may be activated. Clicking on these will display more 
detailed information about the particular button or window. 

The buttons toolbar contains the basic and most frequently used options for searching for articles, changing views between main and sub-stores and 
the printing options.

Buttons: 

Clicking the buttons below or the links will open more information and instructions on the usage of these functions.

Navigation:  Reference >

Stock Viewer

 Store selection drop tab
 POC selection drop tab
 Tree of folders - The groups and subgroups for items within the stock viewer.
 Items List

Navigation:  Reference > Main Screen >

Buttons

Search Opens the search engine to search for single articles
Refresh Refreshes screen view to the default state
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Most of the options have corresponding tools in the menu, keyboard shortcuts assigned to them or, are available with a right mouse click.    

In order to make it easier to find an article and relevant stock among the many thousands, an effective search engine exists which can be utilized in 
a number of ways. On occasion, one may be able to remember the code of a particular product, maybe even the barcode, but often one would 
probably wish to search using the article description, either full or partial. Sometimes one might want to just look in the product groupings for an item 
or similar items. All these options are possible with the product search facility.

Button Search: 

Double-clicking on the item will then take you to the section where the article is located.

Print Opens the print manager
Mainstore Opens a window in the main screen where the main store stock will be displayed
P.O.C Opens a window with the current stock on hand of the selected POC (Point Of Consumption)
History Displays the stock history of the selected article
Export to Excel Exports the current stock view into an Excel data sheet
Exit Exits the stock viewer module

Navigation:  Reference > Main Screen > Buttons >

Button : Search

Click on search to activate the product search engine
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History:  If an article has previously been searched, the system remembers the last item that was looked for. Click on the History icon and the system will jump to that 
last searched location
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This option refreshes the screen layout. For example, after sorting columns by their heading or resizing them, clicking refresh will reset the layout to 
the default view.

Button Refresh: 

This option opens the Report Manager. This option is also available in the menu; File ->Print.

Button Print: 

  Note: The system will only show articles that are enabled!! If all articles are required the  needs to be 
activated in the 'Show Disabled Items' checkbox at the bottom on the Search Engine.

Navigation:  Reference > Main Screen > Buttons >

Button : Refresh

Click to refresh your screen layout.

Navigation:  Reference > Main Screen > Buttons >

Button : Print

Click to open the report manager.

Navigation:  Reference > Main Screen > Buttons >

Button : Mainstore
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By clicking the Mainstore button on the toolbar, the program will display the mainstore stock in the Items list. This option can be activated at the 
same time as the Substore stock (POC) button being activated for simultaneous comparison of the information.

Mainstore: 

By clicking the POC button from the toolbar the program will display the sub-store stock in the Items list. This option can be activated at the same 
time as the Mainstore stock button being activated for simultaneous viewing of the information.

POC: 

Click to activate the Mainstore stock view.

Navigation:  Reference > Main Screen > Buttons >

Button : POC

Click to activate the POC stock view.
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Clicking the history button displays the mainstore stock history of any given product category at a given moment. This may prove helpful when 
comparing the stock situation with the current situation in a sub store for instance.

History: 

Navigation:  Reference > Main Screen > Buttons >

Button : History

Click to activate the historical product stock viewer.

 In order to view historical stock it is necessary to define the store which will be viewed. This is done in the store type selection field.

 Secondly the desired date for the historical stock needs to be selected. This is done by selecting the corresponding date from the calendar.
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This function exports the contents of the active screen to an Excel spreadsheet. 

Exporting to Excel: 

An export window will open

Click  to continue

The exported data will be displayed in Excel, and can be manipulated, saved, or used as desired.

This option will close the stock viewer module. You may also select from the menu; File -> Exit.

Button Exit: 

The Menu bar on the top of the screen contains basic options which are also represented in the toolbar and often also available with a right mouse 
click.

Menu: 

 The historical mainstore stock view can be closed by selecting  from the right corner of the screen.

Navigation:  Reference > Main Screen > Buttons >

Button : Export to Excel

Click to export the active window contents to an Excel spreadsheet.

Navigation:  Reference > Main Screen > Buttons >

Button : Exit

Click to close the stock viewer module. 

Navigation:  Reference > Main Screen >

Menu

Main Screen



This menu contains the basic file options for searching and exporting to Excel sheets. In addition to this the file menu also contains the option to 
open the report manager.

File Menu options: 

In order to make it easier to find an article and relevant stock among the many thousands, an effective search engine exists which can be utilized in 
a number of ways. On occasion, one may be able to remember the code of a particular product, maybe even the barcode, but often one would 
probably wish to search using the article description, either full or partial. Sometimes one might want to just look in the product groupings for an item 
or similar items. All these options are possible with the product search facility.

Button Search: 

Navigation:  Reference > Main Screen > Menu >

File Menu

Search

Export

Print

Exit

Search 

Export the current view to an Excel sheet

Open the report manager

Close the stock viewer

Navigation:  Reference > Main Screen > Menu > File Menu >

File : Search
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Double-clicking on the item will then take you to the section where the Article is located.

Click on search to activate the product search engine
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History:  If an article has previously been searched, the system remembers the last item that was looked for. Click on the History icon and the system will jump to that 
last searched location

This function exports the contents of the active screen to an Excel spreadsheet. 

Exporting to Excel: 

An export window will open

  Note: The system will only show articles that are enabled!! If all articles are required the  needs to be 
activated in the 'Show Disabled Items' checkbox at the bottom on the Search Engine.

Navigation:  Reference > Main Screen > Menu > File Menu >

File : Export

Click to export the active window contents to an Excel spreadsheet.
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Click  to continue

The exported data will be displayed in Excel, and can be manipulated, saved, or used as desired.

This option opens the Report Manager. This option is also available in the Menu; File ->Print.

Button Print: 

This option will close the stock viewer module. You may also select from the menu; File -> Exit.

Button Exit: 

Navigation:  Reference > Main Screen > Menu > File Menu >

File : Print

Click to open the report manager.

Navigation:  Reference > Main Screen > Menu > File Menu >

File : Exit

Click to close the stock viewer module. 
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This menu contains the the options for setting how the information is displayed on the main screen and which columns are included in the view. 

Edit : 

Columns mainstore: 

Choose the columns to be displayed by checking or unchecking the boxes in the table:

Columns sub-store: 

Choose the columns to be displayed by checking or unchecking the boxes in the table:

Navigation:  Reference > Main Screen > Menu >

Edit Menu

Columns Mainstore

Columns SubStore

Item Details

This option chooses the columns that are displayed on the Mainstore View.

This option choosse the columns that are displayed on the Substore View.

Opens the article view tab

Navigation:  Reference > Main Screen > Menu > Edit Menu >

Columns Mainstore

Code Item code
Description Item description
Unit Item unit of measure
Open Opening stock quantity
Loaded Quantity loaded since beginning of period
Issued Quantity issued since beginning of period
Returned Quantity returned since beginning of period
Corrections Quantity adjusted as corrected stock
In Stock Quantity in stock with reservations
Pending Issues Total of reservations for issues to substores
Pending Returns Total of reservations for returns from substores
Available Stock Total of available stock

Navigation:  Reference > Main Screen > Menu > Edit Menu >

Columns Substore
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The folder tree represents the groups and subgroups for items in the stock viewer. By selecting a group or product category, the details will be 
displayed on the Items list side of the screen.

Groups and sub-groups: 

To view the stock for an article, it is always necessary to select the appropriate store. In other words this is the category of articles that is being viewed.

Code Item code
Description Item description
Unit Item unit of measure
Open Opening stock quantity
In Quantity received from mainstore since beginning of period
Out Quantity returned to mainstore or transferred to other location since beginning of period
Corrections Quantity adjusted as corrected stock
Sold Quantity sold as per Micros POS
In Stock Quantity in stock at location
Pending in Total already requested for delivery at location but not yet delivered
Pending out Total already prepared for return to mainstore but not yet returned
Available Stock Total of available stock

Navigation:  Reference > Main Screen >

Tree of Folders

...then select the group

Main Screen



In the main window, all the articles that are assigned to the selected group can be viewed.

Item List: 

The articles are sorted by column headings.

By selecting a folder the corresponding articles belonging to that group will be displayed in the items view. Please note that either the Mainstore 
Button or the POC Button must be activated for the program to view information on the selected group.

Navigation:  Reference > Main Screen >

Items List

Main Screen



The column headings are as follows :

Articles are listed in the window in the order in which they were created, this is the default sort order. 
Clicking on the column heading 'Description' or 'Unit' will change the sort order to sort by that column.

Right mouse clicking on an article will open another menu. These options are also available as keyboard shortcuts and from the toolbar.

In the Article View it is possible to view different types of information regarding the chosen product by selecting the tabs on the left hand side. 
The view may be changed by selecting the tabs, however the information displayed relates to transactions for the selected article only.

Article View: 

Code:      Code of article
Description: Name of article
Unit:  Unit of article

Click on Refresh to return the screen to the default layout.

Navigation:  Reference > Main Screen >

Article View
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The information displayed can be set to cover a specified date range by choosing the dates from the calendar.

Select Date From :                                Select Date To :

The product information side tabs contain specific information on the selected product in various categories : 

The mainstore view displays information for the selected article and its movements within and from the mainstore.

Mainstore: 

Article and its movements within the mainstore.

Article and its movements within the sub-stores (POCs).

Loading transactions of the selected article

Issue transactions of the selected article

Return transactions of the selected article

Transfer transactions of the selected article

Corrections to stock of the selected article

Consumption of the selected article

Sales of the selected article.

Navigation:  Reference > Main Screen > Article View >

Article View

Main Screen



The columns provide the following information: 

If fixed prices are to be used in the numbers displayed, select this option.

The sub-store view displays information for the selected article and its movements within and from the sub-stores.

Sub-stores: 

MainStore Mainstore situations / events
Stock Stock quantity involved in situations / events
Unit Unit of measure of article
Value Value of each independent transaction

Navigation:  Reference > Main Screen > Article View >

Article View

Main Screen



The following options are available on the screen : 

The loadings view displays information for the selected article related to loading transactions. 

Loadings: 

POC Point of consumption event

Stock Stock quantity involved in event
Unit Unit of measure of viewed article

Value Value of each independent transaction

Click to refresh the screen layout to the original state

Click to export the viewed information to an Excel spread sheet.

Click to exit the module

Navigation:  Reference > Main Screen > Article View >

Article View

Main Screen



The following options are available on the screen : 

The issues view displays information for the selected article related to issue transaction to the various POCs.

Issues: 

Date Date of loading transaction
Type Type of loading transaction
Amount Value of loading transaction
Unit Unit of measure of viewed article
Price Unit price of article listed in each individual loading
Currency Loading currency

Price Price in system currency
Total Total in system currency
Exchange Rate Exchange rate to local currency
Vendor Name of vendor
Ref The individual reference of the loading transaction

Click to refresh the screen layout to the original state

Click to export the viewed information to an Excel spread sheet.

Click to exit the module

Navigation:  Reference > Main Screen > Article View >

Article View

Main Screen



The following options are available on the screen : 

The returns view displays information for the selected article related to returns.

Returns: 

Date Date of issue transaction
Destination Location to which items were issued
Status Status of transaction
Amount Amount issued
Unit Unit if measure used in transaction
Price Price in system currency
Total Total in system currency
Ref Individual reference for the transaction

Click to refresh the screen layout to the original state

Click to export the viewed information to an Excel spread sheet.

Click to exit the module

Navigation:  Reference > Main Screen > Article View >

Article View

Main Screen



The following options are available on the screen : 

The transfers view displays information for the selected article related to interdepartmental transfers.

Transfers: 

Date Date of return transaction
Destination Destination store to which the items were returned
Status Status of the return transaction
Amount Amount of the return
Unit Unit of measure of articles returned
Price Unit price of the returned article
Total Total amount of the returned articles
Ref. The individual reference of the return transaction

Click to refresh the screen layout to the original state

Click to export the viewed information to an Excel spread sheet.

Click to exit the module

Navigation:  Reference > Main Screen > Article View >

Article View

Main Screen



The following options are available within the screen : 

Displays inventory corrections for the selected article.

Corrections: 

Date Date of the return transaction
From Origin of the transferred material (From which outlet were the items taken)
To Destination of the transfer (To which outlet are the items taken)
Status Status of the transfer transaction
Amount Amount of articles transferred
Unit Unit of measure of viewed article
Price Unit price of the transferred article
Total Total value of the transfer transaction
Ref. The individual reference of the transfer transaction

Click to refresh the screen layout to the original state

Click to export the viewed information to an Excel spread sheet.

Click to exit the module

Navigation:  Reference > Main Screen > Article View >

Article View

Main Screen



The following options are available within the screen : 

Displays consumption information for the selected article.

Consumptions: 

Date Date of stock adjustment (correction)
Counted Counted physical stock amount
Unit Unit of measure of viewed article
Variance Variance between physical and theoretical stock
SOH Physical stock on hand
Ref. Reference number of the adjustment transaction
Comments Comments that have been included in the adjustment transaction.

Click to refresh the screen layout to the original state

Click to export the viewed information to an Excel spread sheet.

Click to exit the module

Navigation:  Reference > Main Screen > Article View >

Article View

Main Screen



The following options are available within the screen : 

Displays sales information from Micros POS for the selected article.

Sales: 

From Period starting date
To Period closing date
Closing SOH Closing stock on hand
Corrections Corrections made to stock on hand during the period
Consumption Consumption during period
Season Season of consumption
Ship Vessel name

Click to Refresh the screen layout to the original state

Click to export the viewed information to an Excel spread sheet.

Click to exit the module

Navigation:  Reference > Main Screen > Article View >

Article View
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The following options are available within the screen : 

Period ID ID number of period
Open Period starting date
Close Period closing date
Sold Quantity of articles sold during period
Unit Unit of measure of viewed article

Click to refresh the screen layout to the original state

Click to export the viewed information to an Excel spread sheet.

Click to exit the module

Main Screen



Task Manager functions as the module to schedule activity within MMS such as setting storeroom timetables, due times and 
meetings among others. In addition it may be used as the generic shipboard calendar for organizational activity and have the 
system alarm set for a specific activity.

Task Manager Main Screen: 

The main screen is divided into 5 main sections : 

By moving the mouse over the screenshot, the 'hotspots' will be activated, changing the cursor to . Clicking on these will jump to more 
detailed information about the particular topic. 

The buttons provide quick access to options for searching and printing, among other functions.

Buttons: 

Navigation:  Reference >

Task Manager Main Screen

 File Menu - for accessing the most common options

 Function Buttons for accessing the most common functions

 Calendar View - Listing the tasks for a selected day.

 Tasks and Events List below the Calendar

 Daily View of Tasks

Navigation:  Reference > Main Screen >

Buttons:

Main Screen



Most of the options have corresponding tools in the Toolbars, keyboard shortcuts assigned to them or, are available with a right mouse click. 

This function is currently inactive.

This option refreshes the screen layout. For example, having sorted columns by their heading or resized them, clicking refresh 
will reset the layout to their original view.

Button Refresh: 

This button opens Report Manager and allows to print various reports and templates.

Button Print: 

Search: Button currently inactive
Refresh: This option refreshes the screen layout
Print: Opens Report Manager
Exit: Close the Tasks Manager

Navigation:  Reference > Main Screen > Buttons >

Button: Search

Navigation:  Reference > Main Screen > Buttons >

Button: Refresh

Click to refresh your screen layout.

Navigation:  Reference > Main Screen > Buttons >

Button: Print

Click to open the Report Manager

Main Screen



This button will close the Task Manager. This option is also available in the Toolbar.

Button Exit: 

In Calendar View it is possible to see the number of tasks for each day of the month and navigation is quick and easy between 

Before you click print, it's always a good idea to check the printer options on the Details tab of the report.

Navigation:  Reference > Main Screen > Buttons >

Button: Exit

Click to close the Task Manager.

Navigation:  Reference > Main Screen >

Calendar View

Main Screen



particular dates with a mouse click.

Calendar: 

Clicking on a specific day will highlight it in blue and will update the display of the tasks list and the daily view windows.

The Tasks & Events panel collects together the different types of activity that may be scheduled. By default the system 
displays all the activity that has been set in the activity calendar. By selecting a specific task the system will only display that 
particular activity on the calendar.

Tasks & Events: 

Meetings
Regular meetings may be scheduled though this option.

Storeroom Movements
The time when items will be issued (picked up or delivered) may be set in this option.

Requisition due times
If requisitions have to be made by a certain time, these timeframes may be set under this category.

Ship Orders
If ships orders need to be sent by a certain date, these deadlines may be set here.

All
All the above activity may be viewed together by selecting this option.

Navigation:  Reference > Main Screen >

Tasks & Events Panel

 The following types of activity can be managed and scheduled in the Task Manager:

Main Screen



To add a New Scheduled task please right click on the Tasks list.

Both parts of the screen display the same information, but presented in two different ways.  Double clicking an item in either 
panel will open the Task View screen. 

Tasks List: 

Here you can see a list of tasks depending on your selection in Calendar View and in the Tasks & Events Panel.

You can sort the list in different ways by clicking on the column headings, e.g. Department.

To add a new task, right click this part of the screen and select option.

Daily View:

This section allows you to view the daily schedule in a more user friendly way. You can easily spot if specific areas are overloaded or, if you need 
to move a particular event to a different spot.

Navigation:  Reference > Main Screen >

Tasks List and Daily View

Main Screen



This menu contains the options for Printing and Exiting the program.

File : 

Navigation:  Reference > Main Screen >

Menu : File

Print:
Exit:

Open the Report Manager
Close the program

Navigation:  Reference > Main Screen >

Task View

Main Screen



The Task window is divided into 3 tabs. Here the tasks in detail can be defined, setting recurrences and reminders.

General: 

The General tab is where the tasks main attributes may be defined such as timeframe, department & group.

General: 

The General tab contains the following information:

General: Set the main task attributes such as times, department, group and description.

Recurrence: Define whether the task is a 'one-off' or will repeat on a set basis.

Alarm: Add reminders to tasks and configure these reminders for other users.

Navigation:  Reference > Main Screen > Task View >

Tab: General

 Start Time: here you have to specify what time the task begins
 End Time: in this field you specify what time this particular task ends
 Department: select which department is involved in this task

Main Screen



See Also:

This tab allows you to define if this is a one time only task, or if it repeats periodically.

Recurrence: 

The following repeating patterns are available for selection:

 Display Color: the color in which to display the task in the Daily View panel
 Group: allows you to specify the group to which the task belongs:

 Meetings
 Ship Orders
 Requisition Due Times
 Store Movements: This group has a direct connection to the Movements module. It allows you to specify a 'window' for issuing the goods from

the warehouse. During creation of a new movement for a particular department, the user must select one of these 'windows' to pick-up
requested goods. You can specify this window as a task with the group - Store Movements

 Task: here you can provide more information (description) of particular task

 Recurrence Tab
 Alarm Tab

Navigation:  Reference > Main Screen > Task View >

Tab: Recurrence

 Daily: the task repeats every X days, it can be set to repeat for example every 1 or 7 days
 Weekly: you can pick the days of the week on which the task occurs:

Main Screen



You can also specify a Range of Recurrence:

See Also:

The Alarm tab allows you to setup reminders for particular tasks.

Alarm: 

 Monthly: you can specify that the task occurs on a particular day of the month, for example every 5th day of each month

 Start: the date on which the task becomes effective.
 End: here you can either specify the expiry date of the task recurrence or set no ending date.

 Note:
The system automatically defaults to a one-off recurrence when first creating a new task. 
Here the 'Start' & 'End' dates will be the same, although the Recurrence Pattern will show 
'Daily' and 'Every 1 Day(s)'. 

 General Tab
 Alarm Tab

Navigation:  Reference > Main Screen > Task View >

Tab: Alarm

Main Screen



On this screen you can setup a reminder, the time prior to the event when the reminder should be sent, and who should receive the reminder. To 
add recipients of the reminder, please click on Add / Edit button.

See Also:

Add / Edit users allows you to select recipients of the reminder for a particular task.

Add / Edit Users: 

 General Tab
 Recurrence Tab
 Add / Edit Button

Navigation:  Reference > Main Screen > Task View > Tab: Alarm >

Button Add / Edit

Main Screen



The following buttons are available:

Basic operation in this tab is to move appropriate users from the left side of the screen to the right side, therefore assigning the reminder to them. 
When you have finished, click 'Done'.

Moves selected user from left side to the right side (selection)

Moves ALL users from left side to the right side (selection)

Moves selected user from right side (selection) to the left side

Moves ALL users from right side (selection) to the left side 

Main Screen



Navigation:  How to ... >

How to....Add a new task
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Adding new task: 

1. Fill out the general details:

The General tab contains the following information:

 To add a new task, first select the day in the calendar on the main screen, then right click on the Tasks List and from context menu select New.

 A Task View window opens.

 Start Time: here you have to specify what time the task begins
 End Time: in this field you specify what time this particular task ends
 Department: select which department is involved in this task
 Display Color: the color in which to display the task in the Daily View panel
 Group: allows you to specify the group to which the task:

 Meetings
 Ship Orders
 Requisition Due Times
 Store Movements: This group has a direct connection to the Movements module. It allows you to specify a 'window' for issuing the goods from the warehouse.

During creation of a new movement for a particular department, the user must select one of these 'windows' to pick-up requested goods. You can specify this
window as a task with the group Store Movements

Adding New Task



Template Manager is the module which allows created internal requisition forms of all departments to be stored for re-
usage. A folder may be created for each of the departments from which the users can retrieve the ready made requisition 
form.  This way it is necessary to insert only the material quantities in the requisition instead of searching for each and 
every item from the stores. 

Template Manager Main Screen: 

The Main screen consists of the following sections :

By moving the mouse over the screenshot and you will see certain 'hotspots' identified with the cursor 

changing to a . Click on these to move into more detailed information about that particular topic. 

The tree of folders represent the groups and subgroups for templates in the Template Manager.
Here sub folders can be created and the templates can be organized for ease of use. 

Navigation:  Reference >

Template Manager Main Screen

 On the top part are located the the Menu and Function Buttons through which the most common functions may be accessed.

 The tree of folders consists of the Folders that may be created for each department.

 The Template list makes visible the contents of each selected folder.

Navigation:  Reference > Main Screen >

Tree of Folders

Main Screen



Tree of Folders: 

The top level folder, in this example - Bar Templates, will always contain ALL templates. When moving a template to another folder, it will still 
be displayed in the master folder. 

When clicking on a folder in the folder tree, all the templates that belong within it will be displayed in the main window. 

Templates List: 

The main window displays the templates available in the current folder.

 To look for a particular template it is possible to select the folder and browse. In the main screen, the list of templates belonging to a
particular folder will be displayed.

The folder tree on the left is the folder setup. 

 By right clicking with the mouse on a folder, the popup menu below will appear.

Insert Folder: Add a new folder.
Rename: Rename an existing folder.
Delete Folder: Delete an existing folder.
Expand Folders: Expands the tree to show all sub folders.
Collapse Folders: Collapses the tree, hiding sub folders.

 These options are also available from the Edit menu when a folder is currently selected.

Navigation:  Reference > Main Screen >

Templates List
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Double clicking on the selected template will open it for editing, where you can add or delete items. 

Hint: You can sort the list ascending or descending, by clicking on the available column headings (ID, Code, Name, Items, 
Value).    The viewable columns may also be moved to display in a different order by simply clicking on the column header 
with the left mouse button and dragging it to the desired location.

A right click on a template will popup the following shortcut menu:

See Also:

The buttons toolbar contains basic options for performing tasks in Template Manager. 

Buttons: 

Open: Opens the selected template for editing.
New: Create a new template.
Copy: Copy the selected template.
Paste: Pastes the previously copied template.
Delete: Deletes the selected template.
Properties  Shows the template attributes, allowing you to change the Code and Name.

 Add to a Template

Navigation:  Reference > Main Screen >

Buttons

Main Screen



Click the buttons or links for a more detailed description of the particular function. 

Most of the options have corresponding tools in the Toolbar, keyboard shortcuts assigned to them, or are available as a Right mouse click.

The search function enables to look for a specific template quickly by ID, code or name. It is possible also to browse by the 
folders indicated in the left hand window. 

Search: 

You can search for a template in multiple ways:

Search - Search for a specific template
New: - Create a new template
Print: - Opens the Print Manager module
Refresh: - Refreshes the screen layout
Exit: - Closes Template Manager

Navigation:  Reference > Main Screen > Buttons >

Button: Search

Click to search for a template.

 by entering the Template ID, code or user defined name of the template

Main Screen



Clicking 'New' starts the process for creating a new template. 

New Template: 

 by browsing the tree structure and checking one template after another

Navigation:  Reference > Main Screen > Buttons >

Button: New

Click to start creating a new template.

 Once clicking the New button, a wizard will appear to help with the process of creating new template.

 On this screen you need to enter a Code for the template which can be alphanumeric up to 20 characters. Make the text is unique and
meaningful, something that will help you when searching for the template at a later point. It will be easier to tell another user to use template
'BAR001' instead of using the whole name of the template.

 You also need to enter a Name for the template, which is similar to a description.  It can be up to 50 characters long and can describe the
template's contents,

 You will also need to add at least one administrator and at least one user in order to make the template accessible for these users
 Entities where the newly created template should be visible should also be added here

 Once this is complete, click the Finish button to close the wizard and start to add Articles.

Main Screen



This button opens Report Manager and allows to print various reports and templates.

Button Print: 

Navigation:  Reference > Main Screen > Buttons >

Button: Print

Click to open the Report Manager

Main Screen



This option refreshes the screen layout back to its default appearance if the column sizes have been altered or sorted by 
column headings etc.

Button Refresh: 

This option will close the Template Manager. It is also available from the toolbar.

Button Exit: 

Navigation:  Reference > Main Screen > Buttons >

Button: Refresh

Click to refresh your screen layout, i.e. to return to the top of a template or the folder tree if you are 
browsing near the bottom.

Navigation:  Reference > Main Screen > Buttons >

Button: Exit

Main Screen



The Menu bar on the top of the screen contains basic functions that are also represented in the toolbar, and are also 
available with a right mouse click.

Menu : 

This menu contains the most common options for creating a new template, printing or exiting the module. 

File : 

Click to close the Template Manager.

Navigation:  Reference > Main Screen >

Menu

Navigation:  Reference > Main Screen > Menu >

Menu : File

New Template

Print

Export to Excel

Exit

Starts the process of creating a new template

Print a Template

Will convert the selected template into an excel file 

Exit the Template manager module

Navigation:  Reference > Main Screen > Menu >
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The Edit menu contains the most common options for creating, re-opening documents.

Edit : 

The Properties option displays the general description and security details of a single template. In this option it is possible 
to modify the name of the template, department, and the users who can access this template.

Properties : 

code, description and other comments that have been inserted during the creation process

Menu : Edit

Open
New

   Copy
   Paste
   Delete

Properties

Open a selected template. This function is equal to a double click on the mouse.

Create a New Template 

Copy Selected Data

Paste the Copied data to a destination area. This option activates only after having used the 
copy function. 

Delete an item or a selected template. This option is also available by right clicking an item 
inside a Template.

Display the Properties / Nominative Details of a Template

Navigation:  Reference > Main Screen > Menu > Menu : Edit >

Menu : Edit

 By Opening the general tab the program displays the general properties of a template including the

 By opening the Users and Administrators tab it is possible to modify which users have access and the rights to use the template.

Main Screen



The following options are available : 

When finished modification of the users, click 

 To edit the users list,  click  which will open the users list.

 Add a user

 Remove a user

 Add all users

 Remove all users

 The entities where this template can be viewed can also be entered and modified here

Main Screen



The Windows menu allows to change how the windows and screens are displayed. 

Windows : 

Navigation:  Reference > Main Screen > Menu >

Menu : Windows

Arrange All

  Split

Rearranges the windows back to the default view

Splits the selected vies equally across the screen

Main Screen



Templates and Folders 

By RIGHT CLICKING the area underneath the search button a shortcut menu appears. Choose 'Insert Folder' from the menu list. 
 (Under this folder the respective department folders for each section will be created.)

Name the new folder to your choice, i.e. Bar Templates or Housekeeping Templates might be used.  Confirm the name by 
pressing ENTER.

Navigation:  How to ... >

Creating Templates and Folders

 The first task is to create the templates for all departments that use the MMS software. To do this proceed as described below:

Create Templates and Folders



On the right hand side of the screen the heading for the newly created template will appear. 

 Move the cursor to the folder in which you wish to create a new template and click the NEW button on the top or alternatively right
click in the list view and select "New"

 Complete the required fields by inserting an individual code and description for the template. Confirm the given information by
clicking "Add".

Create Templates and Folders



To add items click in the CODE column once, and then press the “+” key.  The Search Engine will open to help locate the products 
that need to 
be added to the template.  Type in the desired word, for example, beer and then press the enter key to initiate the search.

Move to the next empty line in the template and repeat the process until all the required products are inserted.

Close the template creation wizard by clicking the 'Close' button in the upper right corner.

 To insert articles into the new template, first open the template by selecting it with the cursor and then DOUBLE CLICK it.

 Select the desired product from the search results list and DOUBLE CLICK your selection to confirm. This will carry forward the
selected product to the actual template.

Create Templates and Folders



Add to a Template: 

Navigation:  How to ... >

Add items to a Template

 To begin editing a template, double click on it in the main window. The following screen will show up

Create Templates and Folders



Article Search Engine:

Once you press the '+' key, the Search Engine opens allowing you to search for specific items to enter into the Template.

 You can either press the  '+' key on the keyboard or type in the Article Code in the "Code" column and press Enter.

 If you don't know the Article Code or barcode, you can use the search as shown below:

Create Templates and Folders



 Alternatively, you can search through the Main and Sub-group folders.
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History:  If you have previously searched for an item, the system remembers the last item you looked for. Click on the History icon 

and the system will jump to that last searched location

Inserting an item into the template:

You can either enter the item amount into the template or, if you prefer, leave it as 0.000. That way users will have to type in the 
quantity whenever they use the template. Leaving 0.000 as the amount is the most common way of creating the templates, since 
most of the time the amounts are changing. Once you press enter to confirm your entry, the system is ready to accept the next 
one. The process begins again by either typing the article code or using the article search engine to find another item.

Once you have finished with your template, click the "Close" button to return to the list of the templates.

Note: The system will only show articles that are enabled! If the you require the system
to look for all articles, you have to click the  Show Disabled Items checkbox at 
the bottom on the search engine.

 Once you type the article code in the 'Code' field, or use article search engine to find a particular item, the item details are
inserted into your template, and the cursor is placed into the 'Amount' column.

To delete an item from the template you can either right click on the item which will display 

. In addition, you can press Shift+Delete to delete the selected item.
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This section covers some issues that are frequently encountered by our users. The questions are organized by category and, 
where necessary, links are provided to relevant sections of the help.

Put simply, a template is like a list that can be reused throughout the whole system. Think of it like a paper shopping list you have 
photocopied for yourself to use again and again at the supermarket. You just change the amounts you want each time instead of 
rewriting the whole list.

Templates: 

Once a template is created you can use it, for example, to create a Request. The whole list of items from the template would be inserted into your new 
request.

The main reason for creating templates is to save time when creating new entries in the system. When the proper templates are created, it's much faster 
to insert one of these into the current document and adjust the quantities, instead of entering all the articles again from the beginning.

For example:

Navigation: »No topics above this level« 

Frequently asked questions

Navigation: Frequently Asked Questions >

What is a Template?

Frequently Asked Questions



In this case, once a template containing 2 items has been created in Template Manager, it can then be used when creating a new transaction in the 
Movements module.

Frequently Asked Questions



The Vendor Manager is the module which stores all information relating to suppliers, port agents and any other 
references. Beside the Article Manager ît is the most important Module for the administration of Master Data . 
All Information regarding suppliers typed in the Vendor Manager will effect many other Modules (i.e. Address 
Field on Purchase Orders)  so it is most imperative to keep this Information up to date.
The main window displays the primary information for the selected record allowing to quickly find a phone 
number or email address when needed. In Addition the Vendor Manager also administrates more important 
contacts such as travel agents, port agents and others, where for related contacts like company internal contacts 
and port authorities can be stored.

Vendors Main Screen: 

Once opening the module, the following screen image is presented:

Clicking on an icon in the alphabetical breakdown window populates the main screen with the details relating to that initial letter or number.

Navigation:  Reference >

Vendors Main Screen
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By scrolling right on this screen the primary data of the contact will also be available such as the phone number, fax and email address

VENDOR DETAILS

Code:
Name:
Primary Company:
Address:
Country:
City:
Postal Code:
Phone:
Fax:
Email:

TERMS, MINIMUMS, ZONES

Preferred Currency:
Payment Terms:
From Date of:
Delivery Terms:
Payment Method:
Minimum Order Balance:
Bidding Zone:
Secondary Language:

BANK DETAILS

Bank Name:
Address:
Country:
City:
Postal Codes:
Phone:
Fax:
Branch ID:
Account Number:
Swift Number:

The buttons toolbar contains the most frequently used options for quick and easy access. 

Navigation:  Reference > Main Screen >

Buttons
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Buttons: 

These functions are also accessible from the Menu.

Button: Search

The following screen will show up:

Search Criteria: by entering the beginning of the description, code, country etc

Treeview

Filter by Vendor Type;

Search By selecting this function the search engine will open
Refresh Updates the screen with updated information
New Vendor By selecting this function the screen to enter new vendor details will open
Edit Enables users to modify existing vendor details
Delete Removes selected vendor entry permanently
Copy Copies the selected vendor
Paste Vendor that was selected to be copied will be entire by using this function
Email Opens email generator
Show Totals Displays the totals of orders and invoices in the display window

Navigation:  Reference > Main Screen > Buttons >

Button: Search

By selecting this function the search engine will open
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Search Options

The search will only include those results that have been specified by marking the individual search criteria.

This option refreshes the screen layout. For example, once having sorted columns by their headings or resized them, clicking 
Refresh will reset the layout to the default view.

Button Refresh: 

Selecting 'New' will open the Add New Vendor Wizard to create a new vendor file. 

Button New Vendor: 

Navigation:  Reference > Main Screen > Buttons >

Button: Refresh

Click to refresh the screen layout.

Navigation:  Reference > Main Screen > Buttons >

Button: New Vendor

Creates a new Vendor record.
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In order to activate the Vendor, further steps and information can be found under Vendor View

See Also:

Button: Edit

Button: Delete

 Vendor View

Navigation:  Reference > Main Screen > Buttons >

Button: Edit

By selecting this option users will be able to modify the highlighted vendors details. 

Navigation:  Reference > Main Screen > Buttons >

Button: Delete
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Button: Copy

Button: Paste

Button: Email

When selecting this function the screen to generate emails will appear

With this option the vendor will be deleted permanently from the module

Navigation:  Reference > Main Screen > Buttons >

Button: Copy

By selecting this option users will be able to copy all vendor details

Navigation:  Reference > Main Screen > Buttons >

Button: Paste

The vendor that has been copied previously will then be inserted by using this function

Navigation:  Reference > Main Screen > Buttons >

Button: Email

By selecting this option the possibility of sending an email to the vendor will be available
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Button: Show Totals

As in the screenshot below the tabs "Count", "Orders" and "Invoices" will appear

Within view users have the opportunity to be able to import new Vendors and their details via an excel sheet as well as being able to view 
those vendors that have been deleted.

System Configuration

Navigation:  Reference > Main Screen > Buttons >

Button: Show Totals

When this option is selected the quantity of active invoices and orders will be shown for each individual vendor

Navigation:  Reference > Main Screen > Buttons >

System Configuration
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Vendor Import

Vendors previously deleted can be viewed in this display list.

Deleted Vendors

On the top left hand corner of the display a new button has been added

By highlighting a vendor from the list and then by clicking on the above mentioned restore button, the selected vendor will be reactivated and will 
disappear from the below list.

By clicking on "Delete" within this view, the vendor will permanently be deleted and will not be able to be recovered

Navigation:  Reference > Main Screen > Buttons > System Configuration >

Vendor Import

Navigation:  Reference > Main Screen > Buttons > System Configuration >

Deleted Vendors
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When you create a new Vendor, using the wizard, only the most basic details are entered. In order to 
'Activate' your new Vendor for use, you need to access the Vendor Properties to do so. 

By default, the opening view is the General folder and the 'General Information' page. The folder icons in the 
right window represent various pieces of information that relate to the Vendor. Each time you click on a 
different folder you will be presented with a new set of fields to add to the description and setup of that 
Vendor. With these options you can make the configuration as simple or as detailed as you wish. All of the 
folders are broken down individually in this help section and, for ease of use, we refer to them as tabs. 

General: 

The Vendor Properties is displayed starting in the General tab. Empty fields can now be updated

Navigation:  Reference >

Vendor View -> General Information

To open the properties for your Vendor, double click on the Vendor 
in the main window.. 
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Lets break this window down into more detail:

GENERAL INFORMATION

Status: in order to activate this vendor this box must be checked
Type:

Other
Port Agent
Travel Agent
Vendor

Sub Vendor of: vendors can also be a sub vendor of another. With this drop down users are able to select the main vendor from the list of vendors 
already in the system 
Code & Name: the specific code for the vendor and the name of the vendor is to be entered in these slots

ADDRESS

Address: postal address of vendor
Country, City: country and city of headquarters of vendor
Post Code: corresponding post code

CONTACT
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Primary Phone Number: main contact number of vendor
Primary Fax: main fax number for vendor
Email Address: email address of vendor
Web Site: website of vendor

At the bottom of the screen the following tab can be found

Options enables users to edit the layout of the vendor details

By clicking on Close, the vendor view will be exited.

With the Contacts tab, you can enter detailed information for individual contact persons within the 
specified Vendor account. This can prove useful where you are using one Vendor for an array of 
products and deal with separate people in that company for different items or product groups. 

Contacts: 

By clicking the contact tab the following screen will show up

By clicking on   users will be able to add additional contact details corresponding to the vendor in the screen shown below

Navigation:  Reference > Vendor View - Tab: General >

Tab: Contacts
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After entering all the available contact details and by clicking on  a new contact ID will show up under the Contacts tab.

This tab allows you to define payment terms for the supplier, set a minimum order value and assign a Vendor to a particular 
bidding zone. 

Terms, Minimums & Zones: 

This tab is split into three sections. Apart from the minimum order balance, which is free type, the other options are selected from the drop down arrows. 
The options within are defined in the system, Options -> Purchasing. 

Navigation:  Reference > Vendor View - Tab: General >

Tab: Terms, Minimums & Zones
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Payment Terms, Minimum Order Balance and Zones

Preferred Currency: the currency the vendor prefers to calculate in

Payment Terms

From Date of: 
Date of Invoice
Date of Delivery
Prior to Delivery

Delivery Terms: cost of freight; cost, insurance and freight; delivered duty paid; free on board; free carrier arrival etc

Payment Method: bank wire, cash, transfer, check etc

Minimum Order Balance: Each vendor can be assigned to a minimum order balance. When user attempts to send an order below this balance, a 
warning will be triggered

Bidding Zone: Each vendor can be assigned to a user defined Zone, which is used when processing orders internationally

Language: Each vendor can be assigned a default secondary Language

Click 'Close' to close the Vendor properties, click on another tab to continue adding detail or use the  arrows to move to the next 
supplier.

Each Vendor will have their own way of operating and these could all differ greatly. By utilizing the Order Conditions, you preset 
the requirements that each supplier should adhere to.

Order Conditions:

Below is an example of the order conditions. Simply check the box next to the condition you wish to set for the current Vendor. The options are defined 
within the system, Options -> Purchasing, details of how to create these are detailed in Options section of the help.

Navigation:  Reference > Vendor View - Tab: General >

Tab: Order Conditions
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Click 'Close' to close the Vendor properties, click on another tab to continue adding detail or use the   to move to the next supplier.

See Also:

In this module the banking information for the Vendor can be stored 

Bank Details: 

This tab is very straightforward, just enter the relevant banking details for the Vendor.

 Options -> Purchasing. *create link when module complete

Navigation:  Reference > Vendor View - Tab: General >

Tab: Bank Details
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Click 'Close' to close the Vendor properties, click on another tab to continue adding detail or use the   to move to the next supplier.

With the Tax Discount tab, discount rates may be applied and also set a value added tax (VAT) rate. These are then applied at 
a global level for all orders for this Vendor.

Tax Discount: 

Navigation:  Reference > Vendor View - Tab: General >

Tab: Tax Discount

Main Screen



Vendor default Tax: a default tax can be assigned to each vendor by country

CET code: entity code

C.E.T: name of entity/ship/warehouse

Global Discount:

VAT: value added tax

Click 'Close' to close the Vendor properties, click on another tab to continue adding detail or use the   to move to the next supplier.

In Documents various attachments can be added to enhance the Vendor detail. These can include Contracts, 
Terms & Conditions, Complaint Letters, Vendors Public Health Ratings, Pictures and any kind of Document 
necessary for the correspondence with the supplier.
This is a very useful Option that provides the same Information for all the Users of the Material Management at a 
central storing location. 

Documents: 

Navigation:  Reference > Vendor View - Tab: General >

Tab: Documents Previous page Return to chapter overview Next page
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In order to add a new document to the vendors details, click on 

The following will appear:

By selecting the file and then clicking open, the document will be attached to the selected vendor.

Click 'Exit' to close the Vendor properties, click on another tab to continue adding detail or use the to move to the next supplier.

Any side notes that need to be added to the Vendor can be inserted here. This option could be utilized for leaving comments in 
preparation for a handover or might contain a list of outstanding task with the relevant vendor or a short summary of current 
Performance i.e. if a Vendor is monitored more strictly than others before it gets finally approved. 

Navigation:  Reference > Vendor View - Tab: General >

Tab: Notes & Comments

Main Screen



Notes & Comments: 

This section is free text and it may be typed directly in the box. 

Click 'Close' to close the Vendor properties, click on another tab to continue adding detail or use the   to move to the next supplier.

Invoice on file will display all acquired Invoices. Any Other Order that has not been received yet will 
be shown in the Order on File Tab.

Invoice On File: 

The information is 'read only' and cannot be opened to view further detail from here. 

Navigation:  Reference > Vendor View - Tab: General >

Tab: Invoice On File
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Clicking on the column headings will sort the data in ascending or descending order by that column.

Click 'Close' to close the Vendor properties, click on another tab to continue adding detail or use the   to move to the next supplier.

In this section any current orders that have not yet been invoiced are displayed. When they have 

Navigation:  Reference > Vendor View - Tab: General >

Tab: Order On File
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been invoiced, they will be viewable in the Invoice On File tab.

Order on File: 

The information is 'read only' and cannot be opened to view further detail from here.

Clicking on the column headings will sort the data in ascending or descending order by that column.

Click 'Close' to close the Vendor properties, click on another tab to continue adding detail or use the   to move to the next supplier.

Custom properties set up for the particular vendor can be setup here 

Custom Properties:

Navigation:  Reference > Vendor View - Tab: General >

Tab: Custom Properties
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Click 'Close' to close the Vendor properties, click on another tab to continue adding detail or use the   to move to the next supplier.

Secondary Coding:

Alternative codes and their descriptions will be visible here and may be added.

Click 'Close' to close the Vendor properties, click on another tab to continue adding detail or use the   to move to the next supplier.

Navigation:  Reference > Vendor View - Tab: General >

Tab: Secondary Coding

Navigation:  Reference > Vendor View - Tab: General >

Tab: Security
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Security: 

In this tab the rights to view, access and edit the vendor can be set up. In order to add a new administrator click on "Edit"

Within this view the users who can access and view the details of the vendor can be set up. 

Click 'Close' to close the Vendor properties, click on another tab to continue adding detail or use the   to move to the next 
supplier.
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This chapter will guide the user through creating a new 
Vendor step by step. As mentioned elsewhere in the help, 
many of the fields are optional and do not need to be 
completed immediately during the initial setup. The 
properties may be edited at a later date and add in new 
information or change the current details as and when 
required. The initial wizard requires only the most basic 
details to setup a new Vendor.

Add a New Vendor: 

An empty vendor details screen will show up

Navigation:  How to ... >

How to...Add a New Vendor

Click to create a new Vendor record.
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By filling out the fields and making sure that the vendor is enabled in the checkbox on the top left of the 
screen and by clicking close the new vendor will be added to the list

Type: this box shows whether this particular vendor is active or not

Sub Vendor of: vendors can also be a sub vendor of another. With this drop down users are able to select 
the main vendor from the list of vendors already in the system 

Code & Name: the specific code for the vendor and the name of the vendor is to be entered in these slots

Address: postal address of vendor

Country, City: country and city of headquarters of vendor. You can scroll down the list of countries to 
select or, alternatively, start to type the name of the country you are looking for. The system will jump to the 
nearest matches, letter by letter, as you type. 

Post Code: corresponding post code

Primary Phone Number: main contact number of vendor

Other: Other type of contact that does not fall into the other categories
Port Agent: Ships agent in a specified port.
Travel Agent: Travel agency or Tour operator in a specified port.
Vendor: A ship chandler or supplier in a specified port.
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Primary Fax: main fax number for vendor

Email Address: email address of vendor

Web Site: website of vendor

When these basic details have been entered the vendor will then be 
ready to be added to the list. In order to do this the vendor must be 
enabled by marking the box on the top left of the display 

. When this has been done, by 
clicking on 

"Close" the newly created vendor will be added to the list.
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The Warehousing module is used to manage the stock for all product types shore side. The module functions as a tool for 
receiving, controlling and forwarding of items fleet wide. It also consolidates different types of articles into one dispatch / shipment.

Warehousing: 

Below is an image of the Warehousing module main screen as it looks once opened.   On the top are located 
the function buttons and the the toolbar menu. Below these are located three main areas : 

is active; receiving, transfers or corrections.

At the  bottom of the screen, the vessel information, date & time, current user and computer name are displayed.

Navigation:  Reference >

Warehousing

 Calendar - showing all transfer activity using the color green.
 Function tabs - accessing the options for receiving and transferring material from the warehouse
 Transactions Display area  - on the right hand side of the screen showing transaction details.

Navigation:  Reference > Main Screen >

Buttons
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The buttons toolbar contains the most frequently used options for accessing the warehousing tools.

Buttons: 

Clicking the buttons or links below will open more information and instructions on using of these functions.

Most of the options have corresponding tools in the menu, keyboard shortcuts assigned to them, or are available with a right mouse click.        

The search option  provides a way to search and locate a specific transaction within the warehouse module by defining specific 
search criteria.

Search: 

Once the search engine is activated, the  various fields for specifying the search criteria open. To search using a specific criteria, first click
the box to the left of the desired criteria to make the drop down lists active and available.

Search Search for an order request with different criteria
Refresh Refresh the screen view
New Transfer Opens a wizard that will guide the user in creating a new warehouse transfer
New Correction Opens a wizard that will guide the user in making a warehouse stock correction

Stock View warehouse stock for different groups of items
Statistics View statistical information on warehouse items
Product Overview View product information in detail
Print Opens the Report Manager to print and view warehouse and other reports
Exit Exit the requests module

Navigation:  Reference > Main Screen > Buttons >

Buttons : Search

Click the Search button to initiate the search engine functionality.

A warehouse transaction may be searched for on the basis of the PO (Purchase 
Order) number, if this number is known.  Use the drop down list to choose from all 
the purchase orders available in the system.

A warehouse transaction may be searched for by vendor.  The system will limit the 
search to the specific vendor (supplier)  selected  from the drop down list. 

If doing a  search by vessel, the system will only consider orders for the specified 
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Note:  Once the criteria is chosen the search may be initiated by pressing and the results will be displayed in the main screen.

The search results window may be left open in the background.  Any time a new search is needed click the Search Order tab..

This option refreshes the screen layout. For example, once having sorted columns by their heading or resized them,  clicking 
refresh will reset the layout to the default view.

Refresh: 

vessel.  Use the drop down list to choose from the vessels available in the system.

If searching  by order status the system will only consider the requests that meet the 
status chosen from the drop down selection.  The user has nine order status' to 
choose from.

Navigation:  Reference > Main Screen > Buttons >

Buttons : Refresh

Click to refresh the screen layout.

Navigation:  Reference > Main Screen > Buttons >

Buttons : New Transfer
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The transfers screen  is used for making material transfers from selected warehouses to the vessels. This function allows 
information  such as the destination vessel, the destination country and city, and other important details to be added. The items that 
will be included in the transfer can be inserted manually or directly from a purchase order.  By clicking on the transfers tab located 
at the bottom of the main screen,  all transactions relating to transfers can be viewed and accessed.

New transfer : 

The 'Create New Transfer' wizard opens. 

The first step is to select the SOURCE for the items that will be transferred. In other words 
the source is the warehouse from where the items will be taken from. Choose from the drop
down list the desired warehouse. .

The second step is to select the DESTINATION vessel that the items will be transferred to.
Once again choose the appropriate vessel from  the drop down list.

Click to create a new warehouse transfer 
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If there are entries for this vessel in the Itinerary Planer the country, city and agent field will 
will be filled automatically otherwise the date field can be completed by activating the calendar 
selection, simply by clicking on the down arrow to the right side the field. Optionally a time can 
be entered in the field next to the date if needed.

The destination country is selected in the corresponding space by clicking on the 
alphabetical drop down list. 
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Once the destination country has been selected, the destination city can then be chosen. 
The available selection is limited to the country that was chosen in the field above it.

Select the name of the local agent handling the transfer.  A full list of available company 
agents opens for selection by clicking on the down arrow in the field..
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There are now two Options, Click on Apply and items will be added in the next step
or if a purchase order is used as the basis of the transfer, the number can be typed in the field 
'Use PO Items', or the Purchase Order can be selected from the drop down list.

Click  to continue

The newly created transfer now appears in the Transfers Movements screen under the corresponding date 
that was used to create it. Notice the ID number assigned.

By double clicking the created document a new detailed screen will open. Here articles can be inserted that need to be
included in the transfer, if the Option "Use PO items" was not used,
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Move the cursor to the first cell under CODE

Write the name of the product directly into this cell or start the Search Engine by pressing the 
“+” button and locate the correct product this way.

Using the search engine allows the system to bring up all available products from which to choose.
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Select the desired product by DOUBLE CLICKING on the description and it will be inserted into the main sheet.

The 'Sent' column is then automatically hi lighted.  Type the required quantity into the field and confirm by pressing enter.
Continue with this process, moving the cursor again to the code cell in the next line and enter the next article 
that should be included in the transfer.

When finished entering items into the transfer document, close the window by clicking the   on the right hand side. 
The software returns to the transaction display area.   

Once the transfer document is completed, it can be finalized. This is done by selecting the corresponding document
from the main screen and RIGHT CLICKING it.  A shortcut menu appears.  Select 'Finalize'.

By selecting 'Finalize' the transfer status will be set to  and this closes the transaction.

The corrections function provides the ability to process stock adjustments in a selected warehouse.

New Correction : 

The 'Create Correction' dialogue box appears.  Define which warehouse is to be adjusted.
Select a warehouse from the drop down list by clicking on the down arrow.

Navigation:  Reference > Main Screen > Buttons >

Buttons : New Correction

Click to process a new correction
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The date field can be completed by activating the calendar selection, simply by clicking on
the down arrow to the right side the field.  Optionally a time can be entered in the field next
to the date if needed.

Additional information can be entered in the comments space..

Continue by clicking the  button.

The created correction document will appear under the corrections screen under the corresponding day
that was initially selected. This is the location where the corrected articles have to be inserted. 

By double clicking the created document a space will open. In this space articles can be inserted that 
need to be included in the correction.
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Move the cursor to the first cell under CODE

Write the name of the product directly into this cell or start the search engine by pressing the 
“+” button and locate the correct product this way.

Using the search engine allows the system to bring up all available products from which to choose.
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Select the desired product by DOUBLE CLICKING on the description and it will be inserted into the main sheet.

Continue by typing the required quantity in the 'Amount' column, and confirm by pressing enter. Move the cursor 
again to the code cell in the next line and complete all the articles that should be included in the correction.

After completing the correction document, close the window by clicking the   on the right hand side.  The software
returns to the transaction display area.   

Once the transfer document is completed, it can be finalized,   This is done by selecting the corresponding document
from the main screen and RIGHT CLICKING it.  A shortcut menu appears.  Select 'Finalize'.

By selecting 'Finalize' the correction document status will be set to  and this closes the transaction.

The Warehouse Stock Viewer can be used for accessing the amounts and status' of any article or product group in any of the 
warehouses.

Stock: 

Navigation:  Reference > Main Screen > Buttons >

Buttons : Stock

Open the Warehouse Stock Viewer
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Once the Stock Viewer is open, it is necessary to define which warehouse to view. Select a warehouse
from the drop down list by simply clicking on the down arrow..

The next step is to select the type of store to view. Again select the desired store type from the drop down list.

Once the warehouse and store type are selected, the detailed information of the items stored within the warehouse will 
display on the right hand side of the screen.
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The Stock details viewing screen displays the information in columns organized as follows: 

´

The Statistics button is active only when individual products are being analyzed in the Warehouse Stock Viewer.  While in this 
mode it is possible find detailed information concerning purchase history, consumptions, and pending requests for the item.

Statistics: 

A window will open with four separate tabs, each having different type of information about the selected product. Most
of the tabs have the date range selection option available making it possible to define a specific date range to locate the 
required data. 

DETAILS TAB

The information under the details tab contains the product base details such as product code, description and unit.  Below this are the 
statistics -  showing the fixed and average price details. The window also displays the current stock on hand for the 
warehouse and vessels. 

Code Article Code
Description Article description
Unit Article Unit of measure
Open Opening Stock of Article
Received Quantity received in Warehouse
Transferred Quantity of Article transferred from warehouse
Corrections Stock adjustments marked as corrections
Current Current stock of article
Expected in Quantity expected to arrive to warehouse
Expected out Quantity expected to transfer out from warehouse
Available Available stock

Navigation:  Reference > Main Screen > Buttons >

Buttons : Statistics

While in the items view click to open the Statistics form.
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The details viewing screen displays the information in columns organized as follows: 

Warehouse:        Warehouse name
Available:                Quantity available 
SOH:          Stock on hand

PURCHASE HISTORY TAB

Under this tab a complete purchase history for the selected product can be viewed. This information can filtered to view from 
one entity or all entities within the company, as well as a specified date range.

Once these values are chosen, click on the button to display detailed information in the grid below the selection criteria.
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The purchase history details viewing screen displays the information in columns organized as follows: 

Delivery:         Delivery date of the purchase
Destination        :        Destination of the delivery
Requested:                 Quantity requested from vessel
Received:         Quantity received upon delivery at destination
Price:         Price of article upon delivery
Total:         Total value of delivery
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Vendor:         Name of vendor
PO:                 Purchase order reference number relating to the delivery.

CONSUMPTIONS TAB

Under this tab consumption figures for the selected item are available.   This information can filtered to view from 
one entity or all entities within the company, as well as a specified date range.

Once these values are chosen, click on the button to display detailed information in the grid below the selection criteria.
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The consumption details viewing screen displays the information in columns organized as follows: 

Ship:         Name of ship
From:         Period starting date
To:          Period ending date
Season:         Name of season
Closing SOH:         Period closing stock on hand
Corrections:                Corrections made to stock during period
Consumption:        Net consumption during period

PENDING REQUESTS

Under this tab pending requests for the selected item are available.   This information can filtered to view from 
one entity or all entities within the company, as well as a specified date range.

Once these values are chosen, click on the button to display detailed information in the grid below the selection criteria.

Main Screen



The pending requests details viewing screen displays the information in columns organized as follows: 

Ship:         Name of Ship
ID:          Request ID
Date:          Date of Request
Status:         Status level of request
Requested:                 Quantity requested
SOH:         Stock on hand
Days Reserve:         Number of days defined to hold reserve.

The Product Overview displays detailed information about a selected article and its stock distribution within different storage 
locations. It Is also possible to review the transaction delivery and purchase history per product. 

Product Overview : 

The product overview function can be activated by clicking the button once having a product detail screen active (receiving orders, transfers or 
corrections). 

Navigation:  Reference > Main Screen > Buttons >

Buttons : Product Overview

Click to open product overview. 
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First define which warehouse to view by selecting the correct information from the drop down list provided.

Next choose which store type to view by selecting it from the drop down list provided

. 

An inventory of the selected warehouse with a current stock on hand will be displayed in its own window on the left hand side of the screen, and the 
product overview tab opens to the right, which has various sub-windows.
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The other windows contain the following information :

VESSEL STOCK ON HAND DISTRIBUTION

This window displays the current stock on hand for the selected product for all the vessels of the fleet.

ITEM TRANSFER WINDOW

This window displays the item transfers (open and finalized) per vessel into columns as described below:

WAREHOUSE STOCK WINDOW

This window will display the current stock on hand at the selected warehouse

At the bottom left of the screen are located various tabs. Each one of these tabs has special functions that change the 
way the left part of the screen looks while the right hand side stays as before.

OVERVIEW TAB

Date Transaction date
Source Source of transfer (FROM)
Destination Destination of transfer (TO)
Unit Unit of measure of article
Status Transfer status of transaction
Amount Amount of transaction
Price Unit price of article used in transaction
Value Total value of transaction
Comments Free comments may be inserted in this space
Doc ID Document ID created by the system
Last Modified Date transaction last modified 
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The OverView tab displays the Warehouse Management Calendar and a summary of deliveries divided by vendor for the selected day.

GROUPING TAB

The Grouping Tab displays the categories of the products of the selected transfer, displaying every group which the products fall into.

PRODUCT VIEW TAB

This is the default look of the Product Overview screen. It displays the full inventory of the selected warehouse.

QUICK VIEW TAB

The Quick View Tab displays further information regarding the selected article as listed below : 

Key Supplier name
Count Total number of articles in the transaction
Value Value (dollar amount) of transaction

Item Item description
Stock on Hand Stock on hand at selected warehouse
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This option opens the Report Manager. It is also available in Menu; File ->Print.

Print: 

Description Item description
Ordered Quantity ordered
Confirmed Quantity confirmed inbound
Received Quantity received
Unit Unit of measure of article
Price Unit price of article used in transaction
Sub Total Subtotal of transaction

Navigation:  Reference > Main Screen > Buttons >

Buttons : Print

Click to open the Report Manager.

Navigation:  Reference > Main Screen > Buttons >

Buttons : Exit
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This option will close the Warehousing module. You may also select Menu; File -> Exit.

Exit: 

The Tabs at the bottom of the screen open the possibility to access the following areas of the warehouse management module : 

Tabs: 

Click to close the Warehouse Module. 

Navigation:  Reference > Main Screen >

Tabs

 Receiving Orders Screen for receiving orders at a Warehouse
 Transfers Screen for working with item transfers from the warehouse to destination vessels.
 Corrections Screen to processing stock corrections at the warehouse.

Navigation:  Reference > Main Screen > Tabs >

Tabs : Receiving
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The Receiving Orders screen can be used for viewing and managing product orders.  This function allows verification of orders at 
arrival in the warehouse, and confirmation of the quantities received prior to dispatching items to a vessel.

Receiving: 

Below is an image of the Receiving Orders screen as it would look during normal operaton.  On the top are located the Function buttons and the 
Toolbar Menu.  Below these are located several main screen areas: 

At the bottom of the screen, the vessel information, date, time, current user and computer name are displayed.

Inbound or 'Receiving Orders' transactions for the selected date are listed in the corresponding area.

The columns displaying information about the inbound orders are as follows : 

Click on tab to open the Receiving Orders screen

 Calendar showing all inbound orders activity with the color blue.
 Inbound orders transactions are listed on the right hand side of the screen.
 Below the calendar view is a summary screen of a single inbound order.
 Below the inbound orders activity area are tabs for accessing transfers and corrections functions

Main Screen



Double clicking a receiving orders document will open it to its order details, where individual article details are viewed.   

The columns displaying information for the receiving orders details are as follows : 

Right clicking the items view area, will activate further options for managing the receiving, many of which also are available under the Statistics Button

Destination Destination warehouse receiving the items
OS Status of the selected transaction 0- Pending 1-Finalized 3- Posted to external system
PON Purchase order number
VID Vendor identification code
Vendor Name of vendor (supplier)
Value Value in local currency
CUR Local currency unit
Value (System 
Currency) Value in system currency

Gross Weight (KG)    Amount in KG

Code Article code
Description Article description
Ordered Quantity ordered
Confirmed Quantity confirmed by supplier
Received Quantity received at delivery
Unit Article unit of measure
Price Article unit price
Sub Total Subtotal price of delivery
Discount % Discount percentage received
VAT Value added tax
Total
Weight (kg)

Total price of delivery for article
Weight per item

Expire Date Expire date of product
Comments Free comments can be inserted in this space .

Set Ordered to Received
Set Confirmed to 
Received
Show Item Statistics
Show Item History
Show Item Consumption
Refresh

Set selected order to received status
Set selected confirmed to received status
Show item statistics for selected item
Show item history for selected item
Show item consumptions for selected Item
Refresh the view to default.

Main Screen



The transfers screen  is used for making material transfers from selected warehouses to the vessels. This function allows 
information  such as the destination vessel, the destination country and city, and other important details to be added. The items that 
will be included in the transfer can be inserted manually or directly from a purchase order.  Among the transfers tab a New Transfer 
may be created simply by clicking the New transfer Button in the Tool Bar.

Transfers: 

Below is an image of the Transfers Movements screen as it would look during normal operation. At the top are located 
the function buttons and the the toolbar Menu. Below these are located the following main areas : 

At the bottom of the screen, the vessel information, date, time, current user and computer name are displayed..

Transfer transactions for the selected date are listed in the corresponding area.

The columns displaying information for the transfers are as follows : 

Navigation:  Reference > Main Screen > Tabs >

Tabs : Transfers

Click on tab to open the Transfers Movements screen

 Calendar showing all transfer activity with the color green.
 Transfers Movements are listed on the right hand side of the screen
 Below the movements general area are tabs for accessing receiving and corrections functions

ID Document ID 

Main Screen



Double clicking a transfer document will open the transfer details screen where individual article details can be added or viewed.    

      The columns displaying information for the Transfer details are as follows : 

Right clicking the items view area, will activate further options for managing transfers, many of which also are available under the Statistics Button

The transfers screen  is used for making material transfers from selected warehouses to the vessels. This function allows 

number created 
by the system

Source Source warehouse of the Transfer (FROM)
OS Transfer Status 0-Pending 1-Finalized 2-Received by Vessel 3-Posted to External System
Destination Destination of the transfer
Port Delivery port of transfer
Via Name of local agent at destination
Value Dollar value of transfer in system currency
Gross Weight 
(kilogram)

Gross Weight of this 
transfer in kilogram

Code Article 
code

Description Article description
Sent Quantity of articles sent through transfer
Unit Unit of measure of article
Price Unit price of article
Total Total price of article transferred

Update Prices

Delete
Delete Items with Zero 
balance

Show Item Statistics
Show Item History
Show Item 
Consumptions
Refresh

Update Prices for selected Transaction

Delete selected Transaction
Delete Items with Zero balance in selected Transaction

Show Item Statistics for selected Item
Show Item History for selected Item
Show Item Consumptions for selected Item
Refresh the view back to default

Navigation:  Reference > Main Screen > Tabs > Tabs : Transfers >

Via Container Option

Main Screen



information  such as the destination vessel, the destination country and city, and other important details to be added. The items that 
will be included in the transfer can be inserted manually or directly from a purchase order.  Among the transfers tab a New Transfer 
may be created simply by clicking the New transfer Button in the Tool Bar.

Transfers: 

Below is an image of the Transfers Movements screen as it would look during normal operation. At the top are located 
the function buttons and the the toolbar Menu. Below these are located the following main areas : 

At the bottom of the screen, the vessel information, date, time, current user and computer name are displayed..

Transfer transactions for the selected date are listed in the corresponding area.

The columns displaying information for the transfers are as follows : 

Click on tab to open the Transfers Movements screen

 Calendar showing all transfer activity with the color green.
 Transfers Movements are listed on the right hand side of the screen
 Below the movements general area are tabs for accessing receiving and corrections functions

ID Document ID 
number created 
by the system

Source Source warehouse of the Transfer (FROM)
OS Transfer Status 0-Pending 1-Finalized 2-Received by Vessel 3-Posted to External System
Destination Destination of the transfer
Port Delivery port of transfer

Main Screen



Double clicking a transfer document will open the transfer details screen where individual article details can be added or viewed.    

      The columns displaying information for the Transfer details are as follows : 

Right clicking the items view area, will activate further options for managing transfers, many of which also are available under the Statistics Button

HEADER1: 

Here we write something about Text1. In Templates topic on the bottom-left side, you have frames that you can copy and paste here.

See Also:

Via Name of local agent at destination
Value Dollar value of transfer in system currency
Gross Weight 
(kilogram)

Gross Weight of this 
transfer in kilogram

Code Article 
code

Description Article description
Sent Quantity of articles sent through transfer
Unit Unit of measure of article
Price Unit price of article
Total Total price of article transferred

Update Prices

Delete
Delete Items with Zero 
balance

Show Item Statistics
Show Item History
Show Item 
Consumptions
Refresh

Update Prices for selected Transaction

Delete selected Transaction
Delete Items with Zero balance in selected Transaction

Show Item Statistics for selected Item
Show Item History for selected Item
Show Item Consumptions for selected Item
Refresh the view back to default

 Link 1
 Link 2
 Link 3

Navigation:  Reference > Main Screen > Tabs >

Main Screen



The corrections function provides the ability to process stock adjustments in a selected warehouse.

Corrections: 

Below is an image of the Receiving Orders screen as it would look during normal operaton.  On the top are located the Function buttons and the 
Toolbar Menu.  Below these are located several main screen areas: 

At the bottom of the screen, the vessel information, date, time, current user and computer name are displayed..

Correction transactions for the selected date are listed in the corresponding area.        

The columns displaying information for the corrections are as follows : 

Tabs : Corrections

Click on tab to open the Corrections screen.

 Calendar showing all correction activity with the color purple.
 Correction transactions are listed on the right hand side of the screen
 Below the calendar view is a summary screen of a single correction.
 Below the corrections general area are tabs for accessing receiving and transfers functions

Warehouse Warehouse in 

Main Screen



Double clicking a correction transaction document will open the details where individual article details can be viewed.     

The columns displaying information for the correction details are as follows : 

      Right clicking the items view area, will activate further options for managing transfers, many of which also are available under the Statistics Button

which  the 
correction is made 

Date Date of the correction
OS Status of the correction transaction   0- Pending 1- Finalized
Port Port in which the correction has been made. 
Comments Free comments can be inserted in this space.
Value Dollar value of the correction in system currency. 

Code Article 
code

Description Article description
Amount Quantity of articles adjusted in the correction
Unit Unit of measure of article
Price Unit price of article
Total Total price of article transferred

Update Prices
Delete
Delete Items with Zero 
balance
Show Item Statistics
Show Item History
Show Item 
Consumptions
Refresh

Update prices for selected transaction
Delete selected transaction
Delete items with zero balance in selected transactions
Show item statistics for selected Item
Show item history for selected Item
Show item consumptions for selected Item
Refresh the view back to default

Main Screen



The Menu bar on the top of the screen contain basic options which are also represented in the Toolbar. The same options are also 
available by right clicking the Items view.

Menu: 

This menu contains options for exporting and printing warehouse information.  The program can also be exited from here.

File: 

Navigation:  Reference > Main Screen >

Menu Receiving View

Navigation:  Reference > Main Screen > Menu Receiving View >

Menu : File

Export 
Print
Exit

Export the current view to an Excel sheet
Opens the Report Manager for printing reports.
Closes the Warehouse Module

Navigation:  Reference > Main Screen > Menu Receiving View >

Menu : Edit

Main Screen



Using the edit menu functions such as opening, status changing, and finalizing warehouse transactions can be done. The screen 
can be returned to the default view by clicking on the refresh button.

Edit : 

The Windows menu changes how the windows are displayed on the screen.

Windows : 

***
Replace this with some text outlining and summarizing what you write about. Below split your text into sections or steps and use 
header to separate it.

HEADER1: 

Here we write something about Text1. In Templates topic on the bottom-left side, you have frames that you can copy and paste here.

See Also:

Open
Status
Finalize
Refresh

Opens the selected line item
View the transaction status 
Finalize a transaction
Refreshes the view to the default

Navigation:  Reference > Main Screen > Menu Receiving View >

Menu : Windows

Arrange All
     Split

Rearranges the windows back to the default view.
Splits the selected views equally across the screen

Navigation:  Reference > Main Screen >

Enter topic name

Main Screen



Replace this with some text outlining and summarizing what you write about. Below split your text into sections or steps and use 
header to separate it.

HEADER1: 

Here we write something about Text1. In Templates topic on the bottom-left side, you have frames that you can copy and paste here.

See Also:

Replace this with some text outlining and summarizing what you write about. Below split your text into sections or steps and use 
header to separate it.

HEADER1: 

Here we write something about Text1. In Templates topic on the bottom-left side, you have frames that you can copy and paste here.

See Also:

Replace this with some text outlining and summarizing what you write about. Below split your text into sections or steps and use 
header to separate it.

HEADER1: 

Here we write something about Text1. In Templates topic on the bottom-left side, you have frames that you can copy and paste here.

See Also:

 Link 1
 Link 2
 Link 3

Navigation:  Reference > Main Screen > Menu Transfer View >

Enter topic name

 Link 1
 Link 2
 Link 3

Navigation:  Reference > Main Screen >

Enter topic name

 Link 1
 Link 2
 Link 3

Navigation:  Reference > Main Screen > Menu Correction View >

Enter topic name

 Link 1
 Link 2

Main Screen



 Link 3

Main Screen



Navigation: »No topics above this level« 

Frequently Asked Questions

There are several warehouse related reports that can be used for this types of purpose. You can find them by entering in Report Manager 
and selecting All reports starting with WH

 We use 'Loading Report' to show what has been received. Is there a similar report to show items
received at warehouse?

Frequently Asked Questions



Here you can find an explanation of terms used throughout the system. Click the letter to expand a tree or use index to locate specific word.

Account

Account: - Called a cost center in accounting, and is used to assign cost to a specified location or usage type like 
maintenance, spoilage, breakage or consumption. All of the areas onboard have assignments to a certain account even if 
they are not visible for the regular user. 

Accounts Reference

Accounts Reference -  a unique number given out by the accounting department and assigned to a single document to 
identify and trace it.

MORE INFORMATION

Additionally, an account is a label for recording a quantity of almost anything. Most often it is a 
record of an amount of money owned or owed by or to a particular person or entity, or allocated to a 
particular purpose. It may represent amounts of money that have actually changed hands, or it may 
represent an estimate of the values of assets, or it may be a combination of these.

A contra account is an account that carries a balance opposite to the normal balance. An example 
would be Accumulated Depreciation. The term account is also used more generally by analogy and 
association with accountancy concepts.

Accountability

Accountability - To be answerable for the results of an assigned action. Accountability is associated with delegated 
authority and is distinct from responsibility. A supervisor can assign responsibility but cannot give away his/her 
 accountability; the manager is ultimately accountable. Example: The Service Center is responsible for providing financial 
reports and accountable to ensure the financial reports are accurate; however, the unit manager is accountable for the 
budgetary condition or financial standing of the unit. 

Alternate or Alternative Coding

A second bar code or secondary coding that can be added to the article in the article manager if desired in order to be able 
to search by the alternate code (i.e. perhaps an old code for the item which is already well known to the users).

Navigation: »No topics above this level« 

Glossary

Navigation: Glossary > A >

Account

Navigation: Glossary > A >

Accountability

Navigation: Glossary > A >

Alternate Coding

Glossary



Article:

An article in the system is a single item, which once existing can be used to request, purchase, load, transfer and use it in a 
recipe via the Material Management System. The basic definition requires an Article Type, an Article ID a Description 
and a Unit

Article Type:

All articles must be assigned an Article Type:

Article Status:

All articles must be assigned a status:

Status 0 – Article is disabled.
An Article can be disabled in order to stop the using of article on a single vessel or fleet wide. Whenever modifying i.e. 

changing the description an article the article needs to be disabled first.

Status 1 – Article is enabled
When an article is enabled it can actually be used onboard.

Navigation: Glossary > A >

Article

Parent Code Where the item is the 'main' unit size (for example with liquor, the 1 
liter bottle will normally be the parent code).

Child Code The child code is related to a parent code, for example; 75 cl, 50 cl 
bottles which are 'sub' types to the parent code.

Grouping Code Used for example with uniforms. You have a blazer in different sizes 
and the code is the general code. Then for every single size you have 
a different ending no 50020 (Grouping Code) 50020 – L (Size)

Glossary



Average Price:

The Average Price Method is a mathematical operation for evaluating the price of provisions onboard to consider the 
fact that some of the same items have been purchased at different purchasing prices. 

SUMMARY

The system offers different ways to calculate the onboard price. 
These are:

MORE INFORMATION

The basic reason why the Material Management uses an average price is because most of the purchasing prices are never 
fixed and vary in different ways depending on the article group. For example, the price of fruits and vegetables can change 
on a daily basis. The MMS needs an average price to evaluate the stock on hand correctly for the main store as well as the 
movements and as a result of this the outlets. There can be slightly different average prices onboard a single ship for just 
one single item.
In most of the cases the prices at the points of consumption varies in almost the same way as in the main store but the 
level depends on the request and consumption behavior of the specific point of consumption. But the average price in a 
POC can not be higher than the most expensive purchasing price or lower than the cheapest.

The average price is a very important figure for the accounting department in order to calculate the proper Cost of Food / 
Cost of Sales, consumption level and all other reports concerning the food and beverage operation.

The images of the 2 Excel sheets below represent an easy example of how the Material Management actually calculates 
the price.

Navigation: Glossary > A >

Average Price        

 Use FIFO (First In First Out)
 Use Weighted Averages
 Use Last Loading Price
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In real food and beverage operation, the average 
calculation will be much more complex and 
complicated!

Glossary



Bar Code

A bar code is a machine-readable representation of information in a visual format on a surface.
The data is stored in the widths and spacings of printed parallel lines,

MORE INFORMATION

A bar code appears on many articles, and can be scanned with a bar code reader. The numerical equivalent of the bar 
code can be entered into the Alternate Coding field in the article as a point of reference and for searching. 

Navigation: Glossary > B >

Bar Code

Glossary



Base Unit:

A Base Unit is a fundamental unit of measurement which is used to form other compound units for other quantities

SUMMARY

Base Unit - All units used for receiving articles are converted into the base unit . Basically this means that the system will convert for instance a 75cl 

Navigation: Glossary > B >

Base Unit

Glossary



bottle (BT 075) into 0.75 liters. Base units are normally meters, liters, kilograms.

Base and derived units

Base Unit Cost

Navigation: Glossary > B >

Base Unit Cost

Glossary



Base Unit Cost - The Base Unit Cost is defined in the article Manager shore side. It is linked with the unit defined in the same module and is therefore 
responsible for the cost of each                item. i.e.  in this example, the price of one bottle of Absolut Vodka containing 1 liter is $4.58. The basic unit 
price of this article is $4.58 and the basic unit is 1 liter bottle.

Bid/ Bids

Bid, Quotes or Quotation: Quotes or quotations are offers from vendors to supply specific items at 
specific prices. Also known as bids, the ship or headquarters will request quotations from a number of 
vendors, and will select the most suitable responses to be used for future purchasing. 

CET = Company Entity Type

CET

CET describes all the entities the cruise line might have including all the warehouses, ships.

Navigation: Glossary > B >

Bid/ Bids 

Navigation: Glossary > C >

CET

Navigation: Glossary > C >

Consumables
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Consumables

Consumables - Items used to maintain the onboard operation, which are usually not items directly sold as revenue 
producers. Examples of consumables would be paper goods, cleaning materials, etc.

Consumption

The expression consumption is used to describe the amount of Stock Deduction.

SUMMARY

The phrase consumption appears in a few important Material Management modules such as requests and sales import. 
Used in cases and for Points of Consumptions (mainly galleys) where the stock reduction is not initiated by recipes and end 
of cruise inventory will take place. Any time a period reset is performed the stock on hand will be set to zero. The resulting 
difference between the stock on hand and zero level stock will be assumed and accepted as the average consumption of 
the relevant cruise.

Value of Consumption is a expression that can be found especially in food cost reports and includes the consumption and 
the sold items.

Conversions; conversion factors

Conversion

Conversion - If the loading units are different to the units defined in the article manager the system needs to convert it into the correct quantity in order to 
achieve proper stock on hand and for deduction in usage.

Conversion Factor

Conversion Factor - The relationship between the base unit and the other unit(s) being used for loading or deduction in usage.

Navigation: Glossary > C >

Consumption

Navigation: Glossary > C >

Conversion

Glossary



Cost Center:

Cost centers are expressions used in accounting / book keeping departments to record costs by 
area.

Credit Note

Credit Note - If the buyer returns a product, the seller usually issues a credit note for the same (or agreed lower) amount as the invoice, and then 
refunds the money to the buyer or the buyer can apply that credit note to another invoice. The credit note is a very important document that enables 
store keeping and inventory control to remove the goods from the stock and thereby reduce the stock quantity and value.

Cruise Plan

Cruise Plan - The schedule of the ship that includes the ports of call, sea days, dry-dock etc. The Material Management 
System provides a module called Itinerary Planer that will display all the necessary information for the Food and Beverage 
Operation in order to ensure exact provision planning. 

Navigation: Glossary > C >

Cost Center

Navigation: Glossary > C >

Credit Note

Navigation: Glossary > C >

Cruise Plan

Glossary



Customs Declaration

Navigation: Glossary > C >

Customs Declaration / Customs Category
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Depending on local regulations in the ports of call, the vessels will be required to present various 'Customs Declaration' 
reports, detailing quantities of certain items which are being carried on the vessel. 

Customs Category

In the appropriate field in MMS, the user should indicate in which category the item should be listed in order to ensure an 
accurate Customs Declaration.

Navigation: Glossary > C >

Container
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Container        

A container is a method of combining goods from various places and suppliers into one large delivery.

SUMMARY

The Container Module was designed to simplify the loading process. It enables the user to collect all the supplies for a ship 
at a specified location. The collecting of supplies and loading into the container will "merge" the supplies from different 
vendors into a single "container" movement.  It should be mentioned that the implementation of the container module into a 
company's supply chain will also heavily relocate the controlling responsibilities from shipside receiving to the consolidation 
address where the goods will be collected and the stuffing of the actual container will take place. The container module will 
greatly simplify the internal logistics and assure the on time ship supply more than before.

Please note that the assignment of goods to containers is done in the purchasing module because the purchasing process 
has a closer connection to the delivery date and the corresponding consolidation address. For this reason many container 
related tasks will be found in the matching modules.

Delivery Note

Delivery Note - A Delivery Note is a document provided by the vendor that gives information about delivered goods. The 
Delivery Note contains the quantity in pieces, volume or weight of all the articles included in the delivery. In the ideal case, 
the quantities that have been actually received match with the delivery note as well as with the invoice.

Description

Description - The field in the article manager that provides a factual description of the article, such as brand name, product 
name, etc. MMS supports descriptions in up to 5 different languages. This functionality is provided in order to be able to 
purchase / request articles in various languages according to the requirements of the chosen supplier.

Navigation: Glossary > D >

Delivery Note

Navigation: Glossary > D >

Description
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FIFO - First In, First Out Principle

FIFO - This is the most common procedure in shore side warehouses and onboard ships stores to handle the goods within 
the store. Following this procedure, goods are issued or consumed in the order in which they were delivered. For food and 
beverage items, this procedure is important due to the perishability of the items, and ensures that items in the store are 
always fresh. 

FIFO - First In, First Out Price

FIFO Price: The FIFO price is the continuation of the FIFO principle in pricing of goods onboard. FIFO accounting is a 
common method for recording the value of inventory. It is appropriate where there are many different batches of similar 
products. The method presumes that the next item to be issued to a point of consumption will be the oldest of that type in 
the warehouse. In practice, this usually reflects the underlying commercial substance of the issue, since many companies 
rotate their inventory.

MORE INFORMATION

See also:

Fleet 

Navigation: Glossary > F >

FIFO    

 Average Price with detailed overview and examples of different average price calculation

Navigation: Glossary > F >

Fleet / Fleet Range
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Fleet - All the ships belonging to a cruise line.

Fleet Range

Fleet Range - This MMS field is used in the shore side setup of the system to allow specific articles to be used on specific 
ships. Therefore, the article has to be both on enabled status, and assigned to the vessel in the fleet range in order to be 
available for use onboard that particular ship.

Grey + Key (Article Search Engine): 

Grey Plus Key simply refers to the key on your keyboard, which allows you to insert an item into document you are 
creating. Once you press that key the article search engine screen opens.

Article Search Engine:

Navigation: Glossary > G >

Grey + Key
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Single click on the item will bring you then to the section where the article is located.

Glossary
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When you double click an item on the main screen, that item will be added to your current document.

History:  The system remembers the last item you searched for, by clicking on the history button the system
 will jump to that last searched location.

GTIN Global Trade Item Number

GTIN

Global Trade Identification Number (GTIN) is an identifier for trade items developed by GS1 comprising the former EAN 
Standard. 

See also:

    NOTE:
The system will show only articles which are enabled!! If the system should search for all articles, it is necessary to check the 

 Show Disabled Items at the bottom of the search engine.

Navigation: Glossary > G >

GTIN

 Barcode

Navigation: Glossary > H >
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Headquarter:

The main (shore side) office for the cruise line. The place to which (in most operations) the orders (requests) are sent.

SUMMARY

The Material Management System divides all the necessary tasks for the whole procurement and supply chain into 
smaller pieces and gives the responsibility to the most appropriate department. For this reason the division of labor will 
pass many decision making and administrative tasks to the headquarter.

Invoice

Invoice - A document issued by the vendor to a customer, indicating all the products, quantities and agreed prices for 
products or services with which the vendor has already provided the buyer. Invoices refer to a specific delivery, and 
therefore, the invoice needs to be compared with the delivery note in order to check if all information, i.e. quantities 
delivered, etc, is corresponding. An invoice indicates that, unless paid in advance, payment is due by the buyer to the 
seller, according to the agreed terms of payment. Invoices are also often called bills. 

Invoice Number

Invoice Number - A unique number generated by the vendor that helps to identify the invoice.

Headquarter

Navigation: Glossary > I >

Invoice
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Item 

Item - A term used in Micros POS (Point of Sale) for the articles which are sold in any given outlet. In MMS, the Micros 
item information is entered in the article setup on the Sales Setup screen.

Navigation: Glossary > I >

Item
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Inventory, Stock Count, Stock Balance

Inventory

An inventory is a physical count of all the items present in the ships stores, points of consumption or warehouses. 

SUMMARY

An inventory confirms that all necessary bookings regarding the provision like stock balance and value are correct and can 
be finally taken over to the balance sheet. As well, an inventory assures that the system stock on hand is according to the 
counted amount and if necessary reduces or increases the actual stock on hand.  In contrast to a Spot Check inventory, a 
regular inventory comprises all articles.

Navigation: Glossary > I >

Inventory
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MORE INFORMATION

Each cruise line has its own polices and rules about inventories, their executions as well as their cycles. Usually 
inventories are taken at the end of the cruise or at specific times maybe when other departments may be 
affected. The Material Management System supports and optimizes the (periodical) accomplishment and the 
necessary reporting issues. 

See also: 

Ledger Code:

Ledger Code or General Ledger Code is used in the article setup (Shelf Life/ Customs / Other Tab) to 
assign an article to a code / description to ensure accurate record in the general ledger. The descriptions 
which may be found in the drop down menu are also assigned to real 5 digits account reference. This setup is 
done during the setup procedure of the Material Management System.

 Spot Check

Navigation: Glossary > L >

Ledger Code / General Ledger Code
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Loading is an expression used in the Material Management movement module. 

Loading:

A loading is a delivery from a vendor shore side to the ship main store. In order to do a system loading according to the 

Navigation: Glossary > L >

Loading

Glossary



material management requirements, there are 2 basic conditions that have to be fulfilled completely:

In the Material Management a loading is actually a request (ship to shore) that has been processed into a purchase order. 
When "loading" the specific request it can again be further processed into a loading document. To enable ship side 
personnel to do so, the order needs to be on status 5 "order confirmed quantities" in the purchasing module.

Lockers, fridges etc. 

Locker:

Lockers - Storage locations onboard the vessels are referred to as 'lockers'. They are 'sub' locations to main storage 
rooms.

SUMMARY

In contrast to the folders and sub folders in the article manager, a locker actually describes the physical storing location of 
the articles. 

MORE INFORMATION

Proper locker assignment in the article master data will greatly simplify the accomplishment of inventories. The great 
advantage of using locker assignment is that the user is enabled to handle the inventories in locker related count sheets 
which will have immediate effect on the time used for a single stock count.

This means that during an inventory the actual counting can be done with a count sheet only containing the articles 
assigned to a specific locker and thereby avoiding the necessity to handle huge amounts of paper.

The other great advantage is that for example high valuable items can be assigned to special lockers and thereby simplify 
the accomplishment of spot checks of these items.

Lockers

1. A purchase order for the specific loading date has to be placed by the shore side purchasing department.
2. The purchase order has been further processed up to status 5 within the system.

Navigation: Glossary > L >

Lockers
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Microsoft Knowledge Base Article - 183293 

How To Configure a Firewall for MSMQ Access

View products that this article applies to.
This article was previously published under Q183293 

SUMMARY

This article describes how to configure a firewall to allow Internet access to Microsoft Message Queue Server (MSMQ). 
This article discusses the effects of different port restrictions. 

For security, use the HTTP/HTTPS messaging that is available in MSMQ 3.0 as a solution for messaging with MSMQ 
through firewalls, instead of statically opening the ports that are detailed in this article. 

MORE INFORMATION

For additional information about ports used by MSMQ, please see the following article in the Microsoft Knowledge Base: 
178517 INFO: TCP, UDP, and RPC Ports Used by MSMQ 
Terminology used in the following examples: 
DC = dependent client
IDC = independent client
Server = any of the MSMQ server installations
MQIS = Message Queue information store
RPC = remote procedure call 

Example 1: Minimal Send-Only Access for IDC and Server

At a minimum, you must allow incoming traffic to destination TCP port 1801. This is the port over which IDCs and Servers send messages. IDCs and 
servers also send MSMQ internal packets for establishing sessions and so forth. DCs do not use this port. 

If traffic is restricted to this port, outside clients can only send messages, and can only do so by using a direct format name. The MQIS is not available on 
this port, therefore calls that consult the MQIS will fail. This includes Lookups, Queue open with a non-direct format name, and so forth. Note that MSMQ 
routing is not used in this case. The client must be able to contact the remote queue manager directly over this port. 

Example 2: Full Send Access for IDC, MQIS Operations

If you also allow incoming traffic to TCP ports 135, 2101, and UDP port 3527, packets that request operations involving the MQIS (for example, queue 
create, queue open (for send)) with a non-direct format name are permitted. Port 135 is the RPC discovery port, used to discover the ports for the different 
queue manager interfaces. Port 2101 carries the MQIS traffic. Allowing traffic to TCP port 3527 is necessary for full and efficient operation between queue 
managers. Queue managers attempt to ping each other on this port before opening a session. Note that a DC doesn't have a queue manager. This 
functionality is performed by the server on the DC's behalf. 

One benefit is that messages can be sent to queues that are looked up and opened with non-direct format names, and as a result are routed through the 
MSMQ enterprise to their destination queue. 

Example 3: Full Send-Receive Access

Allowing traffic to ports 2103 and 2105 permits the outside IDCs to read from queues on the server and from computers on its connected network. This also 
allows send-receive for DCs. No send or receive from a DC is possible unless these ports are open. 

Additional Ports

Assuming that multicast network packets can reach the firewall, allowing traffic to User Datagram Protocol (UDP) port 1801 permits independent clients to 
discover and/or confirm their site controller on start and also to detect a halted site controller and take steps to discover a new one. 

NOTE: Ports 2xxx are not necessarily fixed. For additional information about this issue, refer to the Knowledge Base article cited earlier. 

The information in this article applies to:

Keywords: kbhowto KB183293
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· Microsoft Message Queue Server (MSMQ) 1.0 
· Microsoft Message Queuing 2.0
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Movement: 

Movement  - A movement is internal transfer of stock between different internal and external sources and destinations.  These 
can be as follows: Vendors, Warehouses, Stores, Points of Consumptions and Accounts, Uniform Allotments etc.

A movement means that the stock is transferred in 2 ways even if this is not obvious to the user.

All of the movements are responsible for the results of the designated periods especially cost reports, stock on hand and 
inventories. So it is the most imperative issue for the user to handle all the movements very carefully and to be fully aware of all 
the effects this may cause. 

Points of Consumptions and Stores affected by Movements:

Shipside

Shore side:

Movement

1. The physical movement of stock:
The release of the moved items from the issuing store and the transfer of the stock amount to the requesting outlet to ensure
correct stock level.

2. The movement of stock on hand value from one account which is linked with the relevant store and to the corresponding
POC account.

Onboard Ashore
Main Stores Vendors

Points of Consumption Warehouses

Accounts

Uniform Allotments

- Main Stores
o Food, Beverage, Hotel, Consumables, Medical,

 These are the actual storing locations of all the items loaded onboard and where they will physically and 
system wise remain until further usage. The stock in the main stores is only reduced by issues. In a very 
well organized store even the quantity level of spoilage should be at an acceptable level. (The MMS system 
provides shelf life handling as well!)

- Points of Consumption
o Main Galley, Bar, Pool deck, Lido café etc.

 POC or Point of Consumption
The exact business and accounting expression for the points on board where the goods are going to be 
used and consumed
The most common POC´s onboard cruise ships are the main galley, the main restaurant and the main bar
where benefit is going to be generated by the sold and used items. The Point of Consumption is actually the
“final destination” of a single item. In this case consumption means that at this point the article / item is going 
to be sold, used or further prepared. Consumption in this case is referring to the way the stock is going to be 
reduced because the supposed method on a Point of Consumption is reducing the stock by linking recipes
to the sales items. The recipes will indicate the exact quantity of each single item that has to be reduced 
once a sales item is sold. That is exactly the reason why the common corresponding expression in the sales
system is Point of Sale or POS because these two expressions are relying to each other. The Material
Management handles the stock and the POS system handles the sales that reduce the stock.

- Uniform Allotments
o Crew

 Uniform Supply
Accounts assigned to each crew member tracking the entire uniform history of a crew member and thereby
having an actual stock when the crewmember is disembarking.

- Accounts
o Breakage, Spoilage, Officers, Dinner Parties etc.

 An account is the accounting expression for the instrument that assigns costs to specific causes.
All the areas affected by the material management system are assigned to accounts but in this case the
account lists costs as an expense account rather than the revenue accounts that oppose the cost and the 
benefit. An account contains only values of the spent or earned sums and not the material, items or 
investments themselves. An Issue to an Account will take stock from a store and assign it to a defined 
cause in order to have total control of the money spent for these causes and to control the budget planned
for the specific cause. The most often used accounts are, Spoilage, Breakage, Consumption of Port
Authorities, Officers, Cocktail Parties, Crew Parties etc.

- Vendor
o Suppliers of Food, Beverage, Consumables, Medicals etc

 A vendor is a company who supplies goods or services to the cruise line. A vendor is also called a supplier.
The Material Management System also supplies an option to evaluate the vendors performance upon the quality of the delivery. This may
include detailed questions about general packing, conditions of supplies, documentation, vendor, security, shore gang and the pier in order
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Warehouse

Material Management

The name of Fidelio's Material Management System is not just the name of the software but also a term in 
business and administration. Material Management includes all the processes in a supply chain as well as 
tracking the sales and consumptions amount while having individual stock levels in the designated area. 
Thereby the Material Management assures a strict control of the stock and avoiding possible loss for the cruise 
line.

Negative Stock Value:

Negative Stock Value means that the stock on hand is below zero. In real life it is of course NEVER possible to have 
i.e. minus 1.5 Bottle of white rum in a bar. Actually a negative stock value is an indication that some kind of mistake 
occurred. In most of the cases the stock viewer is the appropriate module to investigate negative stock value if 
necessary. 

Negative stock value might appear in a Point of Consumption but not in a store because the system prohibits user 
actions resulting in negative stock.

Purchase Order Status 

Order Status:

The order status indicates level of completion in the order process tasks: Detailed description as explained in the 
purchasing manager help file. 
Very important to note is that a loading or order number needs to be at status 5 (order confirmed quantities) before it 
actually can be seen shipside and be loaded into the system. If no office PO number appears within the Material 
Management the order status is probably below 4 and has to be set in the Head Office to status 5. 

to establish detailed ranking of supplier.

- Warehouses
o Company Warehouse

 Warehouses are mostly often used to store items in higher quantities than currently needed on board. This can be to be able to:
 Purchase goods in higher quantities than currently required to achieve lower purchasing prices until needed onboard.
 Store goods that are difficult to procure or the procurement might take longer than the standard time between shipside request and

purchasing
in order to have it any time available the ships are requesting the goods.

 Goods have to be purchased in minimum quantities that are higher than the ships storing capacities and above the usual consumption 
level.
For this purpose the goods can be stored in the warehouse location until requested from the shipside.

 Warehouses can either be used for storing over capacities from ships that are presently not used on board.
 Warehouses can also be used to transfer items between ships, when it comes to overlaps, even if the articles were not actually

physically present in the specific warehouse.
Therefore the items are transferred from the ship to the warehouse and from the warehouse to the other ship.
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Period; defined time range

Period: 

Period
A season is an additional identifier assigned to a specific cruise identifying the location or the geographical position of the 
relevant ship. This enables the system to assign consumptions to specific seasons. 

SUMMARY

A pre defined date range or inventory cycle which is usually according to the cruise start and end date in order to generate 
exact accounting figures. 
These figures will also provide the statistical information regarding the average consumption level during that cruise in that 
specific season.

MORE INFORMATION

The period reset module handles the period turn over procedure in Material Management. This sequence covers the phases 
encapsulating and organizing data in a periodical order, based on set monthly or cruise periods. This allows to report all 
aspects of a purchasing and inventory operation onboard the ships and ashore. 

An obligatory part of the proper functioning of the MMS software is that a closing is made on regular basis. In most cases 
the periods are reset on a per cruise and monthly basis in order to have all the relevant reporting data available to the 
various operational functions. All this is dependent on individual company policies on how the procedures should be set.

POC - POINT OF CONSUMPTION

Point of consumption is a place on the ship where something is consumed. 
In MMS following types of POC are used: 

For this type of P.O.C. you are able to create “Causes” giving you even more detailed information where the items go to.
You could for example create “Officers from Mainstore” P.O.C. with following ”Causes”: Master, Staff Captain, Chief Engineer. 
Another example would be P.O.C. “Complimentary” and cause “Port Authorities”. That allows you to get detailed breakdown of “Accounts”
P.O.C. by causes.

To better understand relations between departments, POC and accounts, please see at below diagram:
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1. Standard (Bars, Galleys, Substores, etc.)
2. Uniforms (Company Assigned effects)
3. Accounts (eg.: Complimentary, Officers from Mainstore) 
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See also:

POS Point Of Sale: 

POS Point of Sale: The place, cost center or F&B outlet were items are sold and transactions occur.

SUMMARY

Point of Sales is the Micros sales system term for point of consumption. 

The Micros sales system is always focused on the sales because it was designed and developed for 
this purpose. The Material Management helps organizing the purchasing and warehouse process and 
therefore it is more related to consumptions figures caused by sales in the Micros system first.

That is why these 2 systems use 2 different terms.

The Material Management can actually help the Micros sales system to administrate sales items 
because any article in Material Management can be defined to be delivered to the Micros sales system. 
The actual import export will be done by persons with the necessary security rights only. 

Where Material Management uses the POS Term:

In the article manager we find in each article the tab sales setup with 3 existing fields that require POS 
data if this functionality is going to be used by the company.

Price:

In economics and business, the price is the assigned numerical monetary value of a good, service or asset.

 Movement
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Classification and Definition in Material Management:

The Material Management Program uses different terms for prices that sound almost the same but the meaning might differ 
from the users intention. So whenever looking and evaluating prices these differences have to be considered:

Purchase Order:

Purchase Order: A Purchase Order (abbreviated PO) is a commercial document issued by a buyer to a seller, indicating 
the type, quantities and agreed prices for products or services that the seller will provide to the buyer. 

Sending a PO to a supplier constitutes a legal offer to buy products or services. Acceptance of a PO by a seller usually 
forms a once-off contract between the buyer and seller and no contract exists until the PO is accepted. 

Structure

A purchase order usually contains: PO number, shipping date, billing address, shipping address, requested terms, and a list 
of products with quantities and prices.

Rationale

The reasons why companies use POs vary. They allow buyers to clearly communicate their intentions to sellers, and 
they protect sellers in the event that a buyer refuses to pay for something which was sent. 

Companies usually request POs when doing business with other companies for orders of significant size, as the PO 
reduces the risks involved.

In the course of the accounts payable process, purchase orders are matched with invoice and packing slips before the 
invoices are paid.

A Purchase Order Number is an auto generated ID that is given to each Purchase Order to assign a 
recognizable criteria to the specific purchase order. Usually the vendors are asked to note this number on the 
delivery note, the invoice and any other correspondence regarding this specific order. 

Material Management Technical Requirements: 

Screen resolution at least 1024x768 pixels

 Purchase Price: The price at which the goods were purchased.
 Bid Price: The price of the quotation
 Last Loading Price: Price of last loading / delivery or container loading
 FiFO Price First In First Out Price
 Average Price 1 as defined in the Options Menu
 Average Price 2 as defined in the Options Menu
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Reserve Stock

Reserve Stock - the 'safety' quantity that should always be on-hand to ensure that the supply of a product is not exhausted prior to the next delivery. In 
MMS, this is indicated in the field 'Days Reserve Stock' where the number of days worth of the item to be held in reserve should be entered.

Requests

A request is the document produced by the ship specifying items to be delivered, with quantities and required date for 
delivery. The request is produced and authorized onboard by the appropriate persons, and is then sent to the headquarters 
for processing.

Report

A report is a document generated by MMS providing information related to MMS data, such as inventory figures, consumption, etc.
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Rebate / Discount:

Rebate/ Discount

A reduction in price, usually a percentage based on volume, applied either at the time of purchase (discount) or returned by 
the vendor later (rebate).

Receiving Unit:

Receiving Unit

The unit of measure in which the vessel receives items delivered. This unit is then used for adding the received 
merchandise to the onhand inventory onboard.

Recipe:

Recipe

Recipes contain lists of ingredients in a particular sales item (such as a cocktail) in order to effectively deduct the correct 
items from the stock on hand when the item is sold. For example, a recipe for Bloody Mary will contain the appropriate 
amounts of vodka and tomato juice or mix.

Sold; Sold Item

Sold:

Sold: Sold Item; in Material Management an item where stock has been reduced by a recipe and the amounts in it.

Season; geographical location of a single vessel

Season: 

A season is an additional identifier assigned to a specific cruise identifying the location or the geographical position of 
the relevant ship.

Seasons were basically introduced in order to track consumptions referring to the actual location of the ship because 
passengers vary accordingly. Seasons will be assigned to periods in the Period Manager

Stock Deduction; reduction of Stock Level

Stock Reduction

The term stock deduction is used in the Material Management System to describe the decrease of stock if caused by a 
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recipe.

Sales Import:

Sales Import

The module in Material Management which facilitates the importation of data from the Micros POS to be 
used in MMS for stock deduction and reporting purposes.  This module is (along with the Stock Viewer) 
the most important tool to detect any stock discrepancies, for example if the stock of any item is not 
logical, i.e. has a negative value.

For the Setup Period of the Material Management the Sales Import offers a very Important functionality 
to link the recipes with the Micros Sales Items. This might also be source for possible stock 
discrepancies if the entries were not made 100% according to the Material Management, company and 
operational requirements.

In cases where Material Management is used in conjunction with Micros sales system, the continuous 
data administration with this module will lead to highly reliable accurate stock figures.

Store; storing location for Food, Beverage, technical equipment, etc.

Store:

A location where products are stored when received, and from where they are issued to the points of consumption (POCs) or sub-stores.

The unit of measure in which the vessel maintains the stock onboard.

Sub store:

The location to which products are issued from the main stores.

The length of time a particular product can be in stock, i.e. the time between when it is produced and when it must be consumed. 

Shelf Life Control:

The process of managing products to ensure they are consumed during their shelf life period.

HACCP

Stock

The stock is the total of the items carried onboard in the stores and in the Points of Consumptions.
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Importance in Material Management 

The main priority of the Fidelio Cruise Material Management System is to keep focus on the stock (so called Stock on Hand) 
and therefore keeping direct and total control of all the items loaded or transferred to the ships stores. All processes and 
modules within the system directly and indirectly affect the stock balance and all the ships results like food cost, profit and 
loss etc.

Whenever mentioning inventories and spot checks there are always 3 different terms in combination with the stock:

Stock on Hand (SOH)

The stock on hand is the value in the Material Management System and is providing the stock level of the specified item(s) 
regarding all transactions in Material Management like Loadings, Transfers, Consumptions, Sales, Spoilage, Breakage etc.

Counted Stock (Counted)

The counted stock is the result of the stock count, inventory or spot check.

Variance 

The variance is also an expression that appears in a column heading in the inventory module. It provides the difference 
between stock on hand (SOH) and counted stock.

Spot Check

Spot check: a kind of Inventory where only the stock of a specific locker will be counted. 

More Information

Usually these spot checks are done when a regular inventory comprising any locker and sub folder (as defined in Article 
Manager) is not taking place for some reason and just some sensitive lockers or article groups need to be checked. These 
spot check inventories can include high value items and those that are relevant for customs authorities in order to provide 
100 % accurate information.

Possibilities in Material Management 

A Spot Check can actually be generated by selecting the type and/or  locker option in the inventory creation window. 
Type: Random 20 or Random 50 will randomly select 20 or 50 items for the spot check that have to be counted.
Locker: Selecting a locker will only add items of the specified locker to the spot check.
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Template is a kind of a list of items, which can be used throughout the whole system.

Templates: 

Once a template is created, you can use it for example to create a request - the whole list of items from template would be inserted into your new 
request.

See example:
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In this case, once a template containing 2 items has been created in Template Manager, it can be then used when creating a new transaction in 
Movements module.
Main reason for creating templates is to save time when creating new entries in the system. When the proper templates are created, it's much faster just 
to insert it into the current document, 
and then just adjust the quantities, rather than entering all the articles from the beginning.
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Short Meaning of Terms ..

Agreed, negotiated and contracted conditions how the seller of a product is going to receive the payments that are due.

SUMMARY

These Conditions can and should include the following points:

MORE

Warehouse

A Warehouse is a commercial building for storage of goods. Warehouses are used by manufacturers, importers, exporters, wholesalers, transport 
businesses, customs, and of course they are used within the cruise ship industry. 

More information

In the cruise ship industry and especially referring to the difficult problem of assuring the ships supply at any time, warehouse have become 
necessary to solve a few problems.
Warehouses can:
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 Rebate, Discount, allowance  etc.
 Due Date of Payment (depending on Delivery Date)
 Time for Payment Allowed
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 be used as a interim storage solution for high quantity items
 difficult to procure and maybe especially produced  goods or goods with long delivery times
 store goods from especially cheap offers to safe costs.
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